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INSTALL LICENSE AGREEMENT
This legal document is an agreement between you, the end user (“YOU” or
“LICENSEE”), and Berkley Integrated Audio Software, Inc. (“BIAS, Inc.”). BY
CLICKING “INSTALL” ON THE FOLLOWING DIALOG, YOU ARE AGREEING TO
BECOME BOUND BY THE TERMS OF THIS AGREEMENT, WHICH INCLUDES
THE SOFTWARE LICENSE AND THE SOFTWARE DISCLAIMER OF WARRANTY
(collectively the “Agreement”). CLICK “QUIT” ON THE FOLLOWING DIALOG IF
YOU DO NOT ACCEPT THE TERMS OF THIS AGREEMENT. THIS AGREEMENT
CONSTITUTES THE COMPLETE AGREEMENT BETWEEN YOU AND BIAS, INC.
IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO NOT USE
OR REGISTER THE SOFTWARE AND PROMPTLY RETURN THE SOFTWARE AND
THE OTHER MATERIALS (INCLUDING WRITTEN MATERIALS, BINDERS OR
OTHER CONTAINERS) THAT ARE PART OF THIS PRODUCT TO THE PLACE
WHERE YOU OBTAINED THEM FOR A FULL REFUND. YOUR USE OF THIS
SOFTWARE SHALL CONSTITUTE ACCEPTANCE OF THIS AGREEMENT, AND
ONCE YOU HAVE REGISTERED THE SOFTWARE YOU MAY NOT RETURN IT.
1.

BIAS SOFTWARE LICENSE

3.

OWNERSHIP OF SOFTWARE AND DOCUMENTATION. As LICENSEE,
you own the media on which the SOFTWARE and DOCUMENTATION are
originally or subsequently recorded or fixed, but BIAS retains title and
ownership of the SOFTWARE and DOCUMENTATION and all subsequent
copies of the SOFTWARE and DOCUMENTATION, regardless of the form
or media on which the original and other copies may exist. This License
is not a sale of the original SOFTWARE or any copy or sale of the original
DOCUMENTATION.

4.

COPY RESTRICTIONS. This SOFTWARE and the DOCUMENTATION are
copyrighted. Unauthorized copying of the SOFTWARE, including
SOFTWARE that has been modified, merged, or included with other
software, or of the DOCUMENTATION is expressly forbidden. You may
be held legally responsible for any copyright infringement that is caused
or encouraged by your failure to abide by the terms of this License.
Subject to these restrictions, and if the SOFTWARE is not copy-protected,
you may make one (1) copy of the SOFTWARE solely for backup
purposes. You must reproduce and include the copyright notice on the
backup copy.

5.

USE RESTRICTIONS. As the LICENSEE, you may physically transfer the
SOFTWARE from one computer to another provided that the
SOFTWARE is used on only one computer at a time if you have
purchased a single user license or, if you have purchased a multi-user
single site license, on up to the number of computers for which you have
purchased a license at one time. You may not electronically transfer the
SOFTWARE from one computer to another over a network. You may not
distribute copies of the SOFTWARE or the DOCUMENTATION to others.
You may not modify, adapt, translate, reverse engineer, decompile,
disassemble, or create derivative works based on the SOFTWARE. You
may not modify, adapt, translate, or create derivative works based on the
DOCUMENTATION without the prior written consent of BIAS.

6.

TRANSFER RESTRICTIONS. This SOFTWARE is licensed only to you,
LICENSEE, and may not be assigned or otherwise transferred to anyone,
whether voluntary or by operation of law, without the prior written
consent of BIAS. Any authorized transferee of the SOFTWARE must
agree to be bound by the terms and conditions of this Agreement, or the
transfer shall be invalid. In no event may you transfer, assign, rent, lease,
sell, or otherwise dispose of the SOFTWARE on a temporary or
permanent basis except as expressly provided herein.

7.

LICENSE TO U.S. GOVERNMENT. If LICENSEE is an agency or
instrumentality of the United States Government, the SOFTWARE and
DOCUMENTATION are “commercial computer software” and
“commercial computer software documentation”, and pursuant to FAR
12.212 or DFARS 227.7202, and their successors, as applicable, use,
reproduction and disclosure of the Software and Documentation are
governed by the terms of this Agreement.

8.

TERMINATION. This License is effective until terminated. This License
will terminate automatically without notice from BIAS if you fail to
comply with any provision of this License. Upon termination you shall
destroy the DOCUMENTATION and all copies of the SOFTWARE,
including modified copies, if any.

9.

UPDATE POLICY. BIAS may create, from time to time, updated versions
of the SOFTWARE. At its option, BIAS will make such updates available
to LICENSEE and transferees who have paid the update fee and returned
the registration card to BIAS.

BIAS offers two distinct license options – SINGLE USER and MULTI-USER
SINGLE SITE. If you have purchased a single user license, the license
terms in section 1a apply to you. If you have purchased a multi-user
single site license (e.g. 5 user lab pack), the license terms in section 1b
apply to you.
1a. GRANT OF LICENSE (SINGLE USER). In consideration of payment of the
single user license fee, which is part of the price you paid for this
product, BIAS, as Licensor, grants to you, LICENSEE, a nonexclusive
license to use and display this copy of a BIAS software program (the
“SOFTWARE”)
and
accompanying
user
documentation
(“DOCUMENTATION”). LICENSEE may install and authorize the
SOFTWARE on one COMPUTER, provided that (a) the COMPUTER is
owned by (or leased to) and under exclusive control of the Licensee; (b)
the SOFTWARE shall NOT be used simultaneously on more than one
COMPUTER at a time, and (c) any COMPUTER(S) with BIAS Software
installed shall not be sold, rented, leased, loaned or otherwise be
removed from the LICENSEE’s possession without first removing and
deauthorizing the Software, except as provided in Paragraph 6 (below)
pertaining to “TRANSFER RESTRICTIONS.” BIAS reserves all rights not
expressly granted to LICENSEE.
1b. GRANT OF LICENSE (MULTI-USER SINGLE SITE LICENSE). In
consideration of payment of the multi-user single site license fee, which
is part of the price you paid for this product, BIAS, as Licensor, grants to
you, LICENSEE, a nonexclusive license to use and display this copy of the
Software and Documentation. LICENSEE may install and authorize the
SOFTWARE on a number of COMPUTERS equal to or less than the
number of licenses purchased (e.g. a 5 User Lab Pack allows up to 5 BIAS
SOFTWARE licenses at a single SITE to be simultaneously installed,
authorized, and used on up to 5 COMPUTERS at said SITE), provided
that (a) each COMPUTER is owned by (or leased to) and under exclusive
control of the Licensee; (b) the SOFTWARE shall NOT be used
simultaneously on more COMPUTERS at a time than the number of
licenses purchased as part of the multi-user single site license, and (c)
any COMPUTER(S) with BIAS Software installed shall not be sold, rented,
leased, loaned or otherwise be removed from the LICENSEE’s
possession without first removing and deauthorizing the Software,
except as provided in Paragraph 6 (below) pertaining to “TRANSFER
RESTRICTIONS.” BIAS reserves all rights not expressly granted to
LICENSEE.

10.

BIAS PRODUCT SUPPORT.

Unlimited Complimentary Self Help Options
2.

ii

SOFTWARE AUTHORIZATION. You must register and AUTHORIZE this
SOFTWARE either online (via the included BIAS Authorization Manager
software) or by phone (1-800-775-2427 +1-707-782-1866). Once the
SOFTWARE is registered and AUTHORIZED, it may not be returned.

If you have questions about installing or using your BIAS products, please
check the manual or user guide first, and you will find answers to most
of your questions there. If you need further assistance, please check the
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BIAS Support Policy and Hours

support section of the BIAS web site, which contains answers to
frequently asked questions, troubleshooting tips, and more:

BIAS, Inc. support policy and hours are subject to change without notice.
http://www.bias-inc.com/support/faq/
Sales and Non-Technical Customer Service
Limited Complimentary Technical Assistance
For product information, sales, and other non-technical customer
service, please email or call:

Ninety days of complimentary technical support assistance for up to three
incidents is available with the initial purchase of current Type 1 BIAS
products (Peak Pro, Peak Pro XT, Master Perfection Suite, SoundSoap Pro).

sales@bias-inc.com
US: 1-800-775-BIAS (2427)
International: +1-707-782-1866

Ninety days of complimentary technical support assistance for a single
incident is available with the initial purchase of current Type 2 BIAS
products (Peak LE, SoundSoap 2).
The support period begins when the product is initially registered and
authorized.
Type 3 products (OEM versions) and legacy products (Deck, Deck LE) are
excluded.
An additional thirty days of complimentary technical support assistance
for a single incident, beginning on the expiration of the initial ninety days
of complimentary support described above, is available with the
purchase of paid upgrades to current Type 1 and Type 2 BIAS products.
To receive e-mail or telephone technical support, you will need a valid
serial number and must be registered for a current BIAS product. Please
keep your original product serial number (located on your original
owner’s certificate) in a safe place as it will be required for support.
Customers who prefer support by email, please contact:
support@bias-inc.com
Customers who prefer support by telephone, (connect and toll charges
apply), please have your computer running and close by the phone and
call us at:
+1-707-782-1865
(9AM-5PM Monday-Friday PST – excluding BIAS holidays)
Fee-based Technical Support Options
Fee-based Support is available for those customers whose support period
has expired (i.e., all complimentary technical support incidents have
been used, or product is no longer a current version) or for Type 3 (OEM
version) customers. Please call:
+1-707-782-1865
(9AM-5PM Monday-Friday PST – excluding BIAS holidays)
For customers living outside of North America, please contact your local
BIAS distributor, or contact BIAS directly. A list of BIAS distributors may
be found at:
http://www.bias-inc.com/distributors.html
Legacy Products
BIAS does not support legacy products. Legacy products are sold as-is,
and will not be developed further. Refunds are not available for legacy
products. Before purchasing a legacy product, BIAS encourages
researching system requirements, as well as downloading and using a
trial version to ensure system compatibility. Users of legacy products
may find useful support information in the BIAS User Forums, provided
by other users – BIAS User Forums are not an official resource for
obtaining technical support.

(9AM-5PM Monday-Friday PST – excluding BIAS holidays)
No technical support is available at the numbers or email address above.
11.

MISCELLANEOUS. This Agreement is governed by the law of the State of
California, without regard to conflicts of law principles.

DISCLAIMER OF WARRANTY AND LIMITED WARRANTY
THE SOFTWARE AND DOCUMENTATION (INCLUDING INSTRUCTIONS FOR
USE) ARE PROVIDED “AS IS” WITHOUT WARRANTIES OF ANY KIND. FURTHER,
BIAS DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS
REGARDING THE USE, OR THE RESULTS OF THE USE, OF THE SOFTWARE OR
DOCUMENTATION IN TERMS OF CORRECTNESS, ACCURACY, RELIABILITY,
CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND
PERFORMANCE OF THE SOFTWARE IS ASSUMED BY YOU, AND NOT BIAS OR
ITS DEALERS, DISTRIBUTORS, AGENTS, OR EMPLOYEES. YOU AGREE TO
ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR, OR
CORRECTION.
BIAS warrants to the original LICENSEE that the media upon which the
SOFTWARE is recorded and the BIAS Key (USB dongle), if applicable, are free
from defects in materials and workmanship under normal use and service for a
period of ninety (90) days from the date of delivery as evidenced by a copy of
your receipt. Further, BIAS hereby limits the duration of any implied
warranty(ies) on the media to the respective periods stated above. Some states
do not allow limitations on duration of an implied warranty, so the above
limitation may not apply to you.
BIAS’ entire liability and your exclusive remedy as to the media shall be, at BIAS’
option, either (a) return of the purchase price or (b) replacement of the media
that does not meet BIAS’ Limited Warranty and which is returned to BIAS with a
copy of the receipt. If failure of the media has resulted from accident, abuse, or
misapplication, BIAS shall have no responsibility to replace the media or refund
the purchase price. Any replacement media will be warranted for the remainder
of the original warranty period or thirty (30) days, whichever is longer.
THE ABOVE ARE THE ONLY WARRANTIES OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, THAT ARE
MADE BY BIAS CONCERNING THE BIAS PRODUCT. NO ORAL OR WRITTEN
INFORMATION OR ADVICE GIVEN BY BIAS, ITS DEALERS, DISTRIBUTORS,
AGENTS, OR EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY
INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY NOT RELY ON ANY
SUCH INFORMATION OR ADVICE. THIS WARRANTY GIVES YOU SPECIFIC
LEGAL RIGHTS. YOU MAY HAVE OTHER RIGHTS WHICH VARY FROM STATE TO
STATE.
NEITHER BIAS NOR ANYONE ELSE WHO HAS BEEN INVOLVED IN THE
CREATION, PRODUCTION, OR DELIVERY OF THIS PRODUCT SHALL BE LIABLE
FOR ANY DIRECT, INDIRECT, CONSEQUENTIAL, OR INCIDENTAL DAMAGES
(INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS
INTERRUPTION, LOSS OF BUSINESS INFORMATION, AND THE LIKE). BECAUSE
SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY
FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATION
MAY NOT APPLY TO YOU.

License Agreement/Credits

iii

This Disclaimer of Warranty and Limited Warranty is governed by the laws of the
State of California, without regard to conflicts of law principles.
Should you have any questions concerning this Agreement, or if you desire to
contact BIAS for any reason, please contact in writing:
BIAS Customer Sales and Service
140 Keller Street
Petaluma, CA 94952
USA
Copyright 1996–2008 BIAS, Inc.
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BIAS Product Support:

Unlimited Complimentary Self Help
Options
If you have questions about installing or using your BIAS
products, please check the manual or user guide first,
you will find answers to most of your questions there. If
you need further assistance, please check:

For customers preferring e-mail assistance, please use
the email form available on our web site at:

http://www.bias-inc.com/support.html

Or, email:

for frequently asked questions, an extensive database of
related articles, troubleshooting tips, and more.

support@bias-inc.com

Limited Complimentary Technical
Assistance
Ninety days of technical support assistance for up to
three incidents is available with the initial purchase of
Type 1 BIAS products (Peak Pro, Peak Pro XT, Master
Perfection Suite, Deck, SoundSoap Pro). Ninety days of
technical support assistance for a single incident is
available with the initial purchase of Type 2 BIAS
products (Peak LE, Deck LE, SuperFreq, SoundSoap 2,
individual Master Perfection Suite plug-ins). Type 3
products (OEM versions) are excluded. Thirty days of
technical support assistance for a single incident is
available with the purchase of paid upgrades to Type 1
and Type 2 BIAS products. The support period begins
when the product authorization code (PAC) is initially
issued following the product registration. To receive email or telephone technical support, you will need a valid
serial number and must be registered for a current BIAS
product. Please keep your original product serial number
and PAC in a safe place as it will be required for support.

http://www.bias-inc.com/support.html

For customers preferring telephone assistance, (connect
and toll charges apply), please have your computer
running and close by the phone and call us at:
+1-707-782-1865
9AM-5PM Monday-Friday PST – excluding BIAS holidays

Fee-based Technical Support Options
Fee-based Support is available for those customers
whose support period has expired or for Type 3 (OEM
version) customers. Please call:
+1-707-782-1865
9AM-5PM Monday-Friday PST – excluding BIAS holidays
For customers living outside of North America, please
contact your local BIAS distributor, or contact BIAS
directly. A list of BIAS distributors may be found at:
http://www.bias-inc.com/distributors.html

Product Support Options

v

Legacy Products
BIAS does not support legacy products. Legacy products
are sold as-is, and will not be developed further. Refunds
are not available for legacy products. Before purchasing
a legacy product, BIAS encourages researching system
requirements, as well as downloading and using a trial
version to ensure system compatibility. Users of legacy
products may find useful support information in the
BIAS User Forums, provided by other users – BIAS User
Forums are not an official resource for obtaining
technical support.

BIAS Support Policy and Hours
BIAS, Inc. support policy and hours are subject to change
without notice.

Sales and Non-Technical Customer Service
For product information, sales, and other non-technical
customer service, please email or call:
sales@bias-inc.com
US: 1-800-775-BIAS (2427)
International: +1-707-782-1866
9AM-5PM Monday-Friday PST – excluding BIAS holidays
No technical support is available at the numbers or email
address above.
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Chapter 1:
Introducing Peak

Welcome!
BIAS Peak™ is an advanced audio application that
provides superior tools for recording, editing, and
processing digital audio on the Mac. Peak was
specifically designed to meet the needs and demands of
audio professionals. By combining high-quality directfrom-disk digital audio editing features with lightning fast
destructive & non-destructive editing environments,
Peak provides unsurpassed audio editing power, and
makes a superb addition to audio applications such as
Cubase™, Digital Performer™, GarageBand™, Live™,
Logic™, Pro Tools™, and practically any other
application that deals with digital audio. Peak offers
advanced sampler support, and works directly with many
popular MIDI sampling keyboards and rackmount
samplers. Peak is also the perfect audio complement to
digital video editing programs, such as Avid Express
DV™, Final Cut Pro™, iMovie™, and Premiere™.

AIFF, Paris™, Jam Image, AU, MP2, MP3, MP4
(AAC), and FLAC formats
•

Non-destructive file- or RAM-based editing with
unlimited undo and redo

•

Professional editing abilities, including userdefinable fade curves, and complete support for
cut/copy/paste with multiple undo and redo

•

Support for third-party digital audio hardware,
such as Apogee™, Digidesign™, M-Audio™, Mark
of the Unicorn™, PreSonus™, or Universal
Audio™ digital audio interfaces, through Core
Audio

•

Support for 8-, 16-, 24-, and 32-bit audio files

•

Support for third-party VST™ & Audio Units effects
and instrument plug-ins, allowing you to add
advanced signal processing features to Peak. Plugins from companies such as BIAS, Cycling `74™,
Steinberg™, Waves™, and Apple™ can be used
with Peak for digital filtering, noise reduction,
reverb, equalization, and other effects in real time

•

The ability to create 100% Red Book compliant
(with CD-TEXT, ISRC codes, and PQ subcodes)
audio CDs directly from a Peak Playlist or audio
document

Peak Features:
•

Direct-to-disk recording and playback at all sample
rates supported by the sound hardware on your
Mac, or through third-party audio hardware

•

User-configurable waveform display

•

•

Support for commonly used audio document
formats, including AIFF, Sound Designer II™,
WAVE, QuickTime™, Raw, System 7 Sound, Sonic

Sophisticated Tools for looping, including Loop
Surfer™, Crossfade Loop, Perpetual Looper, Loop
Tuner™, and Guess Tempo™

•

Sampler Support
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•

Advanced Playlist editing, mastering, and delivery
options

•

Automated batch file processing

•

Customizable Toolbar and Keyboard Shortcuts

•

QuickTime Movie window with scrubbing

Who Is Peak Designed For?

•

Envelope for Convolve DSP

•

Change Pitch ( Variable)

Plug-ins

•

Vbox 3.0 plug-in effects routing matrix, with crosssynthesis linking, with improved presets and GUI

•

Plug-in envelopes in Plug-ins menu

•

Real-time bounce

Playlist

Peak is designed for a wide variety of users, ranging from
composers and multimedia producers to sound
designers, mastering engineers, and video & remix
editors. Peak’s comprehensive recording, editing,
mastering, looping, and processing capabilities make it a
powerhouse tool for virtually any aspect of digital audio
production. If you are interested in sound and possess
imagination and creativity, Peak is for you.

•

Enhanced user interface

•

“Overlap/Gap” – Track assembly editing mode

•

“Centered” – Classical/Take editing mode

•

Customizable volume envelopes

•

Merge Playlist events

•

Split Playlist events

•

Export/print custom formatted PQ sheets

•

Export DDP Files with CD-TEXT

What’s New in Version 6?

•

Burns Red Book CDs with extended ASCII
character set CD-TEXT

Peak 6 offers dozens of updates, enhancements, and new
features, which are described below:

•

New Playlist export option: Send to iTunes

•

Normalize Playlist event

•

Stereo track view

•

Fast-forward & rewind transport controls

DSP Tools

•

Perpetual Looper –
monophonic samples

•

A/B/C/D snapshots for crossfade shape/duration

•

Voiceover Ducking – automatically lowers
background audio when voiceover introduced

•

“Sticky” conform source Regions to Playlist Events
mode

•

DCAT™ Dither Cloning Audio Technology – noise
shaping algorithm, with real-time previewing

•

Zoom to sample level

•

Automatic sample rate conversion matches
impulses & target files in ImpulseVerb™

•

Horizontal zoom buttons

•

Zoom to fit transition
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•

Simplified Vbox plug-ins menu

•

Autoplay option in Open dialog

•

Copy Previous Track Name to CD-TEXT dialog
buttons

•

CD Frames time format: Hours:Min:Sec.CD
Frames (audio documents & Playlists)

•

Hierarchical Add Region Toolbar button pop-up
menu

•

New “Paste Except Audio” command

•

Auto-scrolling

•

Disclosable and resizable views

•

Default crossfades

Editing

Podcasting

•

Create new podcasts and/or episodes

•

Publish locally, and to .Mac & FTP servers

•

Submit podcasts to iTunes Podcast Directory

•

Cache in RAM – holds temp files in RAM during
editing for lightning-fast performance

•

Improved Guess Tempo accuracy

•

Improved Auto Tiling/Stacking window behavior

File I/O

•

File format-specific metadata editing

•

Metadata editing in MP3,
WAVE/Broadcast WAVE files

•

MP3 Export ID3 tag editing

•

Support for nameless markers in WAV files created
on portable recorders

•

MP2 File Support

•

FLAC File Support

•

Default “Save As” templates

User Interface

•

Multi-shade gradient skin

•

Magnetic windows

•

Export Regions now available in the Batch File
Processor

•

Rename/renumber multiple markers/regions

•

Option to display DSP Menu items in category or
alphabetical list

•

Support for Frontier Tranzport wireless control surface

•

Send to iTunes (audio documents & Playlists)

•

Logarithmic Meters with more resolution options
(-12, -24, -48, -96, -∞ dB), and pre/post options

•

Command-Option-click scrolling and zooming

•

Double-click on waveform to begin playback or
select between markers preference

•

Reset Windows command

•

Key commands in toolbar help tips

FLAC,

AIFF,

Operating System & Authorization

•

“Keyless” BIAS Authorization Manager

•

Keyserver Support
environments

•

Optimized support for Mac OS X 10.5 “Leopard”
and Intel processors
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Minimum System Requirements

About Your User’s Guide

To use Peak you will need:

Peak is designed to be simple and intuitive. Your User’s
Guide is designed to help you set up and use Peak for digital
recording and editing as quickly and easily as possible.

•

G4, G5, or Intel-based Mac (>500MHz processor
recommended)

•

Mac OS X v. 10.4.3 or higher

•

Minimum 1024 x 768 screen resolution

•

256 MB RAM (512 MB or more recommended)

•

330 MB available free disk space

•

18 ms hard drive (average seek time) or faster

•
•

This User’s Guide assumes that you are familiar with
standard Mac operating techniques, including:
•

Setting up, starting, and using your Mac

•

Choosing commands from menus

•

Clicking, double-clicking, selecting, Shift-selecting,
dragging with the mouse, and other common operations

QuickTime 7.0 or later

•

Opening, copying, saving and deleting files

Support for third-party audio hardware may
require compatible Core Audio drivers

•

Opening, closing, scrolling, moving, re-sizing, and
selecting Mac windows

For the most up-to-date information, please visit:
http://www.bias-inc.com/peak/
A compatible CD burner is required for burning
CD-TEXT and subcode metadata from a Peak
Playlist document. Burning CD-TEXT with
extended ASCII characters (such as the accented
characters è, é, ç, å, etc.) requires Mac OS X v. 10.5
“Leopard”.

Maximizing Peak’s Performance

If you don’t know how to perform these tasks, please
spend a little time learning about your Mac before going
any further. This will make using Peak much easier and
more enjoyable.
The Chapters in your Peak User’s Guide are arranged in
the order in which you would typically perform tasks
when embarking on an audio project:
•

Chapter 1 introduces you to Peak and explains
some of the requirements for using it

•

Chapter 2 explains how to install and authorize Peak

•

Chapter 3 introduces you to some basic concepts
of digital audio and disk-based recording, as well as
basic Peak operations

•

Chapter 4 explains how to set Peak to for record
and play back audio, and how to import audio from
compatible CD-ROM drives

•

Chapter 5 introduces you to the concepts and
techniques of nondestructive editing with Peak

•

Chapter 6 explains how to create regions and
sequence their playback using Playlists, as well as

The following tips are optional, and will help you get the
best performance out of Peak and your Mac.
To maximize Peak’s performance:

•
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Use a fast hard drive as a scratch disk/record disk –
BIAS recommends at least a 7200 RPM rotational
speed, 18ms access time or better, and a fast data
transfer connection, such as SCSI, FireWire
400/800, ATA, etc.
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how to burn audio CDs, and export in a variety of
common output formats

Add

•

Advanced Playlist – Peak LE features a basic Playlist

•

Amplitude Fit

•

Batch File Processor

•

Bit Depth and Sample rate limited to 24-bit/96kHz

•

Bit Usage

Chapter 10 explains how to use Peak’s Batch File
Processor as well as how to use Apple Events for
file management

•

Cache in RAM

•

Compute File Max dB

Chapter 11 explains how to import samples
directly from compatible samplers, and send
modified samples back to the sampler

•

Convolve

•

Crossfade Loop

•

Customizable Keyboard Shortcuts

•

Customizable Toolbar

•

Chapter 7 explains how to publish podcasts using Peak

•

Chapter 8 explains how to use Peak’s native DSP tools

•

Chapter 9 explains how to use Audio Units & VST
plug-ins, and how to use Vbox to enhance Peak’s
audio production capabilities

•

•

•

1

•

Chapter 12 describes each of the commands found
in Peak’s menus

•

Appendix 1 lists the default Keyboard Shortcuts for Peak

•

Dither

•

Appendix 2 provides a list of useful Peak Actions,
not available in menus

•

Duplicate

•

Envelope from Audio

•

Appendix 3 provides a troubleshooting guide for
commonly encountered problems

•

Export Regions

•

Appendix 4 is a mini-manual for the included BIAS
Sqweez-1 Compressor plug-in

•

Find Peak

•

Guess Tempo

A Glossary completes your Peak User’s Guide

•

Harmonic Rotate

•

ImpulseVerb

•

Includes a 2-band edition of the Freq EQ plug-in

•

Limited to three plug-in inserts

•

Loop Surfer and Loop Tuner

•

“Magic” Pencil Tool

Peak LE has a streamlined feature set and includes the
essential tools required for music production, basic CD
mastering, and editing the audio content in files
commonly used in non-linear video editing systems.

•

Markers from Tempo

•

Meters Dialog

•

Modulate

If you are using the limited edition (LE edition) of Peak,
the following features are not available:

•

Mono To Stereo

•

New Region Split

•

Look for important tips and notes whenever you
see this exclamation mark.

About Peak LE
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Toolbar, Transport, or Playlist. If you hold the mouse
cursor over a Toolbar/Transport icon for 1 second, the
Help Tip for that icon’s function will appear.

•

Panner

•

Perpetual Looper

•

Phase Vocoder

•

Rappify

•

Real-time bounce

•

Recording Notepad

•

Recover Audio File

•

Remove DC Offset

•

Rename/renumber multiple markers and regions

•

Repair Click

•

Repair Clicks

•

RMS Normalize

•

Sampler Support

•

Show Marker Times

•

Snap To Bars|Beats, PS2, Xbox, and Custom Units

•

Stereo To Mono

•

Strip Silence

•

Swap Channels

•

Tape-Style Scrubbing

•

Threshold

•

Vbox is not included

LE

The next type of help is available under the Peak menu.
Choosing Help will open the Peak User’s Guide, which
was installed along with Peak.

You may also use the Links menu to access additional
documentation, tutorials, and technical support online,
via the BIAS website.
BIAS recommends using these resources before
contacting Technical Support. The answers to most
common technical questions can be found in this User’s
Guide, or online. Best of all, using these help resources
is free, easy, and available 24 hours a day, 7 days a week,
365 days a year. If you do need to contact Technical
Support, please see the BIAS Technical Support Policy on
page 5 of this user’s guide.

Features that are not supported in Peak LE will show
this icon in the manual. Features unavailable in
Peak LE will appear greyed out in their menus.

Conclusion
Getting Help with Peak

Now that you know a little about Peak, proceed to the
next chapter to learn how to install and start using it.

Peak provides a variety of helpful resources when you
run into questions. The first type is Rollover Help Tips,
which shows you the function of each icon in the
26
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Installing Peak
Peak’s auto-installer software makes installation very easy.
The steps below will guide you through the process.

7. Select the hard drive/volume on which you wish to
install Peak, and click the Continue button.

Your complete Peak system consists of:

8. Click the Install/Upgrade button (depending on the
configuration of your user account, you may need
to enter your account password. If prompted for
your password, enter it and click the OK button. If
you do not know your account password, please
contact your system administrator for assistance).

•

CD-ROM installer

•

Serial number

•

Authorization File
Before you install Peak, please check the
Minimum System Requirements on Page 21.

To Install Peak:

9. When the installation is complete, a message will
appear indicating that the installation was
successful. Click the Close button to quit the
Installer. (Don’t forget to turn back on any virusprotection software that you may be using the next
time you restart the computer).

1. If you are using any virus protection software, turn
it off or temporarily remove it, and restart your Mac.
2. Insert the Peak installer CD-ROM into your CD-ROM
drive – when its icon appears on your computer’s
desktop, double-click the Install Peak icon.

What Peak Installs:

3. When prompted about the Installer package
running a program to determine if it can be
installed, click the Continue button.

•

Peak Application

•

Plug-ins

4. When the Installer dialog appears, click the
Continue button.

•

Peak Impulses

•

Peak Envelopes

•

Documentation

•

BIAS Authorization Manager

5. Read the Software License Agreement – then click
the Continue button to proceed.
6. Click the Agree button if you agree to the terms of
the Software License Agreement.
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If you would like to register and authorize Peak at this point,
launch the Peak application (which is installed into your
Applications folder by default), and have your Owner’s
Certificate handy, and follow the directions in the next section.

•

Authorizes your computer so it can run Peak. You
may authorize up to two computers for use with
Peak – for example, a studio or office computer,
and a laptop for home or mobile use.
Keep in mind that for each license of Peak – the
software may only be used by one user, on one
computer system at a time. If you have used both
of your authorizations, and need to authorize a
new computer, you will need to first de-authorize
one of the authorized computers before you are
issued a new authorization for the new computer.

Registration & Authorization
Peak must be authorized to work on your computer. You
must register Peak with BIAS in order to authorize it. The
registration and authorization process is outlined below.
Serial Number-Based Authorization System

Peak’s standard authorization system consists of the
following components:
•

BIAS Authorization Manager – A simple application
for managing BIAS software licenses.

•

Serial Number –

•

Your registration and
authorization information on the BIAS Server.

•

•

Located on Owner’s Certificate.

Registration Account –

A file transferred from
your computer to the BIAS server, which adds the
computer you are authorizing to your BIAS
Registration Account.

Authorization Request File –

Authorization File – A file transferred from the BIAS server
to your computer, which authorizes it to run Peak.

About Registration, Authorization, and Trial
Modes:

When Peak is first launched, you will be prompted to
either authorize it or run it in trial mode. For full
functionality, authorize it with the included serial number.
Requirements for Registration & Authorization:

1. Peak must be installed.
2. Your serial number must be available. Depending
on how you obtained Peak, the serial number will
be provided in various ways:
•

In New Retail or Upgrade Packages – On the
Owner’s Certificate

•

In Downloaded Purchases – In an email
receipt from BIAS

You must register with BIAS in order to authorize
your computer – Peak will not launch unless your
computer is authorized to run it.

The registration/authorization process provides the
following services:
•
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Registers your software with BIAS – making you
eligible for technical support and product updates.

Your serial number appears on the Owner’s Certificate, included in the
Peak Pro package, or on the electronic receipt from a downloadable
purchase (not shown here).
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3. A computer with internet access must be available.
To Register & Authorize Peak on a computer with internet
access:

1. Launch Peak – when first launched on an
unauthorized computer, you will be prompted to
authorize it or run it in Trial mode. Click the
“Authorize” button to continue to the BIAS
Authorization Manager – you will need to enter an
administrator password to proceed.
2. Select the product you wish to authorize, and enter
your serial number and email address.
If you use more than one email address, be sure
to make a note of which one you registered with
– this will make managing your BIAS
Registration Account faster and simpler in the
future.

3. Click the “Authorize” button. Peak is now
authorized – click the “Done” button to exit the
BIAS Authorization Manager.
If the computer on which you plan to run Peak
does not have internet access, you may use
another computer to aid in the authorization
process – see the following section for directions
on how to do so.

To Register & Authorize Peak on a computer without
internet access:

1. Launch Peak – when first launched on an
unauthorized computer, you will be prompted to
authorize it or run it in trial mode. Click the
“Authorize” button to continue to the BIAS
Authorization Manager – you will need to enter an
administrator password to proceed.
2. Select the product you wish to authorize, and enter
your serial number and email address.
3. Click the “Alternate Authorization” button.

4. In the Alternate Authorization dialog, click the
“Generate Alternate Authorization” button to
generate an Authorization Request File.
5. Transfer the Authorization Request File that is
generated to a computer with internet access (via
LAN, CD-ROM, flash drive, iPod, etc.).
6. After transferring the Authorization Request File to
the internet-equipped computer, double-click the
Authorization Request File – doing so will
automatically open your web browser, transmit the
Authorization Request File to the BIAS server, and
download your Authorization File to the
computer’s default download directory.
7. Locate the downloaded folder containing the
Authorization File (called “X_BIAS Peak”), and transfer
it back to the host computer on which it will be used.
8. In the BIAS Authorization Manager’s Alternate
Authorization dialog, go directly to the “To Finalize
the Alternate Authorization Process” section and
click the “Open Authorization File” button.
9. Locate the Authorization File that was transferred back
to the host computer in Step 7, and click the “Open”
button. Peak is now authorized – click the “Done”
button to exit the BIAS Authorization Manager.
If you do not have internet access on any computer,
please contact BIAS for assistance at:

US Toll-Free:
International:

1-800-775-2427
+1-707-782-1866

The BIAS Authorization Manager can be found in
the following location, should you later need to
deauthorize or reauthorize Peak:
Systems – Mac HD/Applications/BIAS
Authorization Manager

Mac

C:\Program Files\BIAS\BIAS
Manager\BIAS Authorization

Windows Systems –

Authorization
Manager.exe
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Deauthorizing a Computer
If you need to de-authorize a particular computer that
will no longer be used to run Peak, you can do so by
following the steps below.
The computer running Peak must be connected to
the internet in order to deauthorize it.

To De-Authorize a Computer:

1. Launch the BIAS Authorization Manager from your
hard drive (or launch the BIAS Authorization
Manager program from your installer CD-ROM).
2. In the BIAS Authorization Manager, select Peak as
the product you wish to de-authorize – the serial
number and email address used to authorize that
product will be automatically recalled and will
appear in the Serial Number and Email Address
fields.
3. Click the Deauthorize button.
4. Click the Deauthorize button to confirm the
deauthorization process – the Deauthorization
Successful dialog appears.
5. Click the OK button – then click the Done button
in the BIAS Authorization Manager.

Conclusion
Now that you have installed, registered, and authorized
Peak, please proceed to the next chapter to learn several
basic concepts and functions essential to using Peak.
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Introduction
This chapter explains several key Peak concepts and
functions, including how to open, close, and save audio
documents.

A Brief Explanation of Digital Audio
If you are new to digital hard-disk-based recording, you
may wish to acquaint yourself with a few of the principles
behind digital audio before you dive into using Peak
software. This section explains a few key concepts that
will give you a good general understanding of how Peak
does what it does.
What we hear as sound is actually a pattern of pressure
waves that move through the air. The frequency of these
waves determines the pitch of the sound – how low or
high it sounds. Sound frequency is measured in cycles per
second, or Hertz (Hz). The range of human hearing is
generally considered to be from about 20 Hz at the low
end to 20 kHz at the high end. In practice, however, most
adults hear only as high as 12 kHz to 18 kHz, especially
those of us who may have spent more time than we
should have with headphones or at loud rock concerts.
Sampling and Sample Rate

Your Peak software-equipped Mac computer stores audio
digitally. This means that analog electrical signals from

microphones or other sources are converted into
numbers by a circuit called an analog-to-digital converter
and stored on hard disk. The analog-to-digital (A/D)
converter uses a technique called digital sampling to
convert analog electrical signals into numbers. Digital
sampling is the sonic equivalent of taking a snapshot. By
taking thousands of little digital samples per second and
storing them to a hard drive, an A/D converter can
capture an accurate sample-by-sample representation of
a sound, much like a movie is a frame-by-frame
representation of a moving image. The number of
samples taken of the audio in a second is called the
sample rate. The sample rate determines the recording’s
upper frequency response. A higher sample rate delivers
higher frequency response. As a rule of thumb, a digital
recording’s upper frequency response is roughly half of
its sample rate (known as the Nyquist frequency). The
audio on compact discs, for example, is recorded at
44,100 samples each second, or 44.1 kHz. This sample
rate is the standard for professional-quality digital audio,
and provides an upper-end frequency response of
approximately half the sample rate (known as the
Nyquist frequency): 22.5 kHz, somewhat higher than
most people’s hearing range.
Bit Resolution

Another factor that affects the quality of the audio is the
resolution of each sample. The greater the resolution,
the better the quality. To use an analogy from the film
world, just as image resolution and quality increase with
film size (8 millimeter film is much lower in image quality
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than 70 millimeter film) greater bit resolution (8-bit, 16bit, 24-bit, and 32-bit) results in better fidelity digital
audio. Audio CDs have a resolution of 16-bits.
In practice, the bit resolution determines the recording’s
dynamic range-that is, how many distinct steps you have
to describe a sound’s level, from quiet to loud. For
instance, an 8-bit recording has 256 (28) levels available,
which is the equivalent of 48 decibels (dB) of dynamic
range. On the other hand, a 16-bit recording has 65,536
(216) levels available, equivalent to 96 dB dynamic range.
(The rule of thumb for determining the dynamic range in
decibels is to take the bit rate and multiply it by 6.)

About Disk-Based Recording and
Editing
If you are new to hard-disk-based recording, you will be
impressed by the power and control that Peak software
provides for recording and editing digital audio. You will
encounter several new concepts and techniques for
using a disk-based system such as Peak. Perhaps the
most important among these is the concept of
nondestructive manipulation of audio.
Nonlinear Versus Linear Recording

Perhaps most impressive is the fact that with disk-based
audio production you need not actually modify the
original source material in any way to accomplish these
feats. In most cases, by cutting and pasting you are in
reality only asking the hard disk to access portions of the
audio file in a slightly different order. Since Peak doesn’t
normally cut up, move around, or delete the actual
recording on the hard drive, it’s said to be a
nondestructive editing system. Peak does not rewrite
the file until you choose to save your edits. Other
manipulations, such as playing audio material backwards,
can be accomplished by reading the data in reverse
order. The power and flexibility of disk-based audio
production software such as Peak far surpasses the
capabilities of traditional analog audio production tools.
Hard Disk Storage Requirements

The actual recording of audio to hard disk requires a
significant amount of storage. This is directly affected by
the sample rate and bit resolution at which you record:
the higher the fidelity, the greater the requirements for
storage. As a guideline, 16-bit, 44.1 kHz audio requires
roughly 5 megabytes of storage per minute of mono
recording. Stereo 16-bit, 44.1 kHz audio requires
roughly 10 megabytes per minute. Stereo 24-bit, 44.1
kHz audio requires roughly 15 megabytes per minute.
Hard Disk Maintenance

Nondestructive audio manipulation is possible thanks to
the nature of Peak’s recording medium: a hard disk
instead of a roll of analog tape. Unlike analog tape, which
is a linear recording medium, hard disks provide a
nonlinear, or random-access medium. This is because
audio is stored on hard disk as digital information which
the hard disk can access immediately or randomly
(hence the term “random-access”), simply by moving its
read/write head to the appropriate location and reading
the appropriate data. This allows you to perform such
miraculous feats as cutting and pasting “pieces of sound”
and rearranging material long after it has been recorded.
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Nondestructive Editing

Because audio recording and playback is a hard diskintensive task, it is important that your hard drive be in
good operating condition. In the computer world, this
means keeping it from becoming fragmented by using
hard drive maintenance software. Fragmentation occurs
as your hard drive begins to run out of contiguous
(uninterrupted) space where it can write files. If the data
that makes up a file is stored at a single location on your
drive, it is much easier and faster for your drive to find the
data and read it. However, as contiguous space runs out,
the drive may not be able to write the entire file in one
location and instead must fragment the file by writing
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pieces of it at various locations in whatever smaller open
areas it can find. This requires that the drive search near
and far to read the pieces of the file. Too much
fragmentation can lead to errors in recording and playback
as the hard drive struggles to keep up with the demands of
your audio application. In general, you should keep your
hard disk below 10% fragmentation. Most hard drive
maintenance software packages let you monitor the
degree of fragmentation on your drive and defragment it
by rewriting files into contiguous blocks of data. In
addition to defragmenting your drive regularly, you should
also back up your files and reformat your drive on a regular
basis to keep your system in top operating condition. By
doing this, you will ensure maximum performance from
your Mac and Peak software, and keep your studio running
smoothly. Now that you understand some of the basic
principles behind digital audio and disk-based recording,
take a few moments to learn some of the basic operations
of Peak. These are covered in the sections that follow.

Opening Existing Audio Documents
Peak allows you to open audio files created in a variety of
common audio formats including AIFF, Sound Designer
II, WAVE/Broadcast WAV, QuickTime, Raw, System 7
Sound, Sonic AIFF, Paris, Jam Image, AU, MP2, MP3,
MP4/AAC, and FLAC.
Peak will not allow you to open and edit protected
AAC/MP4 files, such as music purchased from the
iTunes Music Store.

Opening Compressed Audio
Documents
AIFF/AIFC and QuickTime files with compression such as
MACE 3:1, MACE 6:1, IMA 4:1, QDesign, or Alaw are
compatible with Peak.
To open an audio file:

Creating a New Peak Document

1. Choose Open (-O) from the File menu.

Peak will allow you to create an empty audio file of zero
duration by choosing a new mono or stereo document.
However, you would typically record a new audio file in
Peak or open an existing audio file into Peak for editing.
Peak allows you to have multiple audio documents open
at the same time.

2. In the dialog that appears, locate and select the file
that you wish to open.

To create a new audio document:

Choose New (-N) from the File menu or Toolbar. This
command provides a hierarchical menu, which allows
you to choose either a mono or stereo format for the
new document.

The Open dialog

Creating a new mono audio document
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3. When you find the file you wish to open, click the
Open button and Peak will open the audio file into
a new audio window, displaying an overview of the
entire sound. Shift-click or -click to open
multiple files.

Importing a Track from an Audio CD
If your Mac computer is equipped with a compatible CDROM drive, you can use Peak to import audio directly
from an audio CD.

Recently Opened Documents
Peak automatically remembers up to the last eight audio
documents that you have opened and keeps a list of
these at the bottom of the File dialog. This allows you to
easily select a document’s name and reopen it without
having to search on your hard drive. Peak can find and
open a document even if you have changed its location
on your hard drive. If you change the name of the file,
the next time you open Peak, it will automatically update
the name in its internal list.

The Import CD Audio Dialog

To import tracks from an audio CD:

1. Insert an audio CD in your CD-ROM drive.
2. Choose Import CD Track from the File menu or
click the Import CD Track button in the Toolbar.
3. In the dialog that appears, select the CD track that
you wish to import and click Mark. You may mark
multiple tracks for import. If you wish to import all
of the tracks on the CD, click on the Mark All
button.
4. To name a selected CD track, click the Track Name
button.

Name Track dialog
Recently opened documents are displayed in the lower portion of the File menu
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If you have iTunes™ installed, and your computer is
connected to the internet – iTunes will automatically
launch (unless it has been disabled in the Mac OS
CD/DVD Preference pane) when an audio CD is
inserted into the computer’s CD-ROM drive. iTunes
default behavior is to automatically get the track
names from the CDDB™ online CD database. Once
a CD’s tracks are labeled, that information is
available to any application that imports a track,
including Peak. This is a convenient way to
automatically name a CD’s tracks.

5. To select only a portion of the track, click on Set
Import Times button or double-click on the track
in the list. The CD Import Track Range dialog will
appear.

Opening “Dual Mono” Files
Certain audio applications do not directly support stereo
interleaved files, and instead use “dual mono” files,
which comprise the right and left channels of stereo
material. Peak allows you to open such dual mono files,
and in the process creates a new interleaved stereo audio
document. Because Peak actually writes a new stereo
audio file to disk, this conversion process requires hard
disk space equivalent to the two original mono files.
Please note that the Import Dual Mono command
requires that both files be mono files and have the
same bit depth & sample rate.

To open a dual mono file:

1. Choose Import Dual Mono from the File menu.
2. In the dialog that appears, locate the desired files.
3. Select either half of the dual mono file and click
Open. Peak imports the first file and then prompts
you for the second.

The Import CD Track Range dialog

6. By adjusting the Start and End time controls in this
dialog you can import the entire CD track, or a just
specific portion of the track. You may also click
directly on the timeline to adjust start and end
points. Click Play to audition the CD track (or
selected portion of the CD track). Click OK when
you are happy with the selection.
7. Check the Open tracks after importing checkbox if
you want the CD track(s) you are importing to
open in Peak.
8. Click the Import button in the The Import CD
Audio dialog to import the selected tracks and the
Save dialog appears. Use the pop-up menu at the
top of the dialog to navigate to the volume where
you wish to save the audio file. Click Save to save
the file to disk. Peak will save the file(s) in the AIFF
audio format.

4. Select the second audio file and click Open. When
Peak has finished creating the new stereo audio
document you can begin editing.
For simpler importing of Dual Mono files, turn
on the Auto Import Dual Mono feature in the
Options menu. With this feature activated, you
can automatically import dual mono files by
choosing Open from the File menu and selecting
one of the dual mono file’s channels. Peak will
then create a new stereo document containing
both channels. Please note that these dual mono
files must have exactly the same file name with
the suffix “.L” for the left channel and “.R” for the
right channel.

Peak also allows you to export your stereo audio
documents in Dual Mono format.
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Dragging and Dropping Folders,
Disks, and Audio CD Tracks
In addition to opening individual documents by dragging and
dropping them onto the Peak application’s icon, you can drag
and drop entire folders or disks onto the Peak application’s
icon. The contents of the disk or folder(s) will be scanned for
audio documents in formats that Peak can open, such as
AIFF, Sound Designer II, WAVE, QuickTime, MP3, and so on.
This feature is particularly useful when used with
Peak’s Batch File Processor.

Peak allows you to drag an audio CD track directly onto the
Peak icon or open the track directly from the Open
command under the File menu or Toolbar. When you import
a CD track using one of these two methods, the entire track
will be imported. If you do not want to import an entire
audio track, you can still use the Import CD track command
under the File menu (covered earlier in this chapter).

This tool extracts audio data only, and ignores all other
information contained in the file’s header, such as
information about loop points, regular markers, region
markers, etc. When audio data is successfully recovered,
it is placed into a new audio document and must be
saved.
There are a few pieces of information that Peak requires,
in order to attempt file recovery – these include the
number of channels, the file’s bit depth and sample rate,
the audio data location, and the byte order. With these
few bits of information (and depending on the degree of
damage), Peak may be able to recover many otherwise
unusable audio files. To attempt to recover a file, you
must supply correct information about the format the
file was originally recorded in, otherwise, you may end
up with white noise, or a file that plays at the wrong
speed, etc.
When the Recover Audio File encounters corrupt sectors
with media, file, or I/O errors, it will attempt to continue
recovering whatever audio data is available, and will write
the sections containing errors as silence in the new audio
file that is created.

Recovering Damaged Audio Files
Peak includes a tool called Recover Audio File, which
allows you to open a damaged file, and attempt to
recover the audio data contained in it.

The Recover Audio File dialog
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Saving and Closing Documents
It is good practice to save regularly throughout a project
to avoid losing valuable work in the event of a power
failure or other unfortunate occurrence. The Save
command saves the changes you have made to your
audio document by writing it to your hard disk.
The Save command cannot be undone. If you want to be
able to continue to undo your edits, use the Save a Copy
As command under the file menu. Peak allows you to
save your audio documents in a variety of common audio
file formats, each of which is described below. Be aware
that different formats allow different information to be
stored with the file. Peak preserves this information
unless you save the file into a different file format. Saving
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a file in a format different from its original format may,
however, cause some information stored in the file to be
discarded.

World Wide Web and in Java audio applets – it is
supported by many platforms and programs.
•

FLAC – Free Lossless Audio Codec – a popular
“lossless” compressed audio format.

•

MP2 –

•

MP3 –

•

MP4 – MPEG-4 Part 14/AAC-Advanced Audio
Coding format. MP4, or AAC is it also commonly
known, is similar to MP3, but affords greater audio
fidelity and smaller file sizes. Content on many
online music stores (such as the iTunes Music
Store) is sold in this format.

Peak supports the following audio file formats:
•

•

•

•

This is Apple’s Audio Interchange File
Format. It is also Peak’s default file format and is
supported by many Mac software applications.

AIFF –

This is Digidesign’s audio file
format for its digital audio products. Use this
format if you wish to use an audio document in a
Digidesign audio application.

Sound Designer II –

WAVE/.WAV/Broadcast WAV – This is Microsoft’s
Windows Audio File Format. It is supported by
many Windows software applications and some
Mac applications. The WAVE format is best if you
plan to use an audio document in an application
that supports or requires WAVE format files.
QuickTime – This is Apple’s audio file format for
QuickTime-based multimedia. It is supported by
all Mac software applications that support
QuickTime. The QuickTime format is best if you
plan to use an audio document in multimedia
applications that support QuickTime, such as
Macromedia Director™. QuickTime includes
formats such as AAC/MP4.

•

Raw –

•

System 7 Sound –

•

Jam Image –

•

Sonic AIFF – The file format used by Sonic Solutions
audio workstations.

•

.paf – This is the file format used by E-mu’s Paris
audio system. Note this file format favors mono
and dual mono files.

•

.au –

MPEG-1 Audio Layer 2 format.

MPEG-1 Audio Layer 3 format. This is a
popular compressed, commonly used format used
for downloadable music, portable media players, etc.

To save a Peak document:

1. Choose Save from the File menu or press -S on
your keyboard.
2. Select a file format from the pop-up File Type
menu. AIFF is Peak’s default audio file format.
3. Enter a name for the new audio document, select where
you want to save the new file, and then click Save.

This is the header-less raw file format that
may be useful for some game platforms.
This is the Apple audio file
format used for Mac Operating System Sounds.

This is the Jam audio image file
format. Jam audio image files may be created in
Peak and used in Roxio Jam for burning audio CDs.

This file format is commonly used on the

Using the Save As and Save A Copy
As Commands
The Save As command allows you to save a copy of the
current document under a different name, or in a different
location on your hard disk. Since the Save As command
closes the current document and lets you keep working
on the renamed copy, it is useful for saving successive
stages of a project. This allows you to save each major step
under a different name. Later you can retrace your steps
should you want to go back to an earlier version. The Save
A Copy As command will save a copy of the file you are
working on, but it will keep the copy you are working on
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open. This allows you to continue working on your audio
and still be able to undo any edits you executed prior to
using the Save A Copy As command.
To save an audio document under another name:

1. Choose Save As (-Shift-S) or Save A Copy As (Option-S) from the File menu. The Save dialog
appears:

Dithering is the process of minimizing quantization
distortion when converting files from a higher bit depth
format to a lower bit depth format. During dithering,
specific patterns of noise are blended in with the original
bit depth reduced audio material, to produce an end
result that sounds much better than the anomalies that
might result from bit depth truncation alone.
Ideally, dithering/noise shaping should be applied
at the end of the processing chain, once all other
processes such as DSP tools, plug-ins, and sample
rate conversion have modified the high resolution
audio signal.

You can choose the desired dithering type that is suitable
for the type of audio material you are working with in the
Save, Burn Audio CD, and Bounce Playlist dialogs. A
default dither type preference may also be set in Peak’s
Dither Preferences dialog.
The Save dialog

2. Select the desired file format from the File Type popup menu. AIFF is Peak’s default audio file format.
3. If you wish to save the audio document to a
different bit depth resolution, click the bit depth
pop-up. It is strongly recommended that you
enable dithering if you are saving to a lower bit
depth (e.g., 24-bit to 16-bit).
4. Enter a name for the new audio document, select
where you want to save the new file, and click Save.

Peak Pro features BIAS’ advanced DCAT (Dither Cloning
Audio Technology), with various algorithms modeled
after other popular dithering technologies. The
algorithm you choose will depend on the audio material
you are working with. Basic dithering guidelines are:

Using Dithering
If you are saving an audio document or bouncing a Playlist
to a lower bit depth file (e.g., 24-bit to 16-bit), or burning
an audio CD from material higher than 16-bit format, it is
strongly recommended that you enable dithering.
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The Dither Preferences dialog

•

DCAT 1 – Steep curve with great high-frequency
boost, optimized for high-dynamic range program,
ideal for final production stage.
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•

DCAT 2 –

An alternative option to DCAT 1, similar
features but different dither noise color.

•

DCAT 14 – Slightly steeper fifth-order curve. Optimized
for low dynamic range program, such as rock music.

•

DCAT 3 – Less steep curve, moderate high-frequeny
boost, optimized for lower dynamic range than
DCAT 1 and DCAT 2, more suitable if further
processing will be applied to the audio material.

•

DCAT 15 – Steepest curve. Optimized for complex, high
dynamic range program, such as orchestral music.

•

DCAT 4 –

An alternative option to DCAT 3, similar
features but different dither noise color.

•

DCAT 5 – Another alternative to DCAT 1 and 2, strong
high-frequency boost, optimized for high-dynamic
range program and final production.

•

DCAT 6 –

•

DCAT 7 – Models second-order shaper with
moderate high-frequency boost. Useful for
material that might undergo further processing e.g.
converted to MP3 format). Reduces perceived
quantization noise loudness by 6.4 dB. Optimized
to human hearing curve for stereo loudspeakers.

•

•

•

Models high-pass dither.

DCAT 8 – Models ninth-order shaper with strong
high-frequency boost, appropriate for final
production. Reduces perceived quantization noise
loudness by 19 dB. Optimized to human hearing
threshold curve for headphone playback.
DCAT 9 – Models ninth-order shaper with strong
high-frequency boost, appropriate for final
production. Reduces perceived quantization noise
loudness by 15.1 dB. Optimized to human hearing
threshold curve for stereo loudspeaker playback.
DCAT 10 – Models high-pass dither and ninth-order

shaper with strong high-frequency boost,
appropriate for final production. Reduces
perceived quantization noise loudness by 15.3 dB.
Optimized to human hearing threshold curve for
stereo loudspeaker playback.

LE

Peak LE does not feature built in dithering.
Dithering in Peak LE can be performed using the
included MDA Dither plug-in.

Saving Compressed Audio Documents
AIFF/AIFC and QuickTime files with compression such as
MACE 3:1, MACE 6:1, IMA 4:1, QDesign, or Alaw are
compatible with Peak.
You can only Save with file compression using
AIFF or QuickTime file formats.

The final processing stage for audio intended to be
delivered in a compressed file format (i.e., mp3/mp4/
AAC) should be file size compression/encoding.
Decompressing and re-compressing audio documents
will degrade their sound quality each time they are recompressed, so it is best not to save with compression
until all editing and mastering has been completed.
In addition, if the files you plan on compressing require
dithering to achieve the desired output bit depth, do not
use dithering profiles intended for final stage
processing. Applying further processing, including data
compression, to files that have received 'final stage'
dithering may produce undesirable artifacts.

To save an audio document with compression:

•

DCAT 11 –

•

DCAT 12 – Dither noise shaping for 96 kHz material.

•

DCAT 13 – Near-Nyquist dither second-order curve.
Optimized for simple program of average dynamic
range, such as spoken word.

Pre-emphasis curve.

1. Choose Save As (-Shift-S) from the File menu.
The Save As dialog appears.
2. Choose the audio compressor you wish to use
from the Compressor pop-up menu. Some
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compression formats only work with 8-bit or 16- bit
data, so the compression options may be grayed
out, depending on your setting in the bit depth
pop-up menu. Some of the types of available audio
file compression include: MACE 3:1, MACE 6:1,
QDesign Music, ALaw 2:1, 32-bit Floating Point, 64bit Floating Point, IMA 4:1, 24-bit integer, 32-bit
integer, 16-bit Little Endian, and 16-bit Big Endian.

If you have made any changes to your document since
the last time you saved, Peak will ask you if you want to
save them. If you do, choose Yes; if you do not, choose
No. If you change your mind and wish to continue your
session, choose Cancel. If you wish to close all
documents that have had changes made without saving
them, attempt to close the first one, and hold down the
Option key while clicking the Don’t Save button.

3. Click the Options button to adjust the settings for
the specified compression format, and then click OK.
4. Type the name of the new audio document, select the
folder you wish to save the audio document, and click Save.

Peak Windows and Palettes
Closing Audio Documents
To close a file in Peak, choose Close from the File menu
(-W ). To close all files currently open in Peak, choose
Close All from the File menu (-Option-W ) – or hold
down the Option key as you click the red Close button in
the upper left corner of the audio document window.

There are several windows and palettes when you open Peak
that either appear by default or are available to you under
Peak’s Windows menu. Windows that appear in Peak by
default include an audio document window for each audio
file you have open. Windows and palettes that you can turn
on or off include the Transport, the Toolbar, the Contents
Window, and the Movie Window. This section will cover the
basic function of these Peak Windows and Palettes.

The Audio Document window, with the Contents Drawer open
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Peak Audio Document Window

Peak Audio Document windows contain a Waveform
Display, an Audio File Info Bar, a Max Level Indicator in
the lower left corner, and an expandable Contents
Drawer which contains information about markers,
regions, and loops. The Waveform Display is a graphic
representation of the audio file, the Audio File Info Bar
shows the sample rate, bit resolution, file format and file
size of the audio file, and the Max Level Indicator shows
the highest amplitude level in the audio file. At the top
of the Audio Document window is the File Overview, if
it is enabled under the Peak Options menu. The
Contents Drawer is similar to the Contents Window, but
offers a convenient way to view regular, region, and loop
markers on a document-by-document basis, as well as a
complete edit history for that document. The Audio
Window is described in more detail in Chapter 5.
Peak’s audio document window also contains several
different tool icons representing different cursor modes.
The default cursor is a standard Arrow Cursor. You can also
use the cursor palette to select a Hand Cursor for scrolling
a Pencil Tool for drawing directly on the waveform at the
sample level, and a Zoom Tool for zooming the waveform
view in and out. The ESC key on your computer keyboard
will toggle through the four cursor modes.
Blending On/Off

Vertical Lock

Hand Cursor

copied, or inserted. Blending helps to avoid clicks and pops
that can occur when cutting an audio waveform at a nonzero crossing, or when combining material with significantly
different amplitude. The left-most button toggles Blending
on and off, and the Caps Lock key on your keyboard may
also be used to toggle it on and off. More information on
using Blending is available in Chapter 5: Editing.
Horizontal Lock Button

The Horizontal Lock button allows both the Begin & End
markers in a loop or region to be moved simultaneously.
This feature is very useful in situations where the
duration of a selection needs to be maintained, but the
selection needs to be made in a different part of an audio
document. The second-from-left button toggles
Horizontal Lock on and off.
Vertical Lock Button

The Vertical Lock button allows back-to-back Region
markers sharing the same space between samples to be
moved simultaneously. This is very useful when cutting
a long DJ mix or live recording into “tracks” – when you
need to adjust where a track break will occur, without
introducing any gaps between the two regions.

Pencil Tool

Arrow Cursor Tool

The Cursor Tool is the default tool. It is the standard
“arrow” tool that lets you click and select on-screen items.
Horizontal Lock

Arrow Cursor

Zoom Tool

Toggle Drawer

Hand Tool

To access any of these cursors or functions, just click on
the corresponding icon. To change the cursor tool, click
on a new icon. The various cursors and editing modes
are discussed briefly below, and in greater detail in
Chapter 5: Editing.
Blending On/Off Button

When Blending is turned on, Peak creates very short
crossfades between sections of audio that are cut, pasted,

The Hand Tool lets you scroll a waveform in its window.
Zoom Tool

To use the Zoom tool, simply click the tool’s icon in the
audio document window, then move the cursor over the
waveform. A “plus” (+) sign will appear inside the
magnifying glass icon. Click on the waveform to zoom in;
each click of the mouse will zoom in farther. To zoom
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out, option-click on the waveform. A “minus” (-) sign will
appear in the magnifying glass icon, and you can click on
the waveform to zoom out.

“Magic” Pencil Tool Mode

The Pencil Tool features a “Magic” mode, in which it can
be used to automatically repair clicks in the audio
waveform.
To use the Magic Pencil Tool:

•

With the Pencil Tool selected, hold down the Option
key and click the mouse button on a click/anomaly
in the audio waveform – it is repaired.

LE

The Zoom Amount dialog

Option-clicking on the Zoom Tool icon opens the Zoom
Amount dialog, where you can specify the amount of
maginification per click.
Your keyboard’s Option + Control keys, when
held down together, act as a modifier for the Hand
and Zoom tools.
Option + Control + Drag Left or Right temporarily
toggles the cursor into Hand tool mode.
Option + Control + Drag up or down temporarily
toggles the cursor into Zoom tool mode.

The Magic Pencil Tool is not available in Peak LE.

Cursor and Selection Information

The lower section of the audio document window’s
Contents Drawer displays the X (time) and Y (amplitude)
coordinates of the cursor point, Sel: the duration of any
currently selected audio), DTR (Distance to Reference
Marker), and BPM: the tempo in beats per minute. You
can type a value in for the X, Sel, and BPM parameters.
The same information can also be displayed by toggling
the transparent cursor overlay to the “on” position,
which appears next to the mouse cursor, and moves
along with the mouse cursor. Transparent cursor
information can be turned on and off under Peak’s
Options menu (-Shift-T).

Pencil Tool

The Pencil Tool lets you draw directly on the waveform at
the sample level. This is very useful for drawing out
clicks in the waveform. Option-click on the Pencil Tool
icon for the Drawing Tool Smoothing Settings.
The cursor overlay follows the mouse cursor as it moves, and displays
various types of information directly over the waveform

The time format displayed in these fields depends on
which time format (Samples, Min:Sec:ms, SMPTE, or
Bars|Beats) you have chosen with the Time Units
command under the Options menu.

The Pencil Tool dialog

48

Here is how to read the cursor and selection information
that appears in the Cursor Location display.
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Y

=

the current cursor position along the vertical
scale (amplitude), or start point of a selection

X

=

the current cursor position

[L] =

the cursor is positioned over the left channel

[R] =

the cursor is positioned over the right channel

DTR =

Meters

Peak’s meters are much like the VU or LED meters on a
mixing board or tape recorder. They are bar graph meters
that show the relative volume or loudness of the audio as
it plays. They are also designed to show peak volume and
whether the signal has “clipped,” or distorted.

distance to the nearest reference marker
The Meters dialog

Sel =

the duration of the current selection

+/- =

indicates positive or negative phase

BPM =

beats per minute

Transport Window

The Transport window is a floating, re-sizable window. It
contains four main components: a time display showing
elapsed time, the Transport controls (Rewind/Return to
Start, Stop, Play, Fast-forward/Go to End, Record, and
Loop during playback), audio level meters with clip/peak
indicators, and a master fader for playback volume
control.

You can configure the Meters display by choosing Meters
from the Audio menu, or by clicking the appropriate
button in the Toolbar. In the Meters dialog, you can
select the Peak and Clip Indicator Hold times as well as
the meter resolution. The Peak Hold indicators appear
as yellow bars at the far right of each of the bar graphs as
audio plays, and selecting a hold time causes the
indicator to pause for easy reading of the peak value
during playback.

Time Display

Peak’s Time Display serves a number of functions. While
audio is playing, the Time Display shows the elapsed
time in the selected time units format, and tracks the
“playback head”, or cursor. When audio playback is
stopped the Time Display shows the current cursor
location within the audio waveform. Clicking the Time
Display opens Peak’s Go To Time dialog, and allows you
to enter a time value – the insertion point cursor jumps
to this time location in the audio document.
This display will also show the time remaining while
performing Open, Save, DSP processing, or CD-burning
actions.

The Meters dialog

The Clip Indicators appear as red bars at the far right of
each of the bar graphs as audio plays, and are triggered
when audio distorts, or “clips”, and selecting a hold time
causes the indicator to pause for easy reading of any
clipping or distortion that occurs during playback.
Setting the Peak Hold and Clip Indicator Hold Times to
None turns these features off.

LE

The Meters dialog is not available in Peak LE.

The Transport contains the Time Display, Transport Controls, Meters, and Master Fader
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Progress Bar

To resize columns in the Contents Window:

The Meters display changes to a progress bar during
audio processing, and while saving or opening audio files.

•

Click and drag to the right of the column’s title bar
that you want to resize. For example, to make the
Name column wider, click and drag the line
between Name and Time to the right.

To sort columns in the Contents Window:

•
Master Fader

The Master Fader is located just below the counter
display, and is used to control the level of audio
documents being played back in Peak. The Pre/Post
buttons control whether the meters show the gain
change being applied by the Master Fader.

Click the title of the column by which you want to
sort. For example, to sort by Time, click on Time.

To change the sort order in the Contents Window:

•

Click the sort order button in the column title to
change the sort order.

Contents Window

Peak has a floating Contents Window that will display all
regular, Region, and Loop markers contained in any open
audio documents. There are three buttons at the bottom
of the palette that allow you to select which items to
view-from left to right: the Region Button, the Marker
Button and the Loop Button. Option-double-clicking on
any item in the Contents window will bring up the Edit
Region or Edit Marker dialog.

Setting Preferences
You can customize a number of Peak’s parameters so you
can work with the program in a way that best suits you.
Most of these parameters are found in the Preferences
panel and Options menu.

The Contents Window

To resize the Contents Window:

•
50

Click and drag on the lower right hand corner of the
Contents window to resize the Contents Window.

The Preferences dialog
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These include the controls for playing back audio documents,
the selection of the icons in the Toolbar, and the colors that
you want for the audio document window. Once you have
set these preferences as you like, they will stay that way until
you decide to change them again. This section explains how
to set several of these parameters. For any menu items not
covered here, please refer to Chapter 12: Peak Menus. There
you will find explanations of each command in the
Preferences dialog and other Peak menus. Items from the
Preferences dialog and Options menu are also covered
throughout this manual where their discussion is relevant.
Setting Peak’s Playback Parameters

Peak’s Playback Preferences dialog allows you to control
the master output volume, hard disk playback buffer size,
window buffer size, and other playback related options.

The Playback Preferences dialog

general, lower is better. A playback buffer setting of 32 64k is a good place to start. If you are experiencing clicks
in your playback, working with fragmented files, using
processor-intensive real-time DSP, or are using a slow
hard drive, you may need a larger playback buffer setting.
Window Buffer

Peak also allows you to control the amount of RAM the
program uses to cache audio data and the size of each
processing chunk. Use larger values if you are working
with a few large files, and smaller values if you are
working with many smaller files.
Dynamic Scrub Time

Peak provides a unique audio auditioning technique called
dynamic scrubbing. This feature is very useful for precisely
pinpointing and selecting a desired location in an audio
document. Dynamic scrubbing allows you to drag the
mouse forward or backward over a waveform while Peak
plays a short loop (between 10 and 600 milliseconds) at the
scrub location. When you have found the location you are
looking for, let go of the mouse and the insertion point will
be exactly where you want it to be. Peak allows you to
choose the length of this playback loop with the Dynamic
Scrub Time command in the Options menu. You can also
select Tape-Style Scrubbing in this dialog. For a full
description of scrubbing audio in Peak, please see Chapter 5.
To select a loop duration for dynamic scrubbing:

Double-click on Waveform to Begin Playback

If this box is checked, double-clicking in an audio document’s
waveform display starts playback at that point. If this box is
unchecked, double-clicking in the audio waveform selects
the space between adjacent markers (or the beginning
and/or end of a file and the closest adjacent marker).
Playback Buffer

1. Choose Dynamic Scrub Time from the Options
menu, and choose a duration from the hierarchical
submenu. Typically, a value of between 40 to 80
milliseconds works well.
2. You can also select Tape-Style Scrubbing by selecting
it in this submenu. To deselect Tape-Style Scrubbing,
just click any duration value in the submenu.
Scroll During Playback

Peak allows you to control the amount of RAM the
program uses when playing back audio documents. In

With the Scroll During Playback command enabled, Peak
will “scroll” through the audio document as playback
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progresses. This allows you to visually follow the
progress of audio playback. A check next to this menu
item indicates that it is enabled.

or following it. The Auditioning dialog allows you to
select a desired amount of pre-roll or post-roll when you
play the selection. To play a selection with the selected
amount of pre- and postroll, press Control-Spacebar.

To enable Scroll During Playback:

1. Select Scroll During Play from the Options menu.
A check next to this item indicates it is enabled.
2. To disable Scroll During Playback, re-select Scroll
During Play from the Options menu. The absence
of a check next to this item indicates it is disabled.
The Auditioning dialog

Move Waveform During Playback

With the Move Waveform During Play command enabled,
Peak will move the waveform under the cursor as
playback progresses, so that the playhead cursor is
always in the middle of the waveform display. A check
next to this menu item indicates that it is enabled.

To configure Auditioning:

1. Select Auditioning from the Preferences dialog –
The Auditioning Preferences dialog appears.
2. Enter the desired amount of Pre-roll and Post-roll,
and click OK.

To enable Move Waveform During Playback:

1. Select Move Waveform During Play from the Options
menu. A check next to this item indicates it is enabled.
2. To disable Move Waveform During Playback, re-select
Move Waveform During Play from the Options menu.
Show Marker Times

With the Show Marker Times command enabled, all Peak
markers will show a time value as well as the marker name.
To enable Show Marker Times:

1. Select Show Marker Times from the Options menu.
A check next to this item indicates it is enabled.
2. To disable Show Marker Times, deselect Show
Marker Times from the Options menu. The absence
of a check next to this item indicates it is disabled.
Auditioning

Peak’s Auditioning command allows you to audition a
selection along with a specific amount of audio preceding
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Blending

Blending is an automatic crossfade function with a usereditable envelope. Peak can apply blending to areas of
an audio document when they are modified by cutting,
deleting, or other editing processes in order to smooth
abrupt transitions between waveform amplitudes. It
can be very useful for creating a smooth transition
between edits that would otherwise sound too abrupt.
If you have cut, pasted, or inserted audio into a
document, you may wish to enable blending to smooth
things out a bit. It can be toggled on or off by clicking
the Blending button in the Audio Document Window,
or by using the caps lock key on your keyboard.
To configure Blending:

1. Select Blending from the Preferences dialog. Enter
the Duration over which you wish Blending to
occur into the dialog box.
2. To edit the Blending Envelope, click on the Edit
Blending Envelope button. Click OK to exit the dialog
and click Save Preferences Now to save the change.
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For detailed instructions on how to use blending or how to
edit the blending crossfade envelope, see Chapter 5: Editing.
Auto-Import Dual Mono

Certain audio applications, such Digidesign’s Pro Tools, do
not directly support interleaved stereo files, and instead
use “dual mono” files-a pair of files, one for the left
channel and one for the right channel. These files have
typically been exported with the suffix “.L” for the left
channel, and the suffix “.R” for the right channel. AutoImport Dual Mono, when selected, will allow you to select
just one channel of the dual mono file in the Open dialog.
Peak will automatically “grab” the other half of the file, and
convert both files into a single stereo Peak document.

3

The Colors dialog

To customize the colors of the waveform display:

1. Choose Colors from the Preferences panel.
Please note that the Import Dual Mono command
requires that both files be mono files, have the same
sample rate and bit depth, and the must have the
exact same name followed by the suffixes “.L” and
“.R”. If you are using file type extensions (.aif, .wav,
etc) the format must be “Filename.Side.Extension”.
For example – “Song1.L.aif ” and ”Song1.R.aif ”.

To enable Auto-Import Dual Mono:

1. Select Auto-Import Dual Mono from the Options
menu. A check next to this item indicates it is enabled.
2. To disable Auto-Import Dual Mono, simply reselect
Auto-Import Dual Mono from the Options menu.
Choosing Colors

Peak allows you to customize the colors used to display
various elements in audio documents and Playlists. You
can use this dialog to set the background color, waveform
color, and colors for markers, regions, loops, and the
selected event(s) in Playlists. You can select either a preset
color combination, or individual colors for each element in
the audio document window, as well as picking your own
custom colors from a color palette. Changes made using
the Colors dialog affect both the current audio document’s
colors, and any subsequent new audio document’s colors.

2. To select a preset color combination, click the Theme
pop-up menu and choose the preset that you desire.
3. Alternatively, to select individual colors for each
element in the audio document window, choose
Custom from the Theme pop-up menu and then select
the desired colors from the Background, Waveform,
Markers, Loops, and Regions pop-up menus.
4. If you wish, you can use this dialog to further
customize any element in the audio document
window. Pick an element to customize, choose
Custom from the Theme pop-up menu, and select
User Color. A standard Mac color palette will
appear. Use this wheel to select any color you
wish. Click OK to return to the Colors dialog.
5. To close this dialog, click Change (to change one
color) or Change All (to change the colors for all open
audio documents). The audio document window is
now set to the colors and look you’ve selected.
Choosing a Time Format

The Time Units command allows you to choose a time
format for the audio timeline in Peak’s audio
document window and Playlist. You can choose
Samples, Min:Sec:ms, Hours:Min:Sec:cdframes,
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Bars|Beats, CD Frames, and various SMPTE timecode
formats.
The format you choose will depend on the nature of the
project that you are working on.

If your audio document is using Bars|Beats as its Time
Unit, you will want to tell Peak what the tempo of the
audio document is, so the document’s timeline can be
set appropriately. Use the Edit MIDI & Tempo Info
command from the Action menu to set the tempo of the
audio document.

To choose Peak’s time format:

1. Bring the desired window to the foreground (i.e.,
audio document or Playlist).
2. Choose Time Units from the Options menu.
3. From the submenu, choose the time format that
suits the nature of our project. The timeline in audio
document windows and counter display in the
Transport switches to the format that you choose.
The MIDI & Tempo dialog

You can enter the meter of an audio document using the
Edit MIDI & Tempo Info dialog. The numerator
represents the number of beats per measure, and the
denominator represents the value of a beat, where
4=quarter note, 8=eighth note, 16=sixteenth note,
and so forth.

Choosing a time format with the Time Units command

Playlists and audio documents may use Time Unit
formats independent from each other; all audio
documents share the same format.

Audio File Meter, Tempo, Timestamp, and
MIDI Note Name Settings

The Edit MIDI & Tempo Info dialog allows you to specify
the tempo, meter, and timestamp for an audio document,
as well as the root, low, and high key parameters, and the
MIDI Note Name (for use in sample playback instruments).
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You may also enter a timestamp for the audio document
in seconds. If the audio document has a timestamp, then
the displayed time in an audio document will be offset
from this time rather than starting at zero. For example,
if the timestamp for an audio document is four seconds,
then the first sample in the audio document will appear
in the audio document with a time of 4 seconds instead
of zero seconds.
Cache in RAM

On Mac systems with 2 GB or more of RAM, the Cache in
RAM option can be used to dramatically speed up audio
processing. When Cache in RAM is active, audio
documents’ current edit state contains the audio for that
state in RAM. When a file has been edited as desired and
saved, files that have been stored in RAM are written back
to the hard drive.
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Choosing a Scratch Disk

Because audio data can be very large, Peak utilizes a
portion of your hard disk’s free space to hold audio data
that has been cut or copied, as well as for temporary or
scratch files for undo purposes. If your hard disk is short
on space, you may not be able to cut, copy, or modify
large selections. If you have more than one hard drive
attached to your Mac, the Scratch Disks section in the
Preferences dialog allows you to choose the hard drives
(or “scratch disks”) that you wish to use for these
temporary files. Peak allows you to select which disk you
want to have as your default, or “Primary” disk for this
purpose-usually you would select the disk that has the
most free space. If you are connected to a file server, you
can utilize available storage on the server by clicking the
Allow Servers checkbox. Any available servers will then
appear in the Scratch Disks pop-up menu. This feature
is recommended only if you have access to a high-speed
Ethernet, or other fast server.

3. Click OK to close this dialog. Peak will use the disk
you have selected as your Primary scratch disk,
and, if it becomes full, will then use the other disks
you’ve chosen.
The hard drive with the original audio file must
have the equivalent amount of free space (i.e., a
60MB file would require that there be an
additional 60MB of free space on the hard drive
on which the file resides).

You must have write permissions for the selected
Scratch Folders and Disks or else Peak will report
an error. Consult your System Administrator if
you need assistance changing Directory or Disk
permissions.

Keyboard Shortcuts
To choose a scratch disk for temporary files:

1. Choose Scratch Disks from the Preferences dialog.
The Scratch Disks dialog appears.

Peak allows you to customize any Peak menu item with a
keyboard shortcut. To change your keyboard shortcuts,
go to the Preferences dialog and select the Shortcuts and
Toolbar item. Preferences are stored in a file called Peak
6.0 Shortcuts, located in:
Users/<YourUserAccount>/Library/Preferences/
Peak’s default Keyboard Shortcuts are listed in Appendix
1 at the end of this manual.
To add a new Keyboard Shortcut:

The Scratch Disks dialog

2. The Scratch Disks dialog will show all hard drives
currently connected to your Mac. Choose the hard
drive(s) that you wish Peak to use when it creates
temporary files by clicking the checkboxes next to the
drives in the list. To choose the Primary Disk, or the
default disk for temporary files, click on the Primary
button next to that disk. If you are connected to a file
server and would like to use storage available there as
well, enable the Allow Servers checkbox.

1. Choose Shortcuts & Toolbar in the Preferences
dialog.
2. Scroll through the list of menu items, or, with the
list box selected, simply type in the first few letters
of the menu item you wish to assign. Then click on
the name of the Peak menu item you wish to assign
a new keyboard shortcut.
3. Use the Shortcut Key box to enter the letter you
wish to use for a shortcut. You may select the
Command, Option, Shift or Control keys as
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additional modifiers by clicking on the checkboxes
in this dialog.
4. Close the Shortcuts/Toolbar Preferences dialog.
To remove a Keyboard Shortcut:

1. Choose Keyboard Shortcuts in the Preferences
dialog.

8. In the pop-up menu at the bottom of the Open
dialog in FileMaker Pro, choose Tab-Delimited.
9. Find the shortcuts text document you saved in step
3 and click Open.
10. FileMaker Pro will add the records to the database.
11.

2. Scroll through the list of menu items, and click on
the name of the Peak menu item for which you
wish to remove a keyboard shortcut.
3. Click on the Clear button.

Use the Print option in FileMaker Pro’s File menu
to print out your keyboard shortcuts. You can also
sort the imported keyboard shortcut commands by
description or shortcut. Consult your FileMaker
Pro User’s Guide for more information on
importing records, sorting records, and printing.

4. Close the Shortcuts/Toolbar Preferences dialog.

LE

User-defined Keyboard Shortcuts and Toolbar
customization are not supported in Peak LE.

FileMaker Pro is not included with Peak.

MIDI Preferences

Peak’s MIDI preferences dialog allows MIDI devices in
the Mac OS X Audio MIDI Setup utility to be selected as
MIDI input or output devices.

Making a Keyboard Shortcuts “Cue Card”

It’s easy to make a “cue card” that you can keep on your
desk with all the Peak shortcuts you’ve assigned. Using
the supplied FileMaker Pro template, you can import all
of your shortcuts from a text file describing each
keyboard shortcut generated from Peak.
To Create A Custom “Cue Card” of your Keyboard Shortcuts:

1. Choose Shortcuts/Toolbar Preferences in the
Preferences dialog.
The MIDI Preferences dialog

2. Click on the Save As Text button.
3. Enter the name of the keyboard shortcuts text file
you wish to save, and choose the disk and folder
you wish to save into. Click Save.
4. Switch to the Finder and Launch FileMaker Pro.

The left pane displays all devices capable of supplying
MIDI input to Peak, while the right pane displays devices
capable of receiving MIDI from Peak.

5. Choose Open from the File menu in FileMaker Pro.

To enable Peak to receive MIDI data from a device:

6. Open the supplied “Peak Shortcuts Template”
FileMaker Pro template.
7. Choose Import Records from the File menu in
FileMaker Pro.
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•

Check the box in the column immediately to the
left of the device’s name in the MIDI Input Devices
pane.
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To enable Peak to provide MIDI thru functionality for an
enabled MIDI input device:

•

Check the box in the column immediately to the
left of the device’s name in the MIDI Output
Devices pane.

Many control surfaces use MIDI messages to carry
meanings different from those applied by software
instruments to those same messages. As a consequence,
when software instruments receive MIDI data from
control surfaces, unpredictable results can occur.
To avoid this problem, marking the “C” checkbox next to
the name of a device identifies it as a control surface and
blocks MIDI messages from that device from being sent
to any software instruments being used with Peak.
To block MIDI messages from a control surface from being
sent to software instruments:

•

Mark the checkbox in the “C” column to the left of
the device name in the MIDI Input Devices pane.

Using Peak with the Frontier Design Tranzport

Peak has been designed to work with the Frontier Design
Transport controller.
To enable Peak to work with the Frontier Design
Tranzport:

1. Be sure that the Tranzport is properly connected to
your MIDI interface and shows up in the Mac OS X
Audio MIDI Setup utility.
2. In Peak’s MIDI Preferences dialog, mark the
“Enable Frontier Tranzport” checkbox at the
bottom of the dialog and the “C” checkbox next to
the Tranzport’s name in MIDI Input Devices pane.

DO NOT mark the checkbox to the immediate left
of the Tranzport’s name.
3. Click “OK.” A dialog will appear telling you to
restart Peak. After restarting, the Frontier
Tranzport will be active.

The Toolbar
Peak allows you to select almost any Peak command for the
Toolbar. The Shortcuts & Toolbar menu allows you to group
together the functions you use most often, so that you can
simply click a button instead of going to the menus. For
example, if you frequently use Normalize and Pitch Change, you
can choose to have the icons for these functions in the Toolbar,
so that all you have to do to use one of them is to make an audio
selection and click a button. The Toolbar is an easy way to make
your work in Peak faster and more efficient, allowing you to
customize the program to suit the way you work.
To add or subtract items from the Toolbar, use the
Shortcuts & Toolbar item in the Preferences dialog.
Toolbar selections are stored in a preference file called
“Peak 6.0 Shortcuts” located in:
Macintosh HD/Users/UserName/Library/Preferences/
You can reshape and resize the Toolbar by clicking
on the lower right corner of the Toolbar window and
dragging to the desired shape and size. The Toolbar
can be arranged horizontally, vertically, or as a
“cluster” of buttons. Icons in the Toolbar can be sized
anywhere between 16 x 16 pixels to 64 x 64 pixels.

The Toolbar’s button size, configuration, and horizontal/vertical orientation are all user-configurable – three different button sizes shown here
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Quitting Peak

To add a new icon to the Toolbar:

1. Choose Shortcuts/Toolbar Preferences from the
Preferences dialog.
2. Scroll through the list of menu items, and click on
the name of the Peak menu item you wish to have
appear in the Toolbar.
3. Click on the “Place In Toolbar” checkbox to select
the icon to add to the Toolbar. If there is no icon,
the menu item cannot be placed in the Toolbar.
4. Close the Shortcuts/Toolbar Preferences dialog.
To remove an icon from the Toolbar:

1. Choose Shortcuts/Toolbar Preferences from the
Preferences dialog.

When you have finished a project or wish to end an
editing session, the Quit command allows you to quit
Peak and return to the Finder. If you haven’t saved
changes, Peak will warn you before allowing you to quit.
To quit Peak:

•

Choose Quit from the Peak menu (-Q).

If you have made any changes to your document since
the last time you saved, Peak will ask you if you want to
save them. If you do, choose Yes; if you don’t, choose
No. If you change your mind and wish to continue your
session, choose Cancel.

2. Scroll through the list of menu items, and click on
the name of the Peak menu item you wish to
remove from the Toolbar.

If you wish to close all currently open windows
without saving, hold down the Option key and
click Don’t Save.

3. Click on the checkbox to uncheck the item you
wish to remove.
4. Close the Shortcuts/Toolbar Preferences dialog.

LE

Customizable Toolbar is not supported in Peak LE

To resize icons in the Toolbar:

Conclusion
You now know how to create, open, import audio files,
export, close, and save Peak documents. You also know
how to set the preferences for operating Peak. The next
chapter explains how to use your Peak software to record
and play back audio.

1. Choose Shortcuts/Toolbar Preferences from the
Preferences dialog.
2. Move the Toolbar Icon Size slider to the left for
smaller icons, or to the right for larger icons.
3. Close the Shortcuts/Toolbar Preferences dialog.
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Introduction
Peak allows playback of many digital audio file formats, and
can record any audio source that’s connected to your Mac.
Playback and recording may be performed using either
the built-in audio hardware in your Mac, or with a wide
variety of third-party audio hardware interfaces (USB,
FireWire, PCI, etc).
In this chapter you’ll learn how configure and use Peak
for recording and playing back audio.

Configuration of Peak’s Playback &
Record Settings
Whether you are using the built-in audio hardware in
your Mac, or a third-party interface, there are some basic
configuration steps you must perform before playing
back and recording audio. This section will help you get
started quickly with basic settings. Later in this chapter
you will find detailed information on Peak’s various
recording and playback options.
When launching Peak for the first time, a dialog
appears asking whether you would like to
configure your Audio/MIDI preferences. To
quickly set up your audio hardware for the first
time, click Yes.

Peak defaults to using the Mac’s Core Audio built-in
audio hardware. If you plan to use third-party audio
hardware, such as a PCI, USB, or FireWire audio
card/interface, you may need to first install that
hardware’s Core Audio driver, if applicable.
The Mac OS features built-in support for many audio
hardware interfaces, while others require a driver to be
installed. Please check the documentation included with
your audio hardware for details, or contact the hardware
manufacturer.
Be sure to configure the audio interface’s own
utility software or control panel (if one is included
with your interface).

Core Audio

Peak supports Apple’s Core Audio when using the Mac’s builtin audio hardware, as well as with third-party interfaces, such
as those made by Apogee™, Digidesign™, Edirol™, MAudio™, MOTU™, PreSonus™, Tascam™, and many others.
For Peak to work properly with third-party audio
hardware devices, they must be compatible with Core
Audio. Be sure to consult the audio hardware
manufacturer’s instructions when installing &
configuring your audio interface.
The general rule for hardware compatibility is: If a
compatible Core Audio driver is provided by the
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hardware’s manufacturer, or Mac OS X natively
supports the hardware device – Peak is compatible
with it.

To select the desired audio hardware for playback and
recording:

1. From the Audio menu, choose Select Audio I/O.

Audio MIDI Setup Utility

Some audio interfaces may require additional
configuration. In this case the Apple Audio MIDI Setup
Utility may be used to configure your audio hardware.
The Audio MIDI Setup Utility is installed in the Utilities
folder.

2. In the Select Audio I/O dialog, choose the audio
hardware device you would like to use for audio
input and output from the Input and Output
Device menus.
To ensure proper recording, make sure that the
recording format (i.e., bit-depth, sample rate, etc.)
set in Peak matches the recording format in the
Apple Audio MIDI Setup utility’s Input Device
Settings section.

Basic Audio Hardware Configuration
(For Stereo I/O Devices)

3. In the Buffer Size menu, choose 512 – this default
value works well on most systems.
If working with sample rates higher than 44.1kHz,
and/or an older or slower Mac system, you may need
to raise the Buffer Size. The general rule for setting
the Buffer Size is to use the lowest possible value that
allows trouble-free recording and playback. If you
encounter skipping, short dropouts, or other similar
anomalies while recording or playing back audio,
raise the Buffer Size until you find the setting that
works best for your particular system configuration.

The steps in this section will teach you how to
configure the Mac’s built-in audio hardware, as well
as third-party audio interfaces that have only stereo
input and output (two channels in/two channels
out).
Using the same audio hardware device for
both input and output is highly
recommended!

4. Adjust the Input Level slider to the desired level –
note that not all hardware devices allow control of the
input level from within the Select Audio I/O dialog.
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Setting the Input Level slider about 3/4 of the way
up is a good starting point. Once you exit the Select
Audio I/O dialog and click Peak’s record button,
you will see the actual recording level in Peak’s VU
meters in the Transport. The loudest material
you’re recording should register around -6dB. If
your levels are significantly above or below this,
you should return to the Select Audio I/O dialog.

Advanced Audio Hardware Configuration
(For Multi-channel I/O Devices)

2. Choose desired multi-channel device to use for
input, from the Input Device menu.

4
3. From the Audio menu, choose Audio Input
Settings – the Audio Input Settings dialog appears.

When using a third-party, multi-channel audio interface
for playback and recording, you may also need to specify
which input and output connections on your audio
interface should be used.
Peak defaults to using a multi-channel hardware device’s
outputs 1 & 2 for playback, and inputs 1 & 2 for
recording. If you are using a multi-channel hardware
device, and wish to use inputs/outputs other than 1 & 2,
please follow the advanced setup steps below.
Using the same audio hardware device for both
input and output is highly recommended!

To configure Peak to play back through specific outputs of
a multi-channel hardware device:

1. From the Audio menu, choose Select Audio I/O.
2. Choose desired multi-channel device from Output
Device menu.
3. From the Audio menu, choose Audio Output
Settings.
4. In the Audio Output Settings dialog, select the
desired outputs to play audio through, from the
Play Through menu – Click OK when finished.
To configure Peak to record through specific inputs of a
multi-channel hardware device:

4. From the Record Through menu, choose the input
channels you wish to record through.
5. Click OK in the Audio Input Settings dialog.
Please note that due to variations in
naming/numbering conventions of inputs/outputs
on hardware devices, that the channels you select
in Peak’s Play Through and Record Through
menus may not always match the actual
input/output numbering on the device itself. You
may need to consult the documentation that was
included with your audio interface to correctly
select the desired inputs/outputs.

1. From the Audio menu, choose Select Audio I/O.
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Setting the Record Disk & Format
By default, Peak is set up to record in AIFF, mono, 16-bit,
44.1kHz format, and is set up to do so on the largest drive
connected to your Mac system. Peak can be set up to
record in either AIFF or Sound Designer II formats (which
can later be converted to any other supported format), in
mono or stereo, and at any bit-depth and sample rate
supported by the audio hardware configured in the
previous section – and to any hard drive on your system.
It’s a good idea to specify a particular record disk and
location, as the “largest drive” may change. Today your
internal Mac hard drive might have the most space
available on it, and thus be considered the “largest drive”,
but tomorrow your external FireWire drive might have
more space. By specifying a particular drive/location,
your recordings will be easy to find later, since Peak will
then always record to the same place.
To set Peak’s Record Disk:

1. From the Audio menu, choose Record Settings –
the Record Settings dialog appears.

Recording Format & Settings Options
Once you’ve become familiar with the recording process
in Peak, you may need to customize certain settings to
suit the type of recording you will be doing.
Various recording configurations are available within the
Audio I/O Settings, Audio Input/Audio Output Settings,
and Record Settings dialogs. This section describes the
options available for recording.
Audio Output Settings Dialog

The Audio Output Settings dialog allows you to configure
various parameters related to audio playback.
2. From the Record Disk menu, choose the hard drive
you wish to record to – click OK when you are
finished.
To Set Peak’s Recording Format:

1. From the Audio menu, choose Audio Input
Settings – the Audio Input Settings dialog appears.
2. Using the Sample Rate menu, and Channels & Bit
Depth radio buttons, choose the desired recording
format options – click OK when you are finished.
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Clock Source Menu

This menu lets you choose the clock source for digital
sync.

where you can specify which hardware device to use
(when multiple devices are connected to your
computer), the buffer size, and the input level (if the
device supports adjustable input level).

Sample Rate Menu

Audio Input Settings Dialog

This menu allows you to choose the sample rate for
playback. The default sample rate setting is “Auto”. Unless
you need a specific setting, this is best left set to “Auto”.

The Audio Input Settings dialog allows you to configure
various parameters related to audio recording.

Play Through Menu

This menu lets you choose which output channels on
your audio interface will be used for audio playback. For
example, if you are using a hardware interface with
multiple outputs, you can select the appropriate outputs
to route audio output through to your
monitors/headphones.
Sample Rate Converter Quality Menu

Peak features on-the-fly sample rate conversion, used
when playing back audio documents with a sample rate
not natively supported by the audio hardware being
used. A setting of 1 gives the lowest quality sample rate
conversion, and uses the least amount of CPU
resources. A setting of 5 gives the highest quality, and
uses more CPU power. Depending on your Mac
system’s speed, you may need to experiment with this
setting for the best performance. 3 is the default
setting.

Record Through Menu

This menu allows you to choose which inputs on your
audio interface will be used to record through. For
example, if you are using an audio interface with multiple
inputs, you can designate the appropriate inputs to
record the desired source.
Sample Rate Menu

Be aware that the setting used for Sample Rate
Converter quality also affects the quality of TapeStyle Scrubbing. BIAS recommends using the highest
setting possible that your system is capable of.

Select Audio I/O Button

Clicking the Select Audio I/O button in the Audio Output
Settings dialog brings up the Select Audio I/O dialog,

The Sample Rate menu allows you to select the sample
rate at which you wish to record. Some sample rates
may not be available depending on the limitations of
the audio card and its Core Audio driver. Please note
that if you are recording from a digital source you will
want to record at the same sample rate as your digital
source. For more information on sample rates, see the
Glossary. The “Auto” setting in the Sample Rate menu
will record at whatever sample rate the device is
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currently set to. To record at a specific sample rate, be
sure to specify it here.

Please note that the settings you choose here are
independent of any previously set within the Mac
OS Sound Preference pane.

Clock Source Menu

This menu is used to select the desired internal or
external clock source to be used.
Be sure to set the Clock Source to digital in the
Audio Input Settings dialog if you plan to record
from a digital source.

You will notice several pop-up menus, buttons, and
checkboxes in the Record Settings dialog. These allow
you to select which hard drive to record to, what file
format you’d like to record as, and a number of other
options (described below). You may also wish to record
through plug-ins. The next few paragraphs describe how
to set all of these parameters using the Record Settings
dialog.

Channels Radio Buttons

Record Disk Menu

These radio buttons allow you to specify whether to
record in mono or stereo format.

The Record Disk menu allows you to choose which hard
drive you would like to record to. If you have more than
one hard drive connected to your Mac, use this pop-up
to select your record drive. (This option will default to
the largest drive currently available.)

Bit Depth Radio Buttons

These radio buttons allow you to specify the desired bit
depth for a recording. Please note that the actual
maximum bit-rate is determined by your audio input
devic. For more information on bit depths, see the
Glossary.
Record Settings Dialog

When you select Record Settings from the Audio menu
(Option-R) or Toolbar, the Record Settings dialog
appears. This dialog is used to configure settings for
recording with Peak.

File Format Menu

The File Format menu allows you to select the file format
for the audio being recorded. You may choose from AIFF
or Sound Designer II. If you need the newly recorded
audio document to be in a different format, you can
always use the Save As function to save it as another
format once recording is complete. If you do not select
a file format for recording, Peak will default to AIFF.
Monitor Checkbox

The Monitor checkbox allows you to monitor audio
throughput while you are recording.
Be very careful to avoid feedback loops (the audio
signal feeds back into itself ) when recording.
Feedback can damage both your equipment and
your hearing. The Monitor option in the Record
Settings dialog should be disabled if monitoring a
recording will cause feedback.

Record Settings dialog
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Create Split Stereo Files Checkbox

The Create Split Stereo Files checkbox allows you to
record the incoming stereo audio in dual mono format
rather than stereo. Dual mono format is used in
applications like Pro Tools, so this option is useful if you
need to record in dual mono format (i.e., split stereo).

In the Recording Time dialog, designate the duration for
recording in seconds and click OK. For example, to
record for ten minutes, enter “600” in the Seconds field.
Open After Saving Checkbox

The Open after saving checkbox determines whether the
audio document is opened in Peak after it is recorded.

Append to Document Checkbox

The Append to Document checkbox allows you to
record into an existing audio document. To record new
audio into an existing document, place the insertion
point in the existing audio document at the point where
you want to insert the new audio. If the insertion point
is at the beginning of the document, the newly recorded
audio will be inserted at the beginning of the document.
If the insertion point is at the end of the document, the
newly recorded audio will be appended to the end of the
existing document. If the insertion point is somewhere
in the middle of the document, the newly recorded
audio will be inserted at that point. If you make a
selection of audio, the Append to Document feature will
allow you to replace the selected audio with newly
recorded audiog.

Audio Input Settings Button

Clicking the Audio Input Settings button will open the
Audio Input Settings dialog, where you can specify
various recording options.
Select Audio I/O Button

Clicking the Select Audio I/O button in the Record
Settings dialog brings up the Select Audio I/O dialog,
where you can specify which hardware device to use
(when multiple devices are connected to your
computer), the buffer size, and the input level (if the
device supports it).
Record Through Plug-Ins Checkbox

Use Record Timer Checkbox

The Use Record Timer checkbox allows you to designate
a specific duration for recording. Peak will stop
recording after this set time and then open the Save
dialog in order for you to save your recording. Checking
the Record timer checkbox will bring up the Recording
Time dialog.

This checkbox allow you to configure Peak to record
through installed Audio Units and/or VST plug-ins in real
time, rendering the effect of the plug in directly to the
document as you record. This setting also allows
recording the audio output of virtual instrument plug-ins
as Peak audio documents. More information on
recording through plug-ins appears later in this chapter.
Select Audio I/O Dialog

Various input/output options are available in the Select
Audio I/O dialog, which may be accessed by choosing
Select Audio I/O from the Audio menu, or by clicking the
Select Audio I/O button in the Audio Output Settings
dialog.
The Recording Time dialog
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If you are playing virtual instruments and notice a
significant delay from the time you play a note, and the
time you hear it, you may want to experiment with lower
buffer sizes, to reduce latency to the lowest possible level.
Input Level Slider
Select Audio I/O Dialog

Input Device Menu

This menu allows you to choose the desired audio
hardware device to use for input, when more than one is
available.

The Input Level slider allows you to configure the input
level prior to making a recording. This slider, and the input
level slider in the System’s Sound Preference pane serve
the same purpose – adjusting it in Peak will affect the
setting in the Sound Preference pane, and vice-versa. Not
all devices support adjustable input level. If you are using
an audio hardware device that does not support adjustable
input level, it is normal for this slider to appear greyed out.

Output Device Menu

This menu allows you to choose the desired audio
hardware device to use for output, when more than one
is available.

Playing Audio

Buffer Size Menu

This menu controls the buffer size used, and is directly
related to the amount of latency that is encountered. It
is recommended that you use the lowest possible setting
that your computer is capable of. The easiest way to
determine the lowest setting your computer is capable of
is by doing test recordings – if you notice distortion, or
dropouts in the recorded audio, you will need to use a
higher setting. If you do need to raise this setting, it’s
best to do it by one setting at a time, for example, if your
system cannot handle using a 512 buffer size, raise it to
1024 and try again.
If your computer requires a relatively high buffer size for
smooth recording, and you need to monitor your audio
source, it is recommended that you set up your
equipment to allow direct monitoring from a mixer, or
from an audio interface that features direct monitoring.
Direct monitoring will eliminate the problem of latency,
in which you hear what is being recorded after a slight
delay, which is directly proportional to the buffer size
setting being used.

Once you have finished the configuration steps in the
previous section, you’re ready to start playing back audio
documents. The next section will familiarize you with the
various controls and methods used to control audio playback.
The Transport Controls

The Transport Controls that appear in the Transport
window are used for initiating both playback and
recording. They function much like the controls on a
tape recorder. As they appear below, from left to right,
they are Rewind/Return to Start, Stop, Play, Fastforward/Go to End, and Record.
Rewind/Return to Start

Stop
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Play

Fast-forward/Go to End

Record

Use Loop in Playback

To start/stop playback:

•

Press the Spacebar, or click the Play button in the
Transport. Playback begins from the beginning of
the document (or wherever Peak’s insertion
point/cursor is located).

•

To stop playback, press the Spacebar again or click
the Stop button in the Transport.

To stop playback and have the cursor return to its original
location:

•

Press the Return key.

To “rewind” playback:

•

While audio is playing, click the Rewind/Return to
Start button in the Transport.

Note that double-clicking the audio waveform to
begin playback is a preference, which can be
enabled/disabled in Peak’s Playback preferences
dialog.

•

Click any in the Audio Waveform Overview to begin
playback from that point.
In order to double-click to initiate playback, be
sure you have this preference enabled! Peak gives
the option of double-clicking to start playback, or to
select the space between adjacent markers. To set
this preference, open the Playback Preferences from
Peak’s Preference Panel, and check the Doubleclick on Waveform to Begin Playback checkbox.

To return to the beginning of a document:

•

With playback stopped, click the Rewind/Return to
Start button – or press Return key.

•

With audio playing back, press the Return key
twice.

Peak supports the Frontier Design Group’s wireless
Tranzport control surface. For more information
on configuring and using this device to control
Peak, please Chapter 3.

To “fast-forward” playback:

•

While audio is playing, click the Fast-forward/Go to
End button in the Transport.

Triggering Playback of Multiple
Audio Documents

To go to the end of a document:

•

With playback stopped, click the Fast-forward/Go
to End button.

To start playback from a specific point in a document:

•

Click the cursor at the desired location in the audio
document and press the Spacebar on your
computer keyboard. Playback begins from the
cursor location and continues to the end of the
document.

•

Double-click the mouse at the desired location in
the audio document. Playback begins from the
location that you double-clicked and continues to
the end of the document.

Peak allows you to have multiple audio documents open
at the same time. Peak assigns each of these documents
a number based on the order in which it was opened.
Peak provides you with a convenient way of triggering
playback of any open audio document by pressing a
number key on your computer keyboard. This can be a
very useful feature for applications such as live sound
effects playback, since you can open multiple audio
documents and play them from your Mac keyboard.
To trigger sequential playback of multiple audio
documents:

1. Open several audio documents, taking note of the
number that Peak assigns them in the Window
menu. (This is based on the order in which the
documents were opened.)
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2. Press the number that corresponds to the
document(s) you wish to play. You don’t need to
wait until a document has finished playing to press
the next number: typing a numerical sequence on
your keyboard will “queue up” all of the
corresponding documents. They will then play in
the order you choose.
The numeric keypad on an extended keyboard
will not work for this function, you must use the
numbers at the top of the keyboard).

3. If you wish to stop playback and jump to the next
document in queue, press the Return key. Peak
initiates playback of the next document in
sequence.

Peak, and using it to record, you can fine-tune this value.
Be sure to read up on Change Gain, Gain
Envelope,
Normalization,
and
RMS
Normalization in Chapter 8: DSP – for ways to
maximize audio levels after recording.

Basic Recording

Once you have selected the desired hardware, recording,
and format options outlined in the previous sections, it’s
easy to quickly get started recording.
To record audio:

1. Select Record from the Audio menu (-R) – or
click the Record button in the Transport or Toolbar
– the Record dialog appears.

Recording Audio
Once you have finished the configuration steps in the
previous section, you’re ready to start recording audio.
This section will first familiarize you with various controls
and methods to get started recording quickly, and then
offers more advanced techniques such as recording into
QuickTime movies, multi-document recording, and
recording through effects plug-ins.
Before you start recording, it’s a good idea to turn down
the volume of your instrument or audio source, so as to
first set your recording level. When Peak’s Record dialog
first appears, Peak is not actually recording audio yet, but
the meters are active, and will show the current recording
level. This is especially useful for gauging and fine-tuning
recording levels. Slowly bring up the audio source’s level
until it peaks around -6db, which is a good recording level
for most material. This allows a bit of “headroom” so that
if the loudest sections of the audio being recorded
occasionally exceed -6dB, they do not result in “clipping”,
or digital distortion. As you become more familiar with
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2. Play the audio source you wish to record.
3. Click the Record button in the Record dialog –
recording starts.
To stop recording:

1. Click the Stop button in the Record dialog –
recording stops, and a Save dialog is presented.
2. Enter the desired name for the recording.
3. Click the Save button.
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To pause/resume recording:

1. While recording, click the Pause button.
2. While recording is paused, click the Pause button
again to resume recording.
Timed Recording

Peak allows timed recording for a particular duration.
This is especially useful for recording cassettes, LPs,
etc. By setting the record timer, you can make a
recording of the desired material, and rest assured that
once the desired material is captured, that recording
will stop, and your hard drive is not being filled
unnecessarily.
To make a timed recording:

1. From the Audio menu, choose Record Settings
(Option-R).
2. Check the Use Record Timer checkbox – the
Recording Time dialog appears.

7. Click the Record button in the Record dialog –
recording starts.
8. Peak will stop recording after the set amount of
time and then open the Save dialog in order for
you to save your recording – enter the desired
name, and click the Save button.
Don’t forget to turn off the Record Timer when
finished recording, so as not to affect subsequent
recordings.

Recording through Effects Plug-ins

Peak offers the ability to record through Audio Units and
VST format plug-ins. Recording through plug-ins can be
very useful and can save time, as you do not have to later
process audio documents and save them. Be aware that
you cannot undo the effect – if your recording does not
come out as intended, you would have to re-record using
different plug-in settings.
Some examples of why you might want to record
through plug-ins include:

3. In the Recording Time dialog, designate the
duration for recording in seconds and click OK.
For example, to record for ten minutes, enter “600”
in the Seconds field.
4. Close the Record Settings dialog by clicking the OK
button.
5. Select Record from the Audio menu (-R) to open
the Record dialog.

•

You are recording material with a wide dynamic
range (volume changes often and quickly), and it’s
difficult to set the recording level. You can record
through the BIAS Sqweez Compressor/Limiter
plug-in, to help control levels in real time, while
the recording is in progress.

•

You are recording from cassettes, and they all
contain more or less the same kind of broadband
noise (e.g., tape hiss). You can record through a
noise reduction plug-in, such as BIAS SoundSoap 2
or SoundSoap Pro, configured to eliminate this
noise in real time during the recording.

While you can adjust plug-ins during recording, it’s a
good idea to first experiment and fine-tune your settings
before starting to record through plug-ins.

6. Play your audio source.
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Recording and using plug-ins are CPU
intensive activities. If you notice unusual
artifacts, audio dropouts, etc. in recordings
made this way, you may need to raise your
hardware buffer size. If your system is not fast
enough to support recording through plug-ins
in real time, you can always apply plug-ins
after recording.

dialogs would be presented, allowing the four pieces of
this long recording to be saved. It’s a good idea to
develop a naming convention to address multidocument recordings, such as naming your documents
“Part 1/4”, “Part 2/4”, “Part 3/4”, “Part 4/4”, or something
similar, that identifies each file as part of the whole
recording.
When editing documents created during multidocument recording, each one appears in Peak as a
separate audio document.

Multi-Document Recordings (Long
Recordings)

Recording into a QuickTime movie

If you plan to make long recordings with Peak, be aware
that each individual audio document that Peak creates
has a maximum size of just under 2 gigabytes (1.99 to be
precise). If a recording exceeds this size, Peak
automatically creates a new document and continues
recording seamlessly. When a multi-document recording
is finished, Peak will present multiple Save dialogs (one
for each 2 GB document, or fraction thereof ), so each
document may be saved separately. The maximum
recording length will vary depending on the number of
channels used, as well as bit depth and sample rate. The
maximum amount of disk space that can be used in
multi-document recording is 10 GB, spread across five
individual audio documents. This amounts to
approximately 16.5 hours of continuous recording at CD
quality settings (Stereo/16-Bit/44.1kHz). The recording
settings you choose will affect how long a recording you
can make.
For example, if you were to record 10 hours of audio at
16-Bit/44.1kHz, you would be using approximately 600
MB of disk space per hour. At this rate, after about 3.3
hours of recording, you would have used about 2 GB of
disk space. When this 2 GB limit is reached, Peak would
continue recording, but now into a new document –
the first document is stored as a temporary file on the
hard disk. After another 3.3 hours, another 2 GB
document is created, and Peak continues recording into
a third document. When we reach 9.9 hours, Peak
begins recording into a fourth document – this one
being the remainder, or .1 hours (6 minutes). When we
stop Peak at the 10 hour mark, four consecutive Save
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Peak can record audio into a silent QuickTime movie.
This is a useful feature for adding a soundtrack or
voiceover to a QuickTime movie.
To Record into a QuickTime Movie:

1. Create a new stereo or mono document (from the
File menu>New).
2. Open the movie.

3. Open the Record Settings dialog, and check the
Append to Document checkbox.

4. Choose Record from the Audio menu (-R), or
click the Record button in the Toolbar.
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Clicking the Movie icon in the Record dialog causes a QuickTime
movie to play along while recording.

5. Click the Movie icon in the Record dialog.

4

6. Play the audio source you wish to record from, or
prepare to speak into a microphone, etc.
7. Click the Record button in the Record dialog.
8. When finished recording, click the Stop button in
the Record dialog.
9. Save the recording.
10. Choose Save As... and select QuickTime as the file
format

Conclusion
You have now learned how to configure Peak for
recording and playback, and how to record and play back
audio.
Now, continue along to the next chapter, where you will
learn how to edit audio with Peak’s powerful set of
editing tools.
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Chapter 5:
Editing

Introduction
This chapter introduces you to the concept of digital
audio editing. You will learn how to edit digital audio
with Peak’s many powerful editing tools.

permanently change the original source recording until
you finally save the document. Thus, you can cut, copy,
paste, fade in and out of, and otherwise completely
change a recording, and still be able to return back to
square one – the original untouched state of the
recording – up until the time that you save the
document to disk. At that time, all edits are permanently
written into the document.

Editing Audio with Peak
Unlimited Undo and Redo

Peak provides you with a powerful interactive,
nondestructive environment for editing and manipulating
audio. In this environment, not only are virtually all editing
actions completely “undo-able” and “redo-able,” but they can
be performed interactively while audio playback is engaged.
Interactive Editing

Interactive editing means that you can cut, paste, loop, and
process audio with many of Peak’s DSP functions and plugins, even while playing back the very audio that you are
editing. For example, you can start playback, cut a
selection of audio and paste or insert it later in the
document, and when Peak reaches the location of the
inserted audio, it will play it as if it were there all along. This
revolutionary capability makes Peak a supremely fast and
flexible audio production tool that makes conventional
recording and editing methods, such as analog tape and a
razor blade, seem primitive and archaic by comparison.
Nondestructive Editing

Peak’s nondestructive editing capabilities mean that the
edits you perform to an audio document do not

As an editing session progresses, Peak maintains an
internal list of the edits that you perform. Changes that
you make to an audio document are not permanently
applied to the file until you ultimately save it. This is
what gives Peak its unprecedented unlimited undo and
redo capability. Through the use of the Mac’s standard
Undo and Redo commands, you can undo or redo your
actions sequentially, or by using the Edits command,
using a “playlist-style” editing event list. This is a very
exciting technology that allows you to maintain complete
creative freedom of choice – right up until the last
moment before you save your project to disk.

The Audio Document Window
The heart of Peak’s powerful editing capabilities is the
audio document window. The audio document window
provides you with a “window into sound,” allowing you to
make good use of both your eyes and ears to perform
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extremely precise editing tasks. The audio document
window gives you a time-domain representation of sound,
that is, you see the amplitude of the sound over time.
An Audio Waveform

If you have never seen sound displayed in a visual format
before, it may not be immediately obvious how to “read”
an audio waveform. It is actually quite easy to navigate
through a recording with a waveform as your road map.
The peaks in the waveform are areas of high amplitude
(loud spots). The valleys in the waveform are areas of
low amplitude (quiet spots). If the audio material is
music with a pronounced, regular beat, it is generally
very easy to pick out where the beats are simply by
looking for peaks. Using this information, and the
guidelines given shortly in the “A Selection” section, you
will be able to successfully locate and select a desired
portion of the audio document and perform the edits
that you wish. The cursor marks the current location,
and also serves as an insertion point.

Audio Waveform Overview

Peak provides an Overview display of the entire audio
waveform along the top of the screen under the menu
bar. This provides you with a convenient visual reference
of the overall document when you are editing only a
portion in the audio document window. The highlighted
area in the Overview display shows the area of the audio
waveform currently visible in the audio document
window. If desired, you can hide the Overview display to
allow the audio document window to occupy more of
the computer screen.
To show/hide the Audio Waveform Overview:

•

Select Show Overview in the Options menu (-,)
– a check next to this item indicates it is enabled,
and the absence of a check means it is disabled.
(Show/Hide Overview may also be toggle using the
disclosure triangle in the upper left corner of the
audio document window).

A Selection

An audio waveform

Vertical Scaling

Peak allows you to control the vertical magnification of
audio waveforms. This feature is useful if you are editing
and viewing a document with very quiet audio material.

A selection is just what it sounds like: a portion of audio
that you have selected by clicking and dragging with the
mouse. You must select audio in order to perform an
editing action on it. To make good selections for editing,
the best rule of thumb is to begin a selection just before
a peak in the waveform and end it just after a peak in the
waveform. In other words, try to make selections start
and end in areas of low amplitude (“valleys” in the
waveform).

To increase the vertical scaling magnification:

•

Hold the Control key down and press the Up
Arrow key.

A waveform with selected audio

To decrease the vertical scaling magnification:

•

78

Hold the Control key down and press the Down
Arrow key.

It is also important, when possible, to begin and end a
selection at a point where the waveform meets the zero
crossing line (the center line through the waveform).
This helps you avoid creating pops and clicks if you later
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cut or paste the audio, because the point at which the
waveform meets the zero crossing is a point of no
amplitude in the sound wave. Pops and click generally
only occur if you make a careless selection and begin or
end on a portion of the sound wave where the amplitude
is high (where the waveform is high above, or far below
the center point). Enable Auto-Snap in the Options
menu, and select Snap To>Zero Crossings from the
Action menu to have Peak nudge your selection to the
nearest zero crossings automatically.
In addition to snapping to zero crossings in the audio
waveform, Peak features a number of other Snap To
options. These options allow a selection to be “snapped”
to a preset number of samples, or to a custom selection
length. Other Snap To boundaries include:
•

Bars/Beats

•

CD Frames (588 samples or multiple thereof )

•

Sony PS2 Loop Boundaries (28 samples or multiple
thereof )

•

Microsoft Xbox Loop Boundaries (64 samples or
multiple thereof )

•

Custom Units (user-definable number of samples)

The Snap To units you choose will depend on the type of
editing work you will be doing. Most users will probably
use Zero Crossings or Bars/Beats for most musical
applications. Multimedia and video game sound
designers will especially appreciate these new options
when producing audio for a particular delivery platform.
For example, when creating audio loops and sound
effects for a Playstation 2 video game, audio edits need to
be made at increments of 28 samples in order to
loop/play back smoothly in the PS2’s audio engine. By
choosing the Snap To PS2 loop boundary setting, any
edits that are made will automatically be made in units
that will translate smoothly to the PS2’s playback system.
Once markers are placed in the waveform, they may
need to be moved. By holding down the Shift key while
dragging the markers the selected Snap To behavior will
be applied, and the markers may be shifted slightly so as
to conform to the selected Snap To format.

The Zoom In function helps you make very precise
selections by letting you zoom in to a higher
magnification and select exactly the portion of the
waveform you desire. Also, once you have made a
selection, you can adjust the beginning or the end of the
current selection by holding down the Shift key and
clicking with the mouse. Your selection will be
shortened or lengthened accordingly.
Channel Independent Processing

To select only the Left channel, move the cursor over it
and above the left channel’s waveform. The cursor will
show a small “L” at the insertion point. To select only the
Right channel, move the cursor over it and below the left
channel’s waveform. The cursor will show a small “R” at
the insertion point. You can process one channel of an
audio document using most of Peak’s native DSP or
third-party plug-ins.
Peak allows you to select and process the left and
right channels of a stereo file independently, but
you cannot edit (i.e., Cut, Paste, Delete, etc.) the left
and right channels of a stereo file independently.

A Marker

A marker can be placed in a document to identify a point
of importance. A marker appears as a line with a solid
triangular base. Peak allows you to place markers into a
document in order to mark a given location or Region in
a document for later selection, navigation, or editing.
Markers can be moved, named and renamed, “anchored”
to a particular location on a waveform, and given other
attributes. The use of markers is covered in greater detail
later in this chapter.

A waveform with a Marker
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A Loop

A loop refers to a section of audio that is bounded on
either side by loop markers. In the illustration above, the
area that falls between the loop markers “beg loop” and
“end loop” is looped. Loops are used to sustain or repeat
a section of audio. They can be used for material that
you intend to transfer to a sampler, or simply for
playback within Peak itself. Peak allows you to create one
loop per audio file.

markers is different than an audio Region. Regions are
described later in this chapter, as well as in Chapter 6,
Playlists and Audio CD Burning.)In the following
illustration, the area that falls between “My Marker” and
“My Other Marker” is audio between markers.

A waveform with 2 adjacent markers (named “My Marker” and “My
Other Marker”)

Audio Info Area
A waveform with a Loop

Although Peak allows only one loop per audio
document, there is a quick and easy way to mark
multiple desired sections for looping. With the loop
markers in the desired location, choose Select Loop
from the Edit menu, then, choose New Region from
the Action menu – a Region is created that is the
same length as the loop. Using this technique allows
you to create as many Regions as desired within a
single audio document. To loop any of these Regions,
simply -click between a Region’s markers to select
the Region (or press the Tab key until the desired
Region is selected), and then choose Loop this
Selection (-Shift-“-“) from the Action menu.

In the lower left corner of each Peak Audio Document is
the Audio Info Area. The Info Area shows the maximum
amplitude, sample rate, bit resolution, file format, and
file size of the audio file.

Audio Info Area

Clicking on the Max dB section of the Audio Info Area
will open the Change Gain dialog, so that you can change
the gain for the entire audio file, or the current selection.
For more information on the Change Gain DSP function,
please refer to Chapter 8: DSP. Clicking on any other
portion of the Audio Info Area will open the Edit
Metadata dialog.

Audio Between Adjacent Markers

Audio between adjacent markers refers to a section of
audio that is bounded by markers. Understanding the
concept of audio between adjacent markers is important,
as many editing techniques in Peak are based on it. For
example, the audio between adjacent markers can be
quickly and discretely selected for cut/copy/paste edits,
or DSP/effects processing, simply by -clicking between
adjacent markers. (Note: A selection of audio between
80

Selecting Audio
In order to perform most types of editing actions, you
must first select the portion of the document that you
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wish to modify. Peak has several techniques for making
and modifying selections.
To make a selection with the mouse:

•

Click the cursor at the desired start location in the
audio document and drag to select the desired
range.

To extend or shorten a selection:

1. Make a selection with the mouse as explained
above.
2. Hold down the Shift key and click on the end of the
selection that you wish to modify.
3. Drag the mouse to extend or shorten the selection.
When you are satisfied with the length of the
selection, release the mouse.

To select audio between two markers with the Tab key:

1. Create markers at several locations in the
document (various techniques for creating
markers are explained in the next section).
2. Press the Tab key on your computer keyboard.
Peak selects the portion of the waveform that lies
between the first two markers in the document.
3. Press the Tab key again to select the portion of
audio between the next two markers. (If you hold
down the Shift key while tabbing the selection
through the audio file, you can append each
successive space between markers to the current
selection.)
4. Repeat as desired to navigate to and select
additional audio.
To select all audio in a document:

To select audio between two markers:

•

1. Hold down the Command key (z) and click
anywhere in between two markers. (Markers are
explained in detail in the next section.) Peak selects
the audio between the markers.
2. If there are additional markers in the document and
you wish to extend the selection to encompass
other portions of audio that fall between the
markers, hold down the Shift key and the Command
key, and click between another two markers. The
selection will extend from the originally selected
audio to the audio that you just added.
3. Repeat as desired to navigate to and select
additional audio between markers.
Peak offers a preference for selecting the audio
between markers by double-clicking. To enable
this preference, open Peak’s Preference Panel,
click the Playback Preferences button, and then
uncheck the Double-click on Waveform to Begin
Playback checkbox. Once this preference has been
set, you may select audio between two adjacent
markers by double-clicking between them.

Choose Select All from the Edit menu or press A on your keyboard.

Markers & Selections as Navigational Aids

The presence of Regions, loops, or markers – and
selected portions of the waveform can be very helpful in
navigating through an audio document.
When markers are present, the Tab key on your keyboard
may be used to select the audio between markers.
Pressing the Tab key again selects the next space
between markers – when Peak reaches the end of the
document, it will “wrap” back to the beginning. Using
the Option & Tab keys together will select the spaces
between markers in the opposite direction.
This keyboard shortcut makes it very easy to navigate to
specific areas, for example: Imagine you are working
with a recording of an LP, and have placed a marker in
the space between each song (the silent area). To
quickly navigate to the beginning of song 5, simply press
the Tab key five times, and then press the up arrow key
on your keyboard – this would select the space between
markers that bound the fifth song, and the up arrow key
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would locate Peak’s cursor to the beginning of the
selection.
Many other useful tips can be found in Appendix
2: Peak Actions.

Scrubbing
Peak offers a number of ways to scrub audio, described
below.
Dynamic Scrubbing

Auditioning Audio
It is often useful to audition a selection along with just a
bit of audio preceding or following it – without actually
including this material in the selection itself. Peak’s
Auditioning command allows you to do this by specifying
a desired amount of pre-roll or post-roll when you play
the selection.
To audition audio with pre-roll or post-roll:

1. Choose Auditioning from the Preferences panel –
the Auditioning Preferences dialog appears.

Peak provides a unique audio auditioning technique
called dynamic scrubbing. This feature is very useful for
precisely pinpointing and selecting a desired location in
an audio document. Dynamic scrubbing allows you to
drag the mouse forward or backward over a waveform
while Peak plays a short loop (between 10 and 600
milliseconds) at the scrub location. When you have
found the location you are looking for, you can
commence editing. Peak allows you to choose the
length of this playback loop with the Dynamic Scrub
Time command in the Options menu. Peak provides
two types of dynamic scrubbing: dynamic shuttle
scrubbing and dynamic jog scrubbing. Both are
described below.
To select a loop duration for dynamic scrubbing:

•

Choose Dynamic Scrub Time from the Options
menu, and choose a duration from the hierarchical
submenu. Typically, values between 40 and 80
milliseconds work well.

The Auditioning Preferences Dialog

2. Enter the desired amount of pre-roll and post-roll
and click OK.
3. Click the cursor in the audio document and drag to
select the desired range.
4. Press Control-Spacebar – Peak plays the selection,
adding the specified amount of pre- and post-roll.

Setting the Dynamic Scrub feature’s loop time

To use dynamic “Shuttle-type” scrubbing:

1. Hold down the Control key and click and drag the
mouse across a portion of the waveform in an
audio document window. As you drag the mouse,
Peak plays a short loop of the audio at the
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insertion point. You can control the tempo and
direction (forward or backward) of playback by
dragging the mouse slower or faster, forwards, or
backwards.

Since jog scrubbing mode is engaged by pressing the
Option key in combination with the Control key, it is
possible to toggle back and forth between jog and
shuttle modes simply by pressing or releasing the
Option key.

2. Release the mouse button to stop scrubbing. The
insertion point will be exactly where you left off
scrubbing.

Tape-Style Scrubbing

3. To make a selection starting at the current scrub
point, stop scrubbing, hold down the Shift key, and
click the mouse to extend the selection from the
insertion point to the desired end location.

In addition to dynamic scrubbing feature, Peak provides
high resolution tape-style scrubbing. To enable tapestyle scrubbing, set the Dynamic Scrub Time under the
Options menu to Tape-Style.

Jog Scrubbing

To start tape-style scrubbing:

•
Peak provides a variation of the dynamic scrubbing
feature, which is similar to a technique known in
recording studios as jog scrubbing. With this technique,
Peak actually engages playback and moves through the
file at its normal pace, but allows you to control the
playback point by dragging the mouse. You can control
the direction (forward or backward) of playback by
dragging the mouse forwards or backwards. This
scrubbing mode affords a greater degree of control when
you are “zoomed out” in the audio document window.
To use dynamic “jog” scrubbing:

1. Hold down the Control key and Option key and
drag the mouse across a portion of the waveform
in an audio document window. As you drag the
mouse, Peak engages playback while it loops a
short portion of the audio at the insertion point.
Dragging the cursor farther away from the current
insertion point increases the velocity of
scrubbing.
2. Release the mouse button to stop scrubbing. The
insertion point will be exactly where you left off
scrubbing.

Hold down the Control key on your keyboard,
and then click and drag the mouse at the location
in the waveform where you wish to begin
scrubbing.

To deactivate tape-style scrubbing:

•

Release the mouse and Control key.

To control “tape” speed in tape-style scrubbing:

1. As you drag the mouse towards the right,
scrubbing speed will increase.
2. As you drag the mouse toward the left, scrubbing
will slow down.
3. If you drag the mouse to the left of the point where
you started scrubbing, the scrub direction will
change from forward playback to backwards
playback.
The top of the playhead cursor will display the scrubbing
speed, which can vary from +/- 2.25 times the original
speed.

3. To make a selection starting at the current scrub
point, stop scrubbing, hold down the Shift key, and
click the mouse to extend the selection from the
insertion point to the desired end location.
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Using Unlimited Undo and Redo
Peak maintains an internal list of the edits that you perform
during the course of an editing session. These changes are
not permanently applied to the file until you save it. This
gives Peak unlimited undo and redo capability. Through
the use of the Mac’s standard Undo (-Z) and Redo (Y) commands, you can undo and redo your actions
sequentially; or by using the Edits command, using a
“playlist-style” editing event list. This powerful capability
allows you to maintain complete creative freedom of
choice – right up until the last moment before you save
your project to disk. The only limitation in using Redo is
that if you insert a new action when a redo action is
available, you will no longer be able to redo. Remember, as
soon as you perform an editing action other than Undo in
Peak, Redo is no longer available.

number of editing actions performed on an audio
document since you last saved it. You can think of the
Edits command as an “event-based” listing of all your
editing actions since you last saved. Using this list, you
can navigate back in time to the point at which you
performed a particular edit, and if you wish, undo it.
Once you have returned to an earlier state in the project,
you are free to start editing from that point on.
The Edit history list is available in two locations – one is
in the Edits dialog, located under the Edit menu.

To undo an action:

1. Perform an edit (such as cutting audio or moving a
marker).
The Edits dialog

2. Choose Undo from the Edit menu (-Z) or
Toolbar. The action is undone.
3. You can continue undoing actions until you return
to the original state of the audio document (the
state at which it was last saved). When there are no
actions left to undo, the Undo menu item will
appear grayed out.

The other location where the Edit history may be
accessed is in the Audio Document Window’s Contents
Drawer.

To redo an action:

1. If you wish to redo the action that was undone,
choose Redo from the Edit menu (-Y ) or
Toolbar. The action is redone.
2. You can continue redoing actions until none are
left to redo. When there are no actions left to redo,
the Redo menu item will appear grayed out.
Using the Edits Command to Undo a Series
of Actions

The Edits history in the Contents Drawer

Peak’s Edits command provides you with a second
unique and powerful method of undoing virtually any
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Be aware that if you do go back to a past action
and perform a different action at that state in the
project, any edits that originally occurred after
will be gone, and you won’t be able to redo them.

Essential Editing Functions
Peak supports all of the Mac’s essential editing functions
such as cut, copy, and paste and provides several more
specifically designed for audio editing. This section
explains how to use each of these functions.

To use the Edits dialog to return to or undo an action:

1. Perform several edits. (Don’t use the Save
command or you won’t be able to undo any edits
that occurred before you saved.)
2. Choose Edits from the Edit menu. A dialog
appears listing the edits you have performed since
you last saved the document.
3. In the list, double-click on the description of the
action you wish to return to (or select an action
and click the Revert to Item button). Peak returns
the document to the state it was in at the time of
that edit.
4. When you have finished, click Done.

To use the Edits list in the Contents Drawer to return to or
undo an action:

1. Perform several edits. (Don’t use the Save
command or you won’t be able to undo any edits
that occurred before you saved.)
2. From the Window menu, choose Toggle Contents
Drawer (-F), and click the Show History button
in the lower right portion of the drawer – a list of
edits you have performed since you last saved the
document appears.

Because Peak allows you to have multiple audio
documents open at the same time, it is possible to
conveniently cut, copy, paste, and insert audio between
documents. This makes combining material from several
audio documents very fast and easy.
Scratch Disks

Because audio data can be very large, Peak utilizes a
portion of your hard disk’s free space to hold audio data
that has been cut or copied, as well as for temporary or
“scratch” files for undo purposes. If you have more than
one hard drive attached to your Mac, the Scratch Disks
section of the Preferences panel allows you to choose the
hard drives (or “scratch disks”) that you wish to use for
these temporary files. Peak allows you to select which
disk you want to have as your default, or “Primary” disk
for this purpose – ideally you would select the disk that
has the most free space. If you are connected to a file
server, you can utilize available storage on the server by
clicking the Allow Servers checkbox (that is if you have a
very fast server connection). Any available servers will
then appear in the Scratch Disks pop-up menu. This is
recommended only if you have access to a high-speed
ethernet, or other fast server.

3. In the list, double-click on the description of the
action you wish to return to. Peak returns the
document to the state it was in at the time of that
edit.
4. When you have finished, click Done.

The Scratch Disks dialog

Chapter 5: Editing

85

5

Clearing the Clipboard to Reclaim Disk Space

If you no longer need the clipboard contents, you can
free up the disk space occupied by the clipboard by
choosing the Clear Clipboard command from the Edit
menu.

To delete a selection:

1. Click the cursor at the desired location in the audio
document and drag to select the desired range.
2. Press the Delete key, or click the Delete button on
the Toolbar.
3. The selection is removed from the audio
document. Audio occurring after the deleted
section slides over to fill in the gap.

Cutting Audio

The Cut command (-X) allows you to cut a selected
range out of an audio document. Audio that occurs after
the cut slides over to fill in the gap. By cutting and
pasting “pieces” of audio, you can freely rearrange
material in an audio document. This can be a powerful
tool for creating audio remixes for music-oriented
applications, as well as an indispensable tool for general
sound design tasks. When you cut a selection, the Mac
holds the cut audio data in its internal memory (the
Clipboard) in case you wish to paste it elsewhere.
Because all real-time editing you do with Peak is
nondestructive, the audio isn’t actually removed from
the original audio document until you finally save the file
to disk with the Save command. At that time, all edits are
saved and any changes that you have made are
permanently saved to the audio document.
To cut a selection:

Copying Audio

The Copy command (-C) copies the current selection
to the Mac’s Clipboard (or internal memory buffer) so
that you can paste it, insert it, or use it with optional
“Clipboard-based” processing such as Add, Convolve,
Mix, Modulate, and ImpulseVerb. As with the Cut
command, copying and pasting “pieces” of audio, allows
you to freely rearrange material in a document. This can
be a powerful tool for creating audio remixes for musicoriented applications, and is an indispensable tool for
sound design.
To copy a selection:

1. Click the cursor at the desired location in the audio
document and drag to select the desired range.

1. Click the cursor at the desired location in the audio
document and drag to select the desired range.

2. Choose Copy from the Edit menu (-C) or
Toolbar.

2. Choose Cut from the Edit menu (-X) or Toolbar.

3. The selection is copied to the Clipboard.

3. The selected range is removed from the audio
document(s) and held on the Clipboard. Audio
occurring after the cut slides over to fill in the gap.

At this point, you can use the Paste, Insert, or Duplicate
commands to place the copied audio into an audio
document. Each of these commands is explained below.

Deleting Audio

Pasting Audio

If you wish to remove a section of audio from an audio
document without using the Cut command, you can use
the Delete key, or the Delete button on the Toolbar. As
with the Cut command and other editing functions, the
audio isn’t actually removed from the original audio
document until you save the file to disk.

The Paste command (-V ) allows you to paste the
contents of the Clipboard into a location that you choose
by placing an insertion point. Pasting audio deletes any
selected audio and inserts the clipboard audio at the
insertion point. Blending can be used with the Paste
command if you have made a selection – the pasted
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audio will be crossfaded with the audio on either side of
the selection according to the Blending Envelope and
Blending Envelope Duration settings.
By cutting and pasting pieces of audio, you can freely
rearrange material in an audio document. In musical
applications, this gives you the freedom to entirely
“rewrite” compositions by changing the order of things,
repeating desired sections, and so on. In sound design
applications, this gives you the power to “compose” with
sound by creating audio collages.
To paste audio into an audio document:

1. Click the cursor at the point where you wish to
paste the audio data in an audio document or make
a selection of audio you want to delete and replace
with the contents of the clipboard.
2. Choose Paste from the Edit menu (-V ) or
Toolbar.
The Clipboard contents are pasted into the audio
document(s), beginning immediately after the insertion
point. Any selected audio at the location of the paste is
overwritten when the pasted data is inserted into the
audio document.
Replacing Audio

The Replace command allows you to paste audio data
over existing audio – to paste audio into an audio
document without pushing all data to the right of the
insertion point farther to the right (later in time) to
accommodate the newly pasted audio. The Replace
command is useful for “laying over” a portion of audio
while maintaining the timing of the original document.
To replace audio into an audio document:

1. Click the cursor at the point where you wish to
replace the audio data in an audio document.
2. Choose Replace from the Edit menu or Toolbar. All
data to the right of the replaced audio maintains
their time position.

Inserting Audio

The Insert command (-D) allows you to paste audio
data into an audio document without overwriting any
existing data at the insertion point. When you paste data
with the Insert command, all data to the right of the
insertion point or selection start is pushed farther to the
right (later in time) to accommodate the newly pasted
audio. The Insert command is one of Peak’s most useful
tools for restructuring the contents of an audio
document. It is particularly good for “composing on the
fly” since it allows you to cut and insert pieces of audio –
musical phrases, riffs, or simply textural sounds – to
create a composition or soundscape.
To insert audio into an audio document:

1. Click the cursor at the point where you wish to
insert the audio data in an audio document.
2. Choose Insert from the Edit menu (-D) or
Toolbar. All data to the right of the insertion point
is pushed farther to the right (later in time) to
accommodate the newly pasted range.
Duplicating Audio

The Duplicate command has a number of different
behaviors, depending on whether you are working in an
audio document or in a Playlist. The behavior in Playlists
is covered in Chapter 6: Playlists – this section covers the
behaviors of the Duplicate command in audio
documents.
If no selection is made when this command is invoked,
the Duplicate command allows you to paste multiple
copies of audio data into an audio document without
overwriting any existing data at the insertion point.
When you paste data with the Duplicate command, all
data to the right of the insertion point or selection start
is pushed farther to the right (later in time) to
accommodate the newly pasted audio. The Duplicate
command allows you to specify how many times you
would like to Duplicate the audio data contained in the
clipboard. The Duplicate command is very useful for
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creating longer audio documents that need to repeat a
certain piece of audio, such as creating a 4 bar drum loop
out of a 1 bar drum loop.
To Duplicate audio:

1. Select a range of audio, and choose Copy from the
Edit Menu (-C).
2. Click the cursor at the point you wish to insert
duplicate copies of the audio selected in step 1.

The Crop command (-`) allows you to make a
selection in an audio document and quickly remove all
other audio from the audio document except the
selection. The Crop command is a particularly useful
tool for editing material to be used as samples or sound
effects, since it allows you to isolate and save just the
desired portion of a recording.
To crop a selection:

3. Choose Duplicate from the Edit menu.
4. Use the Duplicate slider to indicate how many
copies should be inserted, or type in the number of
desired copies.
5. Click the OK button. All data to the right of the
insertion point is pushed farther to the right (later
in time) to accommodate the newly pasted range.
If there is a selection in the waveform when the
Duplicate command is invoked, then Peak automatically
fills the selection with the Clipboard contents. Peak
determines how many times the Clipboard contents
must be duplicated in order to fill the selection. If the
selection is not evenly divisible by the duration of the
Clipboard contents, Peak includes a fraction of the
Clipboard contents to make the duplication completely
sample accurate to the original selection.
To Duplicate audio to fit a Selection:

1. Select a range of audio, and choose Copy from the
Edit Menu (-C).
2. Select a range of audio that will be the “target”, and
will be filled with the Clipboard contents.
3. Choose Duplicate from the Edit menu – Peak fills
the selection with as many copies of the Clipboard
contents as possible, and fraction of Clipboard
contents if there is not enough space left in the
selection for another duplicate of the full Clipboard
contents.
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Cropping a Selection

1. Click the cursor at the desired location in the audio
document and drag to select the desired range.
2. Choose Crop from the Edit menu (-`). All audio
but the selection is removed from the audio
document.
New Document from Selection

The New Document from Selection command will
automatically create a new Audio Document containing
the selected audio from the source document.
To create a new document from a selection:

1. Make a selection in any open audio document that
you want to have as its own document.
2. Choose Document from Selection from the New
submenu under the File menu (Control-N).
3. A new audio document will be created with the
selected audio.
Silencing a Selection

The Silence command (-E) replaces the selected
portion of an audio document’s waveform with silence.
This feature is very useful for silencing nonessential
portions of a recording that contain an unusual amount of
noise. This can be used very successfully with spoken
material such as dialog or narration to remove noise
between words or during pauses in speech. It can also be
used to remove pops or clicks that occur in such material.
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Repairing Clicks & Pops

To silence a selection:

1. Click the cursor at the desired location in the audio
document and drag to select the desired range.
2. Choose Silence from the Edit menu (-E) – the
selected audio is replaced with silence.
Inserting Silence into a Document

Clicks & pops are common artifacts in digital audio –
they occur in various ways, such as: performing
cut/copy/paste-type edits at non-zero crossings in the
audio waveform, editing without Blending enabled,
recording vinyl records, faulty recording equipment or
cables, digital sync problems, etc. There are two main
categories of clicks that Peak’s tools can repair.

The Insert Silence command allows you to insert a
specific amount of silence into an audio document at the
current insertion point. This feature is very useful for
inserting pauses of a desired duration into a recording,
and can be particularly useful in adjusting the timing or
rhythm of spoken material such as dialog or narration.
When you choose this command, Peak will prompt you
to enter the amount of silence you wish to insert. You
can enter this value in samples, milliseconds, or seconds.
All audio occurring after the insertion point is moved
later in time by the amount of the silence that you insert.

When editing audio with Peak, it is unlikely that
you will introduce new clicks and pops because of
its Auto Snap (to Zero) option. When Auto Snap
(to Zero) is turned on (which it is by default), any
selections made are automatically snapped to the
closest zero crossing in the waveform, where the
audio is at zero amplitude. This ensures that you
do not inadvertently introduce a click or pop
when performing cut/copy/paste type edits.

Analog clicks such as those found in digital recordings of
vinyl records – are caused by scratches or other surface
imperfections on a record. This type of click usually
appears in the audio waveform as an abrupt, jagged
anomaly.

The Insert Silence dialog
Example of a digitized scratch on a vinyl record

To insert silence of a specific duration into a document:

1. Click the cursor at the desired location in the audio
document.
2. Choose Insert Silence from the Edit menu.

Digital clicks are generally caused by digital sync
problems with audio hardware interfaces, bad digital
cables, or recording with improper buffer settings. This
type of click generally has a square shape to it.

3. In the dialog that appears, enter the amount of
silence that you wish to insert into the audio
document – Peak inserts the specified amount of
silence into the document.
Example of a digital click
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Peak’s Pencil Tool can repair either type, though in the
case of digital clicks you may want to use the Repair Click
and Repair Clicks DSP tools, which are specifically
designed for this purpose (more information on Repair
Click and Repair Clicks is available in Chapter 8: DSP).
In either case, to use the Pencil Tool, you must be
zoomed in to sample level (sample level being the first
zoom level at which you can see individual audio
samples) or beyond. Additional information on settings
for the Pencil Tool is available in Chapter 3: Peak Basics.

3. From the Action menu, select Zoom at Sample
Level – you should now be able to see the
individual samples that make up the click.

4. In the tool area of the audio document window,
select the Pencil Tool.

To repair a click with the Pencil Tool:

1. Locate a click in the audio waveform – it will
appear as an abrupt “spike”.
2. Using your mouse, place Peak’s insertion point/
cursor directly over the “spike”.

5. Click into the waveform, and “draw” across the
anomaly, trying to approximate the shape of the
waveform on either side of the click. When you
have repaired the click, don’t forget to switch back
to the Arrow Cursor.

Place the insertion point cursor as close to the click as possible, so you
can easily locate it when zoomed in.

It is useful to place a marker over a click, and
then zoom in to repair it using the Pencil Tool.
Markers are covered in detail later in this chapter.
When you are zoomed in to allow viewing the
waveform in detail, it is very easy to scroll past a
click – having a marker in place makes it easy to
locate the click, should you lose your place.

Draw across the click, trying to approximate the shape of the
surrounding waveform.

When placing the cursor over a click, you may
notice that it jumps to one side or the other. This is
due to the Auto Snap option being enabled, and
Peak trying to move the cursor to the closest zero
crossing in the waveform. You may want to disable
the Auto Snap option for this type of work – it can
be disabled by selecting it from the Options menu.

This picture shows the repaired click, which now blends smoothly into
the surrounding audio.
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Show Edits
When you enable the Show Edits command, Peak
indicates areas of an audio document that you have
edited by enclosing these areas with hatched lines. This
provides you with a convenient visual reference to
portions of the document that have been affected by your
editing actions. Once you save a document, the edits are
saved, and these indicators will no longer appear.

a document, you may wish to enable blending to smooth
things out a bit. You can toggle blending on or off by
clicking the Blend enable/disable button in the audio
document window, or by pressing the Caps Lock key on
your keyboard.

5

To Enable Show Edits:

•

Choose Show Edits from the Options menu. A
check next to this item indicates it is enabled.

The Blending dialog

To Disable Show Edits:

•

Be aware that Blending can interfere with certain
DSP processes available under Peak’s DSP menu,
such as Fade In/Out and Normalize. You will
typically only want to enable Blending only when
you intend to make an edit in which Blending
may be desirable.

Choose Show Edits again from the Options menu.
The absence of a check next to this item indicates
it disabled.

To enable blending:

Using Crossfades and Blending to
Smooth Edits
Blending is an automatic crossfade function with a usereditable envelope. Peak can apply blending to areas of
an audio document where they are modified by cutting,
deleting, pasting, or other editing processes in order to
smooth abrupt transitions between waveform
amplitudes.

•

Click the blending button in the audio document
window, or press the Caps Lock key on your
keyboard. The blending button will light up in blue
when blending is turned on.

To disable blending:

•

Click the blending button in the audio document
window, or press the Caps Lock key on your
keyboard. The blending button will not be
illuminated when blending is turned off.

To set blending parameters:

1. Choose Blending in Peak’s Preferences panel.

The Blending Enable/Disable button in the audio document window

It can be very useful for creating a smooth transition
between edits that would otherwise sound too abrupt. If
you are going to edit (i.e., Cut, Copy, Paste, Delete, etc.)

2. Enter a value in milliseconds in the Duration field.
Peak will apply a crossfade of this duration across
the edit.
3. If you wish to edit the shape of the crossfade that
the blending function applies, click the Edit
Blending Envelope.
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4. Peak’s Crossfades are calculated logarithmically to
preserve volume levels for crossfaded material. If
you want Peak to calculate the Blending Crossfade
linearly, check the Linear Blend Calculations
checkbox.
5. Click OK when you have finished.
To quickly access the Blending Envelope editor,
press the Option key while clicking the Blending
button in the tool area at the upper right of an
audio document window.

cursor and press the Delete key on your computer
keyboard.
5. If you wish to reverse the shape of the envelope
you have created, click the “<->” button. This
creates a mirror image of the envelope.
6. If you would like to save your custom envelope for
later use, click on the Save button before exiting
the envelope editor.
If you save your custom blending envelope into:
/MacHD/Users/<YourUserAccount>/Library/
Preferences/Peak Envelopes/
It will automatically appear in the Envelope popup menu it the Blending Envelope editor.

7. When you are satisfied with your new envelope
shape, click Change to confirm your edits and close
the envelope editor. Peak will use this envelope
until you change it again.
The Blending Envelope Editor

Note that the Blending Envelope will only be
applied to an edit if it is configured prior to
making the edit.

To select and edit the blending envelope:

1. Choose Blending in Peak’s Preference panel and
click the Edit Blending Envelope button. The
Blending Envelope Editor appears. The envelope
shape shown here represents the shape of the
crossfade. Peak also comes with several commonly
used preset envelopes that appear in the pop-up at
the top of all of Peak’s Envelope Editing windows
(see also Editing a Fade In/Out Envelope). These
are stored in the Peak Envelopes folder in the
Preferences folder of your home directory.

If Linear Blend Calculations is checked in the
Blending dialog, the Equal Power X-fade envelope
is very effective for a smooth crossfade that will
not result in a dip in the energy of the audio data.

2. Click anywhere in the envelope area and a new
moveable “breakpoint” will appear.

Creating Fade Ins and Fade Outs

3. Drag the breakpoint to the desired location.

Peak allows you to create fade-ins or fade-outs at any
point in an audio document. Fade ins/outs can be very
useful for smoothly fading in or out of an audio
document, or for fading out of one type of audio material
into another. Very short fade ins can also be useful for

4. Continue creating and dragging breakpoints until
you have created the envelope that you desire. If
you wish to delete a breakpoint, click on it with the
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smoothing or removing clicks and pops in a recording.
Peak allows you to control the exact “shape” of the fade
in/out by providing you with preset envelope shapes as
well as very precise user-definable envelope controls for
the fade. Peak also comes with several commonly used
preset envelopes that appear in the pop-up at the top of
the Envelope Editing windows. These are stored in the
Peak Envelopes folder in your Peak folder.

To edit and save a Fade In/Fade Out envelope:

1. Choose Fade In Envelope (or Fade Out Envelope)
from the Preferences panel. The Fade Envelope
Editor appears. The envelope shape shown here
represents the shape of the fade, and overlays the
selected audio to show where the curve is
graphically applied to the waveform representation
of the audio.
2. Click anywhere in the envelope area and a new
moveable “breakpoint” will appear.

To create a Fade In:

1. Click the cursor at the desired location in the audio
document and drag to select the range you desire.
The Fade In will be applied to the audio within this
selection.
2. Choose Fade In from the DSP menu, or click the
Fade In button in the Toolbar. Peak applies the
Fade In to the selection you have made in the
audio document.
3. To hear the completed Fade In, press ControlSpacebar. You will hear the selected audio
complete with your Fade In.

The Fade Envelope Editor (a Fade In is shown)

3. Drag the breakpoint to the desired location on the
envelope’s curve.

To create a Fade Out:

1. Click the cursor at the desired location in the audio
document and drag to select the range you desire.
The Fade Out will be applied to the selected audio.
2. Choose Fade Out from the DSP menu, or click the
Fade Out button in the Toolbar. Peak applies the
Fade Out to the selection you have made in the
audio document.
3. To hear the Fade Out, press Control-Spacebar. You will
hear the selected audio complete with your Fade Out.

Editing a Fade In/Fade Out Envelope

Peak allows you to control the exact shape of Fade
Ins/Outs by providing you with controls for editing the
Fade In/Out envelope. These are found in the Fade In
Envelope and Fade Out Envelope sections in the
Preferences panel.

4. Continue creating and dragging breakpoints until
you have created the fade envelope that you
desire. If you wish to delete a breakpoint, click on
it with the cursor and press the Delete key on your
computer keyboard.
5. If you wish to reverse the shape of the envelope
you have created, click the “<->” button. This
creates a mirror image of the envelope.
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The steps above for loading a custom envelope
apply only if you have saved a custom envelope
outside of the Peak Envelopes folder, for example,
if you have saved custom envelopes with a project
that will be transferred to another Peak user.
Otherwise, you may simply choose the desired
envelope from the Envelope pop-up menu in the
Fade In/Out Envelope editor dialog.

6. If you would like to save your custom envelope for
later use, click on the Save button before exiting
the envelope editor.
If you save your custom Fade In/Out envelope
into:
/MacHD/Users/<YourAccount>/Library/
Preferences/Peak Envelopes/
It will automatically appear in the Envelope popup menu it the Fade In/Out Envelope editor.

Working with Markers

7. When you are satisfied with your new envelope
shape, click Change to confirm your edits and close
the envelope editor. Peak will use this envelope
every time you apply a Fade In (or Fade Out) until
you change it again.

Peak has a very powerful set of features to control the
placement and modification of markers. Markers are
locations in an audio document that you define as
important. By marking specific locations in a recording,
you can navigate easily to a location for selection, editing
or playback purposes.

To quickly access the Fade Envelope editor, press
the Option key while clicking the Fade In/Out
buttons in the toolbar, or while picking these
commands from the DSP menu.

Markers can also be made into loops. Loops are used to
sustain or repeat a section of audio. They can be used for
material that you intend to transfer to a sampler, or
simply for playback within Peak itself. Peak allows you to
create one loop per audio file. Loops are covered in
detail later in this chapter.

Note that the Fade In/Fade Out Envelope will only
be applied to a selection if it is configured prior to
applying the Fade In/Fade Out DSP function.

To load a Fade In/Fade Out envelope:

A waveform with a Marker

1. Choose Fade In Envelope (or Fade Out Envelope)
from the Preferences panel. The envelope editor
appears.

Creating Markers

2. Click the Load button.
3. In the dialog that appears, locate and select the
fade envelope that you desire, and click Open.
4. Click Change to confirm this new envelope and
close the envelope editor. Peak will use this
envelope until you change it again.
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The next few pages describe in detail the various
ways to create markers – by dropping them “on the
fly” during playback, inserting them during recording
with Notepad Cues, defining them with the mouse
when playback is stopped, creating markers using the
Threshold DSP command, or using the Markers from
Tempo command to insert multiple markers at
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You can easily find any marker, Region, or loop
that you have named by simply typing the first few
letters of its name. For example, if you want to
locate a marker called “Solo,” just type the letters
“s”-“o”-“l”, and Peak will automatically scroll to
the marker called “Solo.” If you hit Enter or
Return after typing the characters, Peak will also
automatically place the insertion point at that
marker. If more than one marker matches the
letters you type in, Peak will locate the first
marker with that name. (Note that numerical
marker name entries will only work from the
keypad, not the numbers keys along the top of
your keyboard.)

regular intervals. Of the various ways to create
markers, the mouse method is perhaps the more
precise. However, since it is possible to fine tune the
location of a marker at any time by dragging it, (or by
using the Edit Marker dialog, explained later) all
methods work equally well – the method you choose
to insert markers will depend largely on the task at
hand.
Remember that if Auto Snap is enabled the
insertion point will snap to the nearest
selected Snap To unit. This will cause your
marker to be placed at the nearest Snap To
unit when you use the mouse to create or place
a marker.

If you re-name the first marker in a document to
“1” – then all subsequent markers will be
automatically named “2”, “3”, “4”, and so on. You
can then quickly locate to the desired marker by
typing its number on the numeric keypad (the
numbers at the top of the keyboard serve another
purpose) and pressing Enter.

Once you have created a marker, you can assign or edit
the marker’s attributes in the Edit Marker dialog.
Double-click the triangular base of the marker to open
the Edit Marker dialog.

Marker Position

The Marker Position field allows you to move a marker to
a specific time location in an audio document by entering
the desired value. The pop-up menu to the right of this
field allows you to choose a time format (samples,
Minutes:Seconds:Miliseconds, etc.) for the value that you
enter in the Marker Position field.

The Edit Marker dialog

Text

Marker, Loop Start, and Loop End

You may wish to give markers meaningful names (up to
256 characters long) based on their locations in an audio
document. Peak gives markers default numeric names
based on the name of the audio document and the order
in which the marker was defined. To name or rename a
marker, simply type the new name in to the Text field of
the Edit Marker dialog.

These three radio-style buttons allow you to define
whether the marker is a regular marker or a loop
marker. If you choose to designate the marker as loop
marker, you can define it as either the loop start or the
loop end by clicking on the corresponding radio
button.
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Anchor To Sample Checkbox

To create a marker during playback:

When you insert or delete audio that is near a marker,
you may want the marker to move with that particular
location on the waveform. This will compensate for the
insertion or deletion, so that the marker remains with
the particular portion of audio you want it to be
associated with. By enabling the Anchor feature for a
marker, you can assure that Peak will “tie” the marker to
a location on a waveform, causing it to stay with that
location even when audio is inserted or deleted into the
document. By default, Peak enables this feature for
markers, loops and Regions.

1. Begin playback of an audio document.
2. At the desired point during playback, press -M
on your computer keyboard. Peak will drop a
marker at that location.
3. Repeat as desired as playback continues. Each
marker will appear at the appropriate location in
the audio document window.
To create a marker during recording:

1. Open the Record dialog.
2. Check the Notepad checkbox.

Be a Reference Marker Checkbox

3. Begin recording.

By defining a marker as a reference marker, you can use
the marker as a reference when you make selections or
move other markers. Selecting or dragging the marker
will then automatically display the distance to the closest
reference marker in whatever time format (Samples or
Seconds) is currently selected in the Peak application.
This may be useful, for instance, if you know that you
want a particular sound event (such as a car door slam)
to happen a certain number of seconds before or after
another sound event (such as a tire squeal).

4. Press the Return key to place a marker – then type
a name for the marker. To place another marker,
press the Return key and type a name for the
second marker, and so on.
Pressing the Return key first, and then typing the
marker’s name ensures that markers are placed
accurately – for instance, if an error was made
when typing in the marker’s name, it might take
longer than anticipated to enter the corrected
name, and the marker would be placed later in
time. By pressing the Return key first, and then
typing the name, you can be sure that the marker
is placed in the correct location.

Delete Marker button

The Delete Marker button allows you to remove the
currently selected marker from an audio document.
The following section explains how to create markers
and define their attributes.
To create a marker when playback is stopped:

1. Click the mouse at the desired location in the
audio document – a dotted vertical line appears,
indicating the insertion point.
2. Press -M on your computer keyboard or choose
New Marker from the Action menu or Toolbar –
Peak places a marker at that location.
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To create a marker using dynamic scrubbing:

1. Hold down the Control key (or Control-Option for
jog-type scrubbing) and drag the mouse across the
desired location to scrub playback.
2. At the desired point during playback, release the
mouse to stop scrubbing.
3. Press -M on your computer keyboard. Peak will
drop a marker at that location.
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To name a marker or set other marker attributes:

1. Double-click on the triangular base of the marker that
you wish to edit. The Edit Marker dialog appears.

Once the duration is altered and the Return key is
pressed, the marker will snap to the new location.
To nudge a marker or a selection of markers to a new
location:

2. Enter a name for the marker.
3. Change other attributes of the marker as desired.
For an explanation of each of these attributes, refer
to the beginning of this section.
4. When you have finished, click OK to close the Edit
Marker dialog – the marker now has the attributes
you selected.

1. Make a selection that includes the marker (or
markers) that you wish to nudge.
2. Choose Nudge Markers from the Action menu or
Toolbar – the Nudge Markers dialog appears.

5

or:

•

You may also open the audio document’s Contents
Drawer and click the desired marker’s name – it will
become editable text and can be re-named. When you
press the Return key, the marker’s name is updated.
The Nudge Markers dialog

To move a marker to a new location:

1. Click on the triangular base of the marker and drag
it to the desired location.
2. To make a marker’s position snap to a zerocrossing (the point at which a waveform crosses
the center phase line) as you drag it, hold down
the Shift key while you drag.

3. In the “Nudge Markers By” field, enter the number
of seconds (positive or negative) by which you
wish to nudge the marker.
4. Click OK to close this dialog – Peak nudges the
marker by the value you entered in the dialog.
Deleting Markers

To move a marker to a new location numerically:

1. Double-click on the triangular base of the marker.
The Edit Marker dialog appears.

There are a number of ways to delete markers,
described below.

2. Choose the desired time units (Samples, Seconds, or
Milliseconds) from the time format pop-up menu.

To delete a marker:

3. In the Position field, enter the precise time location
that you wish to move the marker to.
4. Click OK to close this dialog – Peak moves the
marker to the location you entered in the dialog.

1. Double-click the triangular base of the marker –
the Edit Marker dialog appears.
2. Click the Delete button – the marker is deleted
from the audio document.
3. Click OK to close the Edit Marker dialog.

or:

•

You may also open the audio document’s Contents
Drawer and click the desired marker’s duration – it will
become editable text and a new value can be entered.

To delete markers in a Selection:

1. Make a selection in the audio document that
contains the markers you want to delete.
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2. Choose Delete Markers Only (Option-Delete) from
the Action menu and all markers, Regions, and
loops in the selection will be deleted.

3. Type the name of the Region and click OK. The
new Region will appear in the audio document.
About Regions and CD Frame Boundaries

To Copy/Paste only Markers:

1. Select the desired range of audio, which contains
the markers you wish to copy.
2. From the Edit menu, choose Copy (-C).
3. Select a different range of audio (in the same
document or in a different document).
4. Hold down the Option key, and choose Paste
Markers Only from the Edit menu – just the
markers are pasted into the current selection.

Working with Regions
Regions are portions of an audio document defined by Region
Markers using the New Region command from the Action
menu (-Shift-R) or Toolbar. Regions present in currently
open audio documents will be listed in the Contents window.
Regions can be saved only into AIFF, Sound Designer II, and
WAVE files. However, Peak will also read Regions stored from
other programs in Sound Designer II files. The method Peak
uses to store Regions in AIFF files is specific to Peak and is
not necessarily supported by other software applications. If
you are using Regions with other programs, you will want to
store your files as Sound Designer II or WAVE files.

If you are creating Regions that will be used in a Peak
Playlist – and will eventually be burned as individual
tracks on a Red Book CD, be sure to set Peak’s Snap to
format to CD Frames (Action Menu>Snap To). In
addition, make sure that Auto Snap is active prior to
creating these Regions (Auto Snap can be turned on/off
in the Options Menu).
Creating Regions on CD frame boundaries is most
important when working with continuous play audio
material, such as a DJ mix or live concert recording,
where one track plays into the next with no gaps. By
creating Regions on CD frame boundaries, you can be
assured that the audio CD you create will not have short
gaps or clicks between tracks.
If you have already created Regions, and had the Snap To
format set to a different value, or did not have Auto Snap
turned on, you can easily edit the Region marker position.
To conform Regions to CD frame boundaries:

1. From the Options menu, check that Auto Snap is
enabled (a check appears next to the menu item
when active).
2. From the Action menu, choose Snap To, and CD
Frames from the submenu.
3. Shift-drag a Region marker, and it will snap to the
closest CD Frame boundary.

An audio Region (named “My Region”)

To define a new Region:

1. Make a selection in an opened audio document.
2. Choose New Region from the Action menu (Shift-R) or Toolbar.
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If you created multiple back-to-back Regions ( for
example, with the Markers to Regions command),
but were not in Snap To CD Frames mode, you can
quickly adjust the end of one Region and the
beginning of the next simultaneously by clicking
the Vertical Lock button in the audio document’s
Tool Area, and then following the steps above.

By using Vertical lock mode, you can snap the end of one Region and
the beginning of the next simultaneously.

The Edit Region Dialog

To change the name of a Region:
Note the position of the end of “Region A” and the beginning of
“Region B” – located at a peak in the waveform.

1. Double-click on either the start or end marker of
the Region in the audio document window. The
Edit Region dialog will appear.
2. Type the new name of the Region into the dialog
and click OK.

The end of “Region A” and beginning of “Region B” have been
“snapped” to the closest CD frame boundary.

or:

•

To modify the length of the Region by changing the start
or end:

•

Drag the start or end marker of the Region in the
audio document window.

You may also open the audio document’s drawer
and click the desired marker’s name – it will
become editable text and can be re-named. When
you press the Return key, the marker’s name is
updated.

To locate a Region:
To move a Region without changing its length:

•

•

Hold down the Option key and drag either the start
or end marker of the Region.

Double-click the Region’s name in the Contents
Window or in the audio document window’s
Contents Drawer. The Region will automatically
snap into view, with the Region selected.

or:

•

Click the Horizontal Lock button in the tool
area of the audio document window, and then
drag either the start or end marker of the
Region.

To edit a Region’s start, end, or length manually:

1. Double-click on either the start or end marker
of the Region in the audio document window.
The Edit Region dialog will appear.
2. Enter new values for Start, End, or Length times,
then click OK.

or:

•

Type the first few letters of the Region’s name, and
the Region will snap into view automatically.

Please note that if multiple Regions share similar names,
such as “TheIntro” and “TheEnd”, you would need to
type at least one character beyond “t-h-e-” for Peak to be
able to distinguish between these similar names. If you
plan on using this technique to locate to Regions, it is
recommended that you not use spaces in the Regions’
names, as when you attempt to locate to them, pressing
the Space Bar on your keyboard will initiate playback.
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To split a Region:

1. Place insertion point cursor at the the desired
location.

you are affecting all markers/regions, or just those
containing a particular string of text.
Markers and regions are found and renamed
chronologically, as they appear along the
audio document’s timeline. If you have
created markers and then changed their
positions, they will renamed according to their
new positions.

2. Choose New Region Split (Ctrl-Shift--R) from the
Action menu. The cursor’s position determines
the split point. Any part of the document before
the split point becomes one Region, and any part
after the split point becomes another Region.
To Copy/Paste only Regions:

1. Select the desired range of audio, which contains
the Region markers you wish to copy.
2. From the Edit menu, choose Copy (-C).
3. Select a different range of audio (in the same
document or in a different document).
4. Hold down the Option key, and choose Paste
Markers Only from the Edit menu – just the
Region markers are pasted into the current
selection.

Rename Section

This section allows you to specify how markers and
regions will be renamed and/or renumbered.
•

Rename Field – Adding a text string here changes
the names of all found markers to this text string.
For example, adding “PeakPro” here would result
in all found markers being renamed “PeakPro”.

•

“#” Character – Adding the # character in the
Rename field, and a letter or number in the
Start field adds letters or numbers sequentially
to the renamed marker or region names. For
example, if “PeakPro” was added in the Rename
field, with a “#” directly following it, and the
number “1” was added in the Start field, the
resulting markers/regions would be named
“PeakPro1”, “PeakPro2”, “PeakPro3”, “PeakPro4”
and so on.

•

“0” Character –

Renaming Markers & Regions

The Rename dialog allows you to rename multiple
markers and/or region markers. This dialog is broken up
into two sections, the “Find” section and the “Rename”
section.

Adding the “0” character (zero)
after the # character allows you to control leading
zeros. For example, rename to “Event #000” start
with “10” produces markers/regions named “Event
010”, “Event 011”, “Event 012”, etc.
The “0” character only works with the numbers,
not letters, and only up to 9 leading zeros may be
used.

The Rename Dialog

Find Section

This section allows you to specify whether you are
affecting markers, regions, or both, as well as whether
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To Rename a Series of Markers/Regions:

1. Make a selection in the audio document containing
the markers/regions you wish to rename (or Select
All for the entire document).

Peak’s Batch File Processor to process a file’s Regions
with any of Peak’s DSP functions and third party plug-ins
during the automatic exporting of Regions into new files.

2. From the Action menu, choose Rename.
3. Use the Markers and Regions checkboxes to
specify which type of markers should be renamed.
4. Use the radio button that best suits how you wish
to rename – the All Selected radio button will apply
renaming to all markers/regions that lie in the
selected portion of the audio document, while the
Containing the Text radio button will apply changes
only to markers/regions that contain a specific text
string.

5

5. In the “Rename to” field, enter a new name.
6. If you wish to have this new name appended with
a letter or number, also enter the “#” character in
the Rename field, and then enter the desired
starting number or letter in the Start field.
7. Click OK – the selected range of markers is
renamed.
Exporting Regions

The Export Regions dialog

To export Regions from an audio document:

1. Select the Regions that you wish to export. (To
make selections, you can use the Tab key, Shift-Tab,
or if you wish to select the entire document, press
-A.)
2. Choose Export Regions from the File menu.

Regions may be exported from an audio document using
the Export Regions dialog, or by manually dragging them
from the Contents palette or drawer to the Finder, or to
other applications, such as iTunes.

3. In the Export Regions dialog, choose the
parameters that you wish to use for selecting the
Regions to export.
4. Using the Region Detection options, choose which
Regions are to be exported.

Exporting with the Export Regions Dialog

If you have placed markers or Regions in an audio
document, Peak’s Export Regions command allows you
to export those Regions from the source document and
save each of these Regions as a separate audio
document. This feature is very convenient if you wish to
divide a larger file into Regions and transfer them as
samples into a sample playback instrument, or divide a
live concert record into Regions and export those
Regions as separate files. Furthermore, you can use

5. Using the Output Format options, choose the
format and resolution you wish for the exported
Regions.
6. Using the Output Directory options, choose the
destination for the exported Regions.
7. If you wish the newly exported Regions to appear
as new open Peak documents, choose Output to
new windows.
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8. To save the exported Regions to disk, select Save To
Disk and choose whether you would like to save
the Regions into the same folder as the source files,
or to a different folder. If you prefer to save to a
new folder, use the Set Path button.
9. To export the Regions, click Begin. Peak exports
each of the Regions into its own audio document.
Region Detection area – To export all Regions in an audio
document, click the Export Regions button. To export
audio between adjacent markers, click the Export Audio
between Markers button. To export only Regions that
are bounded by specific marker names, click the Only
Regions button and enter the parameters that you wish
to use to select the desired Regions. For instance, if you
wish to export only Regions bounded by markers with
the word “hit” in them, click the pop-up menu, choose
containing, and type the word “hit” in the field next to
the pop-up. Conversely, if you wish export all Regions
except those with the word “hit” in them, click the popup menu, choose not containing, and type the word
“hit” in the field next to the pop-up menu.

Choose the file format, bit depth
resolution, and Stereo or Mono from these pop-up
menus for the resulting exported audio documents. You
can set the Sample rate in kHz for the resulting files in the
Rate field. You can also designate whether the resulting
audio documents contain Regions or Markers or not.

Output Format area –

Output Directory area – Resulting audio documents can
either be output to new open audio document windows
or saved to the hard drive. Choose Output to New
Windows if you want to have the resulting audio
documents open in Peak or choose Save To Disk if you just
want to write the new audio files to disk without opening
them in Peak. If you Save To Disk, you can simply choose
to use the original audio document’s folder or you can
specify another folder on your hard drive(s) to save the
resulting audio documents by choosing Set Path. The
Name Prefix field allows you to include a specified prefix
to all the resulting audio documents. The default prefix is
the name of the file. Each and every one of the resulting
audio documents will be named with the prefix plus the
name of the individual Region.
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Another exciting feature of the Export Regions function
is that you can Export Regions through Peak’s Batch File
Processor. First configure the Batch File Processor and
turn it on, then, go to Export Regions and check the Use
Batch File Processor checkbox. When you begin
exporting Regions, each one will be affected by the
processes you choose in the Batch File Processor dialog
(see Chapter 8: DSP & Chapter 9: Plug-Ins).
Do not save the output of the Batch File Processor
to the input directory (i.e., the same directory that
contains the files being batch processed).

LE

Export Regions is not available in Peak LE.

Send to iTunes
Entire audio documents and/or the Regions they contain
may be exported directly to your iTunes library. This is a
useful command if you plan to export Regions and then
add them to your iTunes library, as Peak can do this
automatically.
To send an audio document to iTunes:

1. Open and/or bring the desired audio document to
the foreground.
2. From the File menu, choose Send to iTunes.
3. To send the entire audio document as a single file,
click the Single Song button – or, if the audio
document contains Regions, and you wish for each
Region to be sent to iTunes as a separate song, click
the iTunes Playlist button.
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Working with Loops

To create a loop from a selection:

If you’re editing music or other rhythmically-based
material, it is generally a good idea to test a selection to
make sure it contains an even number of beats before
you cut, copy, or paste it. A good way to do this is to
loop the selection and listen to the loop as it plays. As
described in the next section, Peak includes Loop
Surfer, which can automate the process of finding a
rhythmically “correct” length of audio to loop,
assuming you know the tempo and the number of beats
you wish to loop. You can also use the Loop Tuner,
found in the DSP menu, to adjust the loop start and end
points. The Loop Tuner is also described in the next
section.
Loops are useful in material that you plan to transfer to a
sampler. Loop markers created with Peak are recognized
by samplers as sustain loops. Peak allows you to create
one loop per audio document.
When using a single loop per audio document,
there is a quick and easy way to mark multiple
desired sections for looping. With the loop
markers in the desired location, choose Select
Loop from the Edit menu, then, choose New Region
from the Action menu – a Region is created that is
the same length as the loop. Using this technique
allows you to create as many Regions as desired
within a single audio document. To loop any of
these Regions, simply -click between a Region’s
markers to select the Region (or press the Tab key
until the desired Region is selected), and then
choose Loop this Selection from the Action menu.

To play a loop in Peak, select Use Loop in Playback
command (-L) from the Options menu or click the
loop button in the Transport window, begin playback,
and when Peak reaches the loop, it will continue to
repeat until you stop playback. If Use Loop in
Playback is not enabled, Peak will simply play right
through the loop to the end of the audio document or
selection.

1. Click the cursor at the desired location in the audio
document and drag to select the range you want.
2. Choose Loop This Selection from the Action menu (Shift-”-”) or Toolbar. Your selection is now looped. Loop
markers appear at the beginning and end of the loop.
3. To listen to the loop, choose the Use Loop in
Playback command (-L) from the Options menu
(a check next to this menu item indicates it is
enabled), or click the Loop button in the Transport
window, and start playback by pressing the
Spacebar on your keyboard.
4. You can interactively fine-tune a loop by dragging
the loop start or end markers while loop playback
is engaged. As you drag a loop marker to a new
location, Peak will adjust the playback loop to
reflect the changes you make. You can also use the
Loop Tuner to call up a dialog that allows you to
visually fine tune the loop, and even play the loop
while adjusting it to listen to the changes.
To change regular markers into loop markers:

1. Create markers in an audio document.
2. Double-click on the triangular base of the marker
that you wish to define as the loop start point. The
Edit Marker dialog appears.
3. Click the Loop Start button and click OK. The
marker becomes a Loop Start marker.
4. Double-click on the triangular base of the marker
that you wish to define as the loop end point. The
Edit Marker dialog appears.
5. Click the Loop End button and click OK. The
marker becomes a Loop End marker. You have
now defined a loop in your audio document.
To move a pair of loop markers together:

•

Hold down the Option key and drag one of the
loop markers to the desired location.

or:
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•

Click the Horizontal Lock button in the audio
document window, and drag the begin loop or end
loop marker – both markers move in tandem. Be
sure to turn off Horizontal Lock to move the loop
markers independently.

To Save an AIFF File with the Loop Flag Off:

1. From the Options menu, choose Use Loop in
Playback (-L), or click the Use Loop in Playback
button in the Transport. The absence of a check
next to the menu item, or a non-illuminated button
in the Transport indicates the loop flag is turned
on.

The Horizontal Lock button

To listen to the loop only:

1. Choose Select Loop (-”-”) from the Edit menu.
2. Make sure loop playback is enabled using the Use
Loop in Playback command (-L) from the
Options menu (a check next to this menu item
indicates it is enabled), or by pressing the Loop
button on the Transport.
3. Press the Spacebar to begin playing back the loop.
Turn Loop Flag On/Off on Save

2. Save the AIFF file – the loop flag is saved in the off
position.

This feature allows the loop flag in AIFF files to be
turned on or off when saving a file. The state of this
loop flag when a file is saved determines the file’s
playback behavior when loaded into Peak again, or into
another application capable of reading embedded loop
flags.
The loop flag is now toggled on or off when saving,
depending on the state of the Loop Playback setting in Peak.
To Save an AIFF File with the Loop Flag On:

1. From the Options menu, choose Use Loop in
Playback (-L), or click the Use Loop in Playback
button in the Transport. A check next to the menu
item, or an illuminated button in the Transport
indicates the loop flag is turned on.
2. Save the AIFF file – the loop flag is saved in the on
position.
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There are two ways to turn Use Loop in Playback on or off – the Use
Loop in Playback button in the Transport, and the Use Loop in
Playback command in the Options menu.

Crossfading Loops

Peak allows you to crossfade the start and end points
of a loop. Crossfading a loop can be very useful for
smoothing the transition between the end of the
loop and its beginning as it repeats. Peak allows you
to control the envelope of the crossfade, the
duration, and other parameters in the Crossfade
Loop dialog.
The Crossfade Loop dialog

The four checkboxes at the top of the Crossfade
Loop dialog allow you to customize how the end of
the loop is faded into the beginning of the loop.
These boxes indicate where in the loop the
crossfade is applied. For most loops, you should be
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able to leave the default checkbox checked and get
good results.

A

B

C

D

Crossfade Variations

If you consider the crossfades “A”, “B”, “C”, and “D” from
left to right, then:
“A” =

Crossfade between A and C

“B” =

Crossfade between B and D

“C” =

Crossfade between C and A

“D” =

Crossfade between D and B

5
Crossfade positioning options – different uses for loops may call for
different loop crossfade settings – With crossfade position “C” checked
a crossfade is applied as indicated by the red “X”

The Crossfade Loop dialog

The way these crossfade variations are configured
depends on where the loop is destined to be used –
for most purposes the default crossfade position
(Position “C”) works well – if however, you plan on
transferring these loops to a sample playback
instrument such as a SMDI sampler, then you may
want to experiment with different crossfade
positions/combinations. Some hardware based
samplers offer advanced playback controls, allowing
loops to be played forward, backward, and in various
other ways. By changing where in the loop
crossfades are applied, you can customize your
audio content for a particular sampler and for the
desired effect.

Another application that may require using loop
crossfade position(s) other than the default position “C”,
are when creating audio loops intended to be used in a
proprietary video game audio engine. Depending on the
requirements of a particular video game’s audio engine,
users may need to adjust the position of the crossfades
used in their loops, to achieve the desired effect.
Depending on the application requiring crossfades, users
may need “loop with release” (plays the tail of the audio
document – the section of audio that lies outside the
loop markers – after the loop stops playing/sampler’s
key is released) or “loop hold” (doesn’t play the audio
after the loop when the key is released). Because of
these different modes, users may need to turn some
crossfades on or off
To crossfade a loop:

1. Create a loop using one of the techniques
explained earlier in this chapter.
2. Choose Crossfade Loop from the DSP menu or
Toolbar.
3. In the Crossfade Loop dialog that appears, enter a
duration for the crossfade-in milliseconds and click
OK.
4. To hear the completed crossfade, choose Select
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Loop from the Edit menu, select Use Loop in
Playback from the Options menu (-L) or click
the Loop button on the Transport, and press the
Spacebar. You will hear the loop, complete with
your crossfade.
To edit a Crossfade Loop Envelope:

1. Click on the Envelope button in the Crossfade
Loop dialog and the Blending Envelope Editor
appears.

the envelope editor. Peak will use this envelope
until you change it again.
To hear the completed crossfade, choose Select Loop
from the Edit menu, select Use Loop in Playback from
the Options menu or click the Loop button on the
Toolbar, and press the Spacebar. You will hear the loop,
complete with your crossfade.
If you save your custom Blending envelope into:
/MacHD/Users/<YourAccount>/Library/
Preferences/Peak Envelopes/
It will automatically appear in the Envelope popup menu it the Fade In/Out Envelope editor.

The Blending Envelope Editor

LE

The Crossfade Loop dialog is not available in Peak
LE.

Note that this is the same Blending Envelope Editor
that is accessed from the Blending dialog.
Using Loop Surfer

2. Click anywhere on the line and a new moveable
“breakpoint” will appear.
3. Drag the breakpoint to the desired location.
4. Continue creating and dragging breakpoints until
you have created the envelope that you desire. If
you wish to delete a breakpoint, click on it with the
cursor and press the Delete key on your computer
keyboard.
5. If you wish to reverse the shape of the envelope
you have created, click the “<->” button. This
creates a mirror image of the envelope.
6. If you would like to save your custom envelope for
later use, click on the Save button before exiting
the envelope editor.
7. When you are satisfied with your new envelope
shape, click Change to confirm your edits and close
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Peak’s Loop Surfer feature automates some of the steps
for setting up loop points. Loop Surfer allows you to
“Loop Surf ” (adjust your loops during playback) quickly,
easily and in a musically intuitive manner.
If you’re working with music, and know the music’s
tempo in beats per minute, you can use Loop Surfer to
create a loop which lasts for a rhythmically “correct”
length of time.
To use Loop Surfer based on a musical tempo:

1. Place the cursor where you wish to begin the loop
(it’s okay to place it approximately, rather than
exactly, where you wish to start).
2. Choose Loop Surfer from the Action menu (-J).
The Loop Surfer dialog appears.
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and number of beats;
c) change the cursor insertion point to a Loop
Start marker;
d) drop a Loop End marker at the end of the
newly calculated selection;
e) turn on (if it hasn’t already been turned on)
the Use Loop In Playback option under the
Options menu.
The Loop Surfer dialog

f) begin looped playback of the audio selection,
stopping only once you hit your keyboard’s
Spacebar or press Stop on the Toolbar.

3. Type in the music’s tempo. If you are not sure of
the tempo, you can use the Tempo Calculator to
determine the tempo. Simply select a portion of
audio, and type in the number of bars and beats in
the selection. The calculator will determine the
tempo based on your selection. If you are unsure,
and have used a drum machine or sequencer to
create the music, you might wish to refer back to
its settings determine the time signature and
tempo. Additionally, you can use the Threshold
command from the DSP menu to select a portion
of audio that should correspond to the beat; see
“To use Loop Surfer based on a selection” below.
4. Type in the number of beats that you wish the loop
to last. The beats are based upon quarter-notes, in
terms of musical time. For instance, if your song
was in a 4/4 time signature, typing “4” beats would
mean the loop would be one measure in length; if
the song were in 7/4 time, typing “14” would mean
the loop would be two measures in length. (If you
are interested in exploring syncopations, however,
there’s no reason why you can’t type a beat value
that doesn’t correspond to the time signature, such
as “5” if the music is actually in “3/4” time.)
5. If you then select the Start Surfing button (the
default), Peak will automatically:
a)

close the Loop Surfer dialog box;

b) extend the selection from the cursor insertion
point to a calculated length, based upon the tempo

6. If you select the Make Loop button, Peak will
automatically:
a)

close the Loop Surfer dialog box;

extend the selection from the cursor insertion
point to a calculated length, based upon the tempo
and number of beats;
b)

c) change the cursor insertion point to a Loop
Start marker;
d) drop a Loop End marker at the end of the
newly calculated selection;
e) turn on (if it hasn’t already been turned on) the
Use Loop In Playback option under the Options menu.
f) At this point, you must start playback manually
using the Spacebar or the Toolbar if you wish to
begin Loop Surfing.

While you’re Loop Surfing (adjusting your loop during
playback), you’re free to perform all standard looping
functions as described in the previous section, including
adjusting the Loop Start and End points during playback.
Most importantly, you’ll now have a selection that lasts
for a rhythmically correct period of time (that matches
the beat). If you move the markers in tandem, by
holding down the Option key and clicking and dragging
one of the loop markers to the desired location with the
mouse, you’ll find it’s a great way to set up interesting
rhythms and syncopations! Peak’s interactive editing
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capabilities also allow you to use the Loop Surfer dialog
while a loop plays to adjust the tempo, beats and so on.
If you’re not working with music (or if you simply don’t
know the tempo of the music you’re working with), you
might choose to Loop Surf based upon a selection (or
use the Threshold feature), rather than starting at a
cursor insertion point.
To use Loop Surfer based on a selection:

1. Place the cursor where you wish to begin the loop,
and using the mouse, select the portion of audio
you wish to loop. ( You can make your selection in
a variety of other ways, also, as described earlier,
including selecting between markers by -clicking
with the mouse).
2. Select Loop Surfer from the Action menu. The
Loop Surfer dialog appears.
3. If you check the Use Selection box and select
either the Start Surfing or Make Loop button, Peak
will automatically:
a)

close the Loop Surfer dialog box;

extend the selection from the cursor insertion
point to a calculated length, based upon the tempo
and number of beats;
b)

c) change the cursor insertion point to a Loop
Start marker;

drop a Loop End marker at the end of the
newly calculated selection;
d)

e) turn on (if it hasn’t already been turned on)
the Use Loop In Playback option under the
Options menu;

As you “Loop Surf ”, that is, as you move the loop
points simultaneously through an audio document
while audio plays, you may find sections that you
would like to set aside for later. These sections can be
saved as Regions, which can be used to create a remix
within a Peak Playlist, may be exported as new audio
documents, or used in a loop-based sequencing
application, such as Ableton Live or Apple SoundTrack
or GarageBand.
Since Peak allows only one loop per audio document,
you can turn the loops that you like into Regions.
To create Regions from Loops:

1. As a loop plays, choose Select Loop (-”-”) from
the Edit menu.
2. With the loop selected, choose New Region (-R)
from the Action menu. Name the Region and click OK.
3. Hold down the Option key (or click the Horizontal
Lock button in the Toolbar) and drag the begin
loop or end loop marker to a new position in the
audio document – both loop points will move
simultaneously.
4. When you locate another section of the audio
document that you would like to set aside for later
use, choose Select Loop (-”-”) from the Edit menu.
5. With the loop selected, choose New Region (-R)
from the Action menu. Name the Region and click
OK. Continue Loop Surfing and creating Regions as
desired.

f) begin looping and playing. The selection will begin
looped playback (if you have selected Start Surfing);

You may continue placing as many Regions as desired
using this technique. To later loop any of the Regions
you have created, just select the desired Region, and
choose Loop this Selection from the Action menu.

g) wait for you to start playback manually using
the Spacebar or the Toolbar if you wish to begin
Loop Surfing (if you have selected Make Loop).

To create a remix in a Peak Playlist, simply create a new
Playlist, and add the desired Regions to it. For more
information on using Playlists, please see Chapter 6:
Playlists & CD Burning.

or:
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Making Loops into Regions
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To export these Regions as new audio documents, or to
use within another application, please see the section on
Exporting Regions, later in this chapter.

LE

LE

Guess Tempo is not available in Peak LE.

Loop Surfer is not available in Peak LE.
Using Loop Tuner

Loop Tuner provides a way to visually line up the start
and end points of your loop to get a smooth transition at
the loop points. Loop Tuner also allows you listen to the
effects of these adjustments as you make them.

Using the Guess Tempo and Threshold
commands to find tempo

If you are working with music and don’t know the tempo
– and your music has a relatively pronounced or obvious
beat – you can use the Guess Tempo command to have
Peak automatically guess the tempo of a selection. Make
a selection and choose Guess Tempo from the Action
menu. There will be a pause while Peak scans your
selection and calculates the tempo for you. A dialog will
then appear showing you the estimated tempo in BPM,
or beats per minute. You can then enter the estimated
tempo in BPM in the Loop Surfer dialog’s Tempo field, or
click Loop-It to automatically place the guessed tempo
value into the Loop Surfer dialog.

The Loop Tuner showing a smooth transition between the end and
beginning of the loop – this would produce a seamless loop.

As you Loop Surf, you may automatically change the
number of beats in a loop by selecting the loop (-Shift”-”), opening the Loop Surfer dialog (-J), and entering
a new value for beats.
You can also use the Threshold command (described in
greater detail in Chapter 8: DSP) to define a number of
markers or Regions based on amplitude peaks. If you then
select audio with start and end points that correspond to
these sections, you should have a selection that precisely
matches the musical beat. Using Loop Surfer, you could
then automate the process of looping the selection by
following the steps described directly above.
Guess Tempo works best with audio selections that
contain one full measure of audio with pronounced
attacks on the beats, which appear visually on the
waveform as taller sections of the audio. Using the
Normalize feature on the selection prior to Guess Tempo
can improve the accuracy of its deduction.

The Loop Tuner showing an abrupt transition between the end and
beginning of the loop – this would create a click each time the loop repeats.

If you wish to “tune” a loop you’ve made, simply select
Loop Tuner from the DSP menu or Toolbar, and a dialog
will appear. The waveform display in the Loop Tuner
dialog shows the Start and End points of the loop, which
you can visually adjust with the scroll bars at the bottom
of the window. The two zoom buttons – magnifying
glass icons-in the upper left of the Loop Tuner dialog
allow you to adjust the vertical zoom up of the waveform.
The two zoom buttons in the lower left hand corner of
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the Loop Tuner dialog allow you to adjust the zoom view
in and out all the way down to the sample level. You can
listen to the effects of the adjustments as you make them
by clicking on the Play button. To exit this dialog, click
on OK to accept the changes, or Cancel to leave the
original loop unaffected.

LE

Loop Tuner is not available in Peak LE.

Editing QuickTime Soundtracks
Peak allows you to edit QuickTime movie
soundtracks. While you cannot edit QuickTime video
in Peak, you can use Peak as a full-featured audio postproduction tool for QuickTime movies. This makes
Peak an ideal tool for editing and cleaning up
soundtracks, as well as adding sound effects or music
to QuickTime movies.
How to open and edit QuickTime sound tracks in Peak:

1. Select Open from the Edit menu (-O) or Toolbar.
2. In the dialog that appears, locate the QuickTime
movie that you wish to open.

Perpetual Looper

The Perpetual Looper is based on BIAS’ powerful Partial
Harmonic Audio Technology (PHAT). The Perpetual
Looper makes it easy to create smooth, seamless loops of
monophonic, tonal sounds by performing its work in the
frequency domain, instead of in the time domain as
looping has traditionally been done.
The Peak Movie Window

The Perpetual Looper dialog.

The Perpetual Looper is intended for creating “sustain
loops” of single notes or sounds, not phrases or sections
of audio, and generally will not produce useful results
from phrases.
Working with the Perpetual Looper is explained in detail
in Chapter 8: DSP.

LE
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Perpetual Looper is not available in Peak LE.

3. Click the Open button, and Peak will open the
QuickTime movie in a movie window, and open
the movie’s audio track in an audio document
window. Select Movie>Movie Sound Tracks from
the Options menu to Enable or Disable the movie’s
other audio tracks. You can also use this dialog to
toggle multiple soundtracks contained in a movie
on and off to check balances or “solo” certain
tracks. Click on the Set button to accept the
changes, or Cancel to leave the movie unaffected.
To toggle the Movie Window on or off, choose
Movie from the Window menu. A check next to
this item indicates it is enabled.
4. You may now edit the movie’s audio track as you
would any other audio document. The movie will
“scrub” along with the audio, and the placement of
the insertion point in the audio document window
will also scroll the movie to that point.

Peak 6 User’s Guide

5. When you are finished editing the QuickTime
sound track, use Peak’s “Save As” command to save
the movie with its new sound track.

sometimes two applications creating the same file type
will store metadata in them differently.
Peak offers extensive metadata capabilities, including a
“master” metadata chunk (Peak Metadata) that can
contain all of the fields used in every file format for which
Peak supports metadata. Currently, Peak supports
metadata in MP3, FLAC, AIFF, WAVE, and Broadcast WAVE
files.
The Edit Metadata Dialog

Metadata for a specific file format is edited in the Edit
Metadata dialog.

The Movie Sound Tracks dialog

Be careful not to change the duration of the audio
using cut, delete, or insert, as this will cause the
audio and video to fall out of sync.

The Edit Metadata dialog can be reached in one of five
ways:

1. Clicking at the bottom of a document window will
open the Edit Metadata dialog.
2. The Edit Metadata command in the File menu
allows reading and editing of metadata without it
being open in Peak.

Editing Metadata
Metadata is commonly described as “data about data”,
but it is easier just to say that it is descriptive information
about a computer file. Artist, album, and song are three
typical pieces of metadata that might describe a music
file purchased from an online music retailer, while
metadata for a file from a sound effects library might
include file name, duration, sample rate, bit depth, and
sound effects category. [Metadata is most useful when it
is stored as part of the file that it describes, and an
increasing number of file types include metadata
capabilities].
Many people are familiar with the ID3 tags stored in MP3format files. The first metadata format for MP3 files was
called ID3v1. However, that format had some severe
limitations, leading to the creation of ID3v2. While not an
official standard, ID3v2 is currently the most common
metadata format for MP3 files. Peak supports both formats.
Unfortunately, there is no standardization between file
formats on what metadata is stored or how. In fact,

3. The Edit Audio Info command in the Action menu
allows reading and editing of metadata in files that
are open in Peak
4. When saving a file in the MP3 format, choose the
Save As menu item from the File dialog, and then
click the “Format Options” > “Edit ID3v2 Tags”
button to open the Edit Metadata dialog.
5. When publishing a podcast, choosing the Publish
Podcast item from the File menu, then select the
MP3 format and clicking the “Settings…” > “Edit
ID3v2 Tags” button to open the Edit Metadata dialog.
To read and edit file metadata without opening the file in
Peak:

1. Choose Edit Metadata from the File menu.
2. Browse to the file for which you wish to edit
metadata.
3. Click the “Open” button – the Edit Metadata dialog
appears, showing any existing metadata.
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The Edit Metadata dialog allows editing metadata for specific file
formats, and only fields supported by the current file type being
edited are available.

The Edit Peak Metadata chunk dialog contains all of the metadata
fields used in every file format for which Peak supports metadata.
Once entered here, metadata can be applied to any supported file

4. Edit the metadata as desired. Be sure to mark the
checkboxes for all metadata fields you want saved.

4. Click the “Edit ID3v2 Tags” button – the Edit
Metadata dialog opens.

5. Click the “Save” button to save your metadata
changes back to the file.

5. Edit the metadata as desired. Be sure to mark the
checkboxes for all metadata fields you want
saved.

To read and edit metadata in a file that is open in Peak:

1. Choose the Edit Audio Info item from the Action
menu or click at the bottom of the audio document
window. The Edit Metadata dialog will appear,
showing any existing metadata.

6. Click the “Save” button.
7. Click “Save” in the Save As dialog.
To read and edit metadata for a podcast being published
in MP3 format:

2. Edit the metadata as desired. Be sure to mark the
checkboxes for all metadata fields you want
saved.

1. In the Publish Podcast dialog, select “MP3” from
the Format drop-down menu.

3. Click the “Save” button.

2. Click the “Settings…” button – the MP3 Encoder
dialog opens.

Note that metadata edits are not actually saved
until the audio document is saved.

To read and edit metadata when saving a file into the
MP3 format:

3. Click the “Edit ID3v2 Tags” button – the Edit
Metadata dialog opens.
4. Edit the metadata as desired. Be sure to mark the
checkboxes for all metadata fields you want
saved.

1. Choose the Save As item from the File menu.

5. Click the “Save” button.

2. Select MP3 from the File Type menu.

6. Finish entering podcast and/or episode
information, and click the “Publish” button.

3. Click the “Format Options” button – the MP3
Encoder dialog opens.
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The Peak Metadata Chunk

The Peak Metadata chunk provides a central location that
contains all of the metadata fields for all supported file
formats. This means that you can enter all of your
metadata in the Peak Metadata dialog and then copy it to
the metadata for each individual file format through the
use of the “Copy from Peak Metadata” button that
appears at the bottom of the Edit Metadata dialog. Of
course, it is only possible to copy fields that are
supported in the target file format.
Unlike the data that is entered/copied into the Edit
Metadata dialog, the Peak Metadata chunk is stored in a
file in a proprietary form that is read only by Peak.
In addition to the metadata fields, the Edit Peak Metadata
Chunk dialog includes the following controls:

Note that field data in the Edit Metadata will only
be overwritten if there is data for that field existing
in the Peak Metadata Chunk, and the checkbox for
the field in the Edit Metadata dialog is marked.

Conclusion
You have now learned how to manipulate audio with
Peak’s various editing tools, including how to work with
Markers, Loops, and Regions. In the next chapter you
will learn more about the use of Regions in Playlists, and
outputting in a variety of formats, including Red Book
audio CD, DDP, and more.

To read and edit Peak metadata chunk:

1. Choose the Edit Peak Metadata Chunk item from
the Action menu. The Edit Peak Metadata Chunk
dialog will open.
2. Edit the metadata as desired. Be sure to mark the
checkboxes for all metadata fields you want saved.
3. Click the “Save” button.
Note that metadata edits are not actually saved
until the audio document is saved.

To copy metadata from the Peak Metadata Chunk to the
metadata for a file:

1. Be sure that all desired metadata has been entered
in the Edit Peak Metadata Chunk dialog.
2. Open an Edit Metadata dialog for the file being
edited.
3. Mark the checkboxes for every field in the dialog
for which you want to copy data from the Peak
Metadata Chunk.
4. Click the “Copy from Peak Metadata Chunk”
button at the bottom of the dialog.
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Chapter 6:
Playlists & CD Burning

Introduction
This chapter explains how to arrange Regions in a Playlist,
and how to output “masters” in various formats, from
which all subsequent copies are produced. Peak’s Playlist
allows non-destructive editing, crossfading, setting
custom gaps and pauses between tracks, applying effects
plug-ins, setting custom track start offsets, embedding
various types of metadata, such as International Standard
Recording Codes (ISRC), CD-TEXT data, and more.
In the simplest terms, a Playlist is used to string Regions
together in a specific order. Once Regions have been
added to a Playlist, they are referred to as Playlist Events.
The Peak Playlist is a set of instructions that tell the hard
disk which Regions to “read”, and in what order. Playlist
editing does not permanently alter the original audio
data on your hard disk. No matter how many changes
you make, your original recordings remain intact. This
type of nondestructive editing is one of Peak’s most
significant and powerful features.
When editing in Peak’s Playlist window you are not
permanently deleting, moving, replacing, and adding
actual audio as you would if you were cutting and splicing
analog tape. Instead, Peak is creating a “map” of your audio
file. This map, or “Playlist,” simply describes the order in
which you want portions of the recording to be played. If
you’d like to hear the middle of a song first, the end next
and the beginning last, you may arrange your Playlist
Events in this order. Peak will read (e.g., play) from the
hard disk (where the audio data is stored) from any
number of possible points originally designated by Region
markers, and these Regions can be auditioned in the
Playlist in any number of possible arrangements.

Playlist editing allows you to adjust and re-sequence
Playlist Events (e.g., Regions) with ease. Edits can be
heard as soon as you perform them. In addition, Peak
allows you to apply unique effects settings to individual
playlist events. Peak’s Playlist offers a fast, flexible, and
powerful approach to editing and processing digital
audio.
Peak’s Playlist allows you to output in many ways, from
burning audio CDs directly, to creating various file
formats used in the CD manufacturing process. Peak
burns fully Red Book compliant audio CDs from Playlists,
that will play in any CD-R compatible player. If you are
using Peak for commercial mastering, you will be pleased
to know that the master CD you create with Peak can
easily be used in mass duplication, and with an optional
extension, Peak can also export a Playlist in DDP (Disc
Description Protocol), a format preferred over CD by
many duplication companies. You can also use Peak
Playlists to create a Jam Image file for burning audio CDs
using Roxio’s JAM™. You can also bounce (i.e., write to
disk) your Peak Playlist as a Sound Designer II file and
then import the Playlist Events as Regions into other
applications capable of reading Regions from SDII file.
Roxio JAM is no longer manufactured. Its features
are now supported in Roxio Toast™ 8 and later.
JAM Image files created with Peak are simply SDII
files containing Regions, and are compatible with
older versions of JAM, and with Toast 8 or later.
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Overview of Playlist Interface
Playlist Function Buttons

Crossfade Controls

Counter Display

The Playlist Function controls are used for
adding and deleting Regions, burning CDs,
and a number of other common tasks.

This part of the interface contains the controls for
selecting centered or overlap crossfade modes,
fade in/out duration and envelope shape, overlap
or gap duration, and transition “snapshots”.

This part of the interface displays the current track
number (as it will appear on an audio CD), as well
as the current position in the timeline.

Control Area
This part of the interface
contains the CD Options,
Crossfade, Nudge, and
Audition, controls.
CD Options
This part of the interface
contains controls for
assigning Red Book and
Enforce CD Frames
options.

Waveform View Area
The Waveform View
Area contains the
Waveform Display, as
well as the controls for
working in the
Waveform View.

Playhead Cursor
The Playhead cursor
shows the position of
audio playback within
the Waveform View area.

List View Area
The List View Area
contains the columnar
List Display, tools for
working with CD-TEXT
and subcode
metadata, Vbox effects,
as well as any controls
for working in the
Waveform View.
List View Columns/Data Fields
The Playlist’s List View can also be used to make precise edits – to within one sample.
Most of the same kinds of edits may be made within the List View and Waveform View.
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Nudge Controls

Nudging Buttons

Transport Controls

These controls allow choosing between Slip and Shuffle
editing modes, as well as the Preserve Timing and Scroll
Regions modifiers, and nudging Playlist Events.

These controls allow Playlist Events
to be nudged by a custom amount,
in any of Peak’s Time Units.

These buttons allow you to play, stop, rewind, fast
forward and navigate between Playlist Events in the
same way that a CD player’s controls work.

Audition Controls
The Audition Controls
allow you to preview
individual parts of a
crossfade, or the entire
crossfade, with or
without pre- & post-roll.

6
Waveform Display
Area
The Waveform Display
shows Playlist Events
graphically, as well as
displaying crossfades,
volume envelopes, and
the timeline.

Vbox Column
This column controls
unique effects settings
for each Playlist Event.

ISRC, Emphasis, Copy Protection, and CDTXT Columns
These columns allow adding/editing CD-TEXT and subcode channel
metadata.
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Working with Regions is covered in Chapter 5: Editing.
Please familiarize yourself with the use of Regions before
attempting to work with Playlist. As Regions are the only
items that may be added to a Playlist, it is important to
understand how to create and edit them, before working
with Playlists.
The Playlist window is split into four main areas: Basic
Playlist functions, Controls, the Waveform View, and the
List View. This chapter will teach you how to quickly
assemble a Playlist and burn an audio CD, and then goes
over each of the Playlist’s three main sections in detail,
explaining each control, function, and mode.

LE

Unopened documents may also be opened by
dragging them from the Finder into a Peak
Playlist.

To Create a new Playlist:

1. From Peak’s File menu, choose New>Playlist
Document (-Shift-P) – an empty Playlist
document appear.
If your intended output format is audio CD, be
sure that the Red Book and Enforce CD Frames
checkboxes in the CD Options well are checked.
These options ensure that the Playlist handles
audio material properly by snapping to CD Frame
boundaries, and enforcing certain limitations of
the Red Book audio CD specification, such as
having a maximum of 99 tracks, a maximum
duration of 78 minutes, etc. These CD options are
provided because the Playlist is commonly used
for not just CD mastering, but also for compiling
dialogue and musical takes, assembling radio
and podcast programs, and other projects in
which it is not suitable to apply these CD-related
restrictions. More information is available in the
Advanced Playlist Concepts section, later in this
chapter.

The Peak LE Playlist features List View Editing only!

Basic Playlist Concepts – Getting
Started
This section describes the basic aspects of working with
Peak Playlist document. You will learn how to create a
Playlist, add Regions, perform edits, and output a
finished Playlist as an audio CD. Once you have
familiarized yourself with the basic processes involved
with Playlists and would like to learn more, please see
the Advanced Playlist Concepts section later in this
chapter, for detailed descriptions of all Playlist
functions.
Creating a Playlist

Before any Playlist operations can be performed, you will
need to open the audio documents containing the
Regions you wish to sequence, and a new Playlist
document must be created. This section goes over the
most basic elements of working with Playlist. It is
recommended that you read this section before creating
any Playlist-based project.
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Adding Regions to a Playlist

There are several ways to add Regions to a Playlist – for
now, we’ll use the Add Regions button. Information on
the other methods appears later in this chapter.
To Add a Region to a Playlist using the Add Region Button:

1. In the upper left portion of the Playlist interface,
click the Add Region Button – a pop-up menu
appears, containing the names of all open audio
documents, as well as the Regions contained in
each. The main headings are audio document
names, and the indented items are Region names
contained in an audio document.
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To Select a Playlist Event in the Waveform View:

•

Click the desired Playlist Event – you will know it is
selected because it will appear in a different color
than other, unselected Playlist Events. (Colors will
vary depending on your color preference settings).

To Select a Playlist Event in the List View:

•

2. Select the Region you wish to add to the Playlist –
it is added to the end of the Playlist. If no other
items are in the Playlist, it becomes the first item.

Click the desired Playlist Event’s row – you will
know it is selected because the entire row will be
highlighted in the color you have selected as the
Highlight Color in the Mac OS Appearance
preference pane.

6

Deleting Playlist Events

Selected Playlist Events may be deleted in Waveform
View or in List View.

Selecting Playlist Events

Once Regions have been added to a Playlist, they are
referred to as Playlist Events. Playlist Events will usually need
to be edited in some way. This editing may include
trimming the ends, nudging forward or backward along the
timeline, adjusting the level, entering metadata, etc.
Regardless of the type of edit to be performed, it is
important to know how to make selections, as this is how
Playlist Events are targeted for many editing processes.
Playlist Events may be selected in the Waveform or List views.

To Delete a Playlist Event:

•

Select the Playlist Event(s) you wish to delete in the
Waveform or List View areas, and click the Delete
Playlist Event Button in the upper left of the Playlist
interface, or press the Delete key on your
keyboard.

Selected Playlist Events appear in a different color than unselected Events
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Using the Undo and Redo Commands

Peak’s Playlist features unlimited levels of undo/redo. If
any mistakes are made along the way, they can easily be
undone. These steps show how to undo and redo edits
one at a time. More information about using the
graphical Edit History list appears later in this chapter.
To Undo Edits one at a time:

•

From the Edit menu, choose Undo, or press -Z
on your keyboard.

An Overlap Crossfade

Centered
To Redo Edits one at a time:

•

From the Edit menu, choose Redo, or press -Y
on your keyboard.

About Crossfade Modes

Peak features two different styles of crossfades, each
designed for a specific type of workflow. While the end
result of each type of crossfade may sound the same, the
process of working and editing with each is unique.

The Centered style of working with crossfades is designed
for assembling takes (i.e., music, voiceovers, etc.).
Typically, when assembling material this way, an editor has
multiple takes of the same piece of music or dialogue, and
is attempting to string together the best takes of each, to
create the best sounding whole piece of music or dialogue.
Multiple finished songs/pieces of audio are then
commonly placed into another Playlist, in
Overlap/Gap mode, to create an “album”.

Overlap/Gap

The Overlap/Gap style of working with crossfades is
designed for assembling finished songs (or other audio
Regions) in the desired order, with short overlaps
(crossfades), gaps, or pauses between them, as is
common when mastering a CD.

In Centered mode, it is common to use a Playlist to
assemble various takes into a single song (or other
“finished” pieces of audio), which would be bounced
from the Playlist as a single audio document.

Creating crossfades in this mode involves dragging
and/or trimming Playlist Events so that they either
overlap in time, or are spaced out with silent gaps or
pauses between them.
Gaps and Pauses are similar but different, they are
covered in detail later in this chapter.
A Centered Crossfade – with its Edit Point highlighted

As an Event is moved along the timeline, it overlaps more
or less with neighboring Playlist Events, and creates a
longer or shorter crossfade or gap between the Events.
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Centered crossfades are not available in Peak LE!

In this type of editing, an important concept is the “edit
point”. The edit point is the location in the audio content
that defines where the end of one take meets the
beginning of the next. In Centered mode, the edit point is
fixed and the duration of the crossfade is adjusted around
it. This allows a variable length crossfade to be quickly and
easily created, blending the takes together smoothly.
Once a crossfade of the desired length has been created,
the edit point itself can be moved, while the duration of
the crossfade remains constant. This “rolling edit” allows
the edit point to be fine-tuned, while retaining the
crossfade duration, creating a smooth and natural
sounding edit.

The cursor switches between these tool modes
automatically, depending on where it is relative to a
Playlist Event’s Waveform representation. These tools
are described below.
Tool functionality varies depending on whether you
are working in Overlap/Gap or Centered mode, and
whether any modifiers are active – these modes and
modifiers are covered later in this section.

Move Event Tool

When the mouse cursor is placed over a Playlist Event’s
waveform, it is in Move Event mode.
Clicking on a Playlist Event and dragging left or right will
move the entire Event (and other selected Playlist
Events) earlier or later in the timeline.

In a rolling edit, only the Edit Point and the fade envelopes move...

To use the Move Event tool:

1. In the Waveform Display Area, place the mouse cursor
over the middle portion (i.e., not near the edges).
2. Click and hold the mouse button down, and drag the
Event left or right, to the desired position – the Event
moves to an earlier or later position in the timeline.
Trim Event Tool
...while audio stays locked to the timeline.

About the Playlist’s Tools

The Trim Event tool is available in both Overlap/Gap and
Centered modes, and its functionality differs slightly
between these two modes.

The Playlist features three unique tools, each of which is
used for particular types of edits. Most of the edits you
will make in a Playlist will be done using the Move Event,
Trim Event, and Centered Centered Crossfade tools.

In either mode, when the mouse cursor is placed within
a few pixels of the edge of a Playlist Event’s waveform
display, it switches to Trim Event mode and can be used
to trim or extend the Playlist Event.
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Using the Trim tool in Centered mode, when the Preserve
Timing modifier is off results in moving the beginning or
end fade breakpoint, and changing the duration of the
Event’s fade envelope, rather than performing a rolling
edit. This behavior is covered later in this chapter, in the
section on the Preserve Timing modifier.
To use the Trim Event tool in Overlap/Gap mode:

1. In the Waveform Display Area, place the mouse
cursor near the Begin or End Boundary of a Playlist
Event – the cursor switches to Trim Event mode.
2. Click and hold the mouse button down, and drag
left or right – depending on whether you are
trimming left or right, the Event beginning or end
is either trimmed (shortened) or extended
(lengthened).

Centered Crossfade Tool

The Centered Crossfade tool is available only when
working in Centered mode (see next section for details
on Centered mode). In Centered mode, when the
mouse cursor is placed over a Playlist Event’s waveform,
it is in Centered Crossfade Tool mode. The Centered
Crossfade tool is used to create crossfades around a
centered edit point.

By default, a new Playlist that is in Overlap/Gap
mode will have the Preserve Timing modifier
turned off, so that when the Trim Event tool is used,
it trims only the Event that the cursor is placed over.

To use the Trim Event tool in Centered mode:

To use the Centered Crossfade tool:

1. In the Waveform Display Area, place the mouse
cursor near the Begin or End Boundary of a
Playlist Event – the cursor switches to Trim Event
mode.
2. Click and hold the mouse button down, and drag
left or right to perform a rolling edit.
By default, a new Playlist that is in Centered mode
will have the Preserve Timing modifier turned on,
so that when the Trim Event tool is used, a “rolling
edit” is performed. In a rolling edit, the actual
edit point between two Events moves, the duration
of the transition remains constant, and audio
does not move along the timeline. Trimming one
component Event of a transition “untrims” the
other component by an equal amount. More
information on the Preserve Timing modifier
appears later in this chapter.
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1. In the Waveform Display Area, place the mouse cursor
over the middle portion (i.e., not near the edges).
2. Click and hold the mouse button down, and drag
to the left to create a centered crossfade – once a
crossfade has been created, its duration can be
lengthened or shortened by dragging left or right.
Selecting Transitions

When working with transitions, there are many cases
where you will need to select the transition that you wish
to edit. For example, you may wish to modify the type or
duration of fade envelope being used, or perhaps
audition the transition. In all cases, a selected “In” Event,
that is, a Playlist Event that is being faded into, defines
the currently selected transition. When multiple Playlist
Events are selected, the earliest selected “In” Event
defines which transition is selected.
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Creating Transitions between Playlist Events

A variety of different types of transitions may be created
in the Playlist, including gaps, pauses, butt edits, and two
types of crossfades.
In the example below, we’ll be working with an Overlap
crossfade, which is commonly used when assembling
songs in a Playlist, where the songs need to blend
together. As the earlier Event fades out, the later Event
fades in.

3. Enter a time value earlier than the current value
(i.e., if the current start time value is
00:05:00.00, and this is changed to “4:55“, a five
second crossfade would be created between this
Event and the one that precedes it in the
timeline).

Crossfades may be performed in either Waveform View
or List View. More information about other types of
transitions is available later in this chapter, in the section
on Advanced Playlist Concepts.
To Create an Overlap Crossfade between Playlist Events in
Waveform View:

1. Locate two adjacent Events you wish to crossfade.
2. Click on the later of the two Events (or the “In”),
and drag it to the left (earlier in time), so an
overlap in time is created between the two
Events.

6
Auditioning Transitions

When working with crossfades or other transitions, you
may want to audition them to ensure that they are the
right length, and that the Playlist Events blend together
or are spaced apart correctly. This step shows a simple
crossfade audition, though there are a number of
variations on how auditioning can be used.
To Preview a crossfade:

•

To Create an Overlap Crossfade between Playlist Events in
List View:

1. Locate two adjacent events you wish to crossfade
together in List View.
2. In the row for Playlist Event you will be fading into,
single click directly over the time value shown in
the Start column – the time value becomes
editable.

Select the “In” Event, of the crossfade you wish to
audition, and click the Audition Crossfade button
(or press the X key on your keyboard).

For more information, please see the detailed overview
of the Crossfade Audition Controls, later in this
chapter.
Creating Volume Envelopes

Each Playlist Event features a volume envelope, which
allows dynamic level changes. This envelope can be
modified by adding and moving breakpoints.
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2. In the upper right portion of the Playlist interface,
click the Burn Playlist to Audio CD button.

A volume envelope provides dynamic level control to Playlist Events

3. Insert a blank CD – the Burn button becomes
available.

To Modify a Volume Envelope:

•

Click on either the red End Fade In Breakpoint or
the red Begin Fade Out Breakpoint, and drag up,
down, left, or right – the envelope changes,
creating a dynamic level change.

4. In the Burn Audio CD dialog, choose the desired
burning options.

More detailed information about volume
envelopes appears later in this chapter, in the
section on Advanced Playlist Concepts.

Burning an Audio CD

Burning audio CDs is one of the most common ways to
output the contents of a Playlist. Provided that your Playlist
was made in Red Book CD mode (i.e., with the Red Book
checkbox checked), the resulting CD will conform to the
Red Book standard, and will be playable in any CD player.
Burning a CD not made in Red Book CD mode may play
on a standard CD player, but this will depend largely on
the CD player’s capabilities. For maximum compatibility,
it is recommended to burn in Red Book CD mode. For
more information, please review the section on Red Book
CD mode which appears later in this chapter.
If you plan on burning a Red Book audio CD, be
sure to check the Red Book checkbox in the CD
Options control group. More information about
the CD Options controls appears later in this
chapter, in the Output Options section.

To Burn an Audio CD from a Playlist:

1. With the Playlist window in the foreground, choose
Select All (-A) from the Edit menu.
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CD Burning Options are covered in detail later in
this chapter.

5. Click the Burn button – the Playlist is burned to
CD.

Saving a Playlist

Playlist documents may be saved and recalled later.
These steps will teach you how to save a Playlist you are
working on. More information about opening, closing,
and saving Playlists appears later in this chapter.
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To Save a Playlist:

1. With the Playlist window in the foreground, choose
Save from the File menu.
2. You will be presented with the Save dialog – enter a
name, choose a directory, and click the Save button.

Advanced Playlist Concepts –
Detailed Overview of Controls,
Modes, and Tools

3. When you locate the Playlist, select it and click the
Open button.
To Close a Playlist:

•

With the Playlist window in the foreground, choose
Close from the File menu – if the Playlist has not
had its latest edit saved, it will present you with a
Save dialog, giving you an opportunity to save your
work. To save the Playlist, click the Save button – if
you do not wish to save the Playlist, choose the
Don’t Save button.

6

Adding Regions to a Playlist

The Playlist’s sophisticated editing controls allow you to
choose from a variety of editing tools, modes, and
behaviors. The various editing controls are described in
detail below.
Miscellaneous Controls

Some of the items and techniques discussed in this
section involve other elements of the Peak interface
besides the Playlist, but are directly related to working
with Playlists.
Opening, Saving, and Closing Playlists

Playlist documents may be saved and recalled later. When
working with Playlist-based projects, it’s a good idea to
save the Playlist and all source audio documents in a
single folder on your hard drive. This can help to avoid
inadvertently deleting an audio document your Playlist
refers to. These steps will teach you how to close and
save a Playlist you are working on, as well as how to reopen saved Playlists.
To Open a Playlist:

1. From Peak’s File menu, choose Open.
2. Use the Open dialog that appears to locate the
Playlist on your computer’s hard drive.

There are several ways to add Regions to a Playlist.
Regions may be added from within the Playlist, using the
Add Region button, as well as by being dragged in from
Peak’s Contents window, from an audio document’s
contents drawer, from the Finder, or from iTunes.
When dragging Regions into a Playlist from the
Contents Window or an audio document’s
Contents Drawer, be sure the Contents Window or
Drawer is displaying Regions. The buttons at the
bottom of the Contents Window or Drawer
determine whether Loops, Markers, Regions, or a
graphical edit history are being displayed.

To Add a Region to a Playlist using the Add Region Button:

1. In the upper left portion of the Playlist interface,
click the Add Region Button – a pop-up menu
appears, containing the names of all open audio
documents, as well as the Regions contained in
each. The main headings are audio document
names, and the indented items are Region names
contained in an audio document.
2. Select the Region you wish to add to the Playlist –
it is added to the end of the Playlist. If no other
items are in the Playlist, it becomes the first item.

Chapter 6: Playlists & CD Burning

127

To Add a Region to a Playlist from Peak’s Contents
Window:

To Add multiple Regions to a Playlist from Peak’s Contents
Window:

1. If the Contents window is not already open, choose
Contents from the Window menu – the Contents
Window appears.

1. If the Contents window is not already open, choose
Contents from the Window menu – the Contents
Window appears.

2. In the Contents Window, locate the name of the
audio document containing the Region you wish to
add to the Playlist.

2. In the Contents Window, locate the name of the
audio document(s) containing the Region you
wish to add to the Playlist.

3. Click the disclosure triangle to the left of the
Region’s name – a list of all Regions contained in
that audio document appears.

3. Click the disclosure triangle to the left of the audio
document’s name – a list of all Regions contained
in that audio document appears.

4. Click on the name of the Region you wish to add,
and drag it into the Playlist’s Waveform or List Area.

4. -click (for discontiguous selections), or Shiftclick (for contiguous selections) on the names of
the Regions you wish to add to the Playlist, and
drag them into the Playlist’s Waveform or List
Area.
To add all the Regions contained in a document to
a Playlist, in the same order they appear in the
document, click on the Region name in the
Contents window and drag it into the Playlist. All
the Regions it contains are added to the Playlist in
sequential order.

To Add a Region to a Playlist from an audio document’s
Contents Drawer:

1. In the audio document containing the Region you
wish to add to the Playlist, click the Toggle
Contents Drawer button (-F) to open the
Drawer (if it is not already open) – the document’s
Contents Drawer opens from the right side of the
document window.
2. Click the disclosure triangle to the left of the audio
document’s name – a list of all Regions contained
in that audio document appears.
3. Click on the name of the Region you wish to add to
the Playlist, and drag it into the Playlist.
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•

Additional Regions are added to the end of the
Playlist.

•

To place a new Region in a specific location (i.e.,
between two other Playlist Events), drag the new
Region over the Playlist Event (selecting it) that
you wish it to precede, and release the mouse
button. The selected Playlist Event is pushed
further down the List (and later in time) to
accommodate the new Region.

Dragging a Region from an audio document’s drawer to the Playlist.

To Add multiple Regions to a Playlist from an audio
document’s Contents Drawer:

1. In the audio document containing the Region you
wish to add to the Playlist, click the Toggle
Contents Drawer button (-F) to open the
Drawer (if it is not already open) – the document’s
Contents Drawer opens from the right side of the
document window.
2. Click the disclosure triangle to the left of the audio
document’s name – a list of all Regions contained
in that audio document appears.
3. -click (for discontiguous selections), or Shiftclick (for contiguous selections) on the names of
the Regions you wish to add to the Playlist, and
drag them into the Playlist’s Waveform or List Area.

Undoing/Redoing

Peak’s Playlist features unlimited levels of undo/redo.
Before diving into the various editing tools, modes, and
options, it’s probably a good idea to learn how to use
Undo/Redo. This way, if any mistakes are made along the
way, they can easily be undone.
Undo or redo actions may be performed one at a time, or
by using Peak’s graphical edit history window.
To Undo Edits one at a time:

•

To Redo Edits one at a time:

•
To drag all the Regions in an audio document into
a Playlist, click on the name of the document,
rather than the names of Regions – and drag it to
the Playlist. All Regions in the document will be
added to the Playlist.

Adding Regions to Specific Location in a Playlist

Single or multiple Regions may be added either to the
end of the Playlist, or to a specific location. This section
outlines the various behaviors available when adding
Regions to a Playlist.
•

A Region added to an empty Playlist becomes the
first Event.

From the Edit menu, choose Undo, or press -Z
on your keyboard.

From the Edit menu, choose Redo, or press -Y
on your keyboard.

To Undo a Series of Edits:

•

From the Edit menu, choose Undo repeatedly, or
press -Z on your keyboard repeatedly – until you
have undone the desired number of edits.

Or:

1. From the Edit menu, choose Edits – Peak’s
graphical edit history window appears.
2. Select the Edit/point in the project you wish to
return to.
3. Click the Revert to Item button.
4. Click the Done button.
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Be aware that if you undo a series of edits, and
then perform new edits, you will not be able to
return to the series of edits that were performed
after the undone edits – these edits will be
replaced by the new edits in the edit history list.

Indexes

In addition to track indexes, which designate the start or
end of a CD track, you may also burn standard indexes to
audio CDs using Peak. Indexes are created by placing
Markers in the desired location within a source audio
document/Region that is used in a Playlist.
Index markers are not visible when working in the
Playlist, but are burned to CD. Indexes are commonly
used on classical music CDs, where a track may be
relatively long (i.e., 20 minutes or more), and indexes
appear at various intervals or points of interest, within a
single CD track.
With CD indexes in place, a listener can navigate to the
index location using the indexing controls on a
compatible CD player. Most commercial CD players do
not support navigation using indexes
Basic Playlist Controls

Basic Playlist functions are controlled by a series of
buttons which appear on either side of the Counter
Display, near the top of the Playlist interface. These
buttons are used for adding, and deleting Playlist Events,
burning audio CDs, setting crossfade preferences and a
number of other important functions.
Add
Region

Split Playlist
Event

Duplicate
Playlist Event
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Delete
Playlist Event

Merge Playlist
Events

Conform to
Source Regions

Set Default Fades
for Playlist

Butt to Previous Normalize
Event End
Playlist Event

Audio
CD Info

Add Region Button

This control allows you to add any Regions from any
open audio documents to the Playlist. When clicked, a
pop-up menu appears with a list of all available
Regions. The main headings are audio document
names, and the indented items are Region names
contained in an audio document. When a Region name
is chosen from this menu, it is added to the Playlist.
When an audio document name is chosen, all of the
Regions it contains are added to the Playlist in the same
order they appear in the audio document. If the
selected audio document contains no Regions, one is
created automatically that contains the entire audio
document.
Duplicate Playlist Event Button

This control duplicates the selected Playlist Event(s).
Duplicated events are added directly after the selected
Playlist Events.
Split Selected Playlist Event Button

This control allows a single selected Playlist Event to be
split into two separate events. The position of the
Playhead cursor determines the location of the split.
When a Playlist Event is split, the newly created event is
placed directly after the original Playlist Event, spliced
with a butt edit, so there is no change in timing. The
newly created events may be custom named using the
List View if desired.
Merge Selected Playlist Events Button

This control allows two adjacent Playlist Events to be
merged into one. When using this command, the Playlist
is essentially taking the two selected events, and
bouncing them to disk as a new file, deleting the adjacent
selected events, and then automatically importing the
bounced file, and placing it into the timeline in the
position where the adjacent selected events were
originally located. The newly created event may be
custom named using the List View if desired.
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Be sure to save the merged file somewhere where you
will not lose it! For example, if your project is stored
in a specific folder, be sure to save the merged file
there as well, to keep it with the project it belongs to.

Delete Playlist Event Button

This control deletes the selected Playlist event(s). It is the
equivalent of pressing the Delete key on your keyboard.
Butt to Previous Event End Button

This functionality is useful for users who perform edits
in the Playlist, and need to have the original Regions in
the source audio documents updated to reflect these
edits.
Using the Conform Playlist Event to Source Region
command allows additional Playlists to be created,
based on edits made in a prior Playlist, and also allows
exporting Regions from original source documents
that are identical in content to the events used in a
Playlist.
To Conform Source Regions to Playlist Event edits:

This control “snaps” a selected Playlist Event’s Begin
Boundary to the End Boundary of the preceding Playlist
Event, creating a “butt” edit.
When multiple Playlist Events are selected, each one
is butted with the Event that appears before it in the
timeline. Be aware that The Butt to Previous Event
End control overrides current event placement,
and can alter the relationships between Playlist
Events. More information on this and other types of
transitions is available in both the Waveform and
List View sections, later in this chapter.

Conform Playlist Event to Source Region Button

This control conforms the positions of Region markers in a
source audio document to the positions of the selected
Playlist Events’ Begin and End Boundaries. By default, Peak
does not conform the position of Region markers in source
audio documents when edits are performed in the Playlist.
The Conform Playlist Event to Source Region
command can be turned on or off to
enable/disable this behavior. For one time
conforming of Playlist Events to their source
Regions, the button can be clicked on and then off
again immediately. The selected Source Regions
will be conformed, and then subsequent edits will
not be automatically conformed.

1. Select the Playlist Events you wish to conform with
their source Regions.
2. In the upper left portion of the Playlist, click the
Conform Playlist Event to Source Region button –
the Region markers in the source audio
document(s) are repositioned to reflect any edits
that have been made to the Events.
If you use the Conform Playlist Event to Source
Region command, be sure to save the source
audio documents containing the Regions that
were conformed before quitting Peak. If you do
not do this, Region markers may not be in the
positions you expect when you open the audio
document at a later time. Source Regions that
were not located and conformed will show a tilde
(~) character before the Playlist Event’s name in
the List View.

To Conform Playlist Event to Source Region edits:

1. In the upper left portion of the Playlist, click
the Conform Playlist Event to Source Region
button.
2. Edit the desired Region(s) length and/or position
in the audio document as desired – the
corresponding Playlist Events are updated to
reflect any edits that have been made to the Source
Regions.
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Overview of Conforming Playlist Events to Source Regions

Initially, a Region is created in an Audio Document (Dashed lines indicate Region markers).

Here is the Region in a Playlist – now a “Playlist Event” (Note that Conform Playlist Events to Source Regions is ON!)

If we trim the left edge...

...and also trim the right edge...

...the Region markers in the source audio document conform to these edits (note position of Region markers).
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Unlike conforming Source Regions to Playlist
Event edits, you cannot click the Conform Playlist
Event to Source Region for one-time, or
intermittent conforming. To have Playlist Events
update and reflect Region edits, the Conform
Playlist Event to Source Regions mode must be
turned on at all times.

Crossfade Style Radio Buttons

These radio buttons determine which style of crossfade
the rest of this dialog’s options affect.
•

To set default behavior for Gap/Overlap crossfades,
click the Gap/Overlap Button.

•

To set default behavior for Centered crossfades,
click the Centered radio button.

Normalize Selected Playlist Event Button
Crossfade Shape and Duration Controls

This control normalizes the level of the selected Playlist
Event(s). The Playlist’s Normalize function applies
normalization non-destructively, using the Event’s
Volume envelope.

These controls determine the shape and duration of the
Fade In and Fade Out envelopes.
When checked, this checkbox
locks the relationship between the Fade In and Fade Out
durations.

Lock In & Out Checkbox –
To Normalize an Event’s Level:

1. Select desired Playlist Event to normalize.
2. Click the Normalize Selected Playlist Event button.
3. In the Normalize dialog that appears, enter the
desired normalization value, and click the OK
button – the Event’s volume envelope is
modified to create the desired level of
normalization.
Set Default Fades for Playlist Button

This control opens the Playlist Default Fades dialog, in
which you can set various options for how Overlap and
Centered crossfades behave by default.

Note that while the Lock In & Out checkbox is
unchecked, the Fade In and Out shapes may be
edited separately. When this checkbox is checked,
only the “Crossfade In” field may be edited.

Crossfade In & Crossfade Out Duration Fields – The values
in these fields define the duration of the Crossfade In
and Crossfade Out Envelopes.
Fade In & Fade Out Shapes – The thumbnail graphics that
appear below the Fade In & Fade Out duration fields
show the default fade envelope shapes that will be
applied to Playlist Events when they are crossfaded
together. When working in the Playlist, these shapes can
be applied by choosing “default” from the Fade In or
Fade Out Envelope menus in the Crossfade controls, or
in the List View’s I-XF/O-XF columns. Clicking the
thumbnail opens the Fade In Or Fade Out editor dialog,
respectively, where the fade envelope can be modified.
To choose a Fade Envelope:

1. Open the Playlist Default Fades dialog by clicking
the Set Default Fades for Playlist Button in the
upper left section of the Playlist.
Playlist Default Fades dialog
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2. Click the thumbnail graphic for either the Fade In
or Fade Out – the Fade editor dialog appears.
3. Choose the desired envelope shape from the
Current Envelope pop-up menu – or click on the
envelope in the graph display area to add
additional breakpoints to create a custom fade
envelope. Existing breakpoints may be moved by
clicking and dragging. Breakpoints may be deleted
by selecting with the mouse, and clicking the
delete key on your keyboard.
4. Click the Change button when you are finshed.
Note that if you save a custom envelope shape
into:
/MacHD/Users/<YourAccount>/Library/
Preferences/Peak Envelopes/

The New Playlist dialog allows you to designate whether
a new Playlist is opened in Overlap/Gap or Centered
editing mode.
Audio Compact Disc Info Button

The Compact Disc Info Info button opens the CD-TEXT
for Audio CD dialog, which allows entering CD-TEXT
data that is applicable to the entire disc, including Disc
Title, Performer, Songwriter, Composer, Arranger,
Message, Genre, Disc Identifier, Product Code (for EAN
or UPC barcodes), etc.
Any text entered in the Message field of the CD-TEXT for
Audio CD dialog also appears in an exported DDPID file,
one of several files created as part of a DDP Fileset
export.
Counter Display

It will be available in the Current Envelope pop-up
menu in all of Peak’s envelope editor dialogs.

Behavior Controls

The Playlist’s Counter display appears at the center of the
Control Area, and provides a number of useful functions.
In addition to the functions described below, the
Counter Display may also be used for scrubbing.

Automatically Apply Default Settings when Adding Events

When checked, all Events added
to a Playlist will have use the default settings from the
Playlist Default Fades dialog (i.e., the settings in this
dialog, which are mentioned above) applied.

to Playlist Checkbox –

Track Number

Elapsed/Current Time

Track Number Display

Default fades will only be applied to Playlist Events
that are longer than the duration of the default
fade. If a Playlist Event is shorter than the fade
you are attempting to apply (automatically, via
the Default Fades dialog’s settings) no default fade
will be applied.

The current Track Number appears on the left side of this
display. This shows either the Track Number of the
Playlist Event currently being played, or the Playlist Event
that is selected (when Playback is stopped).
Time Display

Show Playlist Type Chooser When Creating a New Playlist
Checkbox

This checkbox determines whether or not the New
Playlist dialog is displayed when creating a new Playlist.
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When the Playlist is being played back, the display shows
the elapsed time from the beginning of the Playlist. When
playback is stopped, it shows the current position of the
playhead cursor within the Playlist’s timeline.
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Previous Track Button

To scrub audio using the Counter:

1. Click into the Display area, and hold the mouse
button down.
2. Drag the mouse cursor to the left or right –
dragging to the left scrubs backwards through the
Playlist, and dragging to the right scrubs forward.
Burn CD

Print/Export Text Report

Rewind

Play

Clicking this button locates the playhead to the beginning of the
previous track. If you are located at the beginning of the Playlist
and this button is clicked, the playhead will “wrap around” to
the beginning of the last event in the Playlist. Using the Previous
track button also changes the selected Playlist Event. The
keyboard equivalent for this control is the Up Arrow key.

Next Track

Rewind Button

Bounce Playlist

Previous Track

Stop

Fast-Forward

Burn CD Button

The Burn CD button opens the Burn Audio CD dialog, where
you can select various options prior to burning a Playlist as a
Red Book format audio CD. More information appears in the
“Output Options” section, later in this chapter.

Clicking the Rewind button while audio is playing will play
audio backwards rapidly until the button is released.
Clicking this button while playback is stopped has the same
effect as using the Previous Track button – the playhead
cursor will locate to the beginning of the previous Playlist
Event, and the selected Playlist Event changes.
Stop Button

Clicking the Stop button stops playback. The keyboard
equivalent for this control is the Space Bar.

Bounce Playlist Button
Play Button

The Bounce Playlist control is used to export the
contents of the Playlist as a file, rather than as an audio
CD. File format options include AIFF, Sound Designer II,
Jam Image, iTunes Playlist, or DDP (Disc Description
Protocol) 2.0 file set. More information on burning audio
CDs and file export options appears in the Output
Options sections, later in this chapter.
Print/Export Text Report Button

This button opens the Export as Text dialog, which allows
printing or exporting a customizable formatted text report,
or exporting a tab-delimited text report, that can be
imported into applications such as FileMaker Pro or Excel.
Burning Audio CDs, Bouncing a Playlist as a new
audio document, exporting text reports, and
exporting DDP filesets are covered in detail later
in this chapter, in the section on Output Options.

Clicking the Play button initiates playback. The keyboard
equivalent for this control is the Space Bar.
Fast-Forward Button

Clicking the Fast-Forward button while audio is playing will play
audio forward rapidly until the button is released. Clicking this
button while playback is stopped has the same effect as using the
Next Track button – the playhead will locate to the beginning of
the next Playlist Event, and the selected Playlist Event changes.
Next Track Button

Clicking this button locates the playhead to the beginning of
the next track. If you are located at the end of the Playlist and
this button is clicked, the playhead will “wrap around” to the
beginning of the first event in the Playlist. Using the Next
track button also changes the selected Playlist Event. The
keyboard equivalent for this control is the Down Arrow key.
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Controls Area

If working with a Playlist destined to become a Red Book
CD, it is highly recommended that you have the Red Book
checkbox checked. Use of the Enforce CD Frames
checkbox will depend on the type of material you are
working with. For continuous mix CDs, it’s best to use
Enforce CD Frames. For CDs that will have their tracks
separated by gaps or pauses, it’s best to leave this option off.

The Controls Area, located in the upper portion of the Playlist
window, contains a number of global editing controls (those
that affect both the Waveform and List Views). This section
covers the function of all controls in this part of the interface.
Show/Hide Controls Area Disclosure Triangle

The Controls Area may be collapsed for a larger view of
other Playlist elements, by clicking the disclosure triangle
that appears to the left of the “Controls” interface label.
CD Options Controls Group

Crossfade Controls Group

The area of the Playlist interface contains various
controls for working with crossfade and gap transitions,
and for defining the shape and duration of fade
envelopes. These are described in detail below.

The CD Options group is a section of the Controls Area,
which contains two important controls – the Red Book and
Enforce CD Frames checkboxes. These are described below.
Red Book Checkbox
Crossfade Mode Radio Buttons

When the Red Book checkbox is checked, the Playlist enforces
a number of behaviors, which ensure that CDs burned from it

These buttons allow toggling between Overlap/Gap and
Centered modes. Details for using each is found later in
this chapter, in the section on the Waveform View Area.
Fade Out Duration Field

will be Red Book compliant as well, and be playable in any CD
player. In Red Book mode, the Playlist enforces the following:
•

A two second pause must exist prior to the first track.

•

Each track must be at least four seconds long.

•

The Playlist may contain a maximum of 99 tracks.

•

ThePlaylist may contain a maximum of 99 indexes.

•

Maximum duration of Playlist is 78 minutes,
including pauses.

This field controls the length of the selected transition’s
Out Event fade out envelope, which is defined in the
waveform display by the two red Default Fade Out
Breakpoints, or List View Column information.
Fade Out Envelope Menu

This menu controls the shape of the selected transition’s
Out Event fade out envelope, which is defined in the
waveform display by the two red Default Fade Out
Breakpoints, or List View Column information.

Enforce CD Frames Checkbox
Fade In Duration Field

When checked, Playlist Events are automatically
conformed to the closest CD frame boundary, and all edits
are automatically “snapped” to CD frame boundaries.
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This field controls the length of the selected transition’s
In Event fade in envelope, which is defined in the
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waveform display by the two red Default Fade In
Breakpoints, or List View Column information.
Fade In Envelope Menu

This menu controls the shape of the selected transition’s
In Event fade in envelope, which is defined in the
waveform display by the two red Default Fade In
Breakpoints, or List View Column information.

Nudge Controls Group

This part of the Playlist interface contains various
controls for nudging Playlist Events and crossfades.

Slip/Shuffle Mode Radio Buttons

The Playlist’s Slip and Shuffle modes offer two different
ways to move Playlist Events when working in Overlap/Gap
mode. Both are useful in the editing process, as there are
situations where different behaviors are required.
Please note that Slip and Shuffle modes do not
apply when working in Centered crossfade mode.
Overlap Duration Field

In Slip editing mode, a selected Event(s)
moves independently of all other Playlist Events. When
multiple Events are selected the relationship between
selected Events remains fixed, and the selected group
moves independently of all other Events. Slip mode
editing is used when it is important to move only the
selected Event(s), and not disturb the placement of
other Events relative to the Playlist’s timeline.

Slip Mode –

This field allows creation of specific-length overlap or gap
transitions between Playlist Events. Entering a negative
value creates an overlap, while a positive value creates a gap.
Transition Snapshot Controls

These buttons are used to store and recall up to four
temporary “snapshots”, or presets, between two Playlist
Events. Snapshots store envelope shapes and durations,
and overlap or gap duration between two Playlist Events.
To store a snapshot:

The S key on your keyboard will toggle between
Slip and Shuffle editing modes.

•

Moving a selected Event or Events with the mouse
while in Slip Mode does not affect the position of
unselected Events relative to the timeline.

•

Moving a selected Event or Events in Slip Mode
affects the duration of the crossfades for the
unselected Playlist Events that appear before and
after the selected Events.

•

The behaviors above hold true for all Playlist Event
movements made using the mouse. A number of
variations are available when moving Events using
the Nudge controls – for more information on

1. Create desired transition.
2. Click the arrow to the left of the snaphot button you
wish to assign the snapshot to (i.e., to assign the
current transition state to snapshot A, click the arrow
that appears to the left of the snapshot A button).
To recall a snapshot:

•

Click the snaphot button you wish to recall (i.e., to
recall the transition state stored in snapshot A,
click the snapshot A button).
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these variations, please see the section on Nudge
Controls later in this chapter.
To choose Slip Mode:

•

Click the Slip Mode radio button.

Preserve Timing Checkbox

Preserve Timing is a multi-function modifier that is
available when working in Overlap/Gap or Centered
mode. When active, it allows the following behaviors:
Trimming one component of a transition
will trim the other component by an equal and opposite
amount, this maintains the duration of the transition, the
relationship of both components’ audio content relative
to each other, and to the timeline (audio does not move
along timeline).

Rolling Edits –

When the Red Book checkbox is checked, the first Playlist
Event (or a selection of multiple Playlist Events that
includes the first) cannot be moved from the two-second
mark on the timeline. Red Book specifications require
a two second Pause before the first Playlist Event.

In Shuffle mode, a selected Event(s)
moves independently of all other Events that precede it,
and all Events that follow it move in sync keeping the
relationships between the selected Event and following
Events fixed.

In List View, (and Peak LE, which features List View only)
rolling edits can be performed by modifying a Playlist
Event’s End time, while Preserve Timing is active.

Shuffle Mode –

•

Shuffle mode is used when it is important to edit a
transition between two Events that appear midPlaylist (after the beginning of the Playlist, but
before the end).

•

In Shuffle mode, any transitions following the
current transitions being edited are not disturbed.

•

Whether a single Event or multiple Events are
selected produces the same effect in Shuffle
editing mode – all Events after the first selected
Events are moved as a group.

•

Moving a selected Playlist Event or Events with the
mouse while in Shuffle Mode does not affect the
position of preceding Events relative to the
timeline, and all subsequent Events are moved by
an equal amount, preserving the relationships
between them.

•

Moving a selected Event or Events in Shuffle Mode
affects the duration of the transition from the
preceding Out Event into the first selected In Event.

Crossfade Creation – Entering a value into either an
“Out” Event’s O-XF-T column, or into the corresponding
“In” Event’s I-XF-T column creates a crossfade of the
specified duration between the two component Events,
by moving the “In” component earlier in time.

When a fade envelope/shape is chosen
from either the O-XF or I-XF columns, the
corresponding component’s fade is modified to conform
to the selected fade type and duration. For example,
choosing a “Fast” fade in of five seconds, will
automatically set the “Out” component’s fade type to
“Slow Out”, also with a duration of five seconds.

Fade Locking –

In the case of the “Customize Fade” item, both
components will be modified to conform to the shape
defined in the Fade Envelope Editor.

To Choose Shuffle Mode:

•

Click the Shuffle Mode button.
In a rolling edit, only the Edit Point and the fade envelopes move...
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•

When the Scroll Regions checkbox is checked, any
use of the Move tool will exhibit this behavior.

•

Since Scroll Regions is a Move tool modifier, the
Nudge In and Out buttons can be used to Scroll the
Audio content in the In and Out components that
make up a transition.
Scrolling Regions requires audio to exist before or after
the Region’s start/end to scroll earlier/later, respectively.

...while audio stays locked to the timeline.

Engaging Preserve Timing does not immediately
cause any changes to fade shapes or durations.
Changes are not made untilone of the component
shapes or durations is modified.

Trim Tool Modifier – Pressing the Option key while
clicking the Nudge In or Out buttons will nudge using
the Trim tool.

Nudge In and Out Buttons

These controls perform different functions, depending
on whether you are working in Overlap/Gap or Centered
modes, and depending on modifiers being used. The
various functions are described in detail below.

Scroll Regions Checkbox

Scroll Regions is a modifier that is available when
working in both Overlap/Gap and Centered editing
modes. When Scroll Regions is active, using the Move
tool on a Playlist Event moves the audio content of a
Playlist Event within fixed Begin and End Event
boundaries – while audio does move along the timeline,
the start and end times of the Event do not change.

Nudge “In”
Event Earlier

Nudge “In”
Event Later

Nudge “Out”
Event Earlier

Nudge “Out”
Event Later

Using the Nudge Buttons in Overlap/Gap Mode

When using these buttons in Overlap/Gap mode, their
functionality is the same as using the Move tool. If the
Option modifier key is used in conjunction with the
Nudge buttons, their function is the same as using the
Trim tool.
Nudge In Event Earlier in Timeline Button – Clicking this
button moves the “In” component of a transition earlier
in the timeline. This is equivalent to clicking and
dragging the In component to the left using the Move
tool with the mouse. The keyboard shortcut for this
button is the Comma key.
Nudge In Event Later in Timeline Button – Clicking this
button moves the “In” component of a transition later in
the timeline. This is equivalent to clicking and dragging
the In component to the right using the Move tool with
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the mouse. The keyboard shortcut for this button is the
Period key.
Nudge Out Event Earlier in Timeline Button – Clicking this

button moves the “Out” component of a transition
earlier in the timeline. This is equivalent to clicking and
dragging the Out component to the left using the Move
tool with the mouse. The keyboard shortcut for this
button is Shift-Comma.

Nudge Amount Field

The Nudge Amount field lets you specify the amount of
time the selected Playlist Event is nudged by for each click
of a nudge button. For example, if you had the Playlist’s
Nudge Format set to Seconds, and you wanted to nudge
Events by one second with each click of a nudge button,
you would enter “1” in the Nudge Amount field.
To Set a nudge amount:

Clicking this
button moves the “Out” component of a transition later
in the timeline. This is equivalent to clicking and
dragging the Out component to the right using the Move
tool with the mouse. The keyboard shortcut for this
button is Shift-Period.
Nudge Out Event Later in Timeline Button –

•

Click into the Nudge Amount field, and edit the
existing value.

To Set a nudge Time Unit:

•

Select Time Units from the Options menu, and
choose the desired format.

Using the Nudge Buttons in Centered Mode

Audition Transition Controls Group

This section describes using the Nudge Buttons in
Centered crossfade mode.
Nudge In Event Earlier in Timeline Button – Clicking this
button lengthens the crossfade symmetrically around the
edit point, by trimming the In and Out components
equally in opposite directions. The keyboard shortcut
for this button is the Comma key.
Nudge In Event Later in Timeline Button – Clicking this
button shortens the crossfade symmetrically around the
edit point, by trimming the In and Out components
equally in opposite directions. The keyboard shortcut
for this button is the Period key.
Option Key + Nudge Out Event Earlier in Timeline Button

Clicking this button while holding the Option key
moves the crossfade earlier in time, while preserving its
duration (a “rolling edit”). The keyboard shortcut for
this button is the Option + Comma keys.

–

The Audition Transition Controls group allows
auditioning crossfades, gaps, or soloing of the individual
“In” and “Out” elements of a crossfade. Use these
controls to fine-tune crossfades.

Audition Transition Button

Clicking the Audition Transition buttons plays both
components of a transition (i.e., a crossfade, butt edit, or
gap) from Fade Out start to Fade In end. The keyboard
equivalent for this control is the X key.
To Audition a transition:

•

Click the Audition Transition button (or press the X
key) – both components of the transition play.

Option Key + Nudge Out Event Later in Timeline Button –

Clicking this button while holding the Option key moves
the crossfade later in time, while preserving its duration
(a “rolling edit”). The keyboard shortcut for this button
is the Option + Period keys.
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Audition Fade Out Button

Clicking the Audition Fade Out button plays only the
Playlist Event that is being faded out of. The keyboard
equivalent for this control is the [letter] O key.
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To Audition the Fade Out portion of a transition:

•

Click the Audition Fade Out button (or press the [letter]
O key on your keyboard) – the Fade Out is soloed.

Pre-roll Presets Pop-up Menu

This menu contains presets for common pre-roll values.
A value chosen from this menu is entered into the Preroll Amount field, to the left of this menu.

Audition Fade In Button

Clicking the Audition Fade In button plays only the
Playlist Event that is being faded into – also referred to as
the “In Event”. The keyboard equivalent for this control
is the [letter] I key.

Post-roll Presets Pop-up Menu

This menu contains presets for common post-roll values.
A value chosen from this menu is entered into the Postroll Amount field, to the left of this menu.

To Audition the Fade In portion of a transition:

•

Click the Audition Fade In button (or press the [letter]
I key on your keyboard) – the Fade In is soloed.

Use Pre-roll in Audition Checkbox

Checking this box applies the specified amount of preroll when auditioning.
Use Post-roll in Audition Checkbox

Checking this box applies the specified amount of postroll when auditioning.

Auditioning Transitions with Pre- and Post-roll

Transitions may be auditioned with a user-defined
amount of pre- and/or post-roll. Having a bit of audio
play before and after the transition can be useful to put
the transition into context with the audio material the
occurs before and after it.
The position of the earliest and latest default red fade
breakpoints in the timeline determines how auditioning
works. Depending on the type of transition being used,
this can vary. The pictures below illustrate this concept.

Pre-roll Amount Field

This field specifies how much pre-roll to apply, when
active. Custom values may be entered. Common values
in seconds may be chosen from the Pre-roll Presets popup menu, to the right of this field.
In this overlap crossfade transition, the earliest fade breakpoint is the
beginning of the fade in on the In Event, and the latest breakpoint is
the end of the fade out on the “Out” Event – so pre-/post-roll are
measured from these points.

Post-roll Amount Field

This field specifies how much post-roll to apply, when
active. Custom values may be entered. Common values
in seconds may be chosen from the Post-roll Presets popup menu, to the right of this field.

In this gap transition, the earliest fade breakpoint is the beginning of the
fade out on the “Out” Event, and the latest breakpoint is the end of the fade
in on the “In” Event – so pre-/post-roll are measured from these points.
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To Preview a Transition with Pre- & Post-roll:

When auditioning a fade in, pre-roll is ignored, as
there is no audio material prior to the first
breakpoint that defines the beginning of the fade in.
Likewise, when auditioning a fade out, post-roll is
ignored, as there is no audio material after the last
breakpoint that defines the end of the fade out.

1. Check the Pre- and Post-roll checkboxes.
2. Enter the desired amount of pre- and post-roll time
in the Pre- and Post-roll fields (or choose from
common values in the Pre-/Post-roll Amount Popup menus).
3. Click the desired Audition button to hear that part
of the transition, with pre- and/or post-roll.
•

To hear just the In Event’s Fade In, click the
Audition Fade In button (or press the [letter]
I key).

•

To hear just the Out Event’s Fade Out, click
the Audition Fade Out button (or press the
[letter] O key).

•

To hear both components of the transition,
click the Audition Transition button (or press
the [letter] X key).

Loop Audition Button

To activate Audition Looping:

Click the Loop Audition button (or press the
[letter] L key on your keyboard). When
looping is active, the Loop button is
highlighted.

To de-activate Audition Looping:

•
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The Waveform View Area appears just below the Controls
Area, and contains a graphical representation of the
Events used in a Playlist, as well as various controls for
configuring view options. The Waveform View Area is
particularly useful for creating and editing crossfade
transitions between Playlist Events, as its graphical
display is highly intuitive. The various controls and
options available in the Waveform View Area are
discussed in detail in this section.

LE

Clicking the Loop Audition Button will repeat
whichever type of crossfade auditioning you choose.
For example, engaging Loop Audition, and then clicking
the Audition Crossfade button will play both
components of the crossfade (the In & Out Events) in
loop mode. If pre- and post-roll values have been
specified, the loop’s length will increase to reflect
these. The keyboard equivalent for this control is the
[letter] L key.

•

Waveform View Area

Click the Loop Audition button again (or press the
[letter] L key again on your keyboard).

Peak LE users may wish to skip ahead to the List
View section, as Peak LE does not offer Waveform
View.

Show/Hide
Triangle

Waveform

View

Area

Disclosure

This small triangle appears to the left of the “Waveform
View” label in the interface. When the Waveform View
disclosure triangle is pointing to the right (closed
position), it is hiding the entire Waveform View portion
of the Playlist’s interface. When the disclosure triangle is
pointing downward (open position) it is showing, or
“disclosing”, the Waveform View portion of the interface.
View Controls

The Playlist’s View Controls allow you to configure
various options to suit the work that you are doing.
These controls affect only the Waveform View Area and
have no impact on settings in the List View or Controls
Area.
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Linear View

View Left

View L+R Sum

steps, along with the section on Playlist Navigation will
teach you how to get around quickly in the Playlist
interface.
View Left Channel Waveform Radio Button

Staggered View

View Right

View Stereo

When this radio button is selected, only the left audio
channel of a stereo Event’s audio is displayed.

Linear View Button

When the Linear View button is selected, the audio
waveform display appears much like a single mono track.
Playlist Events overlapping in time are displayed
overlapping visually on the same horizontal axis.

6
View Right Channel Waveform Radio Button

When this radio button is selected, only the right audio
channel of a stereo Event’s audio is displayed.
Staggered View Button

When the Staggered View button is selected, Playlist
Events are displayed successively on separate horizontal
axes.

View L+R Sum Waveform Radio Button

When this radio button is selected, the sum of both the
left and right audio channels of a stereo Event’s audio are
displayed.

Being able to vary your view of Events along the
Playlist’s timeline is very important. There may be
times when you need the perspective of being zoomed
out all the way, so as to get an overview of how
imported Regions are arranged. Some kinds of edits
may require the precision of a high zoom level, for
example, to align the beats in the waveforms of two
Events you are trying to beat-match. The following few
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Despite the waveform display appearing to be
composed of a single audio channel/waveform
when in L + R Channel mode, this single
waveform is actually a sum of the Left and Right
channels, being displayed simultaneously. When
working in a mono Playlist, only the View Left
Channel Waveform Radio button is available.

Decrease Vertical Zoom Button

This button decreases the vertical zoom level. The
keyboard equivalent is -Down Arrow.
Increase Vertical Zoom Button

This button increases the vertical zoom level. The
keyboard equivalent is -Up Arrow.
View Stereo Waveform Radio Button
Zoom Out Button

When this radio button is selected, both the left and right
audio channels of a stereo Event’s audio are displayed.

This button decreases the horizontal zoom level. The
keyboard equivalent is -[.
Zoom In Button

This button increases the horizontal zoom level. The
keyboard equivalent is -].
A scroll wheel mouse whose wheel doubles as a
button may be used for horizontal zooming. To zoom
using this type of mouse, click the wheel/button, then
rotate the wheel to zoom in or out. Mice with nonbutton wheels may not operate as described above.

Zoom Controls

The Zoom Controls are located in the upper right
portion of the Waveform View area, and control various
zoom-related functions.

Zoom to Fit Transition

Increase Vertical Zoom

Zoom In

Waveform Display Area

The Playlist’s Waveform Display area contains quite a
number of visual elements which are important to
understand. This section will familiarize you with these
elements, the majority of which will be used in every
Playlist project you undertake.
Decrease Vertical Zoom

Zoom Out

Playlist Event Waveform Display
Zoom to Fit Transition Button

This button zooms the currently selected transition to fit
the width of the Playlist window. The keyboard
equivalent is -Shift-].
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The Playlist Event Display shows audio that is contained
between Region markers in the original source audio
document. By default, a Playlist Event appears in blue,
and when selected, in light grey. These colors may vary,
depending on whether you have assigned custom
themes or colors in Peak’s Preference dialog.
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Overview of Waveform View Area

Pause Indicator

Playlist Event Begin Boundary

Track Start Offset Indicator

Custom Volume Envelope

Edit Point Indicator

Playlist Event End Boundary

Fade In Envelope
Custom Fade
Breakpoints
Playlist Event
Begin Time

Playlist Event
End Time

Playlist Event
Name
Fade Out
Duration

6

Playlist Event
Waveform

Fade Out Envelope

Fade In
Duration

Horizontal Scrollbar

Playlist Event Name Display

The Playlist Event Name display appears in the upper
left corner of the Playlist Event Display. If a Playlist
Event’s Display is moved partially off-screen because
of window scrolling activity, the Event’s name will
remain in view as long as any portion of the actual
Region Display is visible. When a Track Offset is set,
the Region Name Display position defaults to the
Offset’s position. If the Offset’s position is moved
partially off-screen due to window scrolling, the Event
Name Display remains visible, even when the Offset
itself is no longer visible.

Timeline

Playhead Cursor

Horizontal Scroll Arrows

When a custom Track Start Offset is set for a particular
Event, it becomes the CD track index for that Event.
Playlist Event Begin Time Display

A Playlist Event’s Begin Time appears in the lower left
corner of a Playlist Event when the Event is selected. The
Playlist Event’s Begin Time display is live, and updates as
a Playlist Event is moved along the timeline.
Playlist Event End Boundary

The Playlist Event End Boundary defines the end of a
Playlist Event.

Playlist Event Begin Boundary

The Playlist Event Begin Boundary is the beginning of a
Playlist Event, and the Playlist Event’s start along the
timeline. A Playlist Event’s Begin Boundary also serves
as the default position of a CD track index, when
working with a Playlist destined to be burned as an
audio CD.

Playlist Event End Time Display

A Playlist Event’s End Time appears in the lower right
corner of a Playlist Event when the Event is selected. The
Playlist Event’s End Time display is live, and updates as a
Playlist Event is moved along the timeline.
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Edit Point Indicator

The Edit Point indicator appears only in Centered
Crossfade mode, and by default, shows the centerpoint
of the crossfade between two Playlist Events.
If custom fades are used, the Edit Point may not be
centered.

Fade In Duration

When working with an overlap crossfade, in which the
Fade In envelope scales automatically, the Fade In
Duration field simply reflects the duration of the
automatically created Fade In envelope.

Fade In Envelope

A Fade In Envelope shape dictates audio amplitude level
increasing over time. A steeper slope creates a more
rapid change in amplitude (a fast fade in), and a more
gradual slope creates a fade in with a slower change in
amplitude (slow fade in).
A Fade In Envelope can be used as a component of a
crossfade, or for simply creating a fade in on a Playlist
Event that does not overlap the previous Playlist Event.
When used as a component of a crossfade, a Playlist
Event’s Fade In Envelope appears automatically when an
overlap in time is created between two Playlist Events.
The corresponding Out Event is given a Fade Out
Envelope that scales to match the duration of the In
Event’s Fade In envelope.
When created automatically by an overlap between two
Events, the duration of the Fade In Envelope is defined
by the two red breakpoints, which mark the beginning
and end of the envelope.
Various envelope shape presets are available in the Fade
In Envelope pop-up menu, some of which are composed
of just the red Begin and End Envelope Breakpoints,
while others feature additional white breakpoints.
Envelope presets automatically scale to fit the length of a
crossfade transition.
Begin/End Fade In Envelope Breakpoints

These default breakpoints appear in red, and mark the
beginning and end of the Fade In envelope.
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If the End Fade In Envelope breakpoint is moved, then
the envelope is considered to be a custom envelope, and
no longer scales automatically, but instead is locked to an
audio time in the Playlist Event, and moves with it as the
Event is moved along the timeline.

Fade Out Envelope

A Fade Out Envelope shape dictates audio amplitude
level decreasing over time. A steeper slope creates a
more rapid change in amplitude (a fast fade out), and a
more gradual slope creates a fade in with a slower
change in amplitude (slow fade out).
A Fade Out Envelope can be used as a component of a
crossfade, or for simply creating a fade out on a Playlist
Event that does not overlap the following Playlist
Event.
When used as a component of a crossfade, a Playlist
Event’s Fade Out Envelope appears automatically when
an overlap in time is created between two Playlist Events.
The corresponding In Event is given a Fade In Envelope
that scales to match the duration of the Out Event’s Fade
Out envelope.
When created automatically by an overlap between two
Events, the duration of the Fade Out Envelope is defined
by the two red breakpoints, which mark the beginning
and end of the envelope.
Various envelope shape presets are available in the Fade
Out Envelope pop-up menu, some of which are
composed of just the red Begin and End Envelope
Breakpoints, while others feature additional white
breakpoints. Envelope presets automatically scale to fit
the length of a crossfade transition.
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Begin/End Fade Out Envelope Breakpoints

These default breakpoints appear in red, and mark the
beginning and end of the Fade Out envelope.
If the Begin Fade Out Envelope breakpoint is moved,
then the envelope is considered to be a custom
envelope, and no longer scales automatically, but
instead is locked to an audio time in the Playlist Event,
and moves with it as the Event is moved along the
timeline.
Fade Out Duration

The Fade Out Duration field simply reflects the duration
of the automatically created Fade Out envelopes.

By default, the Track Start Offset appears in the exact
same position as an Event’s Begin Boundary, and is
represented by a bold white line that overlaps the Event’s
Begin Boundary. When a Track Start Offset is used, it
becomes the CD Track index on the Event it is set for. A
custom Track Offset may be created by dragging this
indicator to a position earlier or later than the Event’s
Begin Boundary. The offset created is represented by a
shaded area that appears directly before or after the
Event’s Begin Boundary.
Offset duration is displayed just to the right of the Offset
indicator, and is indicated with a delta symbol (Δ) and a
positive or negative time value, depending on whether
the Offset is created before or after the Event’s actual
Begin Boundary.

Volume Envelope

Playlist Events feature a Volume envelope, which can be
used to dynamically and non-destructively alter volume.
Volume envelopes can boost gain by up to 6 dB and
attenuate to –inf dB.
Custom Volume Envelope Breakpoints

Custom Volume breakpoints appear in white, and are
added by double-clicking on the Volume envelope. Each
breakpoint displays its gain in dB.

Pause Indicator
Handle (Yellow)

Playlist Event
Begin Boundary

Track Start Offset
Indicator Handle (White)

When setting a a track start offset or pause, be sure to choose the
proper indicator – by default, both are tied to a Playlist Event’s Begin
Boundary. The Track Start Offset Indicator is white, and its handle
appears above the yellow Pause Indicator’s handle.

Custom Fade Breakpoints

Custom Fade breakpoints appear in white, and are added
by double-clicking the Fade envelope. Custom Fade
breakpoints appear in white. Each breakpoint displays
its gain in decibels (dB).
Fade breakpoints are part of the Playlist Event’s Volume
Envelope.
Track Start Offset Indicator

Pause Indicator

Pauses are spaces of a specific duration between CD
tracks that contain audio. By default, the Pause
indicator appears in the same position as a Playlist
Event’s Begin Boundary and Track Start Offset. A
custom Pause may be created by dragging this indicator
to a position earlier or later than the Event’s Begin
Boundary. The Pause is represented by a green shaded
area that appears directly before or after the Event’s
Begin Boundary.

Track Start Offsets are used when a different time than an
Event’s Begin Time needs to be used as a CD track index.
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Timeline

The Timeline provides a reference as to where Playlist
Events exist in time, in relation to the beginning of the
Playlist, or time zero. The Timeline appears horizontally
along the bottom of the Waveform View Area, and is
regularly marked at major time intervals. These marked
intervals will vary depending on the Time Units you have
chosen to use, and the zoom level you are using to view
the Waveform View Area. For example, if you have
chosen to use Minutes:Seconds:milliseconds as your
Time Unit format, and you have zoomed all the way out,
you will see the Timeline marked at one minute intervals.
As you zoom in, you will see the Timeline marked at
intervals of several seconds, and when zoomed in all the
way, the intervals appear every second.
Playhead Cursor

or right. The keyboard equivalents for horizontal scrolling
are Control + Left Arrow to scroll to the left, and Control
+ Right Arrow to scroll to the right, or later in the timeline.
Horizontal Scroll Arrow Buttons

The Horizontal Scroll Arrows appear on the Horizontal
Scrollbar, and like the Scrollbar, are used solely for
changing the view of the Waveform View Area. Whereas
the Scrollbar allows moving as much or as little as
desired, the Scroll Arrows move by a fixed increment
with each click. The amount the Waveform is scrolled
with each click depends on the zoom level. At lower
zoom levels, one click scrolls by a larger amount than at
a higher zoom level. The keyboard equivalents for
horizontal scrolling are Control + Left Arrow to scroll to
the left, and Control + Right Arrow to scroll to the right,
or later in the timeline.

The Playhead Cursor indicates which portion of the
Playlist is currently being played back. Its position
corresponds to the numerical position indicated by the
Counter Display.
•

Clicking anywhere along the Timeline moves the
Playhead Cursor to that location.

•

Double-clicking anywhere along the timeline
initiates playback from that point.

•

If audio is already playing, clicking anywhere in the
timeline continues playback from that point.

•

Selecting a Playlist Event moves the Playhead
Cursor to the beginning of the selected Event.

A scroll wheel mouse’s wheel may also be used for
Horizontal Scrolling in the Playlist’s Waveform
View. Note that scroll wheel mice whose wheel
doubles as a button offer another option – with this
type of mouse, you may also click the wheel/button
and rotate it to zoom in and out horizontally.

Cursor Tools

The Playlist features three unique tools, each of which is
used for particular types of edits. Most of the edits you
will make in a Playlist will be done using the Move Event,
Trim Event, and Centered Crossfade tools.

Horizontal Scrollbar

The Horizontal Scrollbar is the bottom-most graphical
element of the Waveform View Area, and appears only
when there is more graphical content than can be
displayed on-screen at the current zoom level. This control
is used for changing the view only, and does not actually
move Events or other Playlist elements relative to the
timeline or to each other. Horizontal scrolling can be
accomplished by clicking on the scrollbar, and dragging left
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The tools and their functionality vary depending on
whether you are working in Overlap/Gap or Centered
mode – these modes are covered later in this section.

The cursor switches between these tools automatically,
depending on whether you are working in Overlap/Gap
or Centered mode and where the cursor is located
relative to a Playlist Event’s boundaries. These tools are
described below.
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Move Event Tool

In Overlap/Gap mode, when the mouse cursor is placed
over a Playlist Event’s waveform, it is in Move Event mode.

Clicking on a Playlist Event and dragging left or right will
move the entire Event (and other selected Playlist
Events) earlier or later in the timeline.
To use the Move Event tool:

1. In the Waveform Display Area, place the mouse cursor
over the middle portion (i.e., not near the edges).
2. Click and hold the mouse button down, and drag the
Event left or right, to the desired position – the Event
moves to an earlier or later position in the timeline.

2. Click and hold the mouse button down, and drag left
or right – depending on whether you are trimming
the Begin or End Boundary, the Event is either
trimmed (shortened) or extended (lengthened).
By default, a new Playlist that is in Overlap/Gap
mode will have the Preserve Timing modifier turned
off, so that when the Trim Event tool is used, it trims
only the Event that the cursor is placed over. When
Preserve Timing is enabled, the Trim Event tool
allows “rolling edits” to be performed. In a rolling
edit, the actual edit point between two Events moves,
the duration of the transition remains constant,
and audio does not move along the timeline.
Trimming one component Event of a transition
trims the other component by an equal and opposite
amount. More information on the Preserve Timing
modifier appears later in this chapter.

To use the Trim Event tool in Centered mode:

Trim Event Tool

1. In the Waveform Display Area, place the mouse
cursor near the Begin or End Boundary of a Playlist
Event – the cursor switches to the Trim Event tool.

The Trim Event tool is available in both Overlap/Gap and
Centered modes, and its functionality differs slightly
between these two modes.

2. Click and hold the mouse button down, and drag
left or right to perform a rolling edit.

When the mouse cursor is placed within a few pixels of
the edge of a Playlist Event’s waveform display, it
switches to the Trim tool and can be used to trim or
extend the Playlist Event.
To use the Trim Event tool in Overlap/Gap mode:

By default, a new Playlist that is in Centered mode
will have the Preserve Timing modifier turned on,
so that when the Trim Event tool is used, a rolling
edit is performed. When Preserve Timing is
enabled, the Trim Event tool allows “rolling edits”
to be performed. In a rolling edit, the actual edit
point between two Events moves, the duration of
the transition remains constant, and audio does
not move along the timeline. Trimming one
component Event of a transition “untrims” the
other component by an equal amount. More
information on the Preserve Timing modifier
appears later in this chapter.

1. In the Waveform Display Area, place the mouse
cursor near the Begin or End Boundary of a Playlist
Event – the cursor switches to the Trim Event tool.
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Using the Trim tool in Centered mode, when the Preserve
Timing modifier is off, moves the beginning or end fade
breakpoint and changes the duration of the Event’s fade
envelope, rather than performing a rolling edit.
Centered Crossfade Tool

The Centered Crossfade tool is available only when
working in Centered mode (see next section for details
on Centered mode). In Centered mode, when the
mouse cursor is placed over a Playlist Event’s waveform,
it is in Centered Crossfade Tool mode. The Centered
Crossfade tool is used to create crossfades around a
centered edit point.

Selecting Playlist Events

Playlist Events will usually need to be edited in some way.
This editing may include trimming the ends, nudging
forward or backward along the timeline, adjusting the
level, entering metadata, etc. Regardless of the type of
edit to be performed, it is important to know how to
make selections, as this is how Playlist Events are
targeted for many editing processes.
To Select a Playlist Event in the Waveform View:

•

Click the desired Playlist Event – you will know it is
selected because it will appear in a different color
than other, unselected Playlist Events. (Colors will
vary depending on your color preference settings).

Deleting Playlist Events

Selected Playlist Events may be deleted in Waveform
View.
To Delete a Playlist Event:

To use the Centered Crossfade tool:

1. In the Waveform Display Area, place the mouse
cursor over the middle portion (i.e., not near the
edges) of an “In” component of a transition.
2. Click and hold the mouse button down, and drag
to the left to create a centered crossfade – once a
crossfade has been created, its duration can be
modified by dragging left or right.

Select the Playlist Event(s) you wish to delete in the
Waveform or List View areas, and click the Delete
Playlist Event Button in the upper left of the Playlist
interface, or press the Delete key on your
keyboard.

Creating Transitions between Playlist Events

A variety of different types of transitions may be created
in the Playlist, including gaps, pauses, butt edits, and
centered or overlap crossfades.

High Precision Editing Mode

When using the Cursor Tools, you can use a modifier key
to temporarily toggle into High-Precision Editing Mode.
The modifier key is the Control (Ctrl) key on your
keyboard. Whenever this key is held down while using
one of the aforementioned tools or modes, the
tool/mode will make edits in one unit increments.
For example, holding the Ctrl key while trimming a
Playlist Event boundary will trim by one increment of the
current Time Units (i.e., if you are using Min:Sec:ms for
Time Units, this would trim by one millisecond at a time).
150

•

In the example below, we’ll be working with an Overlap
crossfade, which is commonly used when assembling
songs in a Playlist, where the songs need to blend
together. As the earlier Event fades out, the later Event
fades in.
Butt Edits

Butt edits are the default type of transition created as
multiple Events are added to a Playlist, unless default
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fade preferences specify otherwise. In a butt edit, two
Events are positioned back-to-back, with no space
between them.

2. Click on the later of the two Events (or the “In”),
and drag it (using the Move Event tool) to the left
(earlier in time), so an overlap in time is created
between the two Events.

In the case that an Event is no longer butted against its
preceding Event, it is easy to put it back into this
position.
To Butt an Event to the preceding Event in Waveform View:

1. Select the Event you wish to butt against the
preceding Event.

6

Dragging the In Event to the left creates a crossfade.

Centered Crossfades

Centered crossfades are commonly used when
assembling short takes in a Playlist, where the takes need
to overlap in time so as to blend together seamlessly.

Before Butting

2. In the upper left portion of the Playlist interface,
click the Butt to Previous Event End button – the
selected Event is butted to the preceding Event.

To Create a Centered Crossfade between Playlist Events in
Waveform View:

1. Click the Centered mode button in the Crossfade group.
2. In the Waveform Display Area, place the mouse
cursor over the middle portion (i.e., not near the
edges) of an “In” component of a transition.
3. Click and hold the mouse button down, and drag
to the left to create a centered crossfade – once a
crossfade has been created, its duration can be
modified by dragging left or right.

After Butting

Overlap Crossfades

Overlap crossfades are commonly used when assembling
songs in a Playlist, where the songs need to overlap in
time.
To Create an Overlap Crossfade between Playlist Events in
Waveform View:

1. Locate two adjacent Events you wish to crossfade
together.

Clicking on the “In” Event and dragging to the left with the Centered
Crossfade tool creates a centered crossfade.
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To Change the Fade Type:

1. Select the In Event for the transition you are
working on.
2. From the Fade In & Out Envelope pop-up menus,
choose the desired fade types (i.e., Fast In, Slow
Out, Linear, etc.)
Gaps

The difference between gaps and pauses is that pauses
may also contain audio. Pauses containing audio are
often used when creating an audio CD of a live
recording, where the audience applause between songs
is placed in the pause. In this scenario, if a listener
advances to this CD track, they can skip over the
applause and go right to the song, but if they listen to the
CD from beginning to end, they would hear the applause
between songs.

Gaps are silent spaces that are commonly used when
assembling songs in a Playlist, where the songs need to
be spaced apart.

Note that Gaps and Pauses are different. When a
CD created with gaps is played on a CD player, that
the CD player’s counter display will add the silence
contained in a gap to the earlier of the two tracks
surrounding the gap, while the counter still displays
that the earlier track is playing. On a CD with a
pause, the CD player’s counter will count down
backwards for the duration of the pause, and when
finished, the track indicator will show that the next
track is playing. Different CD players will display
Pause times differently – for example, in some cases
the letter “P” ( for Pause) may also appear.

To Create a Gap between Playlist Events in Waveform
View:

1. Locate two adjacent Events you wish to space apart
with a gap.
2. Click on the later (or “In”) Event, and drag it (using
the Move Event tool) to the right (later in time), so
space (the gap) is created between the two Events.

To create a silent pause:

1. Locate two adjacent Events you wish to space apart
with a silent pause.
2. Drag the later Event to the right, or later in time,
creating a gap between the two Events.
Clicking on the “In” Event and dragging to the right with the Move tool
creates a gap.

3. On the later of the two Events, drag the yellow
pause indicator to the left, until it is flush with the
End Boundary of the previous Playlist Event.

Pauses

Pauses are sometimes used between CD tracks instead of
gaps, and can be very similar or quite different from gaps,
depending on how they are used. The most common
use of a pause is to create a silent space between two CD
tracks. A two second silent pause, and a two second gap
– when burned to CD – sound identical to the listener if
they sit back and listen to CD tracks 1 and 2 and the gap
or pause between them.
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Extend Pause Marker to span gap, so it is flush with the previous
Event’s End Boundary.
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To create a pause containing audio:

1. Locate two adjacent Events you wish to space apart
with a silent pause.
2. On the later of the two Events, drag the yellow
pause indicator to the left (earlier in time), until
the indicator’s time display shows the desired
number of seconds, and/or until it spans the
desired amount of the audio waveform in the
earlier track.

Snapshots are temporary, and are not saved with a
Playlist. If you would like to save a snapshot, restore the
desired snapshot to move Playlist Events and envelopes
into the desired configuration, and save the Playlist.
To Set a Snapshot (in “A”):

1. Create desired transition and fade envelopes.
2. Click the Set Transition Snapshot A button – the
current transition is stored as snapshot A.
To Recall a Snapshot (from “A”):

•

Click the Recall Transition Snapshot A – the stored
transition state is recalled.

Editing Volume Envelopes & What It Does

Extending the Pause marker past the previous Event’s End Boundary
creates an “Audio-in-Pause” transition.

Breakpoints on a Playlist Event’s Volume Envelope may
be added, deleted, or moved.

Pauses and gaps can also be created by entering
times into the List View, covered later in this
chapter.
A volume envelope provides dynamic level control to Playlist Events

To Add a Volume Envelope Breakpoint:
Transition Snapshots

•

These buttons are used to store and recall up to four
temporary snapshots, which reflect the state of a
transition between two Playlist Events. Snapshots store
Fade In and Out envelope shapes and durations, and
overlap or gap duration between two Playlist Events.

Double-click on the Volume Envelope where you
want the breakpoint to appear – a custom Volume
Envelope breakpoint appears.

To Delete a Volume Envelope Breakpoint:

•

Option-click on the Volume Envelope breakpoint
you wish to delete.
Default breakpoints (which appear in red) cannot
be deleted.

Store Snapshot A

Recall Snapshot A

To Reset a Default Breakpoint:
Snapshots let you quickly try different transitions until you find the
right one. The arrow button to the left of each letter button stores a
snapshot, while the letter buttons recall snapshots.

•

Option-clicking default breakpoints (these appear
in red) restores their default behavior, in which
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they interact and scale when overlapped with
neighboring Playlist Events.
To Change the Gain of a Volume Envelope Breakpoint:

•

Click and drag the desired Volume Envelope
Breakpoint up to boost gain, or down to attenuate.

or:

1. Double-click on the desired Volume Envelope
Breakpoint – the Set Breakpoint Gain dialog
appears.
2. Enter the desired gain using the Enter volume for
Breakpoint slider, or field.

with Track Start Offsets is played in a CD player, these offsets
determine the point where the CD player’s counter
advances to the next track. They also determine the point
within a track’s content that audio playback starts, when the
next track or previous track controls are used.
Track Start Offsets are useful when you need to precisely
position a track’s start time somewhere other than the
default position at the beginning of a Playlist Event.
To Set a Track Start Offset earlier than an Event’s begin
boundary:

•

Click and drag the white Track Start Offset
indicator left to the desired position.

3. Click the OK button – the breakpoint is moved to
reflect the new gain value.
To Change the Gain of Adjacent Volume Envelope
Breakpoints:

1. Click on the envelope itself, between any two
breakpoints.
2. Drag up or down – the gain and position of the
breakpoints on both ends of the selected segment
is raised or lowered.

To Set a Track Start Offset later than an Event’s begin
boundary:

•

Click and drag the white Track Start Offset
indicator right, to the desired position.

To Change the Position of a Volume Envelope Breakpoint
along the timeline:

•

Click and drag the desired Volume Envelope
Breakpoint left to move it earlier in time, or right to
move it later in time.
Holding the Shift key while moving a breakpoint
constrains its vertical position/dB value, and
restricts movement of the breakpoint
horizontally/in time.

An Event’s Track Start Offset cannot occur earlier
in the timeline than the preceding Event’s Track
Start Offset, or later than the Event’s end boundary.

Track Start Offsets

List View Area

Track Start Offsets are used to create “virtual” start times –
that is, their positions trigger the counter display to advance
to subsequent tracks, and dictate where each CD track
index is placed. When an audio CD burned from a Playlist

The various controls and fields found in the List View
portion of the Playlist are described in this section. Keep
in mind that the columns and fields are described in the
order they appear by default.
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Overview of List View Area
Show/Hide List View
Disclosure Triangle

Track Start
Offset

Pause
Duration

Track End

Fade Out
Envelope Shape

Fade Out
Duration

ISRC
Display

Program
Duration

Copy
Protection

Vbox
Effects

Track
Number

Track
Name

Track Start
Time

Track
Duration

Fade In
Envelope Shape

List View Columns, Controls, and Fields

This section describes each of the controls found in the
List View Area.

Fade In
Duration

Gain

Emphasis

CD-TEXT
(per track)

If the material contained in a Playlist exceeds 78
minutes, and the Red Book checkbox in the CD
Options controls group is checked, the Program
Duration display turns red to alert you of a Red
Book standard violation.

Show/Hide List View Disclosure Triangle

This small triangle appears to the left of the “List View”
label in the interface. In this case, when the List View
disclosure triangle is pointing to the right (closed
position), it is hiding the entire List View portion of the
Playlist’s interface. When the disclosure triangle is
pointing downward (open position) it is showing, or
“disclosing”, the List View portion of the interface.
Program Duration Time Display

Directly opposite from the Show/Hide List View
disclosure triangle, you will find the Program Duration
display. This display shows the duration of all the
contents in the Playlist, from beginning to end, and
includes non-audio transitions such as gaps or pauses. By
default, this display appears in the interface frame which
separates the Waveform View from the List View. When
the Waveform View is hidden, the Program Duration
appears above the List View, below the Nudge Controls,
and when the List View is hidden, it appears in the
window frame, just below the Waveform View Area.

Track Number Column

The Track Number column displays the track number of
each Playlist Event. The number displayed in this column
will become the CD track number if the Playlist is burned
as an audio CD, and also represents the Playlist Event
position when the Playlist is bounced to a new audio
document containing Region markers. This number is
not editable – the only way to change a Track Number is
by changing the order of Events in a Playlist.
The Track Number column also displays a speaker icon
next to the currently playing track.
Track Name Column

The Track Name column displays the names of Events
used in a Playlist. By default, a Track Name appears
exactly as the Region’s original name appears in its
source audio document, though it can be edited in the
Playlist. A single click on a selected item under the Track
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Name column makes the name editable, and a new name
may be entered. Changing the name in the Playlist does
not affect the name of the original source Region in its
audio document, unless Conform Playlist Events to
Source Regions is turned on.

To Edit a Track’s Start Time:

To Edit a Track’s Name:

Track End Time Column

1. Click the name of the track you wish to edit – the
name field becomes editable.
2. Enter the desired name, and press the Return key.

1. Click the Track’s Start Time field – the field
becomes editable.
2. Enter the desired Start Time, and press the Return key.

This column shows the End Time for a Playlist Event.
This value corresponds with the position of the Event
End Boundary.
To Edit a Track’s End Time:

Track Start Offset Column

The Track Start Offset column displays a Track Start Offset
Time value, if one is used – and corresponds to the position
of the Track Start Offset in the Waveform View display area.
By default, a track’s start time is set to an Event’s Begin
Boundary, and displays a value of zero seconds (or
equivalent in the chosen Time Units). A Track Start Offset
allows the actual track start time to be adjusted, so that a
track’s actual start time can be set before or after an Event’s
Begin Boundary. To edit a Track Start Offset in List View,
click in a selected Event’s TS Offset data field under the TS
Offset column – and a new TS Offset may be entered.

1. Click the Track’s End Time field – the field
becomes editable.
2. Enter the desired End Time, and press the Return key.
Track Duration Column

This column shows the overall duration between a
Playlist Event’s Begin and End Boundaries.
To Edit a Track’s Duration:

1. Click the Track’s Duration field – it becomes editable.
2. Enter the desired Duration, and press the Return key.

To Edit a Track’s TS Offset:

1. Click the track’s TS Offset field – the field becomes
editable.
2. Enter the desired TS Offset, and press the Return key.
or:

1. Double-click the TS Offset field for the track you wish
to edit – the Edit Track Start Offset dialog appears.
2. Enter the desired TS Offset, and click the OK
button.

Pause Duration Column

The Pause Duration Column displays a Pause Duration
value, if one is used – and corresponds to the position of
the Pause indicator in the Waveform View display area.
By default, the Pause between tracks is zero seconds (or
equivalent in other Time Units) – this is displayed in the
Pause column, and the Pause indicator (in Waveform
View) is locked to an Event’s Begin Boundary. (See the
section on Pauses on page 162 for more information
about entering positive and negative values).

Track Start Time Column
To Create a Pause:

This column shows the Start Time for a Playlist Event.
This value corresponds with the position of the Playlist
Event Begin Boundary, as well as the default position of
an Event’s Track Start Offset and Pause indicators.
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1. Click the track’s Pause field – it becomes editable.
2. Enter the desired Pause duration, and press the
Return key.
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Fade Out Shape Column

or:

1. Double-click the Pause field for the track you wish to
edit – the Playlist Event Pause Time dialog appears.
2. Enter desired Pause duration, and click the OK button.
Fade In Shape Column

Fields in this column display a thumbnail representation of
the Fade In envelope shape being used for the Playlist
Event. Clicking on the dropdown menu shows a number
of available preset fade in envelope shapes – these include:
Fast –

Fields in this column display a thumbnail representation
of the Fade Out envelope shape being used for the
Playlist Event. Clicking the dropdown menu shows a
number of available preset fade in envelope shapes –
these include:
Fast –
Slow –

This fade envelope creates a fast fade out.
This fade envelope creates a slow fade out.

Linear –

This fade envelope creates a linear fade out.

This fade envelope creates a fast fade in.

6

Fade In Duration Column

The values in fields under this column control the
duration of a fade in.
To Edit Fade In Duration:

1. Click the track’s I-XF-T (“In” Crossfade Time) field
– the field becomes editable.

Slow –

This fade envelope creates a slow fade in.

2. Enter the desired fade in duration, and press the
Return key.
Fade Out Duration Column

The values in fields under this column control the
duration of a fade out.
To Edit Fade Out Duration:

1. Click the track’s O-XF-T (“Out” Crossfade Time)
field – the field becomes editable.
Linear –

This fade envelope creates a linear fade in.

2. Enter the desired fade out duration, and press the
Return key.
Gain Change Amount Column

Fields displayed under this column show the amount of
non-destructive gain change – from the original level in
the source audio document. Changes applied here affect
only the Playlist Event, not the source Region in the
source audio document. A Playlist event’s gain setting
Chapter 6: Playlists & CD Burning
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can be used to control the balance of the event in a
Playlist. You may need to raise the volume or lower the
volume of some Playlist events to maintain a proper
balance of volume levels.
Note that gain changes applied via the Gain
column affect audio level in addition to the gain
value set via a Playlist Event’s Volume Envelope.

To Add an ISRC Code to a Track:

1. Click the Track’s ISRC field – the field becomes
editable.
2. Enter the desired ISRC code, and press the Return
key. The ISRC field entered will be automatically
formatted to accomodate the code entered with
the default dashes.
ISRC codes may also be entered in the CD-TEXT for
track dialog – described below.

Be careful not to set a Playlist event’s gain too high
as you may overload the signal and cause
clipping to occur. You may also introduce clicks
between Playlist events if the difference in gain
between two adjacent or crossfaded Playlist
Events is too large. If you encounter such clicks,
try using volume envelopes to adjust gain instead
of entering a gain adjustment in the Gain column,
and/or, use crossfades to smooth such transitions.

Track CD-TEXT Column

This dialog contains a number of fields in which various
track-specific CD-TEXT data may be entered. This data is
burned to CD only when both the CDTXT checkbox in
the Playlist’s List View, and the Burn CD-TEXT from
Playlist checkbox in the Burn Audio CD Dialog are
checked.

Emphasis Subcode Column

This column’s checkboxes indicate whether a Playlist
Event is flagged for emphasis. The emphasis flag is a CD
data PQ-subcode control bit. Depending on the CD
player, this flag may cause an internal high pass filter to
be engaged, boosting the high frequency content of the
track. Emphasis is not commonly used.
Copy Protection Subcode Column

This column’s checkboxes indicate whether a Playlist
Event is flagged for serial (SCMS) copy protection. The
copy protection flag is a CD data PQ-subcode control bit.
When this flag is turned on for a track, it prevents digital
copies from being made on some equipment.
ISRC Display Column

The CD-TEXT for Track dialog allows track/song-specific CD-TEXT to be
entered.

Fields in this column show the ISRC code for each Playlist
Event.
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Detailed information about ISRC codes and CDTEXT appears later in this chapter, in the section
on Working with CD-TEXT & Subcodes.

Vbox Inserts Column

Peak’s Playlist allows Audio Units and VST effects
plug-ins to be used (via the Vbox routing interface)
on Playlist Events. Each Playlist Event can have
unique effects “snapshots” assigned to it. These
effects are applied as the Playlist is auditioned,
bounced as a new document, or when burned to
audio CD.
Vertical Scrollbar

The vertical scrollbar is one of the bottom-most graphical
elements of the List View Area, and appears along the
right side of the List View area, only when there is more
graphical content than can be displayed on-screen at the
current Playlist window height.

Changing the Order of Columns

When working in List View, you can organize the
columns in any order you like. This can be especially
useful if you are working on a narrow monitor, or not
using all the columns.
To customize the order of columns in List View:

•

Click the column header you wish to move, and
drag to the left or right, into the desired
position.

Selecting Playlist Events

Once a number of Regions have been added to a Playlist,
chances are, they will need to be edited in some way.
This editing may include trimming, nudging, entering
metadata, etc. Regardless of the type of edit to be
performed, it is important to know how to make
selections, as this is how particular Playlist Events are
targeted for editing processes.
To Select a Playlist Event in the List View Area:

•

Vertical Scroll Arrows

The vertical scroll arrows appear on the vertical scrollbar,
and like the scrollbar, are used for scrolling through
columns vertically, when the Playlist window’s height
cannot fit all the rows.
Horizontal Scrollbar

The horizontal scrollbar is one of the bottom-most
graphical elements of the List View Area, and appears
only when there is more graphical content than can be
displayed on-screen at the current Playlist window width.

Click the desired Playlist Event – you will know it is
highlighted because it will appear highlighted.
(Highlight color will vary depending on your Mac
OS Appearance preference settings).

To Select multiple Playlist Events in the List View Area:

1. Click the desired Playlist Event – you will know
it is highlighted because it will appear
highlighted. (Highlight color will vary
depending on your Mac OS Appearance
preference settings).

Horizontal Scroll Arrows

2. With the initial selection still active, hold down
the Command () key and click another
Playlist Event – two Playlist Events are now
selected.

The horizontal scroll arrows appear on the horizontal
scrollbar, and like the scrollbar, are used for scrolling
through columns horizontally, when the Playlist
window’s width cannot fit all the columns.

3. To add additional Playlist Events to the
selection, click on other Playlist Events while
continuing to hold down the Command ()
key.
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Holding down the Command () key while
making selections allows you to select
nonadjacent Playlist Events. Holding down the
Shift key while making selections automatically
selects the entire range of Playlist Events that
appears between two non-adjacent Playlist
Events.

Deleting Playlist Events

Unwanted Playlist Events may be deleted from the List
View in a number of ways.

Reordering Playlist Events

Changing the order of Playlist Events is something that is
only possible using the List View.
To change the order of a single Playlist Event:

1. Select the Event you wish to move to a new
position.
2. Drag the selected Event up or down, to desired
position in the List of Playlist Events, highlighting
the name of the Event you wish the selected Event
to appear before.

To Delete a Playlist Event in List View:

•

Select the Playlist Event(s) you wish to delete in the
List View area, and click the Delete Playlist Event
Button in the upper left of the Playlist interface.

•

Select the Playlist Event(s) you wish to delete in the
List View area, and press the Delete key on your
keyboard.

Renaming Playlist Events

There may be times when you wish to change the names
of Playlist Events. This can be done only in the List View,
but be aware that this does not change the name of the
Region in the original source document, unless Conform
Playlist Event to Source Region is turned on. To change
the name of a source Region, please refer to Chapter 5:
Editing.

Here, we’re moving “Event 3” over “Event 2”, so as to make “Event 3”
the second item in the Playlist.

For example, to move the third Event into the second
position in the List of Events, you would select and drag
the third Event, moving it over the second event (second
event will become highlighted), and release the mouse
button. In this scenario, Events 2 and 3 will change place,
and no other Events are affected.
Creating Transitions between Playlist Events

There are four distinct types of transitions available
between adjacent Playlist Events. These include butt
edits, crossfades, gaps, and pauses.

To Rename a Playlist Event:

1. In the List View portion of the Playlist, click on the
name of the Playlist Event you wish to rename –
the name becomes editable.
2. Enter a new name for the Playlist Event and press
the Return key on your keyboard.

160

The List View does not offer a graphical representation
of the various transitions. You may wish to review the
section about Creating Transitions in the Waveform
View area, to get a better understanding of the different
types of transitions. The Creating Transitions in the
Waveform View section contains pictures of each type
of transition.
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Butt Edits

Centered Crossfades

Butt edits are the default type of transition created as multiple
Events are added to a Playlist. In a butt edit, two Events are
positioned back-to-back, with no space between them.

Centered crossfades are commonly used when
assembling takes in a Playlist, where the takes need to
overlap in time so as to blend together seamlessly.

In the case that an Event is no longer butted against its
preceding Event, it is easy to put it back into this position.

To Create a Centered Crossfade between Playlist Events in
List View:

To Butt an Event to the preceding Event in List View:

1. Locate two adjacent events that are spaced apart by
a gap.

1. Click the Centered mode button in the Crossfade
well.
2. Select the later Event’s row.
3. Click the Start time field to make it editable.

2. Select the later of the two Events.
3. Click the Butt to Previous Event End Button – the
later Event is butted up against the earlier Event,
with no gap between them.

4. Enter a value earlier in time than the current value
(i.e., if the current value is 00:05:00.00, and you
enter “4:55”, you would be creating a five second
centered crossfade, with half of the five second
total duration on each side of the edit point).

Overlap Crossfades

Overlap crossfades are commonly used when assembling
songs in a Playlist, where the songs need to overlap in time.
As the earlier Event fades out, the later Event fades in.
To Create an Overlap Crossfade between Playlist Events in
List View:

1. Locate two adjacent Events that you wish to
crossfade together.

Gaps

Gaps are silent spaces that are commonly used when
assembling songs in a Playlist, where the songs need to
be spaced apart.
To Create a Gap between Playlist Events in List View:

1. Locate two adjacent Events that you wish to space
apart with a gap.

2. Select the later Event’s row.
2. Select the later Event’s row.
3. Click the Start time field to make it editable.
3. Click the Start time field to make it editable.
4. Enter a value earlier in time than the current value
(i.e., if the current value is 00:05:00.00, and you enter
“4:55”, you would be creating a five second crossfade).
Note that if the two Events are not initially butted
against each other, you may wish to look at the
earlier Event’s End Time, and use that as a basis
for when the later Event should start. When the
Start time of the Event you wish to fade into is
earlier than the End time of the Event you wish to
fade out of, a crossfade results.

4. Enter a value later in time than the current value (i.e.,
if the current value is 00:05:00.00, and you enter
“5:05”, you would be creating a five second gap).
Note that if the two Events are not initially butted
against each other, you may wish to look at the
earlier Event’s End Time, and use that as a basis
for when the later Event should start. When the
End time of the earlier Event is earlier than the
Start time of the later Event, a gap results.
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Pauses

To create a silent pause:

Pauses can be used between CD tracks instead of gaps, and
can be very similar or quite different from gaps, depending
on how they are used. The most common use of a pause is
to create a silent space between two CD tracks. A two second
silent pause, and a two second gap – when burned to CD –
sound identical to the listener if they sit back and listen to CD
tracks 1 and 2 and the gap or pause between them.
Pauses are not always silent – they may also contain
audio. Pauses containing audio are often used when
creating an audio CD of a live recording, where the
audience applause between songs is placed in the pause.
In this scenario, if a listener advances to this CD track,
they can skip over the applause and go right to the song,
but if they listen to the CD from beginning to end, they
would hear the applause between songs.

1. Locate two adjacent Events you wish to space apart
with a silent pause.
2. Select the later Event’s row and click the Pause
field – it becomes editable (or double-click in the
Pause column – the Playlist Event Pause Time
dialog appears).
3. Enter the desired pause time (for example, 5
seconds) and press the Return key (or click the
OK button in the Playlist Event Pause Time
dialog) – the later Event is moved five seconds
later in the timeline, and the pause indicator is
moved 5 seconds earlier in the timeline, so it is
flush against the end boundary of the earlier
Event.
To create a pause containing audio:

A positive Pause value creates a gap of the specified
duration, and then extends the Event’s Pause indicator
by an equal amount, placing it at the beginning of the
gap, and flush with the end of the previous Event.
A negative value causes an Event to be butted to the preceding
Event’s end boundary, and extends the Pause indicator by the
specified duration earlier in time, into the audio content of the
preceding Event, creating a Pause containing audio.
If the Pause indicator on an “In” Event occurs earlier in
time than the corresponding “Out” Event’s end
boundary, the Pause column displays a negative value.

1. Locate two adjacent Events you wish to space apart
with a silent pause.
2. Select the later Event’s row and click the Pause
field – it becomes editable (or double-click in the
Pause column – the Playlist Event Pause Time
dialog appears).
3. Enter a negative value for the pause time (for
example, -5 seconds) and press the Return key (or
click the OK button in the Playlist Event Pause Time
dialog) – the later Event is butted to the end of the
previous Event, and the pause now contains the
last five seconds of audio from the earlier Event.
Transition Snapshots

Note that Gaps and Pauses are different. When a CD
created with gaps is played on a CD player, the
counter display will add the silence contained in a
gap to the earlier of the two tracks surrounding the
gap, while the counter still displays that the earlier
track is playing. On a CD with a pause, the CD
player’s counter will count down backwards for the
duration of the pause, and when finished, the track
indicator will show that the next track is playing. CD
players will display Pause times differently – in some
cases the letter “P” ( for Pause) may also appear.
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These buttons are used to store and recall up to four
temporary snapshots, which reflect the state of a
transition between two Playlist Events. Snapshots store
Fade In and Out envelope shapes and durations, and
overlap or gap duration between two Playlist Events.
Snapshots are temporary, and are not saved with a
Playlist. If you would like to save a snapshot, restore the
desired snapshot to move Playlist Events and envelopes
into the desired configuration, and then save the Playlist.

Peak 6 User’s Guide

Store Snapshot A

Recall Snapshot A

Snapshots let you quickly try different transitions until you find the
right one. The arrow button to the left of each letter button stores a
snapshot, while the letter buttons recall snapshots.

Start Offset (TS Offset) data field – after a short
delay, the field contents become editable. You
may also double-click to open the Track Start
Offset dialog, where a new time value can be
entered.
2. Enter the desired Track Start Offset value, and
press the Return key on your keyboard – the Event
now has a Track Start Offset.

To Set a Snapshot (in “A”):

A Track Start Offset cannot occur earlier in
the timeline than the preceding Event’s Track
Start Offset, or later than the Event’s end
boundary.

1. Create desired transition and fade envelopes.
2. Click the Set Transition Snapshot A button – the
current transition is stored as snapshot A.
To Recall a Snapshot (from “A”):

•

Click the Recall Transition Snapshot A – the stored
transition state is recalled.

Track Start Offsets

Track Start Offsets are used to adjust where the
counter display advances to the next track and dictate
where a CD track index is placed. When an audio CD
burned from a Playlist featuring Track Start Offsets is
played back in a CD player, these offsets determine
the point where the CD player’s counter would
advance to the next track. They also determine the
point within a track’s content that audio playback
starts, when the next track or previous track controls
are used.
Track Start Offsets are particularly useful when you
need to precisely position a track’s start time within
a crossfade between two Playlist Events. By default,
an Event’s/Track’s start time is located at the same
position as the Event’s own begin boundary. In a
transition between two Events, the use of a custom
Track Start Offset allows the actual start time to
occur at any point within, before, or after the
transition.
To Set a Track Start Offset in List View:

1. Click once over a selected Playlist Event’s Track

Applying Effects Plug-ins to Playlist Events

Unique effects “snapshots” may be assigned to each
Playlist Event. These effects are applied to each Event
during Playlist preview, as well as when
bouncing/exporting the Playlist, and burning audio CDs.
Effects snapshots contain information about the
arrangement of effects within the Vbox matrix, as well as
the settings of each individual plug-in.
There are a number of controls used to configure Vbox’s
effects settings for each Playlist Event.
Bypass

The Bypass control turns off/bypasses Vbox effects for
the selected Playlist Event.

Active

The Active control turns on/activates Vbox effects for the
selected Playlist Event. If Vbox is not already open and
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active, the Active control opens and activates Vbox for
the Playlist Event.

To enable Vbox state automation for a Playlist Event:

•

From the Vbox pop-up menu, choose Active – If
Vbox inactive, this command opens it. If Vbox is
already open, this command has no additional effect.

To disable Vbox state automation for a Playlist Event:

•

From the Vbox pop-up menu, choose Bypass –
Vbox is disabled for this Playlist Event.

Make Snapshot
To take effects “snapshot” for a series of Playlist Events:

The Make Snapshot control takes a snapshot of the
current Vbox state for the selected Playlist Event.

1. From the Vbox pop-up menu, select Active – If Vbox
is inactive, this command opens it. If Vbox is already
open, this command has no additional effect.
2. Configure Vbox with the desired effects plug-ins,
and configure individual plug-ins as desired.
3. From the Vbox pop-up menu, select Make Snapshot
– a “snapshot” of the current state is saved.

Clear Snapshot

The Clear Snapshot control clears the snapshot assigned
to the selected Playlist Event.

Show Vbox

The Show Vbox control brings the Vbox window to the
foreground.

4. Select the next Playlist Event (and repeat for all
subsequent Events on which you wish to use
“snapshot” automation).
You may also shift-click to select multiple Playlist
Events and choose Make Snapshot to assign the
same effects snapshot to all selected Playlist Events
in one easy step.

This section shows how to configure effects snapshots
only. More general information about using Vbox
and other plug-ins is available in Chapter 9: Plug-Ins.
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5. From the Vbox pop-up menu, select Active.
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6. From the Vbox pop-up menu, select Make
Snapshot – a “snapshot” of the current state is
saved for this Playlist Event.
When the Playlist is played, Vbox will “snap” to each set
of effects that have been set using the steps above. When
the Playlist is burned to disc, or bounced as a new file,
the effects will be applied to each track.
To clear a Playlist Event’s “snapshot”:

1. Select the Playlist Event which contains the
“snapshot” you wish to clear.
2. From the Vbox pop-up menu, select Clear
Snapshot – the selected Playlist Event no longer
contains a saved “snapshot”.
Clicks or pops may occur if your effects snapshots
include any settings that instantiate and deinstantiate plug-ins. When a Playlist is going from one
Event to another very rapidly (especially on slower
computers) clicks and pops may occur. Therefore, it is
recommended that if you want to use different plug-in
configurations for each Playlist Event, configure Vbox
with all the plug-ins you want to use for all Playlist
Events, and then create snapshots for each Playlist
Event with the plug-ins that you don’t want to use on
that Playlist Event muted or bypassed. (For more
information on Vbox, please see Chapter 9: Plug-Ins)

If you plan on creating crossfades and using effects
snapshots in a Playlist, it is recommended that you
apply effects plug-ins to Regions in their source
documents (or in copies of the source documents),
before adding them to the Playlist. The Playlist uses state
automation, and “snaps” from one effects setting to the
next instantly. If the effects used from one Playlist Event
to another differ greatly, the result can be an abrupt
transition. By applying the effects in source documents,
the transition from one Playlist Event to another will
occur smoothly, and effects differences between Events
will be smoothed out by the crossfade between them.

Working with CD-TEXT & Subcodes
A variety of CD-TEXT and/or subcode data may be added
either to entire discs, to individual CD tracks, and in some
cases, to both. This data is added in two formats – CDTEXT, and embedded subcode data. CD-TEXT appears in
the display of compatible CD players, and subcode data
stores information and triggers certain behaviors (such as
emphasis or copy protection) on compatible CD players.
Subcode data is also used for storing product barcode
information and ISRC codes (for tracking copyright info).
Some software-based CD players look up a CD’s info via
online services such as Gracenote’s CDDB™ using ISRC
or track durations to find matches.
Comparing the embedded ISRC codes on an audio
CD with those stored in an online database is one
way for a software-based music player to
automatically get and display CD track names.
More commonly, a software-based music player,
such as Apple’s iTunes, compares the number of
tracks and track durations with an online database.
When a match is found, track information is
retrieved and displayed. Occasionally, multiple
exact matches are found, and the user is prompted
to choose the appropriate set of information.

While Peak’s Playlist supports writing CD-TEXT on both
a per-disc and per-track basis, be aware that most CD
players do not support reading/displaying this data. In
addition, compatible CD players will vary in the types of
CD-TEXT they read or display.
Note that some fields are duplicated as both discand track-specific CD-TEXT. For example, the
Performer field can appear in either category.
Which you use depends on the nature of the disc
you are mastering. A disc featuring a single
performer would use the Performer field in discspecific CD-TEXT, while a compilation featuring
many performers would use the Performer field in
track-specific CD-TEXT.
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Disc-specific CD-TEXT

Composer

Disc-specific CD-TEXT is added in the Playlist’s CDTEXT for Audio CD dialog, which is accessed by
clicking the Audio Compact Disc Info in the upper left
section of the Playlist, and includes the fields described
below.

This field is used when the same composer is responsible
for all tracks on the disc.
Arranger

This field is used when the same arranger is responsible
for all tracks on the disc.
Message

This field is used for optional custom text messages, and
also appears in DDP output from the playlist, allowing
instructions to be passed along to a disc replicator.
Genre

This field is used to describe the genre of the material on
the entire disc.
Disc Identifier

This field is used by record labels as an internal
cataloging number.
The CD-TEXT for Audio CD dialog allows disc-specific CD-TEXT to be
entered.

Product Code
Title

This field is used for the Title of the disc (album
name).

The Product Code (also known as MCN, or Media
Catalog Number) field can contain either EAN or UPC
barcode information.
EAN (European Article Number)

Performer

This field is used when the same performer is
responsible for all tracks on the disc.

EAN is a barcode standard in which barcodes are 13 digits
long.
UPC (Universal Product Code)

Songwriter

This field is used when the same songwriter is
responsible for all tracks on the disc.
166

UPC is an older barcode standard in which barcodes are
twelve digits long. UPC codes are now considered a
subset of the EAN variety of barcodes, which contain
thirteen digits.
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When a UPC code consisting of twelve digits is used
in this field, Peak automatically adds a leading zero
to the code, to give the UPC code the required
thirteen digit length. See http://www.ean-int.org and
http://www.uc-council.org for more information.

Track-specific CD-TEXT

Track-specific CD-TEXT is added in the Playlist’s CDTEXT for Track dialog, which is accessed by clicking a
track’s CDTXT checkbox in the List View area, and
includes the fields described below.

Fields displayed in the List View’s ISRC column show the
ISRC code for each Playlist Event.
ISRC codes may be entered in this field, or by clicking a
Playlist Event’s CD-TEXT checkbox, which opens the
Track CD-TEXT dialog. This dialog contains an ISRC
code field – as well as fields for other per-track CD-TEXT
data, such as Track Title, Performer, etc.

Country
Code

Owner
Code

Year of
Reference Code

Serial
Number

6

Title

This field is used for the Title of the track.

ISRC-formatted codes are composed of four sections – a
Country Code, Owner Code, Year of Reference Code,
and Serial Number.

Performer

This field is used for the Performer of the track.
Songwriter

This field is used for the Songwriter of the track.
Composer

This field is used for the Composer of the track.
Arranger

Country Code – An ISO (International Standards
Organization) member country’s designation. This
portion of the code consists of two capital letters.
Owner Code – The owner’s (sound recording copyright
owner) country. This portion of the code consists of
three alphanumeric characters.
Year of Reference Code – The year in which the ISRC is
allocated to the recording – represented by the last two
digits of the year. This portion of the code consists of
two digits.

The code assigned to the track by the
owner. This code may not be repeated within the same
calendar year. This portion of the code consists of five
digits.

Serial Number –

This field is used for the Arranger of the track.
ISRC Codes

This field is used for the ISRC code for the track.

To find out more about ISRC codes, please visit the
International Federation of Phonographic Industry
website, at:
http://www.ifpi.org/isrc/

About ISRC Codes

ISRC, or International Standard Recording Codes, are
similar to serial numbers, and identify unique recordings.

Be aware that there is a difference between the CD-TEXT
for Track dialog that appears when double-clicking a
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Playlist Event’s/Region’s ISRC data field, and the CDTEXT for Audio CD dialog that appears when clicking the
Playlist’s CD Info button. The CD-TEXT for Track dialog
allows entry of ISRC codes, and other information that
may be unique to a track, and the CD-TEXT for Audio CD
dialog allows entry of information that applies to the
entire audio CD. More information about ISRC codes
appears in the previous section.
To enter an ISRC code:

1. Click a Playlist Event’s ISRC field – it becomes
editable.
2. Enter desired ISRC code, and press Return.

contain identical information for all tracks. In this case,
the ability to copy the information can be a real time
saver.
Editing Subcode Data

Peak’s Playlist is capable of editing Emphasis and Copy
Protection PQ subcode data bits. While these subcodes
are rarely used, there may be times when you wish to
enable these subcodes. More information about using
these subcodes is available earlier in this chapter.
To add an Emphasis (Emp/PE) Flag to a Track:

•
or:

1. Check a Playlist Event’s CD-TEXT checkbox – the
Track CD-TEXT dialog appears.

Check the Emphasis (Emp) checkbox for the
desired Playlist Event – when burned to audio CD,
this track will trigger compatible CD players to
turn on a high pass filter to boost high
frequencies.

2. Enter desired ISRC code in the ISRC field.
Copying CD-TEXT

When entering Track-specific CD-TEXT, you can copy
much of the information, which you may have already
entered, either in a source Region, or a previous track.

To add a Copy Protection flag to a Track:

•

Check the Copy Protection (CP) checkbox for the
desired Playlist Event – when burned to audio
CD, this track will feature digital copy protection.

If the CD-TEXT for a track title is the same as that used for a source
Region’s name, or used in a previous track, it may be copied to the
current track’s CD-TEXT.

When this flag is turned on for a track, it prevents
digital copies from being made on some equipment.

The Title field features a Copy from Region button above
it – clicking this button will copy the name used on the
source Region, and apply it to the Playlist Event.
The Performer, Songwriter, Composer, and Arranger
fields each feature a “Copy from Previous” button above
them. This button will copy the field information from
the previous track. Typically, when working with a CD
where all songs are by the same artist, these fields will
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Indexes

In addition to track indexes, which designate the
start or end of a CD track, you may also burn
standard indexes to audio CDs using Peak. Indexes
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are created by placing Markers in the desired location
within a source audio document that is referred to by
a Playlist. Indexes are not visible when working in
the Playlist, but are burned to CD. Indexes are
commonly used on classical music CDs, where a track
may be relatively long (i.e., 20 minutes or more), and
indexes appear at various intervals or points of
interest, within a single CD track. With CD indexes in
place, a listener can navigate to the index location
using the indexing controls on a compatible CD
player. Most commercial CD players do not support
navigation using indexes.

The commands below, provide a wealth of useful
information about the type of data that can be burned by
particular burners, verifying the data on burned discs,
etc.
To Use the UNIX Commands below:

1. Type the bold text into the Terminal application
exactly as it appears below.
2. Press the Return key – the requested data is
displayed in the Terminal window.
drutil cdtext – Displays CD-Text present on an audio CD
in XML format.

To Create an Index within a CD track:

1. Create a Marker in a source Region destined to be
used in the current Playlist.
Markers may be added to Source Regions at any
point prior to burning. If adding Markers midproject, be sure to save these changes.

2. Add the Region containing the marker to the
current Playlist.
3. Click the Burn Audio CD button – the Burn Audio
CD dialog appears.
4. Check the Markers are Indexes button in the Burn
Audio CD dialog.
5. Insert a blank CD, and click the Burn button – the
disc is burned with an index in the location of the
Marker in the source Region.
Using the Mac OS Terminal

The Terminal utility included with Mac OS X is useful
for checking the capabilities of CD burners that you
may use with Peak, as well as for verifying data on
burned discs, and a variety of other disc-burning
related tasks.

The “drutil cdtext” UNIX command reveals embedded CDTEXT data that has been burned to disc.

The Terminal utility is located in:

drutil info – Displays detailed information about
connected drives.

/Mac HD/Applications/Utilities/
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Peak. CDs may be burned directly from an audio
document, or from a Playlist document. When burning
from a Playlist made in Red Book mode (i.e., with the
Red Book checkbox in the Playlist checked), the
resulting CD actually contains Red Book formatted audio
data in Orange Book format (all computer-burned CD-Rs
are in Orange Book format).

The “drutil cdinfo” UNIX command reveals information
about a CD burner’s features and media compatibility.

drutil discinfo –

Displays disc related info when media is

present.
drutil list –

Lists all connected burning devices.

drutil status –

Such a master can then be replicated into true Red Book
format. The discs burned with Peak are playable in any
CD player (except for those that are not compatible with
CD-R media). Burning a CD not made in Red Book mode
may play on a standard CD player, but this will depend
largely on the CD player’s capabilities. For maximum
compatibility, it is recommended to burn in Red Book
mode. For more information, please review the section
on Red Book mode which appears earlier in this chapter.

Displays detailed information about

inserted media.

A wealth of useful information about CD data
formats such as Red Book and Orange Book is
available at: http://www.cdrfaq.org/

drutil subchannel – Displays subchannel (MCN, ISRC)
info when CD media is present.
drutil trackinfo –

Displays track related info when media

is present.

Burning an Audio CD from a Playlist

Peak can burn audio CDs either from a Playlist, or from
an audio document. This section covers burning from a
Playlist – burning from a document is covered later in
this section.
To Burn an Audio CD from a Playlist:

Output Options
Peak’s Playlist offers a wide variety of output options,
including burning Red Book audio CDs, as a single AIFF
or Sound Designer II file, as a DDP (Disc Description
Protocol) file set, as an iTunes Playlist, as a Jam Image file,
or as a tab-delimited or formatted text report.

1. With the Playlist edited and saved as desired, bring
the Playlist window to the foreground, and choose
Select All (-A) from the Edit menu (or select only
the desired Events).
2. In the upper right portion of the Playlist interface,
click the Burn Playlist to Audio CD button – the
Burn Audio CD dialog appears.

Burning Red Book Audio CDs

3. Insert a blank CD – the Burn button becomes
available.

Burning Red Book format audio CDs is one of the most
common ways to output digital audio projects edited in

4. In the Burn Audio CD dialog – choose the desired
options.
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5. Click the Burn button – the Playlist is burned to
CD.
Burning an Audio CD from an Audio Document

In addition to the advanced options available in the
Playlist, Peak can also burn audio CDs directly from an
audio document. When burning from a document, the
same Burn Audio CD dialog is presented, so you may
choose from the same burning options.
To burn an audio CD from a Peak Audio Document:

1. Open the desired audio document.
2. From the File menu, choose Burn Audio CD – the
Burn Audio CD dialog appears.

4. In the Burn Audio CD dialog – choose the desired
options.
5. Click the Burn button – the document is burned to
CD.
CD Burning Options

The Burn Audio CD dialog contains a number of CD
burning options, which are described below.
Burner Pop-up Menu

This menu allows you to choose which CD burner you
wish to use (when more than one burner is connected to
your computer).
Burn Speed Pop-up Menu

This menu allows you to choose the desired burn speed.
Generally, lower speeds will produce the most reliable
CDs. It is a good idea to check the burn speed rating of
the blank CD media you are using to find its maximum
recommended burn speed.
Use Dither Checkbox

3. Insert a blank CD – the Burn button becomes
available.
When burning a CD from an audio document, it is
especially important to be aware of the “Regions
are Tracks” burning option. The Regions are Tracks
checkbox in the Burn Audio CD dialog controls
whether Regions in the audio document are burned
as separate tracks or not. For more information
see the next section on CD Burning Options.

The state of this checkbox determines whether
dithering should be applied during the burning process.
If you are working with 24-bit content, it is
recommended that you check this box, so as to reduce
the bit depth to 16-bit, while maintaining the highest
possible audio quality through dithering. If this box is
not checked, 24-bit files are simply truncated. More
information on the various dither profiles is available in
Chapter 3: Peak Basics.
Note that dithering preferences are available only
if you are working with 24-bit material. 32-bit
material must be converted/dithered to 24-bit
format, prior to being used in a Playlist.
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Verify After Burn Checkbox

Burning CD-TEXT that contains accented
characters, such as é, á, and ç – requires use of
Mac OS X v.10.5 or later. A CD burner capable of
burning CD-TEXT is also required. You can use
the Terminal to check what your burner is capable
of. See the previous section on Working with CDTEXT and ISRC Codes for more information.

The state of this checkbox determines whether a burned
CD is compared to the audio data contained in the
Playlist and source audio documents, to verify its
accuracy. To verify a CD after burning, be sure this box
is checked.
Note that not all CD burners support verification.
Note that if a burned CD fails verification, it does
not necessarily mean there is a problem with the
CD – it can also indicate simple verification
failure on burners that don’t support it.

Burn in Simulation Mode Checkbox

This checkbox determines whether Peak burns in
simulation mode. In simulation mode, a CD is not
actually burned – instead, Peak goes through all the
motions of burning, and will uncover any problems with
a Playlist before committing to a burned CD. This option
is useful as “burning” in simulation mode can help save
blank media. To use simulation mode, be sure this box is
checked, and be sure to uncheck it when you are ready
to burn a CD.

Write ISRC Codes Checkbox

This checkbox determines whether ISRC codes entered in
the Playlist are burned to CD as embedded subcode data.
To burn ISRC codes to disc, be sure this box is checked. If
the drive being used does not support burning ISRC
codes, this checkbox will be greyed out (unavailable).
Regions are Tracks Checkbox

This checkbox determines whether each Event should
become a separate CD track. If this box is not checked,
one long track will be burned.
This checkbox also affects burning CDs from audio
documents. When burning from an audio document,
any Regions it contains will be made into separate CD
tracks, if this box is checked. Otherwise, the audio
document will be burned as one long track.

Use Buffer Underrun Protection Checkbox

This checkbox determines whether Buffer Underrun
Protection is used while burning a CD. Buffer underrun
errors result from a hard drive not being able to transmit
audio data to a CD burner fast enough while burning a
CD. It is recommended that this box be checked during
the burning process, though most drives support this
automatically.

This checkbox determines whether Markers placed in a
Region’s source audio document are burned to CD as
indexes within tracks.
Creating a New Document from a Playlist

Burn CD-TEXT from Playlist Checkbox

This checkbox determines whether CD-TEXT entered in
the Playlist is burned to CD. To burn CD-TEXT to disc,
be sure this box is checked. If the drive being used does
not support burning CD-TEXT, this checkbox will be
greyed out (unavailable).
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Markers are Indexes

In addition to burning audio CDs, Peak’s Playlist is the
perfect environment for compositing multiple Regions
together to create a single audio document. A Playlist
might be used in this way to create a custom remix, or to
string together a number of vocal takes to create a
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podcast. To learn how to turn multiple Regions into a
single audio document, just follow the steps below.
To create a new Audio Document from the Playlist:

1. With the Playlist window in the foreground, choose
Select All (-A) from the Edit menu (or select only
the desired Events).
2. In the upper right portion of the Playlist interface,
click the Bounce Playlist button – the Bounce
Playlist dialog appears.

SDII (Sound Desiger II)

Choosing this option creates a standard Sound Designer
II (SDII) file, a standard file format for Pro Tools, Peak,
and many other Mac-based audio applications.
JAM Image File

Choosing this option creates a JAM image file, which can
be opened, edited, and burned using Roxio JAM. JAM
Image files are essentially the same as SDII files.
Roxio no longer manufactures the JAM software,
but Toast 8 includes some of JAM’s functionality,
including the ability to open, edit, and burn JAM
image files created with Peak.

To Export a Jam Image file from a Playlist:

1. With the Playlist in the foreground, choose Select
All (-A) from the Edit menu (or select only the
desired Events).
3. In the Bounce Playlist dialog, select the desired
options for the file to be output, and click the
Bounce button.

2. In the upper right portion of the Playlist interface,
click the Bounce Playlist button.
3. In the Bounce Playlist dialog, choose Jam Image
File from the File Format menu, and click the
Bounce button – a Save dialog appears.

Alternatively, choose New>Document from Playlist
from the File menu) – a new file is generated, taking in
to account all edits and effects applied in the Playlist, as
well as all settings made in the Bounce Playlist dialog.
File Format

When creating a new document from a Playlist (also known
as “bouncing” a Playlist), you can choose from several file
formats for the resulting file. These are described below.

4. Choose the desired save location, and click the
Save button – the Playlist is exported as a Jam
Image File.

AIFF

iTunes Playlist

Choosing this option creates a standard AIFF file, a
standard Mac audio file format.

Choosing this option creates an iTunes playlist identical
to the Peak Playlist from which it was burned.
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To Export an iTunes Playlist file from a Peak Playlist:

1. With the Playlist in the foreground, choose Select
All (-A) from the Edit menu (or select only the
desired Events).
2. In the upper right portion of the Playlist interface,
click the Bounce Playlist button.
3. In the Bounce Playlist dialog, choose iTunes
Playlist from the File Format menu, and click the
Bounce button – the name iTunes Playlist dialog
appears.

4. Enter a name for the iTunes Playlist and click the
OK button – the Playlist is exported as an iTunes
Playlist.
Applying CD-TEXT to Tracks in an iTunes playlist.

This highly secure format ensures that the audio data
being burned to CD in the manufacturing process is
identical to the mastering engineer’s intentions when
creating the Playlist in Peak. Exporting as a DDP File Set
results in a folder being created with the following five
files:
DDPID – This file contains the DDP level identifier, Master

If you are working with a Peak Playlist that contains CDTEXT (assuming you will be burning a Red Book format
audio CD containing CD-TEXT), and you are also
planning to bounce it as an iTunes playlist, you can
automatically apply the CD-TEXT data (which iTunes
cannot read) in a format that iTunes can read. To do so,
be sure to check the Use CD-TEXT for naming checkbox
in the Bounce Playlist dialog.
DDP Fileset

ID and UPC/EAN number. It also locates the DDPMS
map stream for physically addressed direct access input
media. The DDP level identifier specifies the level of DDP
implemented and the interpretation of the other DDP
streams.
DDPMS – This file contains information to locate and
process each stream of TS (Text), DS (Subcode) or DM
(Main channel) input data. It contains enough
information to automatically develop PQ subcode data.

This file contains the subcode
information referred to by the DDPMS file.

SUBCODES.DAT –

With the optional DDP extension installed and active,
Peak is capable of exporting a Playlist in DDP (Disc
Description Protocol) 2.0 format, which is commonly
used when delivering a finalized pre-master for CD
manufacturing. DDP files ensures that audio files,
crossfades, edits, and all other data used in a Playlist
remains exactly in the state it was in when exported from
Peak.
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This file contains the audio data referred to
by the previous files in little endian format.

AUDIO.DAT –

– This file contains the CD-TEXT
information entered into the Peak Playlist, that is to be
included on the final CD, created from a bounced DDP
fileset.

CDTEXT.BIN
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Bit Depth

To Export a DDP Fileset from a Playlist:

1. With the Playlist in the foreground, choose Select
All (-A) from the Edit menu.

When creating a new document from a Playlist, you can
specify the desired bit depth for the output file.

2. In the upper left portion of the Playlist interface,
click the Bounce Playlist button.

If you plan to burn the resulting file as an audio
CD, leave the bit depth at the default value of 16bit. It is recommended to change the bit depth
setting only if you have a specific bit-depth
requirement for the project you are working on.

3. In the Bounce Playlist dialog, choose DDP 2.0 Fileset
from the File Format menu, and click the Bounce button
– the Export Playlist to DDP File Set dialog appears.

Dither/Dither Prefs

4. Choose the desired save location, click the Save
DDP Fileset button, which will prompt you to name
and create a folder to which the DDP Fileset will be
saved – the Playlist is exported as a DDP file set.

This checkbox determines whether dithering should be
applied during the burning process. If you are working
with 24-bit content, it is recommended that you check
this box, so as to reduce the bit depth to 16-bit, while
maintaining the highest possible audio quality through
dithering. If this box is not checked, 24-bit files are
simply truncated. More information on the various
dither profiles is available in Chapter 3: Peak Basics.

Exporting in DDP format requires the optional
Peak DDP Extension. If you do not have the DDP
Extension, and need to deliver files in this format,
please contact BIAS for purchase information, at:
US:
International:
Email:
Web:

1-800-775-2427
+1-707-782-1866
sales@bias-inc.com
http://www.bias-inc.com

Sample Rate

When creating a new document from a Playlist, you can
specify the desired sample rate for the output file.
If you plan to burn the resulting file as an audio
CD, leave the sample rate at the default value of
44.1 kHz. It is recommended to change the sample
rate setting only if you have a specific sample rate
requirement for the project you are working on.

Note that dithering preferences are available only
if you are working with 24-bit material.

BIAS DCAT

Choosing one of the BIAS DCAT (Dither Cloning Audio
Technology) algorithms in the Dither Preferences dialog
applies professional dithering and noise shaping during the
Playlist bouncing process. In addition to the many algorithm
presets that are provided for working with different types of
material, you can also adjust and preview Frequency and
Attenuation Skew, to further customize the noise shaping to
best suit the audio material you are working with.
Bounced Playlist Events with Markers or Regions

The ‘Playlist Events Appear as’ radio buttons determine
whether or not bounced files will contain markers,
Regions, or no markers of any kind.
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Use CD-TEXT for Naming

This checkbox allows using CD-TEXT that was entered in
the Playlist to be applied to individual tracks when
bouncing a Peak Playlist as an iTunes playlist. This is
especially useful, as it allows entering track names only
once, and having the exported iTunes playlist’s tracks
metadata entered automatically into iTunes.
Exporting/Printing a Playlist Text Report

In addition to exporting various audio file formats, Peak
can also export customized reports in both formatted
and tab-delimited text formats.
Formatted Playlist Text Report

In the Print/Export Text Report dialog, you can specify
which fields you wish to include in the formatted text
report, and then either export the report as text, in PDF
format, and/or print the formatted report.
To Export a Formatted Text Report in PDF Format:

1. In a completed Playlist project, select all (or just
the desired Events) and click the Export/Print Text
Report button – located in the upper right portion
of the Playlist interface – the Print/Export Text
Report dialog appears.
2. Check the boxes for the information you wish to
include in your report.

Report button – located in the upper right portion
of the Playlist interface – the Print/Export Text
Report dialog appears.
2. Check the boxes for the information you wish to
include in your report.
3. Click the Print/Export PDF button.
4. In the Print dialog, choose the desired Printer,
Presets, etc. and click the Print button.
5. Click the Cancel button to exit the Print/Export
Text Report dialog.
Tab-delimited Playlist Text Report

In the Print/Export Text Report dialog, you can specify
which fields you wish to include in the tab-delimited text
report, and then export it. Tab-delimited text reports are
meant to be imported into another program for
formatting – they are not intended to be used without
additional formatting. Typically, these are imported into
another application, such as FileMaker Pro or Microsoft
Excel, which can deal with tab-delimited text properly.
To Export a Tab-delimited Text Report:

1. In a completed Playlist project, select all (or just
the desired Events) and click the Export/Print Text
Report button – located in the upper right portion
of the Playlist interface – the Print/Export Text
Report dialog appears.
2. Check the boxes for the information you wish to
include in your report.

3. Click the Print/Export PDF button.
4. In the Print dialog, click the PDF button, and from
the menu, choose Save as PDF.
5. In the Save dialog, name your PDF Text Report, and
click the Save button.
6. Click the Cancel button to exit the Print/Export
Text Report dialog.

3. Click the Export Text button – a Save dialog
appears.
4. Name your report, choose a save location, and click
the Save button – your report is exported.
To View the Tab-delimited Text Report (Example):

•
To Print a Formatted Text Report in PDF Format:

1. In a completed Playlist project, select all (or just
the desired Events) and click the Export/Print Text
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Drag it from the Finder onto the Microsoft Excel
application icon. Excel will open the tab-delimited
file.
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of the Playlist interface – the Print/Export Text
Report dialog appears.
2. Check the boxes for the information you wish to
include in your report.
3. Click the Export Text button – a Save dialog
appears.
4. Name your report, choose a save location, and click
the Save button – your report is exported.
To View the Tab-delimited Text Report (Example):

•

Drag it from the Finder onto the Microsoft Excel
application icon. Excel will open the tab-delimited
file.

6

Conclusion
You have now learned all about creating and editing
Playlist documents, and outputting them to a wide
variety of formats. Please continue along to the next
chapter, where you will learn all about Peak’s podcast
publishing tools.
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Chapter 7:
Podcasting

Introduction
In addition to extensive recording and editing tools, Peak
now also allows you to publish podcasts to .Mac, FTP,
and local servers. To publish a podcast, the first thing
you will want to do is assemble the audio program
material that will be your podcast content.

generally referring to a collection of individual
episodes.
While Peak can only record, edit, and directly
publish audio podcasts, it can be used to edit and
master the audio content in a video podcast,
though another utility would be required for
publishing it.

A podcast can be composed of any kind of content you
want. A typical podcast might include voice, music,
and sound effects, but there are no limitations on what
it can be composed of (except for copyrighted
material).
Peak can aid in preparing your program material by
recording voice, musical instruments, (or any other
audio) and importing digital audio files and editing them
together as desired. Once the program is finished, and
has been edited together as a single audio document,
Peak can publish it and help you publicize it in just a few
simple steps.

What is Podcasting?
Podcasting is the process of publishing an audio (or
video) program to a server, and then having listeners
subscribe, and automatically download episodes as they
become available. A podcast is similar to a television
series or radio program, in that it features multiple
episodes. When referring to a podcast, you are

How Podcasting Works
Podcasters first create program material by recording
and editing the content. Podcast program material
could include music, dialogue, interviews – or any
other material desired. Peak offers the perfect
environment for podcast preparation, as it features
many tools for recording and editing, and then
mastering and delivering a final product that sounds as
good as possible. Once the podcast content is finished
various delivery options are available, such as file
format, sample rate, bitrate, etc.
The next step in publishing a podcast is creating an RSS
(which stands for “Really Simple Syndication”) feed,
which will be uploaded to a server along with the actual
podcast, which contains the audio content. Peak’s
Publish Podcast dialog automatically generates an RSS
feed for new podcasts, based on the information entered
into it.
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RSS feeds are only generated for new podcasts. If
you are adding an episode to an existing podcast,
the existing RSS feed is simply modified, by adding
another set of XML tags to it, which describe the
new episode, and provide a link to its location on
the server.

An RSS feed is a text file that contains XML code, and is
used in the syndication process. RSS feeds are broken
down into two main parts – general information about
the podcast, and specific information about each
episode.
The first part of the RSS feed contains general
information about the podcast, such as the name, topic,
keywords to help listeners search for it, a link to the
podcast creator’s website, etc. The second part of an
RSS feed contains information about episodes, or
individual “shows”. Each episode that is published is
appended to the RSS feed, within a set of “<item>”
tags, much like tags used in HTML code. The most

important part contained within an episode’s tags is a
link to the audio content for the episode.
Once the content and RSS feed have been created, the
next step is to publish (upload) both to a server. Peak
supports publishing to .Mac, FTP, and local servers.
Once published, you will want to publicize your podcast.
There are many websites where you can submit your
podcast details for potential subscribers to find. Some of
these include:
•

http://www.podcastalley.com/

•

http://www.podcastingnews.com/forum/links.php

•

iTunes Music Store’s Podcast Directory (via iTunes)

Peak’s Publish Podcast dialog offers an option to
automatically submit your podcast to the iTunes Music
Store’s Podcast directory as a final step in the publishing
process. This is done from within the iTunes application,
rather than on a website.

Anatomy of an RSS feed – showing the “Channel” level tags that describe a podcast as a whole, and the “Item” level tags that describe a single episode.
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Producing your podcast
This section briefly covers the workflow of getting your
podcast ready to publish. It’s a good idea to familiarize
yourself with Peak’s extensive recording, editing,
processing, and mastering tools before attempting to
also use Peak for podcast publishing.
Chapters 3, 4, 5, 6, 8, and 9 in your Peak User’s Guide will
contain the most useful information for those who are
new to using Peak.
The iTunes Music Store’s Podcast Directory is an excellent resource for
publicizing and discovering podcasts.

In addition to making your podcast known via the iTunes
Music Store, you can also place a link to your RSS feed on
your own website. It’s very common these days to see “RSS”
icons on websites. You can Control-click (or right-click) on
such links to copy them, and then paste them into the
application you use to subscribe and listen to podcasts with.

Record & Gather Content

Once you have a podcast in mind, the first step in producing
it is gathering content, which could mean recording voice,
music, or ambient sounds – as well as importing CD tracks,
or opening existing digital audio files from your hard drive.
It’s common to record interviews via the web with
Skype, iChat AV, etc. Peak 6 is designed to record
through professional, Core Audio compatible
audio hardware, and does not record the audio
output of other applications (such as Skype, iChat
AV). However, Peak includes Wire Tap Pro from
Ambrosia Software, which can be used to record
such interviews as digital audio files, which can
be used when assembling your podcast content.

The RSS feed icon is very common on websites – it indicates that there
is an RSS feed that may be subscribed to.

Once subscribed to a podcast, the aggregator application
is scheduled to check the RSS feed at certain intervals. If
the RSS feed has been updated to included a new
episode, it is downloaded. At that point, the episode
may be listened to on the computer to which it was
downloaded, or may be transferred to a portable media
player, such as an iPod (which is where the “podcasting”
term originated).

Peak also includes Soundflower, from Cycling ’74, which
converts the audio output of applications like Skype,
iChat AV, Safari, Firefox, etc. into a virtual hardware
input, which can be recorded by Peak directly.
To learn more about using these included
applications, please see the documentation
included with them on the Peak Pro Production
Pack disc, included with some Peak 6 packages.

Not all RSS feeds link to audio, as they do in the case
of a podcast. RSS feeds may also be linked to video
(“video podcasts”), or to text (“blogs”), or pictures
(“photocasts”) .

Edit & Master

When you have gathered the various pieces of content that
will make up your podcast, it’s time to edit them together.
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You’ll find Peak’s extensive editing and digital signal
processing tools will come in handy for arranging your
background music, interview clips, and other material.

To Add an Episode to an Existing Podcast:

When adding a new episode to an existing
podcast, Peak requires a local copy of the RSS feed,
as it must append this file with tags describing the
new episode, then publish it to the server, replacing
the original RSS file. There are two ways to do this:

Once your final edits have been made, you’ll want to master
the final podcast content, using Peak’s DSP tools and plugins. Mastering processes you may wish to apply will likely
include normalization, equalization, and compression.

• Prior to publishing to a server on the internet,
publish a local copy, using the Save to Disk option
in the Publish well. Publishing to disk is described
later in this chapter.

Publishing your Podcast

Once your podcast is edited as desired, and has been
condensed down to a single Peak audio document, you
can then publish it. If you are already familiar with
podcasting, you should be able to follow the few simple
steps below to get started.

• Use the Finder’s “Connect to Server” command,
the Mac “Terminal” utility, or a third-party file
transfer utility (such as Transmit or Fetch), to
connect to your server, and download a copy of
the RSS feed.

There are two forms of publishing a podcast:
•

Posting a new podcast, which means you are creating
a brand new RSS feed, and publishing it, and
(uploading) an audio file (a first, single episode).

•

Adding an episode to an existing podcast, by
appending an existing RSS feed with a new set of
XML tags, which describe the new episode – and
uploading a new audio file, which contains the
audio content for the new episode.

1. Create, edit, process content as desired, save as a
single audio document.
2. Choose Publish Podcast from File menu.
3. When the Publish Podcast dialog appears, uncheck
the “New Podcast RSS” checkbox – this will grey
out the Podcast Information and iTunes Extensions
wells, as the channel-level information initially
entered in the original RSS feed will be re-used.

To Publish a New Podcast:

1. Create, edit, process content as desired, save as a
single audio document.
2. Choose Publish Podcast from File menu.

4. Enter new information about the new episode in
the Episode Information fields, paying close
attention to the Audio File Name on Server, and
Link fields.

3. Enter podcast, episode, iTunes extensions, audio
encoding and server details.

Be sure the Audio File Name on Server and Link
fields are filled out appropriately, so that you do not
overwrite an earlier episode, and that the updated
RSS feed points to the new episode being added.

4. Click the Publish button – your podcast is
published.
5. Peak automatically copies the URL to your
podcast’s RSS feed to the clipboard – open your
aggregator application (i.e., iTunes, Juice,
NewsFire), then use its “Subscribe” function, and
paste in the URL to subscribe and test out your
new podcast.
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5. Click the Publish button – Peak will prompt you to
locate a local copy of the podcast’s RSS feed.
6. In the Open dialog that is presented, locate a local copy
of the podcast’s RSS feed, and click the Open button.

Peak 6 User’s Guide

If you are new to podcasting, you may wish to first
review the rest of this chapter, to become more
familiar with the information that is required in
Peak’s Publish Podcast dialog.

7. Peak will prompt you that you are about to
replace/overwrite the original copy of the RSS feed
on your server – click the Replace button to
continue the publishing process.
8. Open your aggregator application (i.e., iTunes,
Juice, NewsFire), and navigate to Podcasts in your
Library – locate your podcast, and click the Refresh
button to download the new episode.
If you have not already subscribed, be aware that Peak
automatically copies the URL to your podcast’s RSS
feed to the clipboard. To subscribe, open your
aggregator application (i.e., iTunes, Juice, NewsFire)
and use its “Subscribe to Podcast” function, and paste
in the URL to subscribe and all of the podcast’s
episodes will be downloaded.

The Publish Podcast Dialog
Publishing a podcast using Peak is as simple as choosing
the Publish Podcast command from the File menu, and
entering a few important pieces of information about
your podcast. When this command is chosen, Peak
attempts to publish the foreground audio document.
The following section describes the various fields in the
Publish Podcast dialog in detail.

Peak’s Publish Podcast dialog – showing the settings used to create the example podcast used in this chapter.
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Where Information from Peak Appears in iTunes
The diagrams below illustrate where the information entered in Peak appears in iTunes. Each callout represents a
field in Peak’s Publish Podcast dialog, and shows where in the iTunes interface that field’s data appears. Some of the
information appears in multiple locations in iTunes.
Episode Title
Keywords
(searchable here)

Image
(mp3 only)

Podcast Title

iTunes Summary

Podcast Description
Podcast Title

Episode Advisory

Podcast Advisory

iTunes Subtitle

Episode Title
Author

Podcast Title

Format/Settings

Genre
The iTunes “Get Info” dialog – showing “Summary” Tab
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The iTunes “Get Info” dialog – showing “Info” Tab

Peak 6 User’s Guide

Podcast Information

Author

Fields in the beveled Podcast Information well create
XML tags at both the “channel” and “item” level.
Channel-level tags are general and contain information
about the podcast, but not about individual episodes.
Item-level tags contain information specific to a
particular episode.

The Author field is used for the name of the author of the
overall podcast, as well as for each individual episode.

New Podcast RSS Checkbox

The Author field contents are added into an RSS feed at
both the channel and item level.

The state of the New Podcast RSS Checkbox determines
whether an entirely new podcast is created (with at least
one episode), or whether an episode is being added to
an existing podcast. If you are creating an entirely new
podcast, this box should be checked. If you are adding
an episode, it should be unchecked.

The text entered in the Author field in Peak’s Publish Podcast
dialog appear in iTunes “Get Info” window under the
Summary tab, as the second line, to the right of the podcast
artwork area, and under the Info tab, in the “Artist” field.

Website Link

The Website Link field contents do not appear directly
within the iTunes Podcast Directory, but the publisher’s
website can be accessed by clicking the Website button,
when browsing a listing in the Podcast Directory.

Podcast Title

The Podcast Title field contains the name of the overall
podcast, or collection of episodes. For example, a podcast
about learning how to edit digital audio with Peak might
be called “Learning Peak”, while a specific episode might
be called “Using the Hand, Zoom, and Pencil Tools”.
In the example above, the episode title would not
be entered in the Podcast Title field, but instead
would be entered in the “Episode Title” field, which
is located in the Episode Information well.

The text entered in the Podcast Title field in Peak’s
Publish Podcast dialog appears in the main iTunes
window in the “Podcast” column (this column is
sometimes also referred to as the “Name” column). The
Podcast Title field’s contents also appear in iTunes “Get
Info” window under the Summary tab, as the third line,
to the right of the podcast artwork area, and under the
Info tab, in the “Album” field.
The Podcast Title field contents are added into an RSS
feed at both the channel and item level.

Website Link

A podcast publisher’s website can be accessed by clicking the
“Website” button the iTunes Podcast Directory.

The Website Link field contents are added into an RSS
feed at the channel level.
Podcast Description

The contents of the Podcast Description field appear in
the iTunes “Description” column, and describe an entire
podcast.
The iTunes “Description” column can display two
different types of information, depending on
whether the row being viewed is that of an entire
podcast, or an individual episode.

In a row containing an entire podcast description, (these
rows have a disclosure triangle to the left of the name)
the “Description” field shows the contents of the Podcast

Chapter 7: Podcasting

187

7

Information well’s “Description” field, in Peak’s Publish
Podcast dialog.

when browsing podcasts in your iTunes library) column,
but only for an individual episode.

The Podcast Description field contents are added into an
RSS feed at the channel level.

Episode Description

Keywords

The contents of the Keywords field can be used to search
for a podcast within iTunes, but they do not actually
appear anywhere in iTunes. For example, if you added
the keyword “Peak”, it would not appear anywhere in
iTunes, but you could search for a podcast about Peak by
typing “Peak” in the iTunes search field.

Up to twelve keywords (separated with commas) may be used.
The Keywords field contents are added into an RSS feed
at the channel level only, and can only be used to locate
a podcast, not an individual episode.

The Episode Description field contents do not appear in
iTunes, but are used to describe an episode in other
podcast aggregators, such as Juice, NewsFire, etc.
Essentially, this is the non-iTunes equivalent to the iTunes
Subtitle field (described below).

Peak’s Episode Description field contents work like the iTunes Subtitle
field, but for other aggregators besides iTunes – NewsFire shown here.

iTunes Subtitle

The contents of the iTunes Subtitle field appear in the iTunes
“Description” column, and describe individual episodes.

Filename on Server (xml)

The iTunes “Description” column can display two
different types of information, depending on
whether the row being viewed is that of an entire
podcast, or an individual episode.

The Filename on Server field is used to designate the name
of the XML file (the RSS feed to your podcast) that Peak
generates and uploads during the publishing process.
This field’s contents do not appear within the XML code
that makes up the RSS feed, they just name the file itself.
Episode Information

Fields in the Episode Information well create XML tags at
the item level. These tags contain information specific to
a particular episode.

In an iTunes library row containing individual episode
information, the “Description” field shows the contents
of the Episode Information well’s “iTunes Subtitle” field,
in Peak’s Publish Podcast dialog.
The iTunes Subtitle field contents are added into an RSS
feed at the item level.
iTunes Summary

Episode Title

The contents of the Episode Title field appear in the
iTunes “Name” (the Name column appears as “Podcast”
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The iTunes Summary field contents appear in iTunes in a
secondary window, when you click the “i” icon in the
Description column in an episode’s row. This information

Peak 6 User’s Guide

also appears in the iTunes Podcast Directory in the iTunes
Music Store, under the Podcast Description section.

•

Bit Rate –

Note that when used in conjunction with the
Target Output menu that you can specify a target
bit rate, and apply variable bit rate encoding. This
uses the Bit Rate menu’s setting as a baseline, and
when possible (depending on the audio content)
will reduce the bit rate.

in iTunes, clicking the “i” icon in an episode’s row opens a secondary
window, which displays the contents of the iTunes Summary field in
Peak’s Publish Podcast dialog.

•

Episode Advisory

This menu sets the desired bit rate.

Output Sample Rate –

This menu sets the desired

sample rate.

The Episode Advisory pop-up menu’s setting affects the
rating of an episode only. In iTunes, the rating will appear
in an episode’s row, under the “Podcast” column, as well
as under the “Summary” tab in the “Get Info” window.

•

Encoder Quality – This menu controls the quality of
encoding, and has an effect on the file size. Better
quality equals larger files.

7

MP3

It is possible to have differing ratings for the entire
podcast and individual episodes.

•

Mono – When checked, this option will
automatically create a mono file by mixing the left
and right channels together.

Format

•

Bit Rate – The bit rate can be set between 8 and 320 kbps.

The Format pop-up menu allows choosing the encoding
format for a podcast’s audio content to be uploaded.
Options include AAC and mp3. Clicking the Settings
button to the right of the Format menu gives various
options related to each file format.

•

Quality –

•

Edit ID3 Tags – Clicking this button opens Peak’s
Metadata editor window, where various file attributes
can be set, including Title, Artist, Album, Comments,
Genre, Year, and image. Keep in mind this is file
metadata, and is not referenced in an RSS feed.

Settings

This slider sets the quality of encoding,
and has an effect on the file size.

The options available in the Settings dialog will depend
on whether you have set your desired file format to AAC
or mp3. The available options are described below:

When adding an image to a podcast that will be
submitted to the iTunes Podcast Directory, it’s
recommended to use a square, 600 x 600 pixel (or
larger), 72 dpi .jpg or .png file. Peak adds images as
embedded metadata when publishing in mp3
format only – they are not referenced by the RSS feed.

AAC

•

Compressor – This menu sets the type of AAC file
compression to be used.

•

Target Output – This menu sets whether a specified
bit rate is to be strictly adhered to, or whether
variable bit rate encoding from the setting chosen
in the Bit Rate menu is permissible.

Audio Filename on Server

The contents of this field are used to name the audio file
(podcast content) that is published to a server.
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Link

The contents of this field are used to specify a direct link
to the audio file (the podcast’s actual content) on the
server that you publish to. This link is written into the
RSS feed that Peak creates. For each episode (within
each set of “<item>” tags), there will be a unique link
that points an aggregator application to each episode.
It is important to format the link properly. It needs to be
composed of three main parts:
•

Server/Path + File Name + File Format Extension

<YourAccount>! These examples assume your audio
file is named “audio.mp3”, and that you are publishing to
the root level of your server, rather than to a sub-directory.
Earthlink:
•

http://home.earthlink.net/~<YourAccount>/audio.mp3

.Mac:
•

http://homepage.mac.com/<YourAccount>/audio.mp3

iTunes Extensions

For example:
•

http://www.myserver.com/podcasts/ + Audio + .mp3

or:
•

http://www.myserver.com/podcasts/Audio.mp3
Be aware that the link you provide in this field is
usually significantly different than the path used
for uploading. While the link to the file itself is not
what a subscriber uses to direct their aggregator
application to the RSS feed, it is contained in the
RSS feed, and it’s important that the link to the file
be accurate. You can test the link to your file by
posting a file to the directory on your server using
a file transfer client (such as Transmit or Fetch),
and then pasting the link to the file into your
browser. If the link you paste into your browser is
accurate, then the audio file will play directly in
the browser. If you are not sure how to determine
the appropriate URL to use in the “Link” field, you
may wish to contact your Internet Service
Provider for assistance.

Using iTunes extensions is optional – they are not required
to successfully publish a podcast, but they are required if
you wish to have your podcast appear in the iTunes Podcast
Directory, and to be eligible to be a “featured podcast” in
the iTunes Music Store’s Podcast directory.
The iTunes Music Store staff chooses interesting
podcasts to feature based on program and
technical content.

Name

The name field specifies the name of the podcast owner.
Email Address

The email address field specifies the the podcast owner’s
email address.

Real world examples

Below are some real world examples for the links to the
audio content of a podcast, for two well-known Internet
Service Providers – Earthlink and .Mac. In each case, you
would need to substitute your actual account name for
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Peak 6 User’s Guide

The Name and Email address fields are used solely
by Apple, should they need to communicate with
you regarding your podcast. While these are not
publicly displayed in the iTunes Music Store’s
Podcast directory, be aware that they are present
in an RSS feed generated by Peak, and thus easily
accessible to anyone who subscribes to your
podcast.

Categories

Podcast Advisory

The categories that can be chosen here are used for
placing your podcast into a suitable section of the iTunes
Podcast directory.

The Podcast Advisory pop-up menu’s setting affects the
rating of an episode only. In iTunes, the rating will appear
in an episode’s row, under the “Podcast” column, as well
as under the “Summary” tab in the “Get Info” window.

In the original browsing system used by the iTunes
Podcast Directory, the first three categories were used
for browsing – this older system of browsing is accessible
in the Quick Links section of the iTunes Store interface,
near the upper right corner, and is primarily text-based.

It is possible to have differing ratings for the entire
podcast and individual episodes.

Publish Settings

The Publish well in the Publish Podcast dialog is used to
specify details for connecting and uploading audio and
RSS feeds to a server.
Preset

Entering iTunes Extensions “Categories” in Peak, makes your podcast
appear when browsing within the iTunes Podcast Directory, in the
older text-based “Quick Links” section...

iTunes’ newer system of browsing uses just the first
category assigned in this section of Peak’s Publish
Podcast dialog. This browsing system is accessible from
the “iTunes STORE” section of the iTunes Store interface.
This modernized browsing section includes artwork,
subscriber reviews, and other “richer media” content.

The Preset pop-up menu allows saving and recalling the
details for connecting to servers, and is particularly
handy when your server name is long! Server presets are
stored in:
/MacHD/Users/<YourAccount>Library/Preferences/Peak
Server Presets/
As a security precaution, passwords are not stored
in server presets.

Server Type

The Server Type pop-up menu is used to specify what
type of server you will be publishing your podcast to.
Options include publishing to FTP and .Mac servers, and
locally, to the “Sites” folder in your home directory.
FTP

•

Host Name – This field is used to specify the name
of your FTP server.

...or in the newer “Podcasts” section of the iTunes Store.

Chapter 7: Podcasting

191

7

If you are not sure about your FTP connection
information, you may want to check with your
Internet Service Provider. This is typically the
same information that would be used to
connect using a standard FTP client
application.

•

Username –

•

Password –

•

Path –

If you are publishing to your own domain, which
is hosted by another company, it is particularly
important to enter the Host name and Path
correctly. Again, if you are unsure of what
information to enter, please contact your Internet
Service Provider, who should be able to assist you
in determining the correct Host and Path
information to allow successful podcast
publishing.

.Mac
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Username –

•

Password – This field is used for the password of
your .Mac account.

This field is used to specify the
password of your FTP account.

This field is used to specify the path to
a particular directory, where you wish to
publish your podcast. To publish to the root
level of your server, this field can be left
empty.

Use Default .Mac Account checkbox – When
publishing to a .Mac account, Peak defaults to
using .Mac account information that is entered
into the currently logged in user’s System
Preferences. To set or change this default

The Username field is used to
specify the name of the .Mac account you are
publishing to (if publishing to your own account,
you may with the enter your .Mac account
information in the Mac OS System Preferences
(as described above) to save time in the
publishing process.

•

This field is used to specify the
username of your FTP account.

If you wish to publish to another directory on your FTP
server, you will need to specify a path to that directory.
For example, if your FTP server name is
“ftp.myserver.com” and you have created a directory
called “Podcasts” at the root level, then you would enter
“/Podcasts/” in the Path field.

•

information, open the System Preferences from
the Apple menu, and then open the .Mac
preference pane, where you can add or edit
account information.

The Username and Password fields described
above appear only when the Use Default .Mac
Account checkbox is unchecked.

•

Path – This field is used to specify the path to a
particular directory, where you wish to publish
your podcast. Because of the way file permissions
are set up in a .Mac account, you must publish
either to the Sites directory, or to another
directory within the Sites directory.

If you wish to publish to another directory within the
Sites directory, you will need to specify a path to that
directory. For example, if you have created a directory
called “Podcasts” within the “Sites” directory, then you
would enter “/Sites/Podcasts/” in the Path field.
Save to Disk

You may wish to publish your podcast locally before you
publish to a server, so as to learn more about the process
of podcasting, or simply to test how things will work.
Publishing locally is similar to publishing web pages
locally – to work properly within iTunes and many other
aggregators, your RSS feed and the audio content must
be published to:
/MacHD/Users/<YourAccount>/Documents/Sites/
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Submit to iTunes Music Store after Publishing
checkbox

In order to subscribe to a locally published podcast, it must be
published to the “Sites” folder in your home directory

This checkbox determines whether your podcast is
submitted to the podcast directory located in the iTunes
Music Store. This is an excellent way to publicize your
podcast, as it becomes searchable within the iTunes
Music Store’s Podcast Directory, based on the keywords
you enter in the iTunes Extensions section of the Publish
Podcast dialog.
To Submit your Podcast to the iTunes Music Store’s
Podcast directory:

If you wish to publish to another directory within the
Sites directory, you will need to specify a path to that
directory. For example, if you have created a directory
called “Podcasts” within the “Sites” directory, then you
would enter “/Sites/Podcasts/” in the Path field.
In addition, you must enable Personal Web Sharing in the
Mac OS System Preferences.

1. Prepare your podcast using Peak’s various
recording, editing, and processing tools.
2. From the File Menu, choose Publish Podcast.
3. Fill out the required fields that are suitable for your
podcast, making sure to check the Submit to
iTunes Music Store after Publishing checkbox.
4. Click the Publish button – once published, Peak
copies the URL of your podcast’s RSS feed to the
clipboard, and automatically directs iTunes to the
Submit Podcasts to the iTunes Directory page in
the iTunes Music Store – once there, you simply
paste in your podcast feed URL, and click the
Continue button.

The Mac OS Sharing Preference Pane allows you to configure Web
Sharing preferences.

When saving to the Sites folder in your home
directory, the URL for the RSS feed (assuming RSS
feed name is “rssfeed.xml” will be:
http://localhost/~<YourAccount>/rssfeed.xml

Submitting your podcast to the iTunes Directory is as simple as pasting
in the URL to your RSS feed.

The link to the audio file (assuming the file name
is “audio.mp3”) will be:
http://localhost/~<YourAccount>/audio.mp3
Chapter 7: Podcasting

Be aware that you cannot submit a URL for a
locally published RSS feed to the iTunes Podcast
Directory.
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Conclusion
You have now learned how to publish audio podcasts
with Peak. Peak provides a wealth of tools for creating
and editing the actual audio content that makes up a
podcast – to learn more about Peak’s tools, please see
Chapters 3, 4, 5, 6, 8, and 9 in your User’s Guide. These
contain the most relevant discussions of tools and
techniques for podcast production.
Many excellent resources are available for those who
wish to learn more about podcasting. Michael
Geoghagan’s “Podcast Solutions” book is an excellent allaround resource, while Apple’s website offers a wealth of
technical information, and is a great source to learn
more about the technical side of podcasting:
http://www.apple.com/itunes/store/podcaststechspecs.html
To learn about Peak’s Digital Signal Processing tools,
please continue to the next chapter.
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Chapter 8:
DSP

Introduction
Peak allows you to transform your audio with a variety of
powerful Digital Signal Processing (DSP) tools. You can
apply these tools at any time by first making a selection
in an audio document and then choosing the desired
menu command from the DSP menu.

Processing Audio with Peak’s DSP Tools
The following general procedure describes how to
process a selection in an audio document, or the entire
document, with a particular DSP function. The specific
capabilities and parameters of the DSP function will vary.
To process audio with a DSP function:

1. Select the portion of the audio that you wish to
process with the DSP function. If no selection is
made, the entire document will be processed.

Peak’s Audio Processing Tools
Peak’s DSP capabilities provide composers and
professional sound designers with many interesting and
useful audio effects and processing tools. Peak’s many
DSP functions include Add, Amplitude Fit, Auto Define
Tracks, Bit Usage, Change Duration, Change Duration
( Variable), Change Gain, Change Pitch, Change Pitch
( Variable), Convert Sample Rate, Convolve, Crossfade
Loop, Envelope From Audio, Fade In, Fade Out, Find
Peak, Gain Envelope, Harmonic Rotate, ImpulseVerb,
Invert, Loop Tuner, Mono to Stereo, Stereo To Mono,
Mix, Modify Sample Rate, Modulate, Normalize,
Normalize (RMS), Panner, Perpetual Looper, Phase
Vocoder, Rappify, Remove DC Offset, Repair Click, Repair
Clicks, Reverse Boomerang, Reverse, Strip Silence, Swap
Channels, Threshold, and Voiceover Ducking.
The following sections explain how to use each of these
functions.
By default, Peak’s DSP tools appear in the DSP
menu in alphabetical order. A user selectable “Use
Subcategories in DSP Menu” preference is also
available, which allows DSP tools to be grouped by
type of function (i.e., Analysis, Conversion, Gain,
etc.). For more information, please see Chapter
12: Peak Menus.

2. Select the type of process you wish to use from the
DSP menu.
3. A dialog appears allowing you to set the
parameters for the DSP function.
4. Set the parameters for the DSP function as desired
and click OK. Peak processes the selection with
the DSP function or plug-in.
Note that if no selection is made, Peak will apply
processing to the entire audio document.

Add
The Add command adds any selection of audio copied to the
clipboard into the audio document at the selection point. To
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use the Add command, you must first copy a selection of
audio. The copied material can then be mixed into the
target audio material. The Add command can also be
customized using an envelope. If you wish to Add material
with a variable level, click the envelope button in the Add
dialog. The Add function differs from the Mix function
slightly, in that the Add function never alters the amplitude
level of the target audio material you are adding to – you can
only specify the level of the material you are adding.

Amplitude Fit
Amplitude Fit provides granular normalization of an
audio selection on a grain-by-grain basis. Grains are
small groups of samples, often around 30ms. As each
grain is read in, it is normalized according to the
Amplitude Fit Envelope – each normalized grain
crossfaded with the previous grain and written out as the
result. Amplitude Fit can be used to maximize the level
of an audio selection, or to make quiet passages as loud
as louder passages.

The Add Dialog

To use the Add command:

The Amplitude Fit Dialog

1. Select the audio that you wish to Add to another
audio document and choose Copy from the Edit
menu (-C) or Toolbar.
2. Select the audio that you wish to add the copied
material into.
3. Choose Add from the DSP menu or Toolbar.
4. In the dialog that appears, use the slider to adjust
the amount of the copied signal that you wish to
add into the target audio document. To add copied
material with a variable level, click the envelope
button, create the desired envelope, click the
Change button, and then click the Add button. Be
careful not to add too high an amount, which can
potentially clip the signal.

To apply the Amplitude Envelope to an audio selection:

1. Select the audio material you wish to process.
2. Choose Amplitude Envelope from the DSP menu.
3. Draw the amplitude envelope you wish to apply to
the audio selection in the envelope editor. Points
above and below the 0% line will normalize the
selected audio using the grain-by-grain
normalization technique.

LE

Amplitude Fit is not available in Peak LE.

5. Click OK. Peak adds the two signals together.
6. To hear the results, press the Spacebar.

Auto Define Tracks

LE

The Auto Define Tracks tool allows you to automatically
split audio recordings into separate Regions, each of which
will become an individual CD track when an audio CD is
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burned. This tool is useful for quickly editing LP and
cassette recordings, in preparation for burning them to
CD, or exporting them for use with a portable music player.

parameters are available to help Peak correctly
distinguish between songs and the gaps between them.
Minimum Silence Between Tracks

This field is used to enter the minimum gap time between
songs in the audio document you are working with. If a
recording you are working with contains two second gaps
between each song, start with the default value of “2.00”
in this field. If the gaps between songs vary in length,
enter the value of the shortest gap in the entire recording.
To measure the gap time between songs, activate
the Cursor Info overlay by selecting Show Cursor
Info (-Shift-T) from the Options menu, and then
select the gap between songs in the audio
waveform – the Cursor Info overlay will tell you
the length of the selected area. You may also need
to set your preferred Time Units to Min:Sec:ms –
this can be done in the Options Menu>Time Units.

The Auto Define Tracks dialog

This DSP tool works by automatically placing Region
markers into an audio document based on audio level,
minimum period of silence between songs, and
minimum song duration. Peak analyzes the audio levels
throughout a document, and places Region markers
around each song. The louder parts are considered to be
songs, and the quieter parts are the gaps between them.
Since some songs may contain very quiet parts that could
mistakenly be interpreted as gaps between tracks, a few

Minimum Track Duration

Peak needs to have some information about the length of
each song, in order to accurately divide a long recording

Before using the Auto Define Tracks tool on an LP recording – note the area of silence near the middle of the recording has not yet been edited out...

After deleting silence from middle of the recording (where the LP was flipped over and Peak was left recording), and using Auto Define Tracks...
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into individual songs. The Minimum Track Duration
parameter tells Peak how long the shortest song in a
recording is, and helps ensure that Region markers are
placed in the correct location in the audio waveform –
that is, a begin Region marker just before a song starts,
and an end Region marker just after a song ends – even
if the audio level falls below the threshold value set with
the Silence is Audio Below slider (see next section). If a
recording you are working with contains songs that are
all approximately 4-5 minutes long, a good value to enter
in this field would be 240 seconds (4 minutes).

provided you have entered accurate settings for the other
parameters that define tracks. There may be times
however, where Peak detects more or fewer songs than
the recording actually contains. You may choose to
define the number of tracks using the Silence is Audio
Below slider, or by typing in a known number of songs in
the recording, and then fine tuning with the Silence is
Audio Below slider. Be aware that the values you enter in
the Number of Songs field, and the values you set with
the Silence is Audio Below slider may override each other.
To Auto Define Tracks:

1. Open a recording from a cassette or LP.

Silence is Audio Below slider

This slider controls the threshold level between audio
material you wish to define as a Region and the gaps
between it. As this slider is moved, you will notice Region
markers appearing in the audio waveform in the
background, and you will also notice the value in the
Number of Songs field changing. (More information on
the Number of Songs field is in the next section). For
example, if you are working with a recording from a
cassette, the gaps will typically contain hiss or other
noise that is not completely silent, but has a significantly
lower amplitude level than the program material that you
are trying to isolate into tracks. By adjusting the Silence
is Audio Below slider, you can make the judgment as to
what should be silence, even if it does contain some low
level audio such as tape hiss, or other background noise.

2. Select All (-A).
3. From the DSP menu, choose Auto Define Tracks.
4. In the Minimum Silence Between Songs field, enter
the shortest amount of time (gap time) between
any two songs in the entire recording.
5. In the Minimum Track Duration field, enter the
length of the shortest song in the recording.
6. Adjust the Silence is Audio Below slider until the
Number of Songs field reflects the actual number
of songs in the recording – Peak inserts Region
markers for each song detected (you can visually
scan the waveform of the entire recording and
count the number of individual songs).
7. Click OK.

Number of Songs field

This numerical field is tied to the Silence is Audio Below
slider, and displays the number of songs that Peak
automatically detects in a recording, based on the settings
used for Minimum Silence Between Songs, Minimum
Track Duration, and Silence is Audio Below. Depending
on the settings you choose, Peak will detect a different
number of songs, and this field will display different
numbers. When the Silence is Audio Below slider is
moved, the number of songs detected will update, and
typing in a new value in the Number of Songs field will
update the Silence is Audio Below slider. Typically, the
automatic number of songs detected is very accurate,
200

Tips for using Auto Define Tracks

While Auto Define Tracks can greatly speed up the process
of dividing audio documents into track, there are a few
tips for getting the best results – these are outlined below.
Before Auto Defining Tracks

When recording cassettes and LPs, you will be working
with fairly long audio documents, and there are a few
things you can do to get the most accurate results with
the Auto Define Tracks tool.
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•

•

•

Zoom out all the way, so that you can see the entire
audio document from beginning to end. This way,
when setting parameters in the Auto Define Tracks
dialog, Region markers being placed into the audio
waveform will be visible throughout the document.
Delete excess silence – if you have recorded excess
silence at the beginning or end of the audio
document, or recorded a long pause when “flipping”
a cassette or LP, it’s a good idea to edit this out before
attempting to use the Auto Define Tracks tool.
You may want to apply noise reduction for clicks,
crackles, pops, broadband noise, and hum before
auto-defining tracks. These types of noise are
reflected in the audio waveform and may interfere
with accurate placement of markers. Some of
Peak’s built-in tools can help reduce/remove
certain kinds of unwanted noise, but for the best
results, BIAS recommends using SoundSoap or
SoundSoap Pro. More information is available at:
http://www.bias-inc.com/products/soundsoap/
http://www.bias-inc.com/products/soundsoappro/

•

Get an idea of the length of songs and gap times
between songs – this will give the most accurate
results in placing Region markers/creating tracks.
From the Options menu, choose Show Cursor Info
(-Shift-T), this will show you the duration of the
selected portion of the waveform.

•

Visually scan the audio waveform, while looking for:

After Auto Defining Tracks

There may be times when an anomaly in the audio
waveform, or a less than ideal setting causes a track/Region
marker to be placed in the wrong location. In some cases,
when most of the tracks have been identified correctly, but
one or two have not, it may be easiest to simply adjust the
markers that are in the wrong position.
Region markers may be moved by clicking and dragging the
triangular base to the left or right. Also, by engaging Peak’s
Vertical Lock mode, you may move the end of one
song/Region and the beginning of the next at the same time.
This technique is especially useful when working with
live recordings or DJ mixes, where it’s important to
preserve the overall duration and timing – but a track
index needs to be adjusted into the correct position.
Nudging Markers

If all the Region markers placed into an audio document are
incorrectly placed, but are off by a small amount, you may
wish to use the Nudge feature to adjust them all
simultaneously. To nudge a group of markers, select the
portion of the audio waveform that contains the markers
you wish to nudge, and then choose Nudge from the Action
menu. Now that you know a bit about Peak’s Auto Define
Tracks tool, give it a try! This feature can save a great deal of
time, and the more you use it, and get a feel for how the
various parameters need to be set, the faster it will work.

you should
be able to see how many individual songs there are
by counting the number of high amplitude areas.

The number of songs in the recording –

select the shortest song from
beginning to end, and then turn on Cursor Info,
which will show the length of the selected part of
the waveform. You may need to zoom in to make
a more accurate selection.

The shortest song –

The shortest gap time between songs – select the
gap between songs and measure using the Cursor
Info overlay.

Bit Usage
The Bit Usage meter allows you to monitor bit saturation,
degradation, and the “true” bit depth of a file. The graph
display area in the Bit Usage dialog plots the bits in the
current selection on the vertical axis, and the duration of
the selection on the horizontal axis.
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Change Duration
You can specify the change in duration by a value in
seconds, a percentage of the original, or, for rhythmicallyoriented material, beats per minute. In addition, when
working with rhythmically-oriented material, a special
Transient mode may be used for optimal results.

The Bit Usage Meter

The small rectangles that make up the graph appear in
different shades of black, white, and green. These
represent the level of bit usage over the selected amount
of time. Darker shades equate to more bit usage, while
lighter shades indicate less bit usage. Each rectangle
represents many samples, and the shading corresponds
to the audio waveform. The primary purpose of this
display is to show whether the audio content has been
degraded by processing that has been applied to the file.
For example, the screenshot above shows a 32-bit file, which
has fairly severe bit usage degradation in bits 01 - 07 (in the
upper part of the display), and also in bits 29 - 31 (in the
lower part) – these are represented as vertical white streaks.
The Bit Usage meter also shows the “true” bit depth of a file.
For example, a file recorded at 16-bit resolution, and then
saved as a 24-bit file will be a larger file, but will contain
empty bits. It would appear in the Bit Usage meter with bits
00 - 15 in use (shaded with black and green rectangles),
while bits 16 - 31 would be empty, and appear all white.

1. Select the desired range of audio you wish to examine.
2. Choose Bit Usage from the DSP menu – The bit
usage meter will appear, and plot a graph showing
the status of bit usage in the selected area of audio.

202

A change in duration by a reasonable amount, about 85%
to 115%, can be very convincing. Exaggerated time
stretching, 200% or more, can result in some very
interesting granular textures. Try experimenting with the
Change Duration function on drums, rhythm loops,
speech, sampled instruments or sound effects to achieve
a wide variety of useful effects.
To change the duration of a selection:

1. Select the portion of audio that you wish to process.
2. Choose Change Duration from DSP menu. The
Change Duration dialog appears.
3. Click the radio button for one of the following
fields, and enter a new duration value:

To use the Bit Usage meter:

LE

The Change Duration dialog

• In the Seconds field, enter a new duration in
seconds.
•

Bit Usage is not available in Peak LE.
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In the Percentage field, type the percentage
you wish to slow down or speed up the
selected audio. For example, typing “50%”
will speed up the selection to half its original
duration, typing “200%” will slow down the
selection to twice its original duration.

•

•

In the Beats per minute field, type the old
tempo for the selected audio and then the
desired new tempo, and Peak will compute
the correct new duration. Use this field to
change the duration of rhythmically-oriented
material.
Click the Tempo Envelope radio button to
Create a custom Tempo Envelope that will
vary the tempo/duration dynamically.

4. If you wish to adjust the quality of the duration
change, click on the Prefs button. The DSP
Preferences dialog will appear, allowing you to
choose the size of the Time Shifting Window and
Sample Rate Conversion quality that will be used in
processing. For the Time Shifting Window, a lower
value is best for simpler, monophonic sounds, while
a higher value yields the best results for more
complex, polyrhythmic sounds. For the Sample Rate
Conversion quality, 1 is lowest quality (and uses the
least amount of CPU power) and 10 is the highest
quality (using the most CPU power). Once you have
set these preferences to your liking, click OK.

LE

Peak LE features a more basic Change Duration
algorithm. It features the same controls with the
exception of the Tempo Envelope, and is limited in
quality compared to the algorithm used in Peak Pro.

Change Duration (Variable)
The Variable Change Duration feature allows the selected
portion of an audio document to have its duration
modified dynamically over time, using Peak’s familiar
envelope editor dialog.
This DSP menu item offers quick access to Peak’s
Duration Envelope editor dialog – it opens the same
editor window as when using the Duration Envelope
mode of the standard Change Duration DSP command.

To apply variable duration change to an audio selection:

1. Select the audio material you wish to process.
2. Choose Change Duration (Variable) from the DSP menu.
3. Create the tempo envelope you wish to apply to the
audio selection in the envelope editor, by clicking
to create breakpoints. Points above the 0% line will
lengthen the selected audio’s duration (i.e., slow
down playback). Points below the 0% line will
shorten the duration (i.e., speed up playback).
4. To process the audio selection using the envelope,
press Change.

The DSP Preferences dialog

5. Click OK when you have finished. Peak changes
the duration of the selection according to the
settings that you chose.
A Sample Rate Conversion setting of 8 is the
recommended starting point.
The Duration Envelope dialog
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Change Gain

Change Pitch

The Change Gain function changes the gain (i.e.,
amplitude) of a selection. You can specify the
amount of gain change either in decibels (dB) or as
a percentage. If you wish to double the volume of
a sound, you must apply approximately 6 dB of
gain change, or add 200%. Enable the Clipguard
checkbox in the Change Gain dialog to protect
against the possibility of clipping. Clipguard will
search through the audio document or selection
for the maximum peak in amplitude, and then limit
the Change Gain slider’s range based on the
maximum peak it finds in the audio document or
selection.

The Change Pitch function allows you to alter the pitch
of an audio selection by as much as an octave, with
excellent sounding results.

The Change Pitch dialog

The Change Pitch dialog uses a pitch slider that allows
you to choose a new pitch by musical interval, and “fine
tune” the pitch change by smaller increments called
“cents.” (Cents are divisions of a musical octave-one
octave is equivalent to 1200 cents – thus, 100 cents is a
semi-tone, 50 cents a quarter-tone, etc.)
The Change Gain dialog

To change the gain of a selection:

1. Select the portion of the audio that you wish to
process.
2. Choose the Change Gain command from the DSP
menu or from the Toolbar. The Change Gain dialog
appears.
3. Enter the number of decibels or percentage by
which you wish to change the amplitude of the
selection by.
4. If you wish to protect against the possibility of
clipping, enable Clipguard by checking the
Clipguard checkbox.
5. Click OK when you have finished. Peak will
change the gain of the signal by the amount you
specified.

You can also choose to alter the length, or duration, of
the selection just as you would by slowing down or
speeding up analog tape, or you can choose to preserve
the duration of the selection (something not possible
with analog tape!).
To change the pitch of an audio selection:

1. Select the portion of the audio that you wish to process.
2. Choose Change Pitch from the DSP menu or from
the Toolbar. The Change Pitch dialog appears.
3. Select the interval of transposition up or down by
entering a positive or negative value in cents in the
“Change Pitch by” field or by using the pitch slider.
Fine-tune the interval of transposition by entering
a positive or negative value in cents in the “Fine
Tune by” field or by using the Fine Tune slider.
Check the Preserve Duration checkbox to retain
the original duration of the selected audio.
4. If you wish to adjust the quality of the pitch change,
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click on the Prefs button. The DSP Preferences dialog
will appear, allowing you to choose the size of the
Time Shifting Window and Sample Rate Conversion
quality that will be used in processing. For the Time
Shifting Window, a lower value is best for simpler,
monophonic sounds, while a higher value yields the
best results for more complex, polyrhythmic sounds.
For the Sample Rate Conversion quality, 1 is lowest
quality (and uses the least amount of CPU power) and
10 is the highest quality (using the most CPU power).
Once you have set these preferences to your liking,
click OK to exit the DSP Preferences dialog.

To apply variable pitch change to an audio selection:

1. Select the audio material you wish to process.
2. Choose Change Pitch (Variable) from the DSP menu.
3. Create the pitch envelope you wish to apply to the
audio selection in the envelope editor, by clicking to
create breakpoints. Points above the 0% line will raise
pitch, and points below the 0% line will lower pitch.
4. To process the audio selection using the pitch
envelope, press Change.

5. Click OK when you have finished. Peak transposes
the pitch of the selected audio up or down by the
amount you specified.

Convert Sample Rate
A Sample Rate Conversion setting of 8 is the
recommended starting point.

LE

Peak LE features a more basic Change Pitch
algorithm. It features the same controls, but is
limited in quality compared to the algorithm used
in Peak Pro.

The Convert Sample Rate command allows you to
change the sample rate of an audio document without
changing its pitch. This feature is very useful for
converting audio material into lower or higher sample
rates as required by other applications. Please note that
sample rate conversion is applied to an entire document.
It cannot be applied to just a selection within a
document.

Change Pitch (Variable)
The Variable Change Pitch function feature allows the
selected portion of an audio document to have its pitch
modified dynamically over time, using Peak’s familiar
envelope editor dialog.
The Convert Sample Rate dialog

Sample rate conversion quality may be set in the DSP
Preferences section of the Preferences dialog. A setting
of 1 is lowest quality (and uses the least amount of CPU
power and takes the least amount of processing time)
and 10 is the highest quality (using the most CPU power
and taking the longest to process).
Pitch Envelope Dialog

Chapter 8: DSP

205

8

The default setting for sample rate conversion is 8, and
this should work well in most cases. In a practical sense,
use the highest setting possible for your particular
computer system’s CPU.
To change the sample rate of a document:

1. Choose Convert Sample Rate from the DSP menu
or Toolbar. The Convert Sample Rate dialog
appears.
2. Type in the sample rate that you wish to convert the
audio document to, or click the down arrow to select
from a pop-up of commonly used sample rates.
3. Click OK. Peak converts the entire audio
document to the selected sample rate.

piano tinkling!). To use the Convolve DSP command,
you must first copy a selection of audio. The copied
material will provide the spectral “character” that you will
apply to the target audio material. Convolution can be
very useful not only for creating new and unusual sound,
but also for giving an audio selection a sense of space.
Try copying a small amount of room noise to the
clipboard and then Convolve it with a selection of audio
– the convolved audio will sound like it is being played
in that room environment.
Users of the Convolve feature will also enjoy the
additional parameters of the ImpulseVerb DSP tool,
when set up to use the Clipboard contents as a
convolution source (See the section on ImpulseVerb
later in this chapter for more information).

A Mac’s built-in audio hardware is typically
limited to sample rates from 11 kHz to 96 kHz, and
support will vary depending on the model of Mac.
Higher sample rates are possible with Core Audio
depending on the particular audio hardware
device and its Core Audio drivers.

Because the clipboard contents that provide the
spectrum for this process must be held in RAM,
small clipboard impulses should be used, unless a
large amount of RAM is available. This process
can use a lot of RAM!

To use Convolve:

LE

Peak LE contains a basic sample rate conversion
algorithm.

2. Select the audio that you wish to modify with the
copied audio impulse.

Convolve
The Convolve command is a unique and powerful sound
design tool that allows you to apply the sonic (i.e.,
spectral) characteristics of one sound onto another.
Convolution works by multiplying the frequency
spectrum of the impulse contained in the clipboard and
that of the target audio document, reinforcing the
frequencies that are in common between the two. The
results are always interesting and often quite unlike
anything you’ve heard before. This is especially true
when the character of the two sounds are very different,
and when the clipboard impulse is harmonically rich
(imagine, for example, convolving a rainfall sample with
206

1. Select the audio with the characteristics you wish
to apply and choose Copy (-C) from the Edit
menu or Toolbar.

3. Choose Convolve from the DSP menu. Peak
applies the spectral character of the copied
material to the selection.
4. To hear the results, press the Spacebar.
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If the Option key is held down when the Convolve
DSP is selected, an envelope editor window
appears, and allows variable convolution
between the two audio sources being used.

To apply variable convolution to an audio selection:

1. Copy the audio material you wish to convolve with
to the Clipboard.
2. Hold down the Option key while choosing
Convolve from the DSP menu.
3. Create the convolution envelope you wish to apply
to the audio selection in the envelope editor, by
clicking to create breakpoints. By default, the
convolution envelope is set to apply 100%
convolution across the entire audio selection.
Breakpoints created below this default envelope
will convolve by a lesser percentage – use the Yaxis scale along the left side of the window as a
guide.

The Crossfade Loop dialog

The four checkboxes at the top of the Crossfade Loop
dialog allow you to customize how the end of the loop is
faded into the beginning of the loop. These boxes
indicate where in the loop the crossfade is applied. For
most loops, you should be able to leave the default
checkbox checked and get good results.

8

Crossfade Variations

If you consider the crossfades “A”, “B”, “C”, and “D” from
left to right, then:
“A” =

Crossfade between A and C

“B” =

Crossfade between B and D

“C” =

Crossfade between C and A

“D” =

Crossfade between D and B

The Convolve Envelope Dialog

4. To process the audio selection using the
convolution envelope, press Change.

LE

A

Convolve is not available in Peak LE.

B

C

D

Crossfade Loop
Peak allows you to crossfade the start and end points of
a loop. Crossfading a loop can be very useful for
smoothing the transition between the end of the loop
and its beginning as it repeats. Peak allows you to
control the envelope of the crossfade, the duration, and
other parameters in the Crossfade Loop dialog.

Crossfade positioning options – different uses for loops may call for
different loop crossfade settings – With crossfade position “C” checked
a crossfade is applied as indicated by the red “X”.
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The way these crossfade variations are configured
depends on where the loop is destined to be used – for
most purposes the default crossfade position (Position
“C”) works well – if however, you plan on transferring
these loops to a sample playback instrument such as a
SMDI sampler, then you may want to experiment with
different crossfade positions/combinations. Some
hardware based samplers offer advanced playback
controls, allowing loops to be played forward, backward,
and in various other ways. By changing where in the loop
crossfades are applied, you can customize your audio
content for a particular sampler and for the desired effect.
Another application that may require using loop
crossfade position(s) other than the default position “C”,
are when creating audio loops intended to be used in a
proprietary video game audio engine. Depending on the
requirements of a particular video game’s audio engine,
users may need to adjust the position of the crossfades
used in their loops to achieve the desired effect.
Depending on the application requiring crossfades, users
may need “loop with release” (plays the tail of the audio
document – the section of audio that lies outside the
loop markers – after the loop stops playing/sampler’s
key is released) or “loop hold” (doesn’t play the audio
after the loop when the key is released). Because of
these different modes, users may need to turn some
crossfades on or off.

To edit a Crossfade Loop Envelope:

•

Click on the Envelope button in the Crossfade
Loop dialog and the Blending Envelope Editor
appears.

The Blending Envelope Editor

Note that this is the same Blending Envelope Editor
that is accessed from the Blending dialog.

2. Click anywhere on the line and a new moveable
“breakpoint” will appear.
3. Drag the breakpoint to the desired location.
4. Continue creating and dragging breakpoints until you
have created the envelope that you desire. If you wish
to delete a breakpoint, click on it with the cursor and
press the Delete key on your computer keyboard.

To crossfade a loop:

1. Create a loop using one of the techniques
explained earlier in this chapter.
2. Choose Crossfade Loop from the DSP menu or
Toolbar.
3. In the Crossfade Loop dialog that appears, enter a
duration for the crossfade-in milliseconds and click
OK.
4. To hear the completed crossfade, choose Select
Loop from the Edit menu, select Use Loop in
Playback from the Options menu (-L) or click
the Loop button on the Transport, and press the
Spacebar. You will hear the loop, complete with
your crossfade.
208

5. If you wish to reverse the shape of the envelope
you have created, click the “<->” button. This
creates a mirror image of the envelope.
6. If you would like to save your custom envelope for
later use, click on the Save button before exiting
the envelope editor.
7. When you are satisfied with your new envelope
shape, click Change to confirm your edits and close
the envelope editor. Peak will use this envelope
until you change it again.
To hear the completed crossfade, choose Select Loop
from the Edit menu, select Use Loop in Playback from
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the Options menu or click the Loop button on the
Toolbar, and press the Spacebar. You will hear the loop,
complete with your crossfade.
If you save your custom Blending envelope into:
/MacintoshHD/Users/<YourAccount>/Library/
Preferences/Peak Envelopes/
it will automatically appear in the Envelope
pop-up menu it the Fade In/Out Envelope
editor. Please note that you must apply the
custom fade in/out for it to later appear in the
pop-up menu.

LE

Once an envelope is saved, it is available for use in any of
Peak’s DSP tools that are able to access the Peak
Envelopes folder, stored in your Home directory’s
Preferences folder. Other DSP tools that can access these
envelopes include Fade In/Out, Blending, Panner, Gain
Envelope, Amplitude Fit, and Plug-In Envelope.
Envelopes of varying precision may be created with this
tool. For a more precise envelope, where more points
define the shape, enter a smaller value in milliseconds in
the “ms” field (or use the slider). For a less precise (or
“smoother”) envelope, where fewer points define the
shape of the envelope – use a larger value.

Crossfade Loop is not available in Peak LE.

Fade In & Fade Out

Envelope from Audio
The Envelope from Audio tool allows you to create an
envelope from a selected portion of audio. For
example, imagine a piece of music that has a specific
type of fade out, and you would like to be able to apply
that fade out “envelope” to other pieces of audio. By
selecting the entire fade out, and then using the
Envelope from Audio command, Peak is able to “reverse
engineer” the fade out characteristics, and save them as
an envelope that can later be recalled in any of Peak’s
envelope based tools, such as Fade In/Out, Gain
Envelope, etc.

The Fade In and Fade Out commands allow you to apply
an amplitude envelope to an audio selection. The Fade
In and Fade Out DSP functions, and the Fade Envelope
Editor dialog are described at length in Chapter 5.
To create a Fade In:

1. Click the cursor at the desired location in the audio
document and drag to select the range you desire.
The Fade In will be applied to the audio within this
selection.
2. Choose Fade In from the DSP menu, or click the
Fade In button in the Toolbar. Peak applies the
Fade In to the selection you have made in the
audio document.
3. To hear the completed Fade In, press ControlSpacebar. You will hear the selected audio
complete with your Fade In.
To create a Fade Out:

1. Click the cursor at the desired location in the audio
document and drag to select the range you desire.
The Fade Out will be applied to the selected audio.
The Envelope from Audio’s Envelope Resolution dialog
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2. Choose Fade Out from the DSP menu, or click the
Fade Out button in the Toolbar. Peak applies the
Fade Out to the selection you have made in the
audio document.
3. To hear the Fade Out, press Control-Spacebar. You
will hear the selected audio complete with your
Fade Out.
More detailed information regarding the Fade In
and Fade Out DSP tools is available in Chapter 5:
Editing.

Gain Envelope
The Gain Envelope operation allows you to enter an
amplitude envelope to be applied to an audio selection.
The selected audio’s amplitude will be boosted and/or
attenuated according to the envelope you draw in the
Gain Envelope editor. It is easy to cause samples to clip
when using this feature, so use it carefully.
To apply variable gain and attenuation to an audio
selection:

1. Select the audio material you wish to process.
2. Choose Gain Envelope from the DSP menu.

Find Peak
The Find Peak operation will place the insertion point at
the sample with the maximum amplitude value that it
locates in the audio selection.

3. Draw the gain envelope you wish to apply to the
audio selection in the envelope editor. Points
above the 0% line will amplify the selected audio.
Points below the 0% line will attenuate the selected
audio. Note that the waveform display in the Gain
Envelope editor will change according the
envelope you draw.

The results of a Find Peak operation

To find the maximum amplitude point in an audio
selection:

1. Select the audio in which you wish to locate the
maximum amplitude.

The Gain Envelope dialog

2. Choose Find Peak from the DSP menu.
3. A dialog will appear telling you what the peak value
is, and where it is located. The insertion point will
be placed at the sample where the greatest
amplitude was located.

4. To process the audio selection using the gain
envelope, press Change.

4. Press the left arrow to bring the insertion point
into view or the Shift key to the view of the
insertion point at the sample level

Harmonic Rotate

LE

The Harmonic Rotate tool is excellent for sound design
experimentation. This command allows the frequency
spectrum in a selected range of audio to be rotated
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Find Peak is not available in Peak LE.
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around a horizontal axis, which has the effect of taking
frequencies that were previously associated with one
section of the frequency spectrum, and assigning them
to different areas of the frequency spectrum. The
Harmonic Rotate command can be previewed in real
time, so that desired setting can be found before
spending time processing. Options for processing
include checkboxes for using Real & Imaginary
calculations, and a slider & text field to set amount of
rotation.

Convolve DSP tool allows these natural reverb
impulses to be applied to dry audio signals, giving
the impression that a file was actually recorded in a
particular environment.

The ImpulseVerb dialog

The Harmonic Rotate dialog

2. Choose Harmonic Rotate from the DSP menu.

ImpulseVerb offers real time preview, so that the ideal
settings can be found before processing. In addition,
ImpulseVerb offers an editable Space envelope, which
controls reverb length and decay characteristics, and a
Wet/Dry slider to control the amount of reverb being
applied.

3. Click the Preview button, and select the desired
settings for Real or Imaginary frequency spectrum
calculation, and move the slider, or type in the
desired value.

Enhancements to ImpulseVerb include a new user
interface, as well as new Source Gain and Impulse Gain
sliders, for even more control over reverb
characteristics.

To apply Harmonic Rotate to an audio selection:

1. Select the audio material you wish to process.

4. When you’ve made the desired settings, click OK.

LE

Harmonic Rotate is not available in Peak LE!

ImpulseVerb
ImpulseVerb is an extremely high-quality reverb
processing tool, that utilizes actual reverb impulses
recorded in real spaces, such as performance halls,
cathedrals, caves, and other spaces that have
various reverberation qualities.
The same
convolution technology that is used in Peak’s
Chapter 8: DSP

The ImpulseVerb dialog can also be used as a real
time convolution tool, and is not limited to using
impulse response files to create reverb effects. Any
selection that is copied to the clipboard can be
convolved with the selected range of audio. To
add audio files to the Space pop-up menu within
the ImpulseVerb dialog, simply save the desired file
as a 24-bit Sound Designer II format file, and
place into the Peak Impulses folder within:
/MacintoshHD/Library/ApplicationSupport/BIAS/
Peak/Peak Impulses/
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Invert

To apply reverb using ImpulseVerb:

1. Select the audio material you wish to process.
2. Choose ImpulseVerb from the DSP menu.

The Invert function allows you to invert the phase of a
selection or an entire audio document.

3. Select a Space using the Space pop-up menu, or
choose clipboard to use the contents of the
clipboard.

To invert the phase of a selection:

4. Click the Preview button, and adjust the Wet/Dry
slider to the desired position.

1. Select the portion of the audio that you wish to invert.
2. Choose Invert from the DSP menu. Peak inverts
the phase of the selected audio.

5. To apply the current reverb characteristics, click
the Apply button.
To modify reverb characteristics:

•

Click the Space Envelope checkbox – a standard
Peak envelope editor appears. The example below
shows an envelope for a reverb that fades over
time.

Loop Tuner
Peak’s Loop Tuner provides a way to visually line up
the start and end points of your loop and listen to the
effects of these adjustments as you make them. If you
wish to “tune” a loop you’ve made, simply select Loop
Tuner from the DSP menu or Toolbar, and a dialog will
appear. The waveform display in the Loop Tuner
dialog shows the Start and End points of the loop,
which you can visually adjust with the scroll bars at the
bottom of the window to achieve a natural transition
at the loop point by carefully adjusting the slope
alignment.

While the settings above describe how to simply
modify the reverb effect, other types of settings may
be useful for creative sound design. When using
the ImpulseVerb interface for real time
convolution, experiment with the type of Space
Envelope used – especially when the content used
is a non-impulse response file.
The Loop Tuner showing a smooth transition between the end and
beginning of the loop – this would create a seamless loop.

LE
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ImpulseVerb is not available in Peak LE!

The arrows of the slider will move the loop markers
sample by sample and clicking in the body of the
slider will move the loop markers to the next zero
crossing. The two zoom buttons (magnifying glass
Peak 6 User’s Guide

icons) in the upper left of the Loop Tuner dialog
allow you to adjust the vertical zoom up of the
waveform. The two zoom buttons in the lower left
hand corner of the Loop Tuner dialog allow you to
adjust the zoom view in and out all the way down to
the sample level. You can listen to the effects of the
adjustments as you make them by clicking on the Play
button. To exit this dialog, click on OK to accept the
changes, or Cancel to leave the original loop
unaffected.

Mono to Stereo Conversion dialog

4. Click OK. Peak converts the mono document to a
stereo document.
To change an audio document from stereo to mono:

1. Select the entire audio document with the Select
All command from the Edit menu (-A).
2. Choose Stereo To Mono from the DSP menu or
Toolbar.
The Loop Tuner showing an abrupt transition between the end and
beginning of the loop – this would create a click each time the loop

LE

Loop Tuner is not available in Peak LE.

Mono To Stereo/Stereo To Mono

Stereo to Mono Conversion dialog

These two DSP commands may be used to easily convert
an audio document between one and two channel
formats.

3. In the dialog that appears, adjust the slider to
adjust the left and right-channel balance in the mix.
4. Click OK. Peak converts the stereo document to a
mono document.

To change an audio document from mono to stereo

1. Select the entire audio document with the Select
All command from the Edit menu (-A).

LE

Mono To Stereo/Stereo To Mono is not available in
Peak LE.
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2. Choose Mono To Stereo from the DSP menu or
Toolbar.
3. In the dialog that appears, adjust the slider to
adjust the left and right-channel balance in the
mix.

8

While automatic Mono To Stereo/Stereo To Mono
conversion is not available in Peak LE, you can
achieve the same end result manually, by
selecting all in an open mono or stereo
document, and then opening a new, empty
document. If you copy an entire document, open
a new empty document, and attempt to paste in
the contents of the clipboard, Peak will detect if
there is a different number of channels, and will
prompt you to enter a Left/Right panning value,
and will then allow you to paste in the clipboard
contents.

Mix

To use the Mix command:

1. Select the audio you wish to mix into another
audio document and choose Copy from the Edit
menu or Toolbar (or press -C).
2. Select the audio that you wish to mix the copied
material into.
3. Choose Mix from the DSP menu.
4. In the dialog that appears, use the slider to
adjust the amount of the copied signal that
you wish to mix into the target audio
document. To mix copied material with a
variable level, click the envelope button,
create the desired envelope, and then click the
Change button.
5. Click OK – Peak mixes the two signals together.

The Mix command allows you to mix material that you
have copied to the clipboard with a target selection. This
function can be used as a kind of “sound-on-sound”
capability for mixing audio tracks together, or for
blending sound elements. The Mix command is similar
to the Add command, but it does not have the potential
to clip because the target and clipboard contents are
attenuated before mixing. To use the Mix command, you
must first copy a selection of audio. The copied material
can then be mixed into the target audio material. The
Mix command also allows an envelope to be applied to
the copied material. This can be useful when the content
being mixed needs to have variable levels in it. The Mix
function differs slightly from the Add function, in that the
percentage slider affects both the material being mixed,
as well as the original target material. For example, a
50/50 mix will lower the amplitude level of the target
material.

6. To hear the results, press the Spacebar.

Modify Sample Rate
The Modify Sample Rate command simply changes the
sample rate value store in a file’s header metadata. By
changing this value, you can force a file to play back
faster or slower.

The Modify Sample Rate dialog

This command does not actually change a file’s
sample rate. To change sample rate, use Peak’s
Convert Sample Rate command.

The Mixer dialog
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Modulate

Normalize

This Modulate command functions as a “ring modulator”
which multiplies two audio signals together (e.g., the
material copied to the clipboard and the currently
selected audio). The resulting audio includes the sum
and difference tones of the frequency components of the
modulated audio and the modulating audio. These are
generally very complex timbres that often have a
“metallic” (i.e., inharmonic) character to them.

This command allows you to optimize the volume of a
selection or an entire audio document so that it is at its
maximum possible amplitude without clipping. The
normalize function is very useful for boosting the
volume of material that was recorded at too low a level,
or if used on multiple audio documents, for making
sure that the amplitude of each of the documents is
uniform.

Try using generated tones, like sine, swept sine,
square, or saw-tooth waves with the Modulate
command.

Note that because normalization uniformly
changes the amplitude of a selection (i.e., the
proportions between loud and soft stay the same),
it does not have the same effect as
compression/limiting (which makes the soft parts
louder and does not allow the loud part to exceed
a specified amplitude).

To use the Modulate command:

1. Select the desired source audio and choose Copy
from the Edit menu or Toolbar (or press -C).
2. Select the destination audio.

8

To normalize a selection:

3. Choose Modulate from the DSP menu.
4. In the dialog that appears, use the slider to adjust
the amount of the copied signal that you wish to
use to modulate the destination audio document.

1. Select the audio that you wish to normalize. If you
wish to normalize the entire audio document,
choose Select All from the Edit menu (-A).
2. Choose Normalize from the DSP menu.
3. In the dialog that appears, use the slider to adjust
the percentage of normalization from the
maximum level.

The Modulator dialog

5. Click OK – Peak processes the two signals.
6. To hear the results, press the Spacebar.

LE

The Normalize dialog

4. Click OK – Peak normalizes the selected audio.

Modulate is not available in Peak LE.
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Normalize (RMS)

LE

This command allows you to optimize the volume of a
selection or an entire audio document so that it is at its
maximum possible amplitude without clipping. RMS
Normalization is based on the RMS (Root Mean Square), or
“average” signal level of the selected portion of audio. The
RMS value of a file cannot be increased to an arbitrarily high
value. If the desired RMS specified by the user is so high
that will produce clipping in the signal, the Soft Clip feature
will automatically activate and the resulting RMS level will
be lower than the one specified by the user. The processed
file will be as loud as possible while guaranteeing that the
signal will be limited to the ceiling specified by the user.
The RMS Normalize dialog offers two parameters – RMS
Level and Digital Ceiling. RMS Level allows you to enter the
desired RMS Level (or average level), and the Digital
Ceiling allows you to limit the maximum audio level, which
is also the level at which Soft Clipping will activate, if the
RMS Level exceeds it.
The RMS Normalize function is very useful for boosting the
volume of material that was recorded at too low a level, or
if used on multiple audio documents, for making sure that
the amplitude of each of the documents is uniform.
To RMS Normalize a selection:

RMS Normalize is not available in Peak LE.

Panner
The Panner allows you to adjust the panning, or left-toright movement, of a stereo document by drawing an
envelope in the Panner dialog. Left is at the top of the
graph, and right is at the bottom.
The Panner also offers an option to keep volume constant as
audio pans from side to side. When the Keep Volume
Constant checkbox is enabled, Peak uses Logarithmic
calculation to determine volume levels while panning between
the left and right channels – resulting in overall volume levels
being preserved. When this option is not enabled, Peak uses
linear calculations and does not preserve volume levels. When
disabled, it is common to have dips in the overall audio level
when panning from one channel to the other.
To adjust the panning of a selection:

1. Select the stereo document that you wish to adjust.
If you wish to select the entire document, choose
Select All from the Edit menu (-A).
2. Choose Panner from the DSP menu.

1. Select the audio that you wish to RMS normalize. If
you wish to normalize the entire audio document,
choose Select All from the Edit menu (-A).

3. In the Panner editor dialog that appears, use the
envelope to “draw in” the panning you desire.

2. Choose Normalize (RMS) from the DSP menu.
3. In the dialog that appears, enter the desired RMS
and Digital Ceiling levels, and click the OK button.

The Panner editor dialog
The Normalize (RMS) dialog

4. Click OK – Peak normalizes the selected audio.
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4. Click OK. Peak will change the panning of the
document to reflect the changes you’ve made.
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each partial (often the cause of clicking in otherwise
well-executed time-domain loops), smooth spectral
differences between the start and end of the loop (high
frequencies of a sound generally decay quickly), or
smooth differences in pitch modulation between the
beginning and end of the loop. It even allows the pitch
and amplitude modulations in vibrato to be manipulated
independently of each other.

Panner is not available in Peak LE.

Perpetual Looper
The Perpetual Looper is based on BIAS’ powerful Partial
Harmonic Audio Technology (PHAT). The Perpetual
Looper makes it easy to create smooth, seamless loops of
monophonic, tonal sounds by performing its work in the
frequency domain, instead of in the time domain as
looping has traditionally been done. PHAT is, at its heart,
an analysis/additive resynthesis engine, which gives
Perpetual Looper potent sound design capabilities
beyond smooth looping. The Perpetual Looper is
intended for looping single notes or sounds, not phrases
or sections of audio, and generally will not produce
useful results from phrases.
PHAT uses a Fast Fourier Transform to convert the signal
from the time domain into the frequency domain, then
extracts the harmonic structure of the signal. The
Perpetual Looper’s ability to treat each harmonic
component in the sound individually enables it to
eliminate looping discontinuities in the waveform of

The Perpetual Looper separates the sound being looped
into two components: Partials, which are the harmonic
content, and the Residual signal, which is everything that
is not in the Partials (noise components, non-harmonic
partials, etc.). The user can employ both components, or
choose to use only one or the other. These options
present excellent sound design possibilities.
The Perpetual Looper’s parameters are explained below.
Preset

The Perpetual Looper begins its extraction of a sound’s
harmonic structure by determining its fundamental
frequency. The Preset chooses the range of fundamental
frequencies that will be examined as the basis for
analysis. Select a range of fundamental frequencies that
contains the pitch of the material you are trying to loop.

The Perpetual Looper dialog
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For most applications, the default value of 100 to 600 Hz
will produce excellent results, however, for some
applications, best results are achieved by setting the
range to be narrower. This can be accomplished by
selecting a narrower range from the Preset menu, if one
containing the fundamental frequency of the sound is
available, or by using the Min and Max Pitch parameters
to narrow the range.
Minimum (Min) Pitch

This is the lowest value in the range of fundamental
frequencies being analyzed. Choosing a Preset will set
this parameter, but it can be further adjusted to optimize
loop operation by narrowing the range.
Maximum (Max) Pitch

This is the highest value in the range of fundamental
frequencies being analyzed. Choosing a Preset will set
this parameter, but it can be further adjusted to optimize
the loop operation by narrowing the range.

discard the harmonic component and keep only the
Residual.
Use Loop in Playback

When checked, this allows auditioning the loop.
However, the Perpetual Looper also affects the audio just
after the loop. Unchecking “Use Loop in Playback” allows
playback to continue past the loop to the end, enabling
auditioning of the audio just after the loop.
Frequency Smoothing

Frequency Smoothing modifies frequency variations,
such as in vibrato, that occur within the loop. With the
slider set to the left (0 %), no smoothing is applied. With
the slider set to the right (100 %), all frequency variations
are removed, resulting in an unnaturally perfect sound.
For example, this can turn vibrato (frequency and
amplitude variations) into tremolo (amplitude variation
only).
Amplitude Smoothing

Analysis Window Duration

The Analysis Window Duration specifies the time
window used for FFT analysis. For most uses, the default
value of 40 ms will produce excellent results, but a good
rule of thumb is that the duration should be long enough
to contain three to four periods of the waveform. (The
period, in seconds, is 1/frequency.) When trying to loop
low-pitched sounds, increasing the Analysis Window
Duration may produce the best results.

Amplitude Smoothing modifies level variations, such as
in tremolo or vibrato, that occur within the loop. With
the slider set to the left (0%), no smoothing is applied.
With the slider set to the right (100%), all amplitude
variations are removed. When applied to vibrato, this
produces an effect not found in nature, where frequency
variations are nearly always accompanied by amplitude
variations.
Loop Morph Out Time

Choose an item to generate

The Perpetual Looper separates sound into Partials and
Residual components. When the “Partials + Residual”
radio button is selected, both components will be
generated by the PHAT resynthesis engine, producing
the most natural results. Click the “Partials” button to
generate only the harmonic partials and discard the
Residual component, or click the “Residual” button to
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The Perpetual Looper modifies both the partials and the
residual within the loop. Loop Morph Out Time sets the
period of time following the loop over which the
harmonic and residual components are crossfaded, both
in amplitude and frequency, back to the levels in the
unmodified material after the loop.
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Residual Gain

Phase Vocoder

Gain of the residual signal component within the loop can be
set with this control independently of the gain of the partials.

The Phase Vocoder is a type of audio spectrum
analysis/resynthesis tool that allows you to modify the
duration and/or pitch of an audio selection.

Residual Gain Morph In Time
To use the Phase Vocoder:

If Residual Gain has been adjusted, Loop Morph Out
Timewill correct for the timbral discontinuity that occurs
at the loop end. Residual Gain Morph In Time serves a
similar function for the Residual signal component only
at the loop start. This control sets the time over which
the gain of the residual signal component is faded from
its level before the loop to the level set by Residual Gain
for inside the loop.

1. Select the audio that you wish to process. If you
wish to select the entire document, press -A.
2. Choose Phase Vocoder from the DSP menu. The
Phase Vocoder dialog appears.

To create a loop with the Perpetual Looper:

1. Open a file and use the “Loop This Selection”
command from the Action menu to loop a section.
You do not need to be precise in placing the loop
markers, but you should choose a sustain section
appropriate for looping.
2. Choose “Perpetual Looper” from the DSP menu.
3. Click the “Preview” button to see if the default
settings will work – if necessary, select a narrower
range of fundamental frequencies, or adjust the
min and/or max frequency parameters to create a
narrower range. If attempting to loop a signal with
a low fundamental frequency, try a longer Analysis
Duration Window.
4. Adjust the parameters on the right side of the
dialog to taste.
5. When all settings are satisfactory, click the “Apply”
button to make the changes in the file.

LE

Perpetual Looper is not available in Peak LE.

8
The Phase Vocoder dialog

3. In the Change Duration field, you may enter a new
duration for the selection by typing the time in seconds.
4. In the Change Pitch field, you can change the pitch
of the selection by entering a new value in cents.
(Cents are divisions of a musical octave – one octave
is equivalent to 1200 cents.) Common musical
intervals are stored in the interval pop-up menu,
allowing you to enter a major third, octave, or other
intervals. Use the direction pop-up menu to control
whether the pitch is shifted upward or downward.
5. In the Analysis Settings field, select the number of
bands and FFT (Fast Fourier Transform) size to
determine the quality of the output. The Phase
Vocoder works by analyzing the frequency content of
the audio selection and placing the found
frequencies into tracks. These tracks are then used
to control an oscillator-based resynthesis that uses
the pitch and duration modifications you enter. In
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general, using a smaller FFT size brings less smearing
of the audio output than higher FFT sizes. Using a
larger number of bands setting used increases the
accuracy while tracking of harmonic content of the
source sound. In general, setting the FFT size larger
than the number of bands will give undesirable
results. Due to the nature of the Phase Vocoder’s
algorithm, optimum results are achieved when it is
used with solo instruments and steady state sounds
(such as a voice or solo flute line) rather than
complex tones (such as an orchestra playing).
6. Click OK. Peak processes the audio. To hear the
results, initiate playback.

LE

Phase Vocoder is not available in Peak LE.

Rappify

3. In the dialog that appears, select the amount of
“rappification” you wish to mix back into the
original, with 100% being entirely rappified and 0%
being unchanged.
4. Click OK. Peak processes the audio. To hear the
results, initiate playback.

LE

Rappify is not available in Peak LE.

Repair Click
The Repair Click command will eliminate a selected click
or “spike” in the waveform using the setting designated
in the Repair Clicks dialog (explained next).
To repair a single click:

The Rappify command applies extreme dynamic filtering
to a selection. As one Peak user described it, “Rappify
can turn your hi-fi into lo-fi!” If the target material has a
pronounced beat, this has the effect of reducing the
material to its most essential rhythmic components. Try
using this function with a variety of different music
material for some surprising and exciting results.

1. Place the Insertion Point over the click you wish to
repair.
2. Choose Zoom To Sample Level from the action
menu (Shift-Left arrow).
3. Select the click in the waveform. Please be sure
that your selection is no more than 100 samples.
4. Choose Repair Click from the DSP menu.

To Rappify a selection:

1. Select the audio that you wish to process. If you
wish to select the entire document, press -A.

LE

Repair Click is not available in Peak LE.

2. Choose Rappify from the DSP menu.

Repair Clicks
The Repair Clicks command allows you to find and repair
pops or clicks in an audio document. The Repair Clicks
dialog automates the process of finding and removing
clicks (usually indicated by a sharp “spike” in a
waveform), much like a search and replace dialog in a
word processor.
The Rappify dialog
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The Repair Clicks operation works by looking for any
significant discontinuity from sample to sample. For
example, a sample value of -100 followed by a sample
value of 10,000 is likely to be a click. Once the area of the
click is identified, a smoothing technique is used to
maintain the original shape of the area being repaired.

clicks, while lower values will detect less severe clicks.
Note that lower values such as 10% also have a greater
chance of misjudging audio for a click. In general, a
setting of 40-80% works well.
Repair Size

The Repair Size setting affects how many samples around
the click are used in determining the new shape of the
repair. Repair size can vary from 5 to 100 samples, with
a repair size of 50 samples working well in most
circumstances. Peak will then interpolate what the
correct waveform should be, and repair the click.

The Repair Clicks dialog

If you are working with mostly digitally induced clicks,
the Repair Clicks dialog will become an indispensable
tool. Extremely damaged signals such as those of a
scratching and popping vinyl record will require more
careful repair in addition to using the Repair Clicks
dialog, such as Change Gain, Delete, and the Pencil Tool.
Clicks such as those of a scratching and popping vinyl
record lose their detectability once they are sampled
using Analog to Digital converters.
Using BIAS SoundSoap or SoundSoap Pro will
provide ideal click & crackle reduction for
repairing audio recorded from vinyl. For more
information, please visit the SoundSoap and
SoundSoap Pro web pages, using the links in
Peak’s Links menu.

Smoothing Factor

Smoothing Factor determines how much smoothing is
applied to the click. Material with high frequency
information may require lower smoothing factors to
preserve the high frequencies. In general, a setting of 4060 percent will repair most clicks.

Buttons along the bottom of the Repair Clicks dialog
allow you to control repairing, auditioning, and undoing
click repairs:
•

Click the Repair button when you wish to repair a
click found by the Next Click button.

•

Use the Next Click button to search for the next
potential click in the audio selection.

•

Once a click is located, you may listen to the click
using the Audition button. The Audition button
plays the click using the Pre-roll and Post-roll
settings from the Auditioning dialog in the
Preferences dialog.

•

If you repair a click and are unsatisfied with the
results, simply click on the Undo button.

•

If you would like to repair all of the clicks in the
audio document’s selection without having to
repair each one individually, click the Repair All
button.
Be sure not to confuse repair size with the size of
the selection containing the audio you want to
scan and repair. The repair size refers to the size
of each individual repaired click.

Detection Setting

The Detection Setting value determines how the clicks
are located. Higher values locate only the most severe
Chapter 8: DSP
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Remove DC Offset

To repair multiple clicks in an audio document:

1. Select the entire audio document or the area in the
audio document you wish to repair click.
2. Choose Repair Clicks from the DSP menu.
3. Click the Next Click button. Peak will search for
any clicks. If none are found, you can try again
with a lower detection setting.
4. Audition the click using the Audition button. The
click should sound in the middle of the auditioned
area.
5. Once the click is found, click the Repair button.
Click the Audition button to make sure the click
was adequately repaired. If it was not adequately
repaired, use the Undo button, modify the
smoothing factor or repair size and click the Repair
button again.
6. Proceed from step 3 until all clicks are removed, or
simply click the Repair All button. If you wish to
stop the Repair All process, press -period.
To repair a single click from an audio document:

1. Select the area around the click, centering the click
in the selection.
2. Choose Repair Clicks from the DSP menu or use
Repair Click and skip step 3.

This function allows you to remove any DC Offset in your
audio file. Peak scans the audio for DC offset and then
removes it. Peak will scan the left and right channels of a
stereo file independently. DC Offset is usually caused by
problems in the analog to digital conversion process. The
result is that the waveform is not centered on the base line
– it is offset either higher or lower than the center line.
To use Remove DC Offset:

1. Select the audio that you wish to process. If you
wish to select the entire document, choose Select
All from the Edit menu (-A).
2. Choose Remove DC Offset from the DSP menu.
Peak will scan the audio, and automatically remove
any DC offset that might be present.

LE

Remove DC Offset is not available in Peak LE.

Reverse Boomerang
The Reverse Boomerang command mixes a reversed copy
of the selected audio with the original. This creates a
variety of interesting and useful results. Try using Reverse
Boomerang on drum loops, voice, and sound effects.

3. Click the Repair button. Then click the Audition
button to make sure the click was adequately
repaired. If it was not adequately repaired, use the
Undo button, modify the smoothing factor or
repair size and click the Repair button again.
You may need to lower the detection setting in the
Repair Clicks dialog to find some clicks, depending upon
their severity. Be careful not to lower the detection
setting dramatically – lower it gradually for the best
results.

LE
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Repair Click is not available in Peak LE.

The Reverse Boomerang dialog

To use Reverse Boomerang:

1. Select the audio that you wish to process. If you
wish to select the entire document, choose Select
All from the Edit menu (-A).
Peak 6 User’s Guide

2. Choose Reverse Boomerang from the DSP menu.
3. In the dialog that appears, select the amount of
reversed sound you wish to mix back into the
original, with 100% being entirely reversed, and 0%
being unchanged.
4. Click OK. Peak processes the audio. To hear the
results, press the Spacebar to initiate playback.

Reverse
The Reverse command reverses the current selection. In
a reversed selection, the last sample becomes the first
sample, the second-to-last sample becomes the second
sample, and so forth. The effect is similar to playing a
record or cassette tape backwards.

Strip Silence
Peak includes a Strip Silence tool, which allows areas of
silence, or very low amplitude, to be automatically
silenced, minimized, or completely removed from an
audio document. This tool is useful for removing silence
from recordings that predominantly contain silence (or
very low level audio content), interspersed with some
desired audio content. By adjusting the various Strip
Silence parameters, you can control what content is
preserved, and what is silenced completely or deleted
from an audio document.
The Strip Silence tool is composed of two sections, the
Noise Gate and the Stripper.
Noise Gate

The Noise Gate’s controls include:

To reverse a selection:

1. Select the audio that you wish to reverse. If you
wish to select the entire document, choose Select
All from the Edit menu (-A).
2. Choose Reverse from the DSP menu. Peak
reverses the selected audio. To hear the results,
start playback.

8

Threshold Slider

The Threshold slider determines the level at which all
audio with a higher signal level is preserved, and at a
lower level is either silenced/reduced in level. By default,
the Threshold slider is set to a value of -20dB, and has a
range of 0dB to -60dB.

The Strip Silence dialog
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Setting the Threshold slider is fairly straightforward – for
example, if working with a dialogue recording in which
the voice has a nice strong level, but the ambient room
tone is still audible (around -30dB), you would set the
Threshold slider right around -30dB. This control allows
you designate a level above which audio will be
preserved – and a level below which audio will be
silenced, or removed.

slider is set to about -30dB, that targets the audio below
that level only to be reduced – by how much depends on
how the Reduction Ratio slider is set. To silence these
sub -30dB sections completely, a high setting, such as 4
or 5 might be used for the Reduction Ratio slider.
However, to maintain some amount of room tone, use a
milder setting between 1 and 3.
Attack Slider

A good technique for determining the Threshold
slider setting is by first selecting a portion of audio
containing just the background noise/room tone
(what should be silence, and should be removed),
and using Peak’s Find Peak DSP tool to determine
the exact level. This level can then be used as a
Threshold slider setting in the Strip Silence tool.

The Attack slider determines how quickly level reduction
happens, once audio falls below the threshold level
(which is set with the Threshold slider). By default, the
Attack value is set to 20 milliseconds, and has a range of
10 milliseconds to 500 milliseconds.
Release Slider

Reduction Ratio Slider

This slider provides a proportional amount of reduction,
based on the setting of the Threshold Slider. Whether
audio below the threshold is completely silenced or
simply reduced in level depends largely on the setting
used for the Reduction Ratio slider. The Reduction Ratio
slider provides a proportional amount of reduction for
any audio with a signal level that falls below the
threshold level.
A high setting on the Reduction Ratio slider will
reduce low amplitude sections of the audio waveform
(what is considered “low amplitude” depends on the
level set with the Threshold slider) to complete
silence. A lower setting on the Reduction Ratio slider
will reduce low amplitude sections of the audio
waveform slightly (again, what is considered “low
amplitude” depends largely on what setting is made to
the Threshold slider). By default, the Reduction Ratio
slider is set to a value of 2.00, and has a range of 1.00
to 5.00.
Using the same example of working with a dialogue
recording, which has an ambient room tone around –
30dB, which we would like to minimize. If the Threshold
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The Release slider determines how quickly level
reduction turns off, once audio exceeds the threshold
level (which is set with the Threshold slider). By
default, the Release value is set to 100 milliseconds,
and has a range of 50 milliseconds to 1000
milliseconds.
A good rule of thumb for making settings to the Attack
and Release sliders is to take into account the type of
audio material that you’re with. For example, if working
with dialogue, it takes a relatively long time for a spoken
word to go from zero amplitude to full amplitude, (long
attack time) so it’s best to use a higher attack setting.
This will cause the reduction to be applied more
gradually. Likewise, with this type of material, it’s best to
use a longer release time setting as well, as spoken words
tend to gradually diminish in amplitude, rather than end
very abruptly.
On the other hand, consider a drum recording. Drums
have a much faster attack time – that is, it takes much
less time to hit a drum and have it go from zero
amplitude to full amplitude. Once it’s been hit, it also
takes a very short time to diminish to silence. This type
of audio material would require much shorter attack and
release times.
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Stripper

The Stripper is the section of the Strip Silence tool that
will delete sections of audio that fall below a certain level
and stay below that level for a certain length of time. The
Stripper’s behavior depends on the settings made with
the following parameters:

2. Choose Swap Channels from the DSP menu. Peak
swaps the left channel for the right channel and the
right channel for the left channel. To hear the
results, start playback.

LE

Swap Channels is not available in Peak LE.

Noise Floor

This slider functions much like the Threshold slider in
the Noise Gate section of the Strip Silence tool. Setting
this slider more to the left has the effect of using a lower
threshold setting in the Noise Gate section – that is, only
audio material with the lowest signal level would be
deleted. On the other hand, when this slider is set to a
more “aggressive” setting, audio with a higher amplitude
level would also be deleted. Audio is only deleted when
it stays below a certain level for a certain length of time.
The Noise Floor Slider has a range of 0.0000 – 1.0000%.
Required Silence Before Strip Slider

The Threshold command allows you to split up an audio
document into its component parts by analyzing the
amplitude levels in the audio document and setting a
cutoff or threshold amplitude. For instance, you might
use the Threshold command on an audio document that
contains successive notes from a musical instrument to
split them up, or on a drum loop to break it up into its
component parts. You can save the segments with
Markers, or as Regions.
To use the Threshold command:

This parameter controls how many milliseconds of
consecutive silence (silence being any audio with a level
below the level set with the Noise Floor slider) are
required before silent areas can be eliminated.

LE

Threshold

1. Select the audio you wish to process and choose
Threshold from the DSP menu. After Peak analyzes
the amplitudes in the selection, the Threshold
dialog will appear, allowing you to select a threshold
amplitude for both attack and release values.

Strip Silence is not available in Peak LE!

Swap Channels
The Swap Channels command reverses the left and right
channels in a stereo selection.
To swap channels for a stereo selection:

The Threshold Regions dialog

1. Select the audio that you wish to swap. If you wish
to select the entire document, choose Select All
from the Edit menu (-A).

2. Drag the threshold indicator left or right to set the
threshold amplitude. As you drag the indicator,
new markers will appear in the audio document
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forming markers or regions, depending on your
settings. The Offset sliders allow you to “nudge”
the onsets of markers or regions by plus or minus
0 to 512 samples.

Use the Threshold command to create several
looping points. To convert a marker to a Loop
Start or Loop End point, double-click on the
marker and change it to “Loop Start” or “Loop
End” in the Edit Marker dialog. Also, try
rearranging the regions generated by the
Threshold function in the Playlist or by using Cut
and Paste to create new interesting compositional
and rhythmic ideas!

3. Select Create Regions to create regions instead of
markers. The separate Release Threshold, attack
and sludge settings affect the region end points,
allowing you to eliminate silence from the region
end points.
4. Adjust the Attack value. This parameter sets the
amount of time that audio must stay above the
given threshold to qualify as a new marker or
region.

LE

Threshold is not available in Peak LE.

5. When you have finished, click OK.
6. After the audio document has been
“thresholded” to your satisfaction, you can use
the Export Regions command in the File menu to
export the separated regions into new windows
or files.
7. To select and play regions in order from left to
right, press the Page Up key on your computer
keyboard. To select and play regions in order from
right to left, press the Page Down key.

Voiceover Ducking
The Voiceover Ducking tools is useful for adding vocal
material, such as a radio or podcast show intro, public
service announcement, commercial, etc. to a piece of
background audio. Voiceover Ducking functions much
like a standard “Paste” command, but has the added
benefits of controlling several aspects of the background
material.

The Threshold DSP tool allows inserting markers or Regions based on the amplitude of the audio signal
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Postroll Voiceover

Controls how quickly the voiceover content fades out.
To use Voiceover Ducking:

1. Open the audio document that you wish to add a
voiceover to (a podcast, for example).
2. Open the audio document that contains the
voiceover content (or record a voiceover).
The Voiceover Ducking Dialog

The background and voiceover material must be
in the same audio format (i.e., the same bit depth,
sample rate, and number of channels).

Attack

Controls how quickly the background audio fades out
(until it reaches the level set in the Ducking Amount field).
Decay

Controls how quickly the background audio fades back in to
full volume (from the level set in the Ducking Amount field).

3. In the document that contains the voiceover, select
and copy the desired portion to the clipboard.
4. In the document that contains the background
material, place the playhead cursor where you wish
to have the voiceover start.
5. From the DSP menu, choose Voiceover Ducking –
the Voiceover Ducking dialog appears.

Ducking Amount

Sets the level of audio ducking (volume reduction) for
the background audio material.

6. Set parameters as desired, and click OK to add the
voiceover from the Clipboard to the background
audio.

Hold

The Hold field forces ducking to be maintained. For
example, if you have a voiceover that has a 3 second pause
in between two passages of dialogue, but you don’t want
the background audio level to fade back in during the 3
second pause, you would enter a value of 3 in the Hold
field. This would force the background material to remain
ducked, until after the second passage of dialogue.

Conclusion
You have now learned how to manipulate and process
audio using Peak’s native DSP capabilities. In the next
chapter, you will learn how to use VST & Audio Units
effect and instrument plug-ins with Peak.

Preroll Voiceover

Controls how quickly the voiceover content (audio on
Clipboard that’s being pasted in) fades in.
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Chapter 9:
Plug-Ins

Introduction
Peak supports Audio Units, and VST format effects plugins and virtual instruments. Audio Units is a plug-in
standard, or format, created by Apple Computer, Inc.
VST (“Virtual Studio Technology”) is a standard audio
plug-in technology developed by Steinberg Media
Technologies, AG.
Both Audio Units & VST plug-ins formats offer an exciting
array of real-time effects and instruments from
companies like BIAS, Cycling ‘74, Korg, Maxim Digital
Audio, Native Instruments, Steinberg, Waves, and many
others. Audio Units & VST plug-ins operate in real-time,
and are “native”, or “host-based”. This type of plug-in is
powered by your computer’s CPU, and does not require
any additional processing hardware. They work in realtime, meaning that any parameter changes are heard
instantaneously, and no processing time is required until
the desired settings are found. This avoids having to
experiment with settings, process, and then undo if the
settings are not correct.

Plug-ins Included with Peak
Peak comes with a wide variety of plug-ins – some made by
BIAS and others made by third party manufacturers. The
list below shows plug-ins included in each edition of Peak.
Documentation for BIAS plug-ins is available in separate

user’s guides, and is automatically installed into the
following directory:
/Mac HD/Library/Documentation/BIAS/
BIAS user’s guides may also be downloaded from the
BIAS website, at:
http://www.bias-inc.com/downloads/documentation/
For more information on the third-party plug-ins
bundled with Peak, please visit the manufacturer’s
website, listed below with each bundled plug-in.
Plug-ins Included with Peak LE

•

BIAS Freq-2 – 2 Band Paragraphic EQ

•

Dreampoint Freeverb-C – (Reverb)
http://www.dreampoint.co.uk/

•

MDA Ambiance – Ambiance/Reverb Processing

•

MDA Bandisto – Multi-band distortion

•

MDA BeatBox – Drum replacer

•

MDA Combo – Amp & speaker simulator

•

MDA De-ess – High frequency dynamics processor

•

MDA Degrade – Low-quality sampling

•

MDA Delay – Simple stereo delay with feedback
tone control
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•

MDA Detune – A low-quality stereo pitch shifter

•

MDA Dither – Range of dither types including
noise shaping for reduction to 8- and 16-it

•

•

MDA Vocoder – 16-band vocoder switchable to 8band for low processor usage
http://mda-vst.com/

MDA DubDelay – Delay with feedback saturation
and delay time modulation

Plug-ins Included with Peak Pro

•

MDA Dynamics – Compressor / Limiter / Gate

Includes all of the effects plug-ins listed above, as well as:

•

MDA ePiano – Virtual Piano instrument

•

BIAS Freq-4 – 4 Band Paragraphic EQ

•

MDA Image – Stereo image adjustment and M-S
matrix

•

BIAS Sqweez – Compressor/Limiter

•

MDA Leslie – Rotary speaker simulator

•

BIAS Vbox 3.0 – Effects routing matrix

•

MDA Limiter – Opto-electronic style limiter

•

MDA Looplex – Interesting Loop Processing effect

•

MDA Loudness – Equal loudness contours

•

MDA Re-Psycho! – Drum loop pitch changer

Plug-ins Included with Peak Pro XT

•

MDA RezFilter – Resonant filter with LFO and
envelope follower

Includes all of the effects plug-ins listed above, as well as:

•

MDA RingMod – Ring Modulator

•

MDA Round Panner – 3D panner

•

MDA Shepard – Continuously rising/falling tone
generator

•

MDA Splitter – 2 way signal splitter

•

MDA Stereo Simulator – Haas delay and comb
filtering

Peak Pro includes a 4-band version of Freq.

•

BIAS SoundSoap Pro – Professional Audio
Restoration/Noise Reduction

•

BIAS Master Perfection Suite, which consists of:
GateEx –

gate/expander

PitchCraft –

•

MDA Sub-Synth – Several low frequency
enhancement methods

•

MDA Talkbox – A simple talkbox plug-in

•

MDA TestTone – Signal generator with pink and
white noise, impulses and frequency sweeps

•

MDA Thru-Zero Flanger – Flange / Chorus / ADT

•

MDA Tracker – Pitch tracking oscillator / EQ

•

MDA VocInput – Pitch tracking oscillator for
vocoder carrier input

232

pitch correction/transposition

RepliQ –

EQ matching

Reveal –

advanced analysis tool

SuperFreq-4-, 6-, 8-, & 10 –
Sqweez-3 &- 5 –
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paragraphic equalizers

multiband compressors

Documentation for BIAS GateEx, PitchCraft, RepliQ, Reveal, SoundSoap 2, SoundSoap Pro,
SuperFreq, and Sqweez-3 & -5 is available in
separate user’s guides, included with Peak Pro XT.
Appendix 4 of this User’s Guide contains a minimanual for the included BIAS Sqweez-1
Compressor plug-in.

All documentation is available in electronic form to
registered users, at:

BIAS Plug-ins

The BIAS plug-ins included with Peak are VST plug-ins,
but they are grouped separately from other VST plugins.

http://www.bias-inc.com/documentation/

BIAS VST plug-ins are automatically installed into:
/MacHD/Library/Audio/Plug-Ins/VST/

Installing Plug-ins
VST Plug-ins

While Peak includes a wide variety of plug-ins, there
are hundreds of other Audio Units or VST plug-ins that
are available separately, and that are compatible with
Peak.
Many third-party plug-in packages will include a
custom installer program that automatically installs
plug-ins in the correct directory, so that Peak and
other Audio Units/VST hosts can access them. Be sure
to consult the documentation that came with your
plug-ins for the manufacturer’s installation
instructions.

Plug-ins installed into the “global” VST directory at the
root level allow any user account that is logged in to
access them.
/MacHD/Library/Audio/Plug-Ins/VST/
Installing plug-ins into the VST directory in a user’s
Home directory allows only that user to access
them.
/MacHD/Users/<YourUserAccount>/Library/Audio/Plug-Ins/VST/

There are two locations that Audio Units or VST plug-ins
may be installed so that Peak can access them – for more
information, please see the next section.
Audio Units Plug-ins

Plug-ins installed into the “global” Components directory
at the root level allows any user account that is logged in
to access them.
/MacHD/Library/Audio/Plug-Ins/Components/
Installing plug-ins into the Components directory in a
particular user’s Home directory allows only that user to
access them.

While it does not matter whether you choose to
install into the global plug-ins directory, or the
plug-in directory in your Home directory, it is
easier to maintain a single plug-ins directory. If
you have plug-ins installed in both locations,
and wish to consolidate into a single directory,
it’s easy to move the plug-ins from one directory
to the other. The simplest way to do this is to
open two Finder windows next to each other,
and drag the plug-ins from one directory to the
other. For more information on organizing files
in the Mac Finder, please consult the
documentation that was included with your
Mac.

/MacHD/Users/<YourUserAccount>/Library/Audio/
Plug-Ins/Components/
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Organizing Plug-ins with Folders
When using many types of plug-ins from various
manufacturers, it is useful to be able to sort the plug-ins
in a particular way. For example, you may want to group
all of your EQ or reverb plug-ins together.
Audio Units plug-ins are automatically sorted into groups
based on the manufacturer.
BIAS plug-ins are automatically sorted into their own
plug-in category.
VST plug-ins may be organized in practically any way
desired – you might choose to organize by the type of
effect, or by manufacturer, etc. Peak allows you to
organize your VST plug-ins into folders inside the
“global” VST plug-ins folder (or the VST plug-ins
folder within your Home directory). Each folder you
create inside the VST plug-ins folder can store groups
of plug-ins that will appear as submenus when
assigning a VST plug-in on a channel insert or within
Vbox.

Insert 2, the output of the equalizer plug-in will flow into
the input of the reverb plug-in. Inserts are typically
more convenient when using a small number of plugins.
Vbox

Peak includes BIAS Vbox for managing and mixing effects
plug-ins. Think of Vbox as a virtual effects box, in which
you can combine, repatch, and mix your effects plug-ins
in real-time. Using its unique effects matrix, Vbox lets
you combine multiple individual plug-ins. Vbox can
patch plug-ins in series, in parallel, or in series and
parallel, and you can hot-swap plug-ins. Vbox has
controls for each plug-in to mute, solo, and edit
parameters. Vbox also provides input and output gain
controls both globally and for each individual plug-in,
and a control for the global Wet/Dry mix. Use Vbox’s A/B
comparison feature to get just the right settings, and use
Vbox’s presets to store configurations and settings for
later use.
To open an Audio Units plug-in on an insert:

1. Select Insert 1 from the Plug-Ins menu.
2. Select Audio Units from the submenu.
3. Select the manufacturer from the next submenu.

Using Effects Plug-ins
Peak can access Audio Units and VST format effects plugins in two different ways – using “Inserts”, or through the
Vbox effects routing matrix. The method you choose will
depend on how many plug-ins are being used
simultaneously, and the functionality required for the
task at hand.

4. Select the plug-in you wish to use from the next
submenu.

Inserts

Peak features five individual channel inserts and each
insert may contain a single plug-in. When using inserts,
signal flows through the effect in each insert in the order
of the insert number. For example, if an equalizer plugin is used on Insert 1, and a reverb plug-in is used on
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Opening an Audio Units plug-in
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To open a BIAS or VST plug-in on an insert:

through the plug-in in real-time. This option
is best if you plan to process additional
files with the same plug-in, and do not need to
temporarily disable the effect.

1. Select Insert 1 from the Plug-Ins menu.
2. Select BIAS or VST from the submenu.
3. Select the plug-in you wish to use from the next
submenu.

•

If you have customized the organization of your
VST plug-ins, you may have additional submenus
to navigate through.

Clicking Remove will deactivate/close all open
effects plug-ins. To use these plug-ins again,
you would need to select them from the PlugIns menu(s).
Plug-ins may also be bounced in real time, by
choosing Real Time Bounce from the Plug-Ins
menu.

To apply a plug-in:

1. With an audio document open, open the desired
effect plug-in as described above.

The Real Time Bounce option is useful when
working with the included Jack plug-in. This
mehtod allows a raw audio signal to be routed out
of the computer that Peak is running on, to be
processed with external hardware, and then
returned into the computer to be saved to disk.

2. Configure the plug-in’s settings as desired (plugins from different manufacturers may have knobs,
buttons, sliders and other types of controls).
3. Start playback to audition the audio document, and
make any adjustments to the plug-in’s controls, if
necessary. Effects plug-ins operate in real time, so
any adjustments to controls are heard instantly.

Note that using Real Time Bounce with external
hardware requires using an audio hardware
interface with at least 4 mono inputs/4 mono
outputs (or 2 stereo inputs/2 stereo outputs).

To bounce/render a plug-in:

1. Follow the steps described above, for previewing
effects plug-ins.
2. Select Bounce from the Plug-Ins menu. Peak will
apply the current plug-in settings to the audio
document in the foreground.

To close a plug-in:

1. Select Insert 1 from the Plug-Ins menu.
2. Select VST from the submenu.
3. Select None from the second submenu.

3. When processing (“Bouncing”) is finished, Peak
will display a dialog asking if the plug-in should be
disabled.
•

•

Clicking Bypass will leave the plug-in active,
but will put it into Bypass mode, so that no
audio is being processed by the plug-in. This
option is best if you plan to process additional
files with the same plug-in, but you wish to
temporarily disable the effect.

Closing a plug-in’s editor window does not
deactivate the plug-in! You must follow the steps
outlined above to deactivate a plug-in.

LE

Peak LE features two inserts and can host two
plug-ins at a time.

Clicking Keep Active will leave the plug-in
active, and will allow audio to be processed
Chapter 9: Plug-Ins
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The Vbox Matrix

Box Controls

Vbox is a plug-in routing environment, in which you can
assign, route, and modify the flow of audio signals through
Audio Units and VST plug-ins contained in the matrix.

An active box has several features including the name of
the assigned plug-in, input level control, output level
control, solo button, bypass button, mute button, edit
button, input meters, output meters, and input source.

The Vbox matrix occupies the center portion of the Vbox
interface. It appears as a grid, with 4 rows and 4 columns
of smaller boxes, each of which can hold a plug-in.
The actual size of the Vbox matrix may be larger than the
4x4 grid shown in the Vbox window. You can scroll
through the Vbox matrix using the arrow buttons located
at the lower-right hand corner of the Vbox window.

Plug-In Assignment Pop-up

To assign an effect plug-in in an inactive box, click on the
box. A pop-up menu displaying all the Audio Units, BIAS,
and VST plug-ins installed in your system will appear,
allowing you to assign a particular effect plug-in to the box.
To assign a plug-in:

Matrix Arrow Buttons

1. Click in an inactive box for the Plug-In Assignment
pop-up menu.
2. Select the desired plug-in from the pop-up menu.

The Vbox matrix is made up of individual boxes. Each
box can be assigned an effect plug-in. When a box has an
effect plug-in assigned to it, it is active. If there is no
plug-in assigned to a box, it is inactive.

An Active Box

An Inactive Box

To open Vbox in Peak:

•

Select Vbox from the Plug-Ins menu – The Vbox
matrix appears.

LE
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Peak LE does not include Vbox. Peak LE users
wishing to use more simultaneous plug-ins should
contact BIAS for upgrade information
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If you play back with more plug-ins than your CPU
can handle, audio may begin to play back
erratically. The CPU meter at the top right of the
Vbox window allows you to monitor CPU usage.

Overview of the Vbox Interface
Monitor State “A”
Vbox Presets Menu

Assign State “A”

Monitor State “B”
Assign State “B”

Vbox Preferences
CPU Meter

Box Handle

Clip
Indicators

Wet/Dry Mix
Slider

Plug-In Assignment
Menu

Factory Presets
Menu
Master Input
Level Meters

Master
Output Level
Meters

Bypass Button
Solo Button
Mute Button
Edit Button

Signal Flow

Master Input
Level Slider

Signal Flow
Routing
Switch

Input/Output
Level Sliders

Master
Output Level

Input/Output
Level Meters

9
MIDI
Mapping
Button

Vertical
Scroll
Buttons

CrossSynthesis
Link Button

Horizontal
Scroll Buttons

Factory Preset Assignment Menu

To deactivate a plug-in:

This menu allows you to select factory presets in Audio
Units and VST plug-ins used in the Vbox matrix.

1. Click on the name of the currently assigned plugin.
2. Choose None from the Plug-In Assignment pop-up
menu.

To select a plug-in preset:

1. Click the Factory Preset Assignment pop-up menu.
2. Select the desired preset – the preset settings are
loaded.

To “hot swap” a plug-in:

1. Click on the Plug-In Assignment pop-up menu.
2. Select a different effect plug-in.
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Solo

Each active box within the Vbox matrix features its own
set of input and output meters and sliders, which allow
you to cut or boost the input or output of the box.

The Solo button bypasses all the other plug-ins on the
same row. This allows you to audition just one box
without processing the audio through the other boxes
on the row.

Click and drag the slider up or down to cut or boost the
audio +/-6 dB (+/-100%). The center position of the
indicator is 0 dB cut/boost. Hold down the Option key
on your keyboard and click the indicator to return it to
the center position.
On the left and right side of the box are input and output
meters. These meters show the audio levels input to the
plug-in and output from the plug-in. The lights at the
tops of the meters are clipping indicators. If the audio
clips (reaches maximum level for more than 2
consecutive samples), the clip indicators will come on
and stay lit for a few moments. To reset clip indicators,
click with the mouse.
Virtual instrument plug-ins differ from effects plug-ins in
that they do not have the capability to have audio routed
into them – they do not have audio inputs. The only
input a virtual instrument can receive is via MIDI. Due to
this limitation, it is normal for the input level sliders to
have no effect over the audio playback level for that
instrument. In addition, it is normal for there to be no
activity in the input level meters.

Edit

The Edit button brings up the plug-in editor for the plugin assigned to that box. The plug-in editor will appear in
a new window, and contains the plug-ins own user
interface, with all of its various controls available.
Editing Effect Plug-In Parameters

Clicking the Edit button on an active box opens its editor,
which is the plug-in’s own user interface. Here, you will
be able to access and adjust the parameters of the
specific plug-in. You can modify the parameters and save
your presets into a preset file using the Load and Save
buttons at the bottom of the plug-in’s editor window.
The arrow buttons allow you to move through any
existing factory presets for the plug-in, or click on the
name of the preset for the Presets pop-up menu.
Factory Preset Controls

Bypass Plug-In

Mute
User Preset Controls

The Mute button mutes all audio output from the box.
You can toggle the mute button on or off by pressing this
button. Muting a box in a serial arrangement may mute
all audio in that series, depending on how signal is
routed.

Please note that the Presets field and Up/Down
arrows are used exclusively for factory presets.
User presets are not stored here.

Bypass

The Bypass button prevents the plug-in from processing
the audio input to the box. The audio will flow through
the box directly to the outputs, or to other boxes in the
same series.
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Moving Plug-Ins

Vbox lets you move plug-ins from any active box to any
other box, active or inactive, in the Vbox matrix.
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To move a plug-in from one box to another:

•

Click on the box handle of the active box, the cursor
will change to a grabbing hand – drag and drop it on
any other box. There is no need to precisely align
the plug-in within the borders of the target box – if
the hand icon is placed over the target box, the
selected plug-in will automatically snap into place.
Box Handle

Grabbing Hand Icon

Upper-left box input

Creating Serial Chains

Vbox will automatically assume you want to create serial
chains of boxes. Simply activate boxes in rows, making
sure there are no inactive boxes between the first and
last active plug-ins in the row.
Target Box

Creating Parallel Chains

Moving a plug-in from one box to another

Moving a plug-in to an inactive box will simply move the
plug-in from one box to the other. Moving a plug-in to
an active box will replace the plug-in in the target box.
Changing Input Routing

Use the input indicator on the left center of a box to
create parallel chains.
Master Wet/Dry Controls

Vbox allows you to change the signal flow into parallel
box configurations. To move an input from the left-box
to the upper-left box, click on the green input indicator
on the left center of the box.

The slider in the Vbox window labeled Wet/Dry allows
you to control the combination of dry signal with signal
passed through the Vbox matrix. Drag the slider
indicator upward to hear more of the effected signal
from the Vbox matrix (wet), or downward for more of
the original source signal (dry). Move the slider all the
way to the Dry position to hear the original audio source
only, without any processing through the Vbox matrix.

Left-box input

Master Wet/Dry Controls

Chapter 9: Plug-Ins

239

9

Master Level Controls & Meters

Vbox matrix by clicking on the Presets pop-up menu at
the top of the Vbox matrix.

The master input and output level sliders control input
and output levels. Click and drag the sliders up or down
to cut or boost the audio +/-6 dB (+/-100%). The
center position of the indicator is 0 dB cut/boost. Hold
down the Option key on your keyboard and click the
indicator to return it to the center position.

Any presets you save into the Vbox Presets folder will
appear in the Presets pop-up menu. The Vbox Presets
folder resides in the following directory on OS X:
/MacHD/Users/<YourAccount>/Library/Preferences/
In order to save Vbox presets, use only the Vbox
presets menu, located at the top of the Vbox
interface. Do not use the presets strip at the
bottom of the interface – this is intended to be used
for factory and user presets on individual plugins, not those in use within the Vbox matrix!

Master Input/Output Levels

A/B Comparisons

Corresponding input and output meters are located next to
each slider. These meters show the audio levels input and
output from the entire Vbox matrix. The lights at the tops of
the meters are clipping indicators. If the audio clips (reaches
maximum level for more than 2 consecutive samples), the
clip indicators will come on and stay lit for a few moments.
To reset clip indicators, click with the mouse.

Vbox allows you to create and compare “snapshots” of
different matrix configurations.

Virtual instrument plug-ins differ from effects plug-ins
in that they do not have the capability to have audio
routed into them – they do not have audio inputs.
The only input a virtual instrument can receive is via
MIDI. Due to this limitation, it is normal for Vbox’s
Master Input level slider to have no effect over the
audio playback level for an instrument in the
matrix. In addition, it is normal for there to be no
activity in Vbox’s Master Input level meters.

Loading and Restoring Vbox Presets

You can save your Vbox matrix as a preset or restore a
240

Press the left arrow button to store the current Vbox matrix
into storage location A. Press the right arrow button to
store the current Vbox matrix into storage location B. Press
the A or B button to restore a saved matrix.
Vbox Preferences

You can control the size of the Vbox matrix by clicking
the Preferences button at the top of the Vbox matrix.

Enter the height and width of the matrix you wish to
build. Note the new matrix size will not take effect until
the next time you launch Vbox. The Vbox matrix can
grow as large as 99x99!
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Recording Through Effect Plug-ins

Plug-ins Envelope

In addition to processing existing audio files, Peak also
allows recording through effect plug-ins. This can be a
very useful and timesaving step, especially when
recording in a known environment, or when the exact
same set of effects needs to be applied. While recording
through plug-ins, you are free to adjust plug-in
parameters – however, be aware that you will be making
permanent changes to the material that is recorded, and
will not be able to undo these adjustments.

Peak features an editable plug-ins envelope, which
allows applying a variable wet/dry mix over a selected
portion of an audio waveform. For example, if you have
a dialogue clip that you would like to apply reverb to,
but would like the amount of reverb to vary dynamically,
you can create a custom envelope that automatically
varies the amount of reverb applied to different portions
of the clip.
To apply effects plug-ins dynamically:

While recording through plug-ins can be a
timesaver, be aware that if you are not happy with
the results, you cannot undo them. If you are not
sure about the settings to use, record a dry signal,
and apply effects later. This way, you can freely
experiment with effects settings and not have to
commit to them.

Regardless of whether you’re using effects plug-ins on
channel inserts or within the Vbox matrix, the process for
recording through them is the same.

1. Make a selection of the audio document you want
to process.
2. Choose Plug-Ins Envelope from the Plug-Ins menu
(or from Peak’s Preferences panel).
3. A dialog appears allowing you to draw a breakpoint
envelope to control how much of the effect is
applied over time. Points at the top of the graph
represent 100% wet, while points at the bottom of
the graph represent 0% wet (dry).

To configure Peak to record through Plug-Ins:

1. From the Plug-Ins menu, open and configure the
plug-in(s) you wish to record through.
2. Select Record Settings from the Audio menu. The
Record Settings dialog will appear.
3. Check the Record Through Plug-Ins checkbox and
click OK.
4. Select Record from the Audio menu (-R) or
Transport. You are now ready to record audio
through the plug-in(s).
5. Be sure to disable the active plug-in(s) after you
have made the recording. If you do not
disable/bypass the plug-in(s), when you play back
the recording, you will hear a processed file being
played through the active plug-in in real time and it
will sound as if the recording has twice the desired
effect.

Plug-Ins Envelope dialog

4. When you are finished drawing an envelope, click
Change.
5. Configure the plug-ins you wish to apply.
6. Choose Bounce from the Plug-ins menu.
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Plug-in Latency Compensation
Plug-ins may introduce a short delay, known as latency,
into the audio they are being used to process.
Depending on the type of processing the plug-in
performs, the amount of latency can vary – so it is
common for different plug-ins to produce varying
amounts of latency.
Latency typically appears in audio documents after
bouncing, by a shift in samples later in time relative to
the document’s own timeline.
Peak features an automatic plug-in latency compensation
feature called Auto Adjust Bounce for Latency – which
automatically compensates for the latency introduced
into a processed signal.
Automatic latency compensation may be toggled on and
off from Peak’s Options menu.

To determine delay compensation:

1. Bounce effect(s).
2. Measure the silence inserted by the bounce by
selecting the silence and viewing the duration of
the selection in samples. ( You can use either the
time display counter in the Transport, or turn on
the Cursor Info overlay from the Options menu –
either way will show the length of the selected
piece of audio in the chosen Time Units. Time
Units should be set to Samples for this process).
3. Undo the bounce.
4. Hold down the Option key while choosing Bounce
from the Plug-Ins menu.

To Toggle Latency Compensation On/Off:

•

You may only use manual delay compensation when
the Auto Adjust Bounce for Latency option is disabled.
When it is active, you will not be able to access the
Bounce Effects dialog by holding down the Option key
and choosing Bounce from the Plug-Ins menu.

From Peak’s Options menu, select Auto Adjust
Bounce for Latency.

5. Enter the delay compensation amount from step 2.
6. Click OK or press Return.

A check next to the Auto Adjust Bounce for Latency item
indicates that this feature is active. The absence of a
check next to this item means it is inactive.
Plug-in latency compensation may also be used manually.
To compensate for plug-in latency when bouncing effects
on a selection, hold down the Option key when choosing
Bounce, and enter the delay compensation you want in
samples in the Bounce Effects dialog.

Using Effect Plug-ins with the Batch
File Processor
Peak allows you to use your Audio Units and VST effect
plug-ins with the Batch File Processor (see Chapter 10:
Batch File Processor & Apple Events for a detailed
description of the Batch File Processor). This can be a
very powerful and timesaving processing option if you
need to apply the same plug-in(s) to many audio files.
To use plug-ins with the Batch File Processor:

1. Open an Audio Document.
The Bounce Effects dialog
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2. Open and configure the desired Audio Units or VST
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plug-in(s) that you wish to use in the batch process.
(See the section on Using Effects Plug-Ins earlier in this
chapter for detailed directions on opening plug-ins).
3. Choose Batch File Processor from the File menu.
4. Choose any other processes you want to use for
the Batch File Processor and Set the Batch File
Processor’s Output directory folder.
5. Add “Bounce” from the list of Available Processes
to the list of Selected Processes for Batch.

Configuring Peak for Virtual Instrument
Playback

In order to play virtual instruments, you must enable a
keyboard input. Virtual instruments may be played by
clicking keys in Peak’s MIDI keyboard window, or by enabling
keyboard MIDI control (uses your computer’s keyboard as a
MIDI input), or by using an external MIDI keyboard.
With Peak’s MIDI Keyboard Window:

•

6. Turn the Batch File Processor On and click OK.

From the Window menu, select MIDI – Peak’s
MIDI keyboard window appears.

7. In the Finder, locate the files/folders you wish to
batch process – and drag and drop them over the
Peak application icon in the Dock.
8. Peak will batch process these files and save them to
the designated directory folder.

LE

Peak LE does not support Batch File Processing.

Active virtual instruments now receive input when keys
in Peak’s MIDI keyboard window are clicked.
With your Computer keyboard:

•

Using Virtual Instrument Plug-ins

From the Options menu, select Keyboard MIDI Input.

Active virtual instruments now receive input when keys
on your computer’s keyboard are pressed.
With an External MIDI Controller:

Peak supports Audio Units and VST format virtual
instruments. Virtual instrument support in Peak offers a
quick and easy way to record performances, and greatly
expands the scope of Peak’s sound design possibilities.
Virtual instruments may be used in Peak in a variety of
ways. A single virtual instrument may be loaded on a
channel insert, or multiple virtual instruments may be
loaded into Vbox and be played simultaneously.
Instruments may be loaded for playback as well as for
recording directly to a Peak audio document.

1. Connect a MIDI interface to your Mac and follow its
installation/setup instructions. After you have
configured your MIDI interface, launch Peak.
2. Open Peak’s Preference Panel>MIDI Preferences.
3. Select the desired MIDI device and click OK – then
click the Save button to exit Peak’s Preference panel.

Virtual instruments may also have effects plug-ins
chained in a series after them, so the effects plug-ins are
used to modify the instrument’s output.
Before playing virtual instrument plug-ins, an input
method must first be configured.
Chapter 9: Plug-Ins
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Active virtual instruments now receive input when keys
on your MIDI controller are pressed.
Depending on the MIDI interface you are using,
you may need to install a driver (provided by the
interface manufacturer). You may also need to
restart Peak and/or your computer before the
computer recognizes that a keyboard is connected
– your computer needs to recognize that an
interface is connected before Peak can use it for
MIDI input.

Now that an input method has been configured, you may
open and play any Audio Units or VST format virtual
instrument plug-ins that are installed in your system.
Just as when using effects plug-ins, virtual instruments
may be used on channel inserts or within the Vbox
matrix. The steps below describe how to use virtual
instruments in a variety of ways.
Loading Virtual Instruments on Inserts

using the keyboard on your computer, or using a
MIDI controller.

Recording Virtual Instruments
At some point, you will probably want to record your
virtual instrument performances. This is a very simple
process.
Peak can record the audio output of virtual instruments
directly into a Peak audio document. The configuration
for recording virtual instruments is similar to recording
through effects plug-ins.
To Configure Peak to Record Virtual Instruments:

1. From the Plug-Ins menu, open and configure the
virtual instrument plug-in(s) you wish to record.
2. Select Record Settings from the Audio menu. The
Record Settings dialog will appear.

Loading virtual instrument plug-ins is done the same way
for both Audio Unit and VST formats.

You may want to monitor your recording. To do
this, open the Record Settings dialog and check the
Monitor On/Off checkbox. If you are using direct
monitoring through an audio interface, you may
not need to enable software monitoring in Peak.

To Load a virtual instrument on a Channel Insert:

•

From the Plug-Ins menu, select Insert 1>Audio
Units (or VST)>desired instrument

3. Check the Record Through Plug-Ins checkbox and
click OK.
4. Select Record from the Audio menu (-R) or
Toolbar – Peak is now ready to record audio output
from the virtual instrument plug-in(s).

Playing Virtual Instruments
Once a MIDI input method has been configured, it’s very
easy to play a virtual instrument in Peak.

5. Click the Record button in the Record dialog –
Peak is now recording.
6. Be sure to disable the active plug-in(s) after you
have made the recording, before playing it back. If
you do not disable the plug-ins, no signal will be
heard.

To Play an Instrument:

1. Load the desired instrument plug-in.
2. Click a note in Peak’s MIDI keyboard window,
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Deactivating Virtual Instrument Plug-ins
Deactivating virtual instrument plug-ins is done the same
way for both Audio Unit and VST formats.

Virtual Instrument
Plug-in

To Deactivate a virtual instrument from a Channel Insert:

•

From the Plug-Ins menu, select Insert 1>Audio
Units (or VST)>None

Effect Plug-in

4. Bypass the effect plug-in by clicking the “Bypass”
button in the plug-in’s thumbnail.

Playing Virtual Instruments with
Audio Documents
There may be times when you wish to play a virtual
instrument at the same time as an audio document, for
example, if you are trying to learn a part of a song.

Bypassed Effect
Plug-in

To do this, you will need to run the instrument within
Vbox, and you will need to use the following setup.
To Configure and Play virtual instruments alongside audio
documents:

1. With running, and the desired audio document
already open, choose Vbox from the Plug-Ins menu.

9

5. Start playback of the audio document.
6. Send MIDI input to the instrument (via Peak’s
MIDI keyboard window, your computer keyboard,
or using a MIDI controller).

2. In the Vbox interface, select the desired virtual
instrument to be played.

Cross-synthesis
Virtual Instrument
Plug-in

3. In a parallel row, choose any effect plug-in – it does
not matter which you use.

Cross-synthesis is a potent sound modification tool in
which a sound source called the “program” or
“modulator” signal modifies another, which is called the
“carrier”. One of the most familiar forms of crosssynthesis is vocoding, where the spectral makeup of one
sound is imposed on the other. The classic example of
this uses a voice to modify a sustained sound like an
organ chord, resulting in a “talking organ” .
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In Peak, four different kinds of cross-synthesis are
available, as well as simple mixing of the two sources.
Vbox 3 serves as the host for cross-synthesis, which can
be performed using an audio file and a software
instrument (synthesizer or sampler) as the sources, or
using two instruments. The degree of modulation in the
cross-synthesis (or, in the case of mixing, the balance
between the two signals) can be manipulated using a
MIDI modulation wheel (continuous controller 1).

5. Click the “Link” button in the lower left of the Vbox
window. The Link dialog will appear.

6. Choose the type of cross-synthesis you want to use.
7. If you are using a modulation wheel to control the
cross-synthesis, click the “Controller Thru”
checkbox if you want the mod wheel messages to
be passed through from Peak to other applications.
8. Click OK. Cross-synthesis is now in effect.
Tips for using Vbox Cross-Synthesis
1. For selections other than Mixer, you will hear
only the carrier when modulation depth is at 0.

Vbox’s Link dialog allows choosing the desired type of cross-synthesis

2. The Vbox wet/dry slider must be set to “Wet” in
order to hear the cross-synthesis. As you move it
away from “Wet,” you introduce more of the dry
Program signal. In some applications, such as when
the Program signal is voice, adding a little dry
signal can be useful in maintaining intelligibility.

In order to use cross-synthesis, Vbox must be
instantiated and two modules used within it, one below
the other. The top module will be the carrier and the
bottom the program/modulator. In order to play the
audio file through Vbox, you will need to instantiate a
processor, such as an EQ, for it to play through. You may
bypass the processor if you don’t wish to use it.
To use cross-synthesis:

1. With an audio file open, invoke Vbox by choosing
it from the Plug-Ins menu or assigning it to one of
the inserts in the Plug-Ins menu.
2. Instantiate the carrier signal in a module. For a first
experience, you may want to try instantiating a
software synthesizer into the top module in Vbox.
Select a pad program or other sustained sound
having a rich frequency spectrum.
3. Instantiate the program source in the module below
the carrier. If you are, for example, using a voice file
for the carrier, you might instantiate Freq-4.
4. Select both modules by clicking on one and then
shift-clicking on the other.
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Using a Modulation Wheel to Control Crosssynthesis

Using the mod wheel is easy: it is only necessary to be
sure the controller housing the mod wheel is set up in
Peak.
When the controller is activated, the mod wheel serves
as a control for modulation depth, where a value of 0
(the wheel all the way down) is no modulation and 127
(the wheel all the way up) is full modulation depth. At a
modulation depth of 0, you will hear only the carrier
signal. As the wheel is moved up, you will hear the
selected type of cross-synthesis being applied. When
using the cross-synthesis Mixer function, the wheel
ranges from full Dry signal at 0 to full Wet signal at 127.
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When the Controller Thru checkbox is marked, mod
wheel messages are passed through Peak to other
applications.
It is not necessary to have a mod wheel to use
cross-synthesis, however, without one, crosssynthesis will always use full modulation depth
and the balance in the Mixer function cannot be
varied.

About Cross-synthesis Types in Peak

Each type of cross-synthesis creates a different type of
effect, these are described in details below.

added to the phase of the frequency in the filter. Thus, if
the source has lots of energy at a given frequency and the
filter has none, the resulting signal will have none
(anything times zero is zero), while if they both have
significant energy at that frequency, the output will have
LOTS of energy there.
Magnitude Multiplication

Magnitude Multiplication is the same as convolution,
except that the phase of the output signal at any given
frequency is the same as that of the source; the phase
response of the filter does not affect the output phase
response.
Vocoder

Mixer

The mixer does the obvious: it simply mixes the two
signals. The difference between using this Mixer and
simply letting Vbox mix the outputs of two modules is
that a MIDI controller can be used to crossfade between
the two sources.
Modulation

Peak’s Modulation is actually ring modulation, a form of
amplitude modulation that uses four-quadrant
multiplication. Ring modulation produces sidebands
that are rarely harmonically related, leading to its
popularity for mechanical or robotic voice and other
sounds.

In the original, analog vocoders, the program signal went
through a bank of bandpass filters and the output level of
each band was analyzed, then that spectral profile was
used to control the levels of a second filter bank through
which the carrier was passed, thus imposing the spectral
characteristics of the program onto the carrier. In the
digital domain, vocoding is similar to magnitude
multiplication, except that instead of multiplying the
magnitude of the source (carrier) at each frequency by
that of the filter (program), the spectral response of the
filter is smoothed to create a spectral envelope, which is
used for the multiplication. This can produce better
results than magnitude multiplication or convolution
when the signals are complex. Like magnitude
multiplication, the phase of the output signal is the same
as that of the source.

Convolution

Convolution is a form of spectrum multiplication, in
which one signal is considered the source and the other
acts effectively as a filter. The process is performed in the
frequency domain, where the magnitude (level) of each
frequency component in the source is multiplied by the
magnitude of the same frequency component in the
filter, and the phase at that frequency in the source is

Conclusion
You have now learned how to use Peak to manipulate
and process audio using Audio Units and VST effects
plug-ins. You’ve also learned how to open, play, and
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record virtual instrument plug-ins. In the next chapter,
you will learn how to use Peak’s powerful Batch File
Processor as well as how to use Apple Events with Peak
for file management.
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Chapter 10:
Batch File Processor
and Apple Events

Introduction
Peak allows you to process any number of audio files at
once with any number of possible processes using the
Batch File Processor. Peak also supports Apple Events,
which allows you to manage whole libraries of audio files
quickly and easily with database applications such as
FileMaker Pro.

Batch File Processor
Peak’s Batch File Processor is one of the most powerful,
versatile, and useful features in Peak. Using the Batch
File Processor, you can integrate any series of Peak
processes (called a batch script), and apply these scripts
to any number of audio files.
The currently open audio document and selection
you make will be used for previewing processes
sequenced into your batch script.

To use Batch File Processing, go to the File menu and
select Batch Processing. The Batch File Processor dialog
appears.
Peak’s Batch File Processor is split into three areas: Input,
Process, and Output. Sequence a series of steps for Peak
to execute in the Process section, then set your output

10
file settings in the Output area. Once Peak’s Batch File
Processor is configured, you may turn on the Batch File
Processor in the Input area.
Once the Batch File Processor is configured and turned
on, any files you drop onto the Peak application’s icon
(or an alias) will be batch processed according to your
settings. You can even drop folders or disks onto Peak’s
icon and all of the supported audio contents will be
batch processed. You can continue dropping files,
folders, or disks, onto the Peak icon for batch processing
while the Batch File Processor is turned on. All
subfolders within folders or disks you drag onto the Peak
application icon for Batch File Processing will be
recreated in the Batch File Processor’s output directory,
preserving all organization of your files. Audio
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documents opened using the Open command from the
File menu will not be batch processed.

Process Area

You can also have the Batch File Processor run in the
background while you work in another application.
Supported contents include all file formats that Peak can
read, including AAC, AIFF, Sound Designer II, WAVE,
QuickTime, Raw, JAM image files, System 7 Sound, AU,
MP2, MP3, and MP4.
New audio documents created with the Batch File
Processor will have the same file name as the original input
audio document and may also include an optional suffix.
Input Area

Input Area

The Input Area allows you to enable or disable batch file
processing. Once the Batch File Processor is configured,
you may turn it on with the On button. If you have
finished batch processing and no longer need to batch
process files, you can use the Off button to disable batch
file processing.
You can include/exclude mono or stereo files from the
batch process by using the Process All Files, Only Mono
Files, and Only Stereo Files buttons. Process All Files is
the default setting. To have Peak’s batch processor only
work with mono files, click the Only Mono Files button.
Similarly, to only process stereo files (excluding mono
files), engage Only Stereo Files.
If you are going to process both stereo and mono
audio documents, open a stereo audio document
and make a selection before configuring the batch
processor. This will allow most processes to make
the correct decisions on how to process both mono
and stereo input files using the Batch File
Processor.
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Process Area

The Process Area shows two lists; the list on the left,
labeled Available Processes, allows you to select
processes that will be used in your batch script. Almost
every process that Peak is capable of will appear in this
list. The list on the right is labeled Selected Processes
For Batch and contains the Peak processes in the current
batch script.
Double-click on a process in the Available Processes list
to add it to the Selected Processes for Batch list.
Alternatively, click on a process in the Available Processes
list and then click the ‘Add >>’ button. To remove
items from the Selected Processes for Batch list, click on
the items and then click on the ‘<< Remove’ button.
When you add a process to the Available Processes list, you
may be required to supply settings for the process. The
front-most audio document and selection will be used for
any previewing the process may support. Peak’s batch
processor allows you to use multiple instances, or
occurrences, of a single process – each with its own settings.
You may also specify which part of the file to apply the
process to. Once a process has been added to the
Selected Processes for Batch list, you may use one of the
buttons ‘Entire File’, ‘Apply Just To First x Seconds’, or
‘Apply Just To Last x Seconds’. Use these buttons to
configure how to apply the selected process to an audio
document. For instance, if you are using a Fade In
process and only wish to apply it to just the first three
seconds of the audio document, click the Fade In
process from the Selected Processes for Batch list and
then type a “3” into the ‘Apply Just to First x Seconds’ edit
text field. All processes are applied by default to Entire
File unless you configure the process otherwise.
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Output Area

After clicking Set you will be asked to provide the output
file format, bit depth, and compression options using the
Save As dialog described in Chapter 3. Choose which
folder to save the processed audio files into with the Save
As dialog.

Output Area

Log File

Use the Output Area to configure how your audio
documents will be stored after they have been processed
using your batch script. There are three options
regarding how output files should be handled after
processing has taken place, these are described below:
Save Changes...

Choosing Save Changes in the Output pop-up menu
results in processed files being saved to disk.
Export Regions...

Choosing Export Regions in the Output pop-up menu
results in processed files having any Regions they contain
be exported as individual files.
For more information on using Peak Export
Regions tool, please see Chapter 5: Editing

Leave Open

Choosing Leave Open in the Output pop-up menu
results in processed files being opened in new audio
document windows.
If you choose the Leave Open option the Set button
is unavailable, and you will have to save each
open file you intend to keep.

You can create a text Log File during batch processing to
keep track of which files have been processed. This is
useful for lengthy batch processing sessions where the
possibility of a power failure or other circumstance could
prevent the batch process from completing. Click on the
Log File checkbox to specify that a log file should be
created for the batch process. After turning the Log File
feature on, Peak will ask you to provide a destination for
the log file. The log file can be viewed using a text editor.
The Batch File Processor will divert any error messages
to the log file if it is enabled. This is useful because any
errors Peak encounters during batch file processing will
not require user attention during processing. However,
Peak will issue a System Beep sound if an error occurs
during Batch File Processing. If this happens, check the
log file for errors.
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Preserve File Attributes

If you wish to process a group of files with a variety of
attributes, such as file formats, bit depths, etc. and have
the processed files retain their original attributes, click
this box to enable file attribute preservation. This option
allows the Batch File Processor to focus on all the
available DSP processes, rather than on file format (and
other attributes) conversion. If you wish to process a
group of files and also change them all to the same
output format, leave this box unchecked, and select the
desired output format by clicking the Set button in the
Output area of the Batch File Processor.
File Name Suffix

Once you have chosen how to output files from the
Batch Processor, click the Set button to specify the
output document format, settings, and location.

If you want the output audio files of your Batch Process
to be appended with a suffix, such as .WAV, simply enter
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the suffix you want appended in the File Name Suffix
field. All resulting audio file names will be appended
with the suffix you specify.
Make sure that the output directory ( folder) is not set
to the input directory or Peak’s Batch File Processor
may get caught in a loop. Peak’s Batch File
Processor does not support overwriting input files.

5. You will be back in the Batch File Processing dialog.
Click Log and choose the output folder to save the
log file into.
6. Click the On button in the Input Area of the Batch
File Processor. The Batch File Processor is now
turned on.
7. Click OK to close the Batch File Processor dialog.
8. Switch to the Finder, and drag and drop a folder full
of audio documents onto the Peak application’s
icon.

Save Script

Peak allows you to save your batch script into a settings
file that can be recalled later. This feature is useful if you
frequently process files using a specific sequence of
processes. After configuring the Batch File Processor,
click Save Script to save your batch sequence into a Batch
Script file. You will be prompted to choose a save
location and name for the batch script. The settings file
holding your batch script will store the processes, each
process’ settings, and the output file format.

9. Peak will process all audio files in the folder that
was dropped onto the Peak application icon.
10. Once the files have been processed, open an audio
document, choose the Batch Processor command
from the File menu. You may then turn off the
Batch File Processor by clicking Off in the Batch
Processing dialog.

Load Script

To recall a batch script settings file that was stored using
the Save Script button (as described above), click Load
Script button. For example:
To convert a folder of files into AIFF IMA 4:1 files
Normalized to 95% with a Log:

1. Choose the Batch Processor command from the
File menu.
2. Double-click the Normalize item in the Available
Processes list. Enter “95” in the following
normalization settings dialog.
3. Click Set in the Output Area of the Batch File
Processor. Choose AIFF from the File Format popup menu. Choose IMA 4:1 from the Compression
pop-up menu.
4. Choose the folder to save the output files into.
Click Save.
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Errors and Cancelling Batch
Processes
Any errors during Batch File Processing will produce a
System Beep to notify you of the trouble. If an error
occurs during Batch File Processing, Peak will not place
an error dialog on the screen. This happens so that
processing can continue. If you have specified that you
wish to create a log file, error messages that would
appear in an error dialog will appear in the log file,
indicating where in the batch file process the error
occurred.
Once the batch file processor has started, it will continue
to process files as quickly as possible. If you find it
necessary to halt the batch process, press -Period. A
dialog will appear allowing you to cancel the batch
process. If you choose to cancel the batch process, Peak
will finish processing the current file and then ignore any
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other files to be processed. Once batch processing has
been cancelled, Peak will turn the batch file processor
Off.

Full Document Path:

John’s HD:Sounds:Brass:Trombones:With Mutes:C5-A6.aiff
Simplified Document Path:

LE

Batch File Processing is not available in Peak LE.

Peak’s Audio Librarian Tools
Peak’s Audio Librarian Tools are ideal for anyone who
maintains a large number of sound effects or other types
of samples. Through Apple Events, Peak allows users to
catalog and audition sounds from ordinary database
applications, such as FileMaker Pro (several ready-made
templates are included). Peak also includes Batch
Region Processing (via the Export Regions command in
the File menu).

Volume Name: John’s HD:Document Name: C5-A6.aiff
Using the simplified document path, Peak searches the
indicated volume for the first occurrence of a document
matching the name described (called a Find File
operation). Once it is found, it is opened up and ready
for playback.
“Savvy” Core Suite of Apple Events (event
class = ‘aevt’)

odoc (Open Document)

The “odoc” event instructs Peak to open an audio
document with the document path provided in the data
following the event.
quit (Quit Peak)

Apple Events™ Support
Peak understands a vocabulary of Apple Events. Apple
Events can automate procedures for you, such as
triggering the playback of an audio document.
The standard suite of Apple Events that “savvy”
applications must understand includes the “odoc” (open
document) event. For example, when you double-click
on a Microsoft Word document, the Mac Finder sends an
“odoc” Apple Event to the application Microsoft Word.
Unfortunately, “odoc” requires the complete document
path of the document you wish to open. You can use
“odoc” with Peak, but Peak has another feature that
makes opening and playing your documents much
easier: simplified document descriptions instead of
entire document paths. To illustrate this difference,
compare the following:
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The “quit” event Quits Peak.

Peak events ( event class = ‘FURP’ )

Peak has its own class of events that it understands, all of
which have the ID “furp.” This class descriptor must be
present for Peak to understand the events you send to it.
sff (Set FindFile Volume)

The “sffv” event tells Peak to use the data following the
event (a string of text) as the Volume name to search
when providing a simplified document path. When
specifying volumes, don’t use colons in the name of the
volume.
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sfff (Set FindFile File)

play (Play the front most window)

The “sfff ” event tells Peak to use the data following the
event as the name of the document to find when
specifying a simplified document path.

The “play” event initiates playback of the front most
opened audio document. Use the “stop” event to stop
playback, or wait until the document completes it’s
playback.

offf (Open the FindFile File)

Example Scripts

The “offf ” event tells Peak to find the document on a
volume specified by the most recent “sfff ” and “sffv”
events. If the document is found, it is opened in a window.
If the document is not found, Peak will beep once.
stop (Stop any currently playing audio)

The “stop” event takes no additional data and instructs
Peak to stop playing any audio that is currently playing.
clos (Close the front-most window)

The “clos” event takes no additional data and instructs
Peak to close the front-most window, if one exists.

The FileMaker Pro documents included in the Peak Extras
folder are intended to illustrate Peak’s functionality in an
audio document database environment. To try out the
scripts, open one of the FileMaker Pro documents, type in
the Volume Name (the exact name of the hard disk the
audio document resides on) and Document Name for an
audio document on one of your hard drives, hit Enter and
press the graphic play button. If the document is found,
Peak will play the audio document. You can create new
records with the -N keystroke from FileMaker Pro to
get a new empty record.
Below is an example Script Definition from FileMaker Pro
that might be used to create a Play Button. There are six
steps to this Script Definition:

Example of a FileMaker script included wiht Peak, that can locate, open, and play an audio file from your Mac’s hard drive.
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1. Stop any currently playing audio documents
(STOP).
2. Close any open digital audio windows (CLOS).
3. Pass the FindFile Volume name to Peak from some
FileMaker Pro field (SFFV ).
4. Pass the FindFile File name to Peak from some
FileMaker Pro field (SFFF).
5. Tell Peak to find and open the document described
by steps 3 and 4, above (OFFF).
6. Tell Peak to Play the front-most audio document
(PLAY ) (opened in step 5).

FileMaker Pro is not included with Peak.

LE

Apple Events are not supported in Peak LE.

Conclusion

10

You have now learned how to batch process audio using
Peak’s Batch File Processor as well as how to use Apple
Events to manage whole libraries of audio files with
database software such as FileMaker Pro. In the next
chapter, you will learn how to use Peak to edit and
transfer samples to and from hardware (SMDI) Samplers.
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Chapter 11:
Samplers

Introduction
Peak allows you to import samples directly from
compatible samplers, edit or process the audio using
all of Peak’s powerful editing and processing
functions, and then send the modified sample back
to the sampler, all in the digital domain. This
capability allows you to use Peak as a powerful
sample editing and sound design tool, giving you
access to audio processing capabilities far more
advanced than those typically found on sample
playback instruments.

LE

Peak LE does not support hardware samplers.

The following sections explain how to transfer audio
documents between your sampler and your Mac.
Some samplers have a different interpretation of
loop points than Peak does. To compensate, you
may need to use the Sampler preference dialog to
adjust loop points forward or backward by plus or
minus one sample. You may enter independent
settings for sending and receiving loop points, as
well as loop start and loop end offsets for each. To
adjust loop point offsets, select Sampler from the
Preferences dialog.

Working with SMDI Samplers
Peak’s SMDI Sampler Support makes it possible to
transfer several audio documents at once to or from your
SMDI sampler.
SMDI Samplers supported in Peak (at time
of printing):

•

E-mu – E-IV, ESI-32, ESI-4000, E-64, E5000

•

KURZWEIL – K2000, K2500, K2600

•

PEAVEY – SP/SX

•

YAMAHA – A3000, A4000, A5000
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SMDI Samplers

SMDI Samplers, such as the Kurzweil K2500 or the E-mu
E-IV, use SCSI to transfer samples between devices. In
order to transfer samples between the Mac and your
sampler using SMDI, you must connect a SCSI cable
between your Mac and the sampler. Consult your
sampler’s owner’s manual for instructions on how to
connect the cable to your Mac with proper termination.
Always use high-quality SCSI cables to avoid data
transmission errors.
Peak allows the user to turn fast Asynchronous SCSI
transfers On or Off in the Sampler dialog. Turn
Asynchronous transfers OFF if you are having trouble
transmitting samples to a SMDI device, or if your Mac
does not support Asynchronous SCSI transfer.
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Start

To use the SMDI Sampler dialog:

1. Choose SMDI Sampler or the name of your
sampler from the Sampler menu. The SMDI
Sampler Transfer dialog appears.

Enter the first sample number stored in your sampler
that you wish to view in the list of samples. If you change
this value, you must click on the Update button for the
list of samples to be updated. Some SMDI samplers start
their samples at sample number zero, others start at 200.
Refer to your SMDI Sampler’s manual for information on
how samples are stored in your particular device.
# Items

The # Items edit text field controls how many samples
are displayed in the list of samples. If you change this
value, you must click on the Update button for the list of
samples to be updated.
The SMDI Sampler Transfer dialog

Send

List of Samples

This dialog features a list of samples stored in the SMDI
device. Since there are hundreds of sample locations in
a SMDI device, an exact range of samples to display is
used. You may click on items in the list to view detailed
information about the sample in the Info portion of the
SMDI Sampler Transfer dialog. You may also Shift-click
or Command-shift-click to select multiple items in the list
of samples.

To send the front-most Peak audio document to the
SMDI Sampler, click on the sample in the list of samples
that you wish to send the sample to and press the Send
button. If a sample already exists at the chosen location
in the SMDI Sampler, it will be replaced.
To send multiple opened Peak audio documents to
the SMDI Sampler, shift-click or -click to select
multiple destinations in the list of samples and
click the Send button. Peak audio documents will
be sent to the selected destinations in the order that
they appear under Peak’s Windows menu.

Update

The Update button rebuilds the list of samples shown in
the SMDI Sampler Transfer dialog. Peak will scan the
SMDI device starting at the sample number indicated in
the Start edit text field until the number of samples
entered in # Items edit text field have been scanned.

Receive

To receive a sample from the SMDI sampler, click on the
sample in the list of samples that you wish to receive and
press the Receive button.

SMDI Device

Any SMDI devices Peak detects attached to your Mac will
show up in this pop-up menu. Choose the device you
would like to use from the pop-up menu. Peak will scan
the device for sample information starting at the sample
number indicated in the Start edit text field.
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To receive multiple samples from your SMDI
Sampler, shift-click or -click multiple destinations
in the list of samples and click the Receive button.

To send an audio document to your SMDI sampler:

location, Peak will retrieve the information about the
sample including its sample rate, size, bit depth,
stereo/mono format, and loop points and display the
information in the Info area of the SMDI Transfer
dialog. If there is not a sample stored in the SMDI
device with the sample number, “(Empty)” will appear
in the sample Info area of the SMDI Transfer dialog.

1. Choose Open from the File menu to locate and
open the audio document you wish to send to your
SMDI sampler, or open the audio document by
double-clicking it in the Finder.
2. Choose the SMDI Sampler command from the Sampler
menu. If Peak finds a SMDI sampler connected to your
Mac, the SMDI Sampler Transfer dialog appears.
3. Make sure the correct SMDI device is selected in
the SMDI Device pop-up menu.
4. Click on the sample in the List of Samples that you
wish to replace.
5. Click Send. Peak will send the sample to your
SMDI sampler.
6. When you are finished using the SMDI Transfer
dialog, click the close box of the dialog or click the
Cancel button.

SMDI Sampler Error Messages &
Troubleshooting

If a SMDI device cannot be found connected to your Mac,
Peak will display the message “No SMDI devices could be
found connected to this Mac.” If this happens, and your
SMDI device is connected to your Mac with a SCSI cable,
try the following:
•

Make sure your SCSI cables are properly
connected. SCSI cables can come loose if they are
not tightened down using the cable’s connector
screws. Make sure you connect the SCSI cables to
your Mac only when it is turned off.

•

Make sure there is not another SCSI device
connected to your Mac using the same SCSI ID as
your SMDI device. Consult your SMDI device’s
owner manual for information on how to change
the SCSI ID of your SMDI device.

•

You may need to turn on your SCSI devices in the
correct order. Turn all of the SCSI devices
connected to your Mac on first, then turn on the
Mac and launch the Peak application.

To send a SMDI sample to Peak:

1. Choose the SMDI Sampler command from the
Sampler menu. If your SMDI sampler is properly
connected to the Mac SCSI chain, you will see the
SMDI Sampler Transfer dialog appear.
2. Make sure the correct SMDI device is selected in
the SMDI Sampler pop-up menu.
3. Click on a sample in the List of Samples that you
wish to receive.
4. Click the Receive button. Peak will transfer the
sample you identified to the Mac and place it into a
new audio document window. Audio documents
created by bringing samples over from a SMDI
device are not saved until you use the Save
command from the File menu.
5. When you are finished, click the SMDI Sampler
Transfer dialog’s close box or click the Cancel button.
To browse through samples stored in your SMDI device:

•

Click on a sample in the List of Samples. If your SMDI
device has a sample stored at this sample number

A note about the Yamaha A3000
Peak supports the Yamaha A3000 digital sampler. You
can access the A3000 sampler using either the Yamaha
A3000 or SMDI menu selection under Peak’s Sampler
menu. Please note the A3000 cannot replace existing
samples, and any transfers to the A3000 will be placed in
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the next available empty sample in RAM, regardless of
where you instruct Peak to place the sample. When
“BulkProtect” is turned on, the A3000 does not respond
to SMDI messages.
“BulkProtect” is at UTILITY mode>MIDI function>Bulk
page. BulkProtect is always ON after you turn on the
A3000, so you will need to turn it off before you can do
SMDI transfers.

The Sampler Preferences dialog
You can access the Sampler Preferences from Peak’s
Preferences dialog to set Loop Offsets and Asynchronous
SCSI transfer.

Conclusion
You have now learned how to import samples directly
from compatible samplers (to edit or process the audio
using all of Peak’s functions) and send the modified
samples back to the sampler. In the next and final
chapter, you will find detailed descriptions of each Peak
command and function, menu by menu.
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Chapter 12:
Peak Menus

Introduction
This chapter explains each of the commands found in
Peak’s menus. For step-by-step instructions on
implementing these commands, refer to the index, and
go to the appropriate chapter where use of the
command is covered.

Help

This command will open the Peak User’s Guide, which is
installed along with the Peak application.
Authorization Manager

This command launches the BIAS Authorization
Manager, which allows you to manage your BIAS
software licenses.

Peak Pro Menu
The following items and commands appear under the
Peak Pro menu.

Check for Updates

This command checks to see if a newer version of Peak is
available.
Preferences...

The Preferences command opens Peak’s Preferences
dialog, which contains many of the customizable
elements of the application. Preferences details are
listed below, for each category of Preferences found in
Peak’s Preferences dialog.
About Peak...

Colors

This menu shows information about the particular
version of Peak you are using, including the exact version
number and your serial number.

Peak allows you to customize the colors used to display
the elements in audio documents. You can use this
dialog to set the background color, waveform color, and
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colors for markers and loops. You can select either a
preset color combination, individual colors for each
element in the audio document window, as well as
picking your own custom colors from a color palette.
Changes made using the Colors dialog affect both the
current audio document’s colors, and any subsequent
new audio document’s colors. See Chapter 3 for more
information on this feature.

The Scratch Disks dialog

Blending

Blending is an automatic crossfade function with a usereditable envelope. Peak can apply blending to areas of
an audio document when they are modified by cutting,
pasting or other editing processes in order to smooth
abrupt transitions between waveform amplitudes. It can
be very useful for creating a smooth transition between
edits that would otherwise sound too abrupt. If are
going to cut, paste, or insert audio into a document, you
may wish to enable blending to smooth things out a bit.
It can be toggled on or off by clicking the Blending
button in the Audio Document Window, or pressing the
Caps Lock key on your keyboard. For detailed
instructions on how to use blending or how to edit the
blending crossfade envelope, see Chapter 5: Editing.

The Document Colors dialog

Scratch Disks

Because audio data can be very large, Peak utilizes a
portion of your hard disk’s free space to hold audio
documents that have been cut or copied, as well as for
temporary or “scratch” files for undo purposes. If your
hard disk is short on space, you may not be able to cut,
copy, or modify large selections. If you have more than
one hard drive attached to your Mac, the Scratch Disks
command in the Preference menu allows you to choose
the hard drives (or “scratch disks”) that you wish to use
for these temporary files. Peak allows you to select
which disk you want to have as your default, or “Primary”
disk for this purpose-usually you would select the disk
that has the most free space. If you are connected to a
file server, you can utilize available storage on the server
by clicking the Allow Servers checkbox. Any available
servers will then appear in the Scratch Disks pop-up
menu. This feature is recommended only if you have
access to a high speed Ethernet, or other fast server.
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The Blending dialog

Auditioning

Peak’s Auditioning command allows you to audition a
selection along with a specific amount of audio
preceding or following it. The Auditioning dialog allows
you to select a desired amount of Pre-roll or Post-roll
when you play the selection.
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Plug-Ins Envelope

This command allows you to apply plug-in effects
gradually according to the envelope you create in the
Envelope Editor dialog. This is very useful for varying
the intensity of effects over time.
Sampler Preferences

The Auditioning Dialog.tif

Fade In Envelope

The Fade In Envelope command allows you to edit
Peak’s fade-in envelope. Fade-ins can be very useful for
smoothly fading into an audio document, or for fading
into one type of audio material from another. Very short
fade ins can also be useful for smoothing or removing
clicks and pops in a recording. The Fade In Envelope
dialog allows you to control the exact shape of a fade in
by providing you with user definable envelope controls.
For detailed instructions on how to create fade ins and
edit their envelopes, see Chapter 5: Editing.

The Sampler Preferences dialog

Fade Out Envelope

The Fade Out Envelope command allows you to edit
Peak’s fade-out envelope. Fade-outs can be very useful
for smoothly fading out of an audio document, or for
fading out of one type of audio material into another.
The Fade Out Envelope dialog allows you to control the
exact shape of a fade out by providing you with userdefinable envelope controls. For detailed instructions on
how to create fade out and edit their envelopes, see
Chapter 5: Editing.

Preferences...>Fade Out Envelope

The Sampler command allows you to set an offset of one
sample, for those samplers that require it, as well as
choose SCSI preferences. See Chapter 11: Samplers, for
more on the Sampler Preferences dialog.

DSP Preferences

Peak’s DSP tools appear in the DSP menu in alphabetical
order by default. A user selectable “Use Subcategories in
DSP Menu” preference is also available, which allows DSP
tools to be grouped by type of function: Analysis,
Conversion, Effects, Gain, Loops & Regions, Repair, and
Time & Pitch. To enable DSP categorization, simply
check the “Use Subcategories in DSP Menu” checkbox in
the DSP Preferences window.
Peak DSP Preferences allow you to set the size of the
“window” used in time shifting, and the quality of sample
rate conversion. A setting of 8 is recommended for
Sample Rate Conversion Quality, (with 1 being lowest and
10 being the highest). A setting of 30ms is recommended
for the time shifting window size – a lower setting is
better for simpler, monophonic sounds, and a higher
setting is better for more complex polyphonic.
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playback, working with fragmented files, using
processor-intensive real-time DSP, or are using a slow
hard drive, you may need a larger playback buffer setting.
Window Buffer

Peak allows you to control the amount of RAM the program
uses to keep audio documents buffered in RAM. Use larger
values if you are working with a few large files, and smaller
values if you are working with many smaller files. Experiment
to find the best settings for your system and working style.

The DSP Preferences dialog

Shortcuts/Toolbar Preferences
Playback Preferences

The Playback Preferences dialog contains the following
controls:

Peak allows you to customize any Peak menu item with a
keyboard shortcut. To change your keyboard shortcuts,
go to the Preference menu and select the Shortcuts and
Toolbar item. Keyboard shortcuts are stored in a
preference file in the directory:
/Users/<YourUserAccount>/Library/Preferences/
Peak’s default Keyboard Shortcuts are listed in Appendix 1.
You may also customize the Peak Toolbar using the
Shortcuts & Toolbar dialog. Just scroll to a function in
the dialog list, and use the checkbox to toggle the icon
on and off. This allows you to group only the items you
use most frequently on the Toolbar for easy access.

The Playback Preferences Dialog

Double-click on Waveform to Begin Playback

If this box is checked, double-clicking in an audio document’s
waveform display starts playback at that point. If this box is
unchecked, double-clicking in the audio waveform selects
the space between adjacent markers (or the beginning
and/or end of a file and the closest adjacent marker).
Playback Buffer
The Shortcuts & Toolbar dialog

Peak allows you to control the amount of RAM the
program uses when playing back audio documents. In
general, lower is better. A playback buffer of 32k is a
good place to start. If you are experiencing clicks in your
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Customized Shortcuts & Toolbar are not available
in Peak LE

Window Preferences

Hide Others

Peak’s Window Preferences allow you to set several window
styles and behaviors.

Temporarily puts any other open applications into the
background. This is a useful command if you have
several applications open, and want to focus on working
in Peak. Other applications can be brought back into the
foreground by clicking on their icon in the Dock.
Quit Peak

Choosing Quit Peak closes the Peak application. If you
haven’t saved changes to a currently open audio
document, Peak will prompt you to do so before quitting.

The Window Preferences dialog

“Floating” windows always appear above other windows. It is
particularly useful to set plug-ins, movies, and the Contents
window as floaters, so they are always quickly accesible.
Live Document Resizing scales an audio document’s contents
when the window is resized, allowing you to see the audio
waveform’s size change as you change the size of the window.
Window Magnetism makes windows snap together when
they are positioned close to each other. This feature is
useful for creating tight window arrangements and
maximizing available screen real estate.

File Menu
This menu contains all of the standard Mac commands
for opening, closing, and saving files, as well as several
additional commands specific to the Peak application.

Dither Preferences

The dither preferences dialog allows you to choose
which dithering algorithm is applied when saving files or
bouncing Playlists. For more detailed on the various
dithering algorithms included in Peak, please see the
section on Dithering in Chapter 3: Peak Basics.

LE

12

Peak LE does not feature built in dithering.
Dithering in Peak LE is performed using the
included MDA Dither plug-in.

Hide Peak

Temporarily puts Peak into the background, and hides all
windows. Peak can be brought back into the foreground
by choosing its icon from the Dock.
Chapter 12: Peak Menus
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New

This command allows you to create a new Peak audio
document. When you choose this command, a submenu
menu appears which allows you to choose either a mono
or stereo format for the new audio document, or to
create a Playlist document or a new audio document
from an open Playlist document.
Mono Document

Choosing Mono Document (-N) creates a mono (one
channel) audio document.

The Open Dialog

Close

Stereo Document

Choosing Stereo Document (Shift--N) creates a stereo
(two channel) audio document.
Document From Selection

Choosing Document From Selection (Ctrl-N) creates a
new audio document from any selected audio in an open
audio document.

The Close command (-W ) closes the currently active
Peak audio document. If you haven’t saved changes,
Peak will prompt you to do so before it closes the
document. If you have many documents open and don’t
wish to save any of the changes you’ve made, Optionclick on the prompt dialog’s Don’t Save button.
Close All

Choosing Playlist Document (Shift--P) creates a new
Playlist document.

The Close All command (Option--W) closes all open
Peak audio documents. If you haven’t saved changes, Peak
will prompt you to do so before it closes the documents.
If you don’t wish to save any of the changes you’ve made,
Option-click on the prompt dialog’s Don’t Save button.

Document From Playlist

Save

Choosing Document From Playlist (Shift--B) creates a
new audio document from an open Playlist document.

The Save command (-S) saves the current audio
document. Peak can save audio documents in a wide
variety of audio file formats. For more information on
supported file formats, please see Chapter 3: Peak Basics.

Playlist Document

Open

The Open command (-O) allows you to locate and open
an audio document. Peak can open audio documents in a
variety of formats including AIFF, Sound Designer II, WAVE,
QuickTime, Raw, System 7 Sound, Sonic AIFF, Paris, Jam
Image, AU, MP2, MP3, MP4, and FLAC.
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Save As

The Save As (Shift--S) command allows you to save a copy
of the current audio document under a different name, in a
different location on your hard drive, or in a different audio
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file format. The saved copy will become the active open
audio document. You can save the document with a variety
of audio compression schemes. For detailed instructions on
using this feature, see Chapter 3: Peak Basics.

Import Dual Mono
The Import Dual Mono command lets you import two
mono files and create an interleaved stereo file.
Certain audio applications, such as Pro Tools, use “dual
mono”, rather than stereo interleaved files. Peak
allows you to open such dual mono files, and in the
process creates a new stereo audio document.
Because Peak actually writes a new stereo audio file to
disk, this conversion process requires hard disk space
equivalent to the two original mono files. For more
information on opening dual mono files, see Chapter
3: Peak Basics.
Recover Audio File

The Save As dialog

Save A Copy As

The Save A Copy As command (Option--S) allows you
to save a copy of the currently active open audio
document under a different name without replacing the
active open audio document.

The Recover Audio File command allows you to open a
damaged audio file, and attempt to recover the audio data
contained in it. This tool extracts audio data only, and
ignores all other information contained in the file’s
header, such as information about loop points, regular
markers, Region markers, etc.

Import CD Track

The Import CD Track command allows you to import
tracks from an audio CD. CD tracks imported to Peak will
be saved as AIFF files. For more detail on importing CD
audio with Peak, see Chapter 4: Playback & Recording.

12
Recover Audio File dialog

When audio data is successfully recovered, it is
placed into a new audio document and must be
saved. For more information on working with the
Recover Audio File command, please see Chapter 3:
Peak Basics.

Import CD Audio dialog
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LE

Recover Audio File is not available in Peak LE.

Peak’s DSP functions and third party plug-ins during the
automatic exporting of Regions into new files. For more
information on exporting Regions, see Chapter 5:
Editing.

Export Dual Mono

The Export Dual Mono command allows you to save a
stereo audio document as separate mono digital audio
documents. This feature is convenient if you intend to
use the audio document in a multitrack audio
application, such as Pro Tools, which does not directly
support stereo audio files. When you choose this
command Peak will prompt you to name both the left
and right sides with a Save dialog.

LE

Export Regions is not available in Peak LE.
However, Regions may be dragged from the
Contents Window to the Finder as discrete files.

Export as Text

If you wish to keep a text record of your Playlist, you may
export the Playlist into a new text document. The text
document will show names, times, crossfade times, and
gain levels of each Playlist Event.

Export Regions

If you have placed markers or Regions in an audio
document, Peak’s Export Regions command allows you
to save each of these Regions as a separate audio
document.

Publish Podcast

Choosing the Publish Podcast command publishes the
foreground audio document locally, or to a .Mac or FTP
server. The Publish Podcast dialog provides fields for
entering information used to create an RSS syndication
file, options for encoding an MP3 or AAC audio file, as
well as information for submitting and publicizing your
podcast via the iTunes Music Store’s Podcast directory.
For detailed information about publishing podcasts with
Peak, please see Chapter 7: Podcasting.

The Export Regions dialog

This feature is very convenient if you wish to divide a
larger file into Regions and transfer them as samples into
a sample playback instrument, or divide a live concert
record into Regions and export those Regions as
separate files. Furthermore, you can use Peak’s Batch
File Processor to process a file’s Regions with any of
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The Publish Podcast dialog
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Send to iTunes

Choosing the Send to iTunes command sends the
foreground audio document directly to your iTunes
library. If the document you’re working with in Peak
contains regions, Peak gives you the option to create an
iTunes playlist, with each region listed as a track within
that playlist. For more information on using the Send to
iTunes feature, please see Chapter 5: Editing.
Batch Processor

Peak’s Batch File Processor is one of the most powerful,
versatile, and useful features in Peak. Using the Batch
File Processor, you can integrate any series of Peak
processes (called a batch script), and apply these scripts
to any number of audio files.

Once the Batch File Processor is configured and turned
on, any files you drop onto the Peak application’s icon
(or an alias) will be batch processed according to your
settings. You can even drop folders or disks onto Peak’s
icon and all of the supported audio contents will be
batch processed. You can continue dropping files, folder,
or disks, onto the Peak icon for batch processing while
the Batch File Processor is turned on. All subfolders or
disks you drag onto the Peak application for Batch File
Processing will be recreated in the Batch File Processor’s
output directory, preserving all organization of your files.
Audio documents opened using the Open command
from the File menu will not be batch processed. More
information on batch processing with Peak appears in
Chapter 10: Batch File Processor and Apple Events.

LE

Batch File Processor is not available in Peak LE.

Burn Audio CD

Choosing the Burn Audio CD will burn the foreground
audio document as an audio CD. If Regions are
contained in the document, Peak will prompt you as to
whether these should be used to designate different
tracks on the finished audio CD.
Batch File Processor

Recently Opened Documents

To use Batch File Processing, go to the File menu and
select Batch Processing. The Batch File Processor dialog
appears.
Peak’s Batch File Processor is split into three areas: Input,
Process, and Output. Sequence a series of steps for Peak
to execute in the Process section, then set your output
file settings in the Output area. Once Peak’s Batch File
Processor is configured, you may turn on the Batch File
Processor in the Input area.

Peak automatically remembers the last several audio
documents or Playlists that you have opened and keeps
a list of these at the bottom of the File menu. This allows
you to easily select a document’s name and reopen it
without having to search for it on your hard drive. Peak
can also find and open a document even if you have
changed its location on your hard drive. And if you
change the name of the file, the next time you open
Peak, Peak will automatically update the name in its
internal list.
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Edit Menu
This menu contains all of the standard Mac commands
for cutting, copying, and pasting, as well as several other
commands specific to Peak.

available, you will no longer be able to redo. In other
words, as soon as you perform an editing action other
than Undo, Redo is no longer available
Edits

The Edits command provides you with a second unique
and powerful “unlimited undo” feature. You can think of
the Edits command as a kind of “random access” undo with
a list of all your editing actions since you last saved. Using
this list, you can navigate back in time to the point at which
you performed a particular edit, and if you wish, undo it.
Once you have returned to an earlier state in the project,
you are free to start editing from that point on, if you wish.
Be aware that if you do go back to a past action and
perform a different action at that state in the project, any
edits that originally followed will be gone and you won’t
be able to redo them.

Undo

The Undo command (-Z) undoes the last action that
you performed. Since Peak features unlimited undo and
redo capability, repeatedly choosing this command will
undo each action that you have performed on your audio
document. If you wish, you can continue undoing
actions until you return to the original state of the audio
document. When there are no actions left to undo, the
Undo command will be unavailable and appear grayed
out.
Redo

The Redo command (-Y ) “undoes” the undo
command. If you wish, you can continue redoing actions
until there are no items left to redo. In this case, the
Redo command will be unavailable and appear grayed
out. The only limitation in using the Redo command is
that if you insert a new action when a redo action is
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The Edits dialog

Cut

The Cut command (-X) cuts selected data from an
audio document and copies it to Peak’s Clipboard. Once
you have cut a portion of an audio document, you can
paste it or insert it at another location in the same
document or a different document.
Copy

The Copy command (-C) copies selected audio into
Peak’s Clipboard. Once you have copied a portion of an
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audio document, you can paste it or insert it at another
location in the same document or a different document.
Paste

The Paste command (-V ) allows you to paste the
contents of the Clipboard into a location that you choose
by placing an insertion point. Pasting audio deletes any
selected audio and inserts the clipboard audio at the
insertion point.
Paste Markers Only

The Paste Markers Only command allows you to paste
the markers contained in a copied selection into a
location that you choose by placing an insertion point.
This feature in particularly useful for pasting markers set
at specific times into another audio document, much like
using a template.
Replace

The Replace command allows you to paste audio from
Peak’s Clipboard over existing audio, without pushing all
data to the right of the insertion point farther to the right
(later in time) to accommodate the newly pasted audio.
Duplicate

The Duplicate command has a number of different
behaviors, depending on whether you are working in an
audio document or in a Playlist. More information about
this command is available in Chapters 5 & 6.
If no selection is made when this command is invoked,
the Duplicate command allows you to paste multiple
copies of audio data into an audio document without
overwriting any existing data at the insertion point.
When you paste data with the Duplicate command, all
data to the right of the insertion point or selection start
is pushed farther to the right (later in time) to
accommodate the newly pasted audio. The Duplicate
command allows you to specify how many times you

would like to Duplicate the audio data contained in the
clipboard. The Duplicate command is very useful for
creating longer audio documents that need to repeat a
certain piece of audio, such as creating a 4 bar drum loop
out of a 1 bar drum loop.
If there is a selection in the waveform when the
Duplicate command is invoked, then Peak automatically
fills the selection with the Clipboard contents. Peak
determines how many times the Clipboard contents
must be duplicated in order to fill the selection. If the
selection is not evenly divisible by the duration of the
Clipboard contents, Peak includes a fraction of the
Clipboard contents to make the duplication completely
sample accurate to the original selection.
Insert

The Insert command (-D) allows you to paste audio
into an audio document without overwriting any existing
data at the insertion point. When you paste data with the
Insert command, all audio to the right of the insertion
point or selection start is pushed farther to the right
(later in time) to accommodate the newly pasted audio.
Insert Silence

The Insert Silence command allows you to insert a
specific amount of silence into an audio document at the
current insertion point. When you choose this
command, Peak will prompt you to enter the amount of
silence you wish to insert. You can enter this value in
Samples, Milliseconds, or Seconds. All audio occurring
after the insertion point is moved later in time by the
amount of the silence that you insert.

The Insertion dialog
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Silence

command (Down Arrow) places the insertion point at
the end of a selection.

The Silence command (-E) replaces the selected audio
in the audio document’s selection with silence.
Delete

The Delete command (the Delete key) allows you to cut
an audio selection without transferring it to the
Clipboard.
Delete Markers Only

Set Selection

The Set Selection command allows you to precisely edit
the length, start and end times of an audio selection by
entering numerical values in the Set Selection dialog.
Use the Time Units pop-up menu at the top of the dialog
to select the time units you want, and use the radio
buttons to select whether you want to affect the Start or
End of the selection.

The Delete Markers Only command (Option-Delete)
allows you to easily remove all markers, Region markers
and loops in the current audio document selection
without removing the audio.
Crop

The Crop command (-`) allows you to remove all other
audio from the audio document except the selection.

The Set Selection dialog

Clear Clipboard

Select Loop

Peak utilizes a portion of your hard disk’s free space to
hold audio that has been cut or copied. The Clear
Clipboard command allows you to free up disk space
occupied by the contents of the clipboard if you no
longer need the audio contained there.

The Select Loop command (-”-”) will automatically
select the audio within the loop start and loop end
markers, if you have defined a loop in a document.

Select All

If you have made a selection in an audio document, then
made another selection, you can use Previous Selection
(-Shift-Left Arrow) to jump back to the previous
selection. You can then use Next Selection (-ShiftRight Arrow) to jump ahead again. This works for
multiple selections.

The Select All command (-A) selects all audio in the
audio document.
Insertion Point at Selection Start/End

Previous Selection/Next Selection

The Insertion Point at Selection Start command (Up
Arrow) places the insertion point at the beginning of a
selection. The Insertion Point at Selection End
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Action Menu
This menu provides several commands for zooming in
and out of the audio document window, creating loops,
markers and Regions, and navigating to specific locations
in an audio document.

wish to select and edit audio with great precision. To
view a waveform in progressively greater detail, select
this command repeatedly or press -] repeatedly on
your computer keyboard. Holding down the Option
key while you make a selection will zoom the
waveform view in so that your selection fills the audio
document window after you release the mouse
button.
Increase Vertical Zoom

The Increase Vertical Zoom command (Control-Up
Arrow) makes the waveform “taller,” or increases the
vertical zoom. The Increase Vertical Zoom command is
useful for obtaining a better “big picture” view of quieter
audio material.
Decrease Vertical Zoom

The Decrease Vertical Zoom command (Control-Down
Arrow) makes the waveform “shorter,” or decreases the
vertical zoom.
Fit Selection

The Fit Selection command (Shift--]) will zoom the view
so that your selection fills the audio document window.
Zoom Out
Zoom Out All the Way

The Zoom Out command (- [) zooms the waveform
view out allowing you to see more of the entire
waveform, but in less detail. The Zoom Out command is
useful for obtaining a better “big picture” view of audio
material. To zoom progressively out from a waveform,
select this command repeatedly or press - [ repeatedly
on your computer keyboard.
Zoom In

The Zoom In command (-]) zooms the waveform
view in so that you can view audio data in greater
detail. The Zoom In command is essential when you

The Zoom Out all the way command (Shift-- [) zooms
the audio document window to show an overview of the
entire audio document.
Zoom at Sample Level

The Zoom at Sample Level command (Shift-Left Arrow)
zooms the audio document window to the single-cycle
level, allowing you to view the waveform a single
sample at a time. This is useful for drawing on the
sample with a pencil tool, or fine-tuning loops and
markers.
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Zoom at Sample Level (End)

Snap Start

The Zoom at Sample Level (End) command (Shift-Right
Arrow) zooms the audio document window to the singlecycle level and places the insertion point at the end of
the audio selection.

This command will cause the beginning of the current
selection to move to the nearest selected Snap To unit.

Snap To

This command will cause the end of the current
selection to move to the nearest selected Snap To unit.

This command will cause new selections in the audio
waveform to move, or “snap” to the nearest selected Snap
To unit. The Snap To units available are listed below:

Snap End

Loop This Selection

•

Zero Crossings

•

Bars/Beats

•

CD Frames (588 samples or multiple thereof )

•

Sony PS2 Loop Boundaries (28 samples or multiple
thereof )

The Loop This Selection command (Shift--”-”)
automatically creates a loop from the current selection
by placing loop markers on either side of the selection.
Since Peak supports a single loop per audio document,
choosing this command in a document with a loop
already defined will cause the loop markers to move to
the current selection.

•

Microsoft Xbox Loop Boundaries (64 samples or
multiple thereof )

Nudge Loop Backward

•

Custom Units (allow entry of a user-definable
number of samples)

The Snap To units you choose will depend on the type of
editing work you will be doing. Most users will probably
use Zero Crossings or Bars/Beats for most musical
applications. Multimedia and video game sound
designers will especially appreciate these new options
when producing audio for a particular delivery platform.
For example, when creating audio loops and sound
effects for a Playstation 2 video game, audio edits need to
be made at increments of 28 samples in order to
loop/play back smoothly in the PS2’s audio engine. By
choosing the Snap To PS2 loop boundary setting, any
edits that are made will automatically be made in units
that will translate smoothly to the PS2’s playback system.

The Nudge Loop Backward command (Option-Left
Arrow) pushes, or “nudges,” the loop point backward.
This allows you to fine-tune the loop.
Nudge Loop Forward

The Nudge Loop Backward command (Option-Right
Arrow) pushes, or “nudges,” the loop point forward.
This allows you to fine-tune the loop.
New Marker

Snap Start & End

The New Marker command (-M) creates a new marker
at the current insertion point in an audio document.
Markers are locations in an audio document that you
define as important. By marking specific locations in a
recording, you can navigate easily to a location for
selection, editing or playback purposes.

This command adjusts the beginning and end of the
current selection to the nearest selected Snap To unit.

Once you have defined a marker, you can assign or edit a
number of its attributes with the Edit Marker dialog that

280

Peak 6 User’s Guide

appears when you double-click the marker. This dialog
and the attributes contained within are explained in
Chapter 5: Editing.

New Region

The New Region command (Shift--R) defines a
selection as a new Region and adds it to the Regions
menu. Locate a Region by double-clicking the name of a
Region in the Contents Window. The audio document
will automatically scroll to display the selected Region,
and the Region will become the current selection in the
audio document. For more detail on Regions in Peak,
see Chapter 5: Editing, and Chapter 6: Playlists & CD
Burning.
New Region Split

The Edit Marker dialog

Markers from Tempo

The Markers from Tempo command will automatically
create markers at regular intervals based on the tempo
that is entered. To use Markers from Tempo, you will
either need to know the tempo of the audio material you
are working with, or you can use Peak’s Guess Tempo
feature to figure it out. Place Peak’s insertion point in the
waveform at the point you wish to have the first marker
placed. Designate whether you prefer to have markers
placed every Beat or Bar, and then indicate the duration
for which you wish to have markers placed. Peak will
place markers either for the duration of a selected range
of audio, or you can enter a specific value. Click OK to
create markers. Markers from Tempo is described in
more detail in Chapter 5: Editing.
When working with audio material with a
pronounced beat, it’s best to place the insertion
point just before a downbeat. This ensures that all
following markers will also be placed just before
beats for the duration you choose.

The New Region Split command will subdivide an
existing Region or audio document into two separate,
back-to-back sections, one on either side of the insertion
point. To use this feature, simply place the insertion
point cursor within an existing Region or audio
document, and choose the New Region Split command
from the Action menu – the existing Region or
document is split into two sections at the point where
the insertion point was placed.
Capture Region to Playlist

The Capture Region to Playlist command (-K) will
create a Region based on a selection made in an audio
document and automatically enter it into a Playlist.
This feature is very useful when you need to quickly
create Regions that will also be used immediately in a
Playlist.
Markers to Regions

The Markers to Regions command will convert any
markers in a selection to Regions. If you make a
selection containing two markers, they will be
converted to one Region with the name of the first
marker. If you make a selection containing three or
more markers, the markers will be converted to
contiguous, butt-spliced Regions. For example, if you
have three markers named “Foo 1”, “Foo 2”, and “Foo 3”
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and select them and apply Markers to Regions, the
resulting two Regions will be named “Foo 1” and “Foo
2”-wherein the first marker has become the begin
Region marker of Region “Foo 1”, the second marker
has become the end Region marker of Region “Foo 1”
and the begin Region marker of “Foo 2”, and the third
marker has become the end Region marker of Region
“Foo 2”.
Alternatively, hold the Option key down when selecting
the Markers To Regions command to make each marker
a Region that ends at the next marker.

negative numbers, and Peak nudges the marker by the
value you entered in the dialog.

The Nudge dialog

Rename

The Rename dialog allows you to rename multiple
markers and/or region markers using a custom naming
conventions. More information about renaming markers
and regions appears in Chapter 5: Editing.

Three Markers named “Foo”

The Rename dialog

Go To

Two Regions named “Foo”

Nudge

The Nudge command allows you to nudge all marker,
loops and Regions in the current audio document
selection by the number of seconds entered in the
Nudge Markers dialog. Type either positive or
282

The Go To command (-G) allows you to quickly and
precisely navigate to a the start or end of a selection,
the start or end of a loop, a specific marker, or a
specific time location in an audio document. This
command is essential for speedily locating any of these
important locations in an audio document. Choosing
the Go To Time command allows you to enter the exact
time location that you wish to navigate to. In addition,
the Location submenu lists all markers, Regions and
loops.

Peak 6 User’s Guide

The Go To Time dialog

Edit Audio Info

The Edit Peak Metadata Chunk dialog

The Edit Audio Info command opens the Edit Metadata
dialog.
The Edit Metadata dialog allows editing metadata specific
to the file format you are working with.
As different file types support different types of
metadata, you may see different fields, for example, the
available fields for an MP3 file will be different than the
available fields for a WAVE file.

More information about editing metadata is
available in Chapter 5: Editing.

Edit MIDI & Tempo Info

The Edit MIDI & Tempo Info dialog allows you to specify
the tempo, meter, and timestamp for an audio document,
as well as the root, low, and high key parameters, and the
MIDI Note Name (for use in sample playback instruments).

12
The Edit Metadata Dialog

Edit Peak Metadata Chunk

The Edit Peak Metadata Chunk dialog contains all of the
supported metadata fields for all of the file formats in
which Peak supports metadata. These formats include
MP3, FLAC, AIFF, and WAVE. This dialog acts as a bridge
between file formats, and once metadata in entered into
the Peak Metadata Chunk dialog, it may be easily applied
to any of the aforementioned file formats.

If your audio document is using Bars|Beats as its Time Unit,
you will want to tell Peak what the tempo of the audio
document is, so the document’s timeline can be set
appropriately. Use the Edit MIDI & Tempo Info command from
the Action menu to set the tempo of the audio document.
You can enter the meter of an audio document using the
Edit MIDI & Tempo Info dialog. The numerator represents
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the number of beats per measure, and the denominator
represents the value of a beat, where 4=quarter note,
8=eighth note, 16=sixteenth note, and so forth.
You may also enter a timestamp for the audio document in
seconds. If the audio document has a timestamp, then the
displayed time in an audio document will be offset from this
time rather than starting at zero. For example, if the
timestamp for an audio document is four seconds, then the
first sample in the audio document will appear in the audio
document with a time of 4 seconds instead of zero seconds.

can use the Guess Tempo command to have Peak
automatically guess the tempo of a selection. Make a selection
and choose Guess Tempo from the Action menu. There will
be a pause while Peak scans your selection and calculates the
tempo for you. A dialog will then appear showing you the
estimated tempo in BPM, or beats per minute. You can then
enter the estimated tempo in BPM in the Loop Surfer dialog’s
Tempo field or in the Audio Information dialog’s Tempo field
or press the Loop It button to create a loop at the current
insertion point with the detected BPM.

Loop Surfer

Peak’s Loop Surfer feature (-J) automates some of the
steps for setting up loop points. Loop Surfer allows you
to “Loop Surf ” (adjust your loops during playback)
quickly, easily and in a musically intuitive manner.

Audio Menu
The Audio menu contains commands for playing back and
recording audio, as well as configuring Peak’s Recording
Settings, your audio hardware, and Peak’s Meters.

The Loop Surfer dialog

If you’re working with music, and know the music’s
tempo in beats per minute, you can use Loop Surfer to
create a loop which lasts for a rhythmically “correct”
length of time. For more detail regarding Loop Surfer,
see Chapter 5: Editing.

LE

Loop Surfer is not available in Peak LE.

The Stop/Return to Start command (Return) stops
playback and places the insertion point at the beginning
of the audio document.
Play+Pause

Guess Tempo

If you are working with music and don’t know the tempo-and
your music has a relatively pronounced or obvious beat-you
284

Stop/Return to Start

The Play+Pause command (Spacebar) starts playback of
the audio file from the insertion point or pauses
playback.
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Play Selection

The Play Selection command plays only the selected
portion of an audio document.
Play with Auditioning

The Play with Auditioning command (Control-Spacebar)
plays the selected portion of an audio document with
pre-roll and post-roll. The pre-roll and post-roll times are
designated in the Auditioning dialog under the
Preference menu.
Stop & Extend Selection

The Stop & Extend Selection command stops playback
and extends any selection from the point at which
playback was initiated. The Stop & Extend Selection
command can also be used to start playback from the
insertion point or selection start.

When you select Record from the Audio menu (-R),
Transport, or Toolbar, the Record dialog appears. There are
transport buttons-Record Settings, Pause, Stop, and Recordalong the bottom, an Audio Source display that shows you the
waveform as it is being recorded, and a Notepad window. The
sample rate, bit depth, and number of channels you selected
in the Record Settings dialog are also displayed, along with the
amount of time you have available to record on the selected
Record Disk with the recording settings you have chosen.
The Notepad feature in the Record Dialog allows you to
type in text descriptions, transcribe a recording, or type
in comments called Notepad Cues at specific points
during the recording of an audio document. The
Notepad feature is available from the Record dialog and
may be used once a recording starts.

LE

Notepad Cues are not available in Peak LE.

Record Settings

Go to End

The Go to End command places the insertion point at
the end of the audio document.

When you select Record Settings (Option-R) from the
Audio menu or Toolbar, the Record Settings dialog
appears. This dialog is used to configure your settings
for recording with Peak.

Record

The Record command (-R) opens the Record window.
This window allows you to start and monitor recording.

12
The Record Settings dialog

The Record dialog

You will notice several pop-up menus, buttons, and
checkboxes in the Record Settings dialog. These allow
you to select which hard drive to record to, what file
format you’d like to record in, sampling rate, source
input, and so on. The next few paragraphs describe how
to set all of these parameters using the Record Settings
dialog. More information about recording is available in
Chapter 4.
Chapter 12: Peak Menus
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Record Disk

The Record Disk pop-up menu allows you to choose
which hard drive you would like to record to. If you
have more than one hard drive connected to your
Mac, use this pop-up to select your record drive.
(This option will default to the largest drive
currently available to your Mac unless you select
otherwise.)
File Format

The File Format pop-up menu allows you to select
the file format for the incoming audio. You can
choose from AIFF or Sound Designer II. (If you need
the newly recorded audio file to be in a different
format, use the Save As function to save it as a
another format once recording is complete.) If you
do not select a file format for recording, Peak will
default to AIFF.
Monitor checkbox

newly recorded audio will be inserted at the beginning
of the file. If the insertion point is at the end of the
file, the newly recorded audio will be appended to the
end of the existing file. If the insertion point is
somewhere in the middle of the file, the newly
recorded audio will be inserted at that point. If you
make a selection, the Append to document feature will
allow you to replace the selection with newly recorded
audio from the beginning of the selection through the
end of the selection or wherever you stop the
recording.
Record timer checkbox

The Record timer checkbox allows you to designate
a specific duration for recording. Peak will stop
recording after this set time and bring up the Save
dialog for your audio recording. Checking the
Record timer checkbox will bring up the Recording
Time dialog. In the Recording Time dialog,
designate the duration for recording in seconds and
click OK.

The Monitor checkbox allows you to monitor the audio
source while you are recording.
Split Stereo Files checkbox

The Split Stereo Files checkbox allows you to record the
incoming stereo audio as dual mono files rather than a
single stereo file. Dual mono files are used in programs
like Digital Performer or Pro Tools so this option is
useful if you need to record dual mono files (i.e., split
stereo).

The Recording Time dialog

Open after saving checkbox
Append to document checkbox

The Append to document checkbox allows you to
record into an existing audio document. To record
into an existing audio document, place the insertion
point in the existing audio document at the point
where you want to insert the new audio. If the
insertion point is at the beginning of the file, the
286

The Open after saving checkbox determines whether the
audio document is opened in Peak after it is recorded.
Audio Input Settings Button

Clicking on the Audio Input Settings button will opens
the Audio Input Settings dialog, where you can specify
the recording format to be used.
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Select Audio I/O Button

Meters Settings

Clicking the Select Audio I/O button in the Record
Settings dialog brings up the Select Audio I/O dialog.
Note that in many instances there may be no settings for
a given device (including the Apple Built-In Sound!).
Some sound card’s drivers have control panels or utility
applications that will launch when you click on the Select
Audio I/O button. The actual third-party dialog will differ
depending on the type of audio hardware you have.

The Meters Settings command opens the Meters
dialog, which allows you to configure the Meters
display. Using the Meters dialog, you can select the
Peak Hold time, Clip Indicator Hold Time, and meter
resolution. The Peak Hold indicators appear as yellow
bars at the far right of each of the bar graphs, and
selecting a hold time causes the indicator to pause for
easy reading of the peak value during playback. The
Clip Indicators appear as red bars at the far right of
each of the bar graphs, and are triggered when audio
distorts, or “clips”, and selecting a hold time causes the
indicator to pause for easy reading of any clipping or
distortion that occurs during playback. Setting the
Peak Hold and Clip Indicator Hold Times to None turns
these features off.

Record Through Plug-Ins checkbox

If you have plug-ins installed, you can record through
them in real-time. This is useful if you want to use a
noise reduction, equalizing, or dynamics plug-in during
recording.
For complete instructions on recording audio in Peak,
please see Chapter 4.
Select Audio I/O

The Select Audio I/O command brings up a the Select
Audio I/O. The Select Audio I/O dialog is used to select
the audio hardware you would like to use for audio input
and output.

The Meters dialog

Audio Input Settings

The Audio Input Settings dialog is used to specify which
channels of a multichannel audio interface should be
used for recording. In addition, you can select a specific
sample rate and recording format (i.e., number of
channels and bit depth).

12

Audio Output Settings

The Audio Output Settings dialog allows you to specify
output related settings, such as Clock Source, Sample
Rate, which channels of a multichannel audio interface
to play audio through, as well as Sample Rate
Converter quality (for use with Tape-Style Scrubbing).
Chapter 12: Peak Menus
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DSP Menu

then click the Add button. Be careful not to adjust too
high an amount which can potentially clip the signal.

This menu contains Peak’s DSP-based audio processing
and advanced editing tools. A complete description of
Peak’s DSP functions and instructions on how to use
them are given in Chapter 8: DSP.

The Add dialog

LE

Add is not available in Peak LE.

Amplitude Fit

Amplitude Fit provides granular normalization of an audio
selection on a grain-by-grain basis. Grains are small groups
of samples, often around 30ms. As each grain is read in, it
is normalized according to the Amplitude Fit Envelopeeach normalized grain crossfaded with the previous grain
and written out as the result. Amplitude Fit can be used to
maximize the volume level of an audio selection, or to
make quiet passages as loud as louder passages.

Add

The Add command adds any selection of audio copied to
the clipboard into the audio document at the selection
point. To use the Add command, you must first copy a
selection of audio. The copied material can then be mixed
into the target audio material. To add copied material with
a variable level, click the envelope button, create the
desired envelope, and then click the Change button, and
288

The Amplitude Fit Envelope editor

LE

Peak 6 User’s Guide

Amplitude Fit is not available in Peak LE.

Auto Define Tracks

The Auto Define Tracks tool allows you to automatically
split audio recordings into separate Regions, each of which
will become an individual CD track when an audio CD is
burned. This tool is useful for quickly editing LP and
cassette recordings, in preparation for burning them to CD.

display is to show whether the audio content has been
degraded by processing that has been applied to the file.

The Bit Usage Meter

LE

Auto Define Tracks

This DSP tool works by automatically placing Region
markers into an audio document based on audio level,
minimum period of silence between songs, and
minimum song duration. Peak analyzes the audio levels
throughout a document, and places Region markers
around each song. The louder parts are considered to be
songs, and the quieter parts are the gaps between them.

Bit Usage is not available in Peak LE.

Change Duration

The Change Duration command allows you to slow
down or speed up the selected material by a specified
amount without changing its pitch.

Since some songs may contain very quiet parts that could
mistakenly be interpreted as gaps between tracks, a few
parameters are available to help Peak correctly distinguish
between songs and the gaps between them. More information
about Auto Define Tracks is available in Chapter 8: DSP.

12

Bit Usage

The small rectangles that make up the graph appear in
different shades of black, white, and green. These
represent the level of bit usage over the selected amount
of time. Darker shades equate to more bit usage, while
lighter shades indicate less bit usage. Each rectangle
represents many samples, and the shading corresponds
to the audio waveform. The primary purpose of this

The Change Duration dialog

You can specify the change in duration by a value in
seconds, a percentage of the original, or, for rhythmically-
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oriented material, beats per minute. A change in duration
by a reasonable amount, about 85% to 115%, can be very
convincing. Exaggerated time stretching, 200% or more,
can result in some very interesting granular textures.
Try experimenting with the Change Duration function on
drums, rhythm loops, speech, sampled instruments or
sound effects to achieve a wide variety of useful effects.

by smaller increments called “cents.” (Cents are divisions of
a musical octave-one octave is equivalent to 1200 centsthus, 100 cents is a semi-tone, 50 cents a quarter-tone, etc.)
You can also choose to alter the length, or duration, of the
selection just as you would by slowing down or speeding up
analog tape, or you can choose to preserve the duration of
the selection (something not possible with analog tape!).

Change Duration (Variable)

Variable Change Duration allows the selected portion of an
audio document to have its duration modified dynamically
over time, using Peak’s familiar envelope editor dialog.
Change Gain
The Change Pitch dialog

The Change Gain function changes the gain (i.e., amplitude)
of a selection. You can specify the amount of gain change
either in decibels (dB) or as a percentage. If you wish to
double the volume of a sound, you must apply approximately
6 dB of gain change, or add 200%. Enable the Clipguard
checkbox in the Change Gain dialog to protect against the
possibility of clipping. Clipguard will search through the audio
document or selection for the maximum peak in amplitude,
and then limit the Change Gain slider’s range based on the
maximum peak it finds in the audio document or selection.

Change Pitch (Variable)

The Variable Change Pitch function feature allows the selected
portion of an audio document to have its pitch modified
dynamically over time, using Peak’s familiar envelope editor dialog.
Convert Sample Rate

The Convert Sample Rate command allows you to change
the sample rate of a sound without changing its pitch.
This feature is very useful for converting audio material
into lower or higher sample rates as required by other
applications. Please note that sample rate conversion is
applied to an entire document. It cannot be applied to
just a selection within a document. Refer to Chapters 3
and 4 for an explanation of commonly used sample rates.

The Change Gain dialog

Change Pitch

The Change Pitch function allows you to alter the pitch of
an audio selection by as much as an octave. The Change
Pitch dialog uses a slider that allows you to choose a new
pitch by musical interval, and “fine tune” the pitch change
290

The Convert Sample Rate dialog
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LE

Peak LE is limited to a maximum sample rate of 96kHz

LE

Crossfade Loop is not available in Peak LE.

Convolve

Envelope from Audio

The Convolve command is a unique and powerful sound
design tool that allows you to apply the sonic (e.g.,
spectral) characteristics of one sound onto another.
Convolution works by multiplying the frequency spectrum
of the impulse contained in the clipboard and that of the
target audio document, reinforcing the frequencies that
are in common between the two. To use the Convolve
DSP command, you must first copy a selection of audio.
The copied material will provide the spectral “character”
that you will apply to the target audio material.

The Envelope from Audio tool allows you to create an
envelope from a selected portion of audio. For
example, imagine a piece of music that has a specific
type of fade out, and you would like to be able to apply
that fade out “envelope” to other pieces of audio. By
selecting the entire fade out, and then using the
Envelope from Audio command, Peak is able to “reverse
engineer” the fade out characteristics, and save them as
an envelope that can later be recalled in any of Peak’s
envelope based tools, such as Fade In/Out, Gain
Envelope, etc. Once an envelope is saved, it is available
for use in any of Peak’s DSP tools that are able to access
the Peak Envelopes folder, stored in your Home
directory’s Preferences folder. Other DSP tools that can
access these envelopes include Fade In/Out, Blending,
Panner, Gain Envelope, Amplitude Fit, and Plug-In
Envelope.

LE

Convolve is not available in Peak LE.

Crossfade Loop

The Crossfade Loop function applies a “smoothing” effect
to loops made in Peak audio documents. Crossfade Loop
fades the end of the loop into the beginning of the loop
to make the loop sound smoother. (It uses the Blending
envelope you’ve set in Peak’s Preference menu’s
Blending dialog.) Use the Crossfade Loop dialog to select
the length of the crossfade in milliseconds.

12
Envelope from Audio

Envelopes of varying precision may be created with
this tool. For a more precise envelope, where more
points define the shape, enter a smaller value in
milliseconds in the “ms” field (or use the slider). For
a less precise (smoother) envelope – use a larger
value.

The Crossfade Loop dialog
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Fade In & Fade Out

The Fade In and Fade Out commands allow you to apply
an amplitude envelope to an audio selection. The Fade
In and Fade Out DSP commands, and the Fade Envelope
Editor dialog are described in detail in Chapter 5: Editing.

section of a file with a particular amplitude, and assigning
them to different areas of audio with different amplitudes.
The Harmonic Rotate command can be previewed in real
time, so that desired setting can be found before spending
time processing. Options for processing include
checkboxes for using Real & Imaginary calculations, and a
slider & text field to set amount of rotation.

Find Peak

The Find Peak operation will place the insertion point at
the sample with the maximum amplitude value that it
locates in the audio selection.

LE

Find Peak is not available in Peak LE.

The Harmonic Rotate dialog

LE

Gain Envelope

The Gain Envelope operation allows you to enter an
amplitude envelope to be applied to an audio selection.
The selected audio’s amplitude will be boosted and/or
attenuated according to the envelope you draw in the
Gain Envelope editor.

Harmonic Rotate is not available in Peak LE.

ImpulseVerb

ImpulseVerb™ is an extremely high-quality reverb
processing tool, that utilizes actual reverb impulses
recorded in real spaces, such as performance halls,
catherdrals, caves, and other spaces that have various
reverberation qualities.

The Gain Envelope dialog

Harmonic Rotate

The Harmonic Rotate tool is excellent for sound design
experimentation. This command allows the frequency
spectrum in a selected range of audio to be rotated
around a horizontal axis, which has the effect of taking
frequencies that were previously associated with one
292

The ImpulseVerb dialog

The same convolution technology that is used in Peak’s
Convolve DSP tool allows these natural reverb impulses
to be applied to dry audio signals, giving the impression
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that a file was actually recorded in a particular
environment. ImpulseVerb offers real time preview, so
that the ideal settings can be found before processing. In
addition, ImpulseVerb offers an editable Space envelope,
which controls reverb length and decay characteristics,
and a Wet/Dry slider to control the amount of reverb
being applied.
The ImpulseVerb dialog can also be used as a real
time convolution tool, and is not limited to using
impulse response files to create reverb effects. Any
selection that is copied to the clipboard can be
convolved with the selected range of audio. To
add audio files to the Space pop-up menu within
the ImpulseVerb dialog, simply save the desired file
as a 24-bit Sound Designer II format file, and
place into the Peak Impulses folder within:

icons) in the upper left of the Loop Tuner dialog allow
you to adjust the vertical zoom up of the waveform. The
two zoom buttons in the lower left hand corner of the
Loop Tuner dialog allow you to adjust the zoom view in
and out all the way down to the sample level. You can
listen to the effects of the adjustments as you make them
by clicking on the Play button.

The Loop Tuner dialog – showing a smooth transition between the
looop’s end and beginning.

/Mac HD/Users/Library/Preferences/

LE
LE

Loop Tuner is not available in Peak LE.

ImpulseVerb is not available in Peak LE!
Mono To Stereo/Stereo To Mono

Invert

These two DSP commands may be used to easily convert
an audio document between one and two channel formats.

The Invert function allows you to invert the phase of a
selection or an entire audio document.

12

Loop Tuner

Peak’s Loop Tuner provides a way to visually line up the
start and end points of your loop and listen to the effects
of these adjustments as you make them. The waveform
display in the Loop Tuner dialog shows the Start and End
points of the loop, which you can visually adjust with the
scroll bars at the bottom of the window to achieve a
natural transition at the loop point by carefully adjusting
the slope alignment. The arrows of the slider will move
the loop markers sample by sample and clicking in the
body of the slider will move the loop markers to the next
zero crossing. The two zoom buttons (magnifying glass

Mono to Stereo Conversion dialog

LE

Mono To Stereo/Stereo To Mono is not available in Peak LE.
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While automatic Mono To Stereo/Stereo To Mono
conversion is not available in Peak LE, you can
achieve the same end result manually, by selecting
all in an open mono or stereo document, and
then opening a new, empty document. If you copy
an entire document, open a new empty
document, and attempt to paste in the contents of
the clipboard, Peak will detect if there is a different
number of channels, and will prompt you to enter
a Left/Right panning value, and will then allow
you to paste in the clipboard contents.

Mix

and difference tones of the frequency components of the
modulated audio and the modulating audio. These are
generally very complex timbres that often have a
“metallic” (i.e., inharmonic) character to them.

The Modulator dialog

The Mix command allows you to mix material that you
have copied to the clipboard with a target selection. This
function can be used as a kind of “sound-on-sound”
capability for mixing audio tracks together, or for
blending sound elements. The Mix command is similar
to the Add command, but it does not have the potential
to clip because the target and clipboard contents are
attenuated before mixing. To use the Mix command, you
must first copy a selection of audio. The copied material
can then be mixed into the target audio material.

LE

Modulate is not available in Peak LE.

Normalize

This command allows you to optimize the volume of a
selection or an entire audio document so that it is at its
maximum possible amplitude without clipping. The
normalize function is very useful for boosting the volume
of material that was recorded at too low a level, or if used
on multiple audio documents, for ensuring that the
amplitude of each of the documents is uniform.

The Mix dialog

The Normalize dialog

Modulate

This Modulate command functions as a “ring modulator”
which multiplies two audio signals together (e.g., the
material copied to the clipboard and the currently
selected audio). The resulting audio includes the sum
294

Normalize (RMS)

This command allows volume optimization of a
selection or an entire audio document, so that it is at its
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maximum possible amplitude without clipping. RMS
Normalization is based on the RMS (Root Mean
Square), or “average” signal level of the selected
portion of audio. The RMS value of a file cannot be
increased to an arbitrarily high value, that is, if the
desired RMS value specified is so high that will produce
clipping, the Soft Clip feature will automatically activate
and the resulting level will be lower than specified by
the user. The processed file will be as loud as possible
while guaranteeing that the signal will be limited to the
ceiling specified by the user.

The Panner dialog

LE
The Normalize (RMS) dialog

Panner is not available in Peak LE.

Perpetual Looper

The RMS Normalize dialog offers two parameters – RMS
Level and Digital Ceiling. RMS Level allows you to enter
the desired RMS Level (or average level), and the Digital
Ceiling allows you to limit the maximum audio level,
which is also the level at which Soft Clipping will activate,
if the RMS Level exceeds it.
The RMS Normalize function is very useful for boosting
the volume of material that was recorded at too low a
level, or if used on multiple audio documents, for making
sure that the amplitude of each of the documents is
uniform.

The Perpetual Looper is a new tool based on BIAS’
powerful Partial Harmonic Audio Technology (PHAT).
The Perpetual Looper makes it easy to create smooth,
seamless loops of monophonic, tonal sounds by
performing its work in the frequency domain, instead of
in the time domain as looping has traditionally been
done. PHAT is, at its heart, an analysis/additive
resynthesis engine, which gives Perpetual Looper potent
sound design capabilities beyond smooth looping. The
Perpetual Looper is intended for looping single notes or
sounds, not phrases or sections of audio, and generally
will not produce useful results from phrases.

12
LE

RMS Normalize is not available in Peak LE.

Panner
The Perpetual Looper Dialog

The Panner allows you to adjust the panning, or left-toright movement, of a stereo document by drawing an
envelope in the Panner dialog. Left is at the top of the
graph, and right is a the bottom.

PHAT uses a Fast Fourier Transform to convert the signal
from the time domain into the frequency domain, then
extracts the harmonic structure of the signal. The
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Perpetual Looper’s ability to treat each harmonic
component in the sound individually enables it to
eliminate looping discontinuities in the waveform of each
partial (often the cause of clicking in otherwise wellexecuted time-domain loops), smooth spectral differences
between the start and end of the loop (high frequencies of
a sound generally decay quickly), or smooth differences in
pitch modulation between the beginning and end of the
loop. It even allows the pitch and amplitude modulations
in vibrato to be manipulated independently of each other.
The Perpetual Looper separates the sound being looped
into two components: Partials, which are the harmonic
content, and the Residual signal, which is everything that is
not in the Partials (noise components, non-harmonic
partials, etc.). The user can employ both components, or
choose to use only one or the other. These options present
excellent sound design possibilities. For more information
on the Perpetual Looper, please see Chapter 8: DSP.

LE

Perpetual Looper is not available in Peak LE.

Rappify

The Rappify command applies extreme dynamic filtering to a
selection. As one Peak user described it, “Rappify can turn your
hi-fi into lo-fi!” If the target material has a pronounced beat, this
has the effect of reducing the material to its most essential
rhythmic components. Try using this function with a variety of
different music material for some surprising and exciting results.

The Rappify dialog

LE

Rappify is not available in Peak LE.

Repair Click
Phase Vocoder

The Phase Vocoder is a type of audio spectrum
analysis/resynthesis that allows you to modify the
duration and/or pitch of an audio selection.

The Repair Click command will eliminate a selected click
or “spike” in the waveform using the setting designated
in the Repair Clicks dialog (explained next).

LE

Repair Click is not available in Peak LE.

Repair Clicks

The Phase Vocoder dialog

LE
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Phase Vocoder is not available in Peak LE.

The Repair Clicks command allows you to find and repair
pops or clicks in an audio document. The Repair Clicks
dialog automates the process of finding and removing clicks
(usually indicated by a sharp “spike” in a waveform), much
like a search and replace dialog in a word processor. Repair
Clicks works by looking for discontinuity from sample to
sample. For example, a sample value of -100 followed by a
sample value of 10,000 is likely to be a click. Once the area
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of the click is identified, a smoothing technique is used to
maintain the original shape of the area being repaired.

The Repair Clicks dialog

If you are working with mostly digitally induced clicks,
the Repair Clicks dialog will become an indispensable
tool. Extremely damaged signals such as those of a
scratching and popping vinyl record will require more
careful repair in addition to using the Repair Clicks
dialog, such as Change Gain, Delete, and the Pencil Tool.
Clicks such as those of a scratching and popping vinyl
record loose their detectability once they are sampled
using Analog to Digital converters. For more information
on using Repair Clicks, please see Chapter 8: DSP.

The Reverse Boomerang dialog

Reverse

The Reverse command reverses the current selection.
In a reversed selection, the last sample becomes the
first sample, the second-to-last sample becomes the
second sample, and so-forth. The effect is similar to
playing a record or cassette tape backwards.
Strip Silence

LE

Repair Clicks is not available in Peak LE.

Remove DC Offset

This function allows you to remove any DC Offset in your
audio file. Peak scans the audio for DC offset and then
removes it. Peak will scan the left and right channels of a
stereo file independently. DC Offset is usually caused by
problems in the analog to digital conversion process. The
result is that the waveform is not centered on the base line
– it is offset either higher or lower than the center line.

LE

Remove DC Offset is not available in Peak LE.

Reverse Boomerang

The Reverse Boomerang command mixes a reversed
copy of the selected audio with the original. This creates
a variety of interesting and useful results. Try using
Boomerang on drum loops, voice, and sound effects.

The Strip Silence tool allows areas of silence, or very low
amplitude, to be automatically silenced, minimized, or
completely removed from an audio document. This tool
is useful for removing silence from recordings that
predominantly contain silence (or very low level audio
content), interspersed with some desired audio content.

12
The Strip Silence dialog

By adjusting the various Strip Silence parameters, you
can control what content is preserved, and what is
silenced completely or deleted from an audio document.
The Strip Silence tool is composed of two sections, the
Noise Gate and the Stripper. Additional information
about Strip Silence is available in Chapter 8: DSP.
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Voiceover Ducking

LE

Strip Silence is not available in Peak LE.

Voiceover Ducking is useful for adding vocal material, such
as a radio or podcast show intro, commercial, etc. to a piece
of background audio. Voiceover Ducking functions much
like a standard “Paste” command, but had the added benefit
of controlling several aspects of the background material.

Swap Channels

The Swap Channels command reverses the left and right
channels in a stereo selection.

LE

Swap Channels is not available in Peak LE.

Threshold

The Threshold command allows you to split up an audio
document into its component parts by analyzing the
amplitude levels in the audio document and setting a
cutoff or threshold amplitude. For instance, you might
use the Threshold command on an audio document that
contains successive notes from a musical instrument to
split them up, or on a drum loop to break it up into its
component parts. You can save the segments with
Markers, or as Regions. See Chapter 8: DSP for more info
on using the Threshold command.

The Voiceover Ducking dialog

Sampler Menu
This menu allows you to import samples directly from
compatible samplers, edit or process the audio using all
of Peak’s functions, and send the modified sample back
to the sampler. Peak supports SMDI samplers. For
detailed information on using Peak with SMDI samplers,
see Chapter 11: Samplers.

Audio waveform divided into sections (using markers) based on
amplitude using the Threshold tool.

LE
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Threshold is not available in Peak LE.
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Send to Sampler

Plug-Ins Menu

The Send to Sampler command will send the selected
sample from Peak to your sampler using the Sampler dialog.

The Plug-Ins menu provides access to any Audio Units,
BIAS, or VST effects or virtual instrument plug-ins
installed in your system.

Revert from Sampler

The Revert from Sampler command will revert to the
previously received sample from Peak to your sampler
using the Sampler dialog.
Send All to Sampler

The Send All to Sampler command will send all selected
samples from Peak to your sampler using the Sampler dialog.
Revert All from Sampler

The Revert All from Sampler command will revert all
previously received samples from Peak to your sampler
using the Sampler dialog.
E-mu, Ensoniq ASR-X, Kurzweil, Peavey,
Yamaha Sampler

A large number of samplers support SMDI sample
transfer. Choosing the name of your sampler from the
Sampler menu will open the Sampler dialog. SMDI
Samplers, such as the Kurzweil K2500 or the E-mu E-IV,
use SCSI to transfer samples between devices. In order
to transfer samples between the Mac and your sampler
using SMDI, you must connect a SCSI cable between
your Mac and the sampler. Consult your sampler’s
owner’s manual for instructions on how to connect the
cable to your Mac with proper termination. For detailed
information on using Peak with Samplers, see Chapter
11: Samplers.

LE

Peak can access plug-ins in two different ways – using
“Inserts” or through Vbox. An insert can contain a single
plug-in, and up to 5 inserts are available. When using inserts,
signal flows through the plug-in in each insert in the order of
the insert number. For example, if an equalizer plug-in is
used on Insert 1, and a reverb plug-in is used on Insert 2, the
output of the equalizer plug-in will flow into the input of the
reverb plug-in. Inserts are typically more convenient when
using a small number of plug-ins is required.
Inserts (1-5)

Any installed VST or Audio Units plug-in may be assigned
to any insert. Each insert can contain a single plug-in.
VST & Audio Units plug-ins may be mixed and matched.
When more than one plug-in/insert is active, the output
of Insert 1 flows into the input of Insert 2, the output of
Insert 2 flows into the input of Insert 3, and so on.

LE

Peak LE supports up to two plug-ins at a time.

Sampler Support is not available in Peak LE
BIAS

Choosing BIAS from the Insert “X” submenu brings up
another submenu, displaying all currently available BIAS
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plug-ins. Select the desired plug-in from this menu, and
its editor window (interface) will appear.
VST

Choosing VST from the Insert “X” submenu brings up
another submenu, displaying all currently available VST
format plug-ins. Select the desired plug-in from this
menu, and its editor window (interface) will appear.
Audio Units

Plug-In Envelope

Choosing Plug-In Envelope brings up Peak’s Plug-in
Envelope editor, which allows applying a variable wet/dry
mix over a selected portion of an audio waveform. For
example, if you have a dialogue clip that you would like
to apply reverb to, but would like the amount of reverb
to vary dynamically, you can create a custom envelope
that automatically varies the amount of reverb applied to
different portions of the clip.
Bounce

Choosing Audio Units from the Insert “X” submenu brings
up another submenu, displaying all currently available Audio
Units format plug-ins. Select the desired plug-in from this
menu, and its editor window (interface) will appear. For
more information on third-party plug-ins, please refer to the
manufacturer’s documentation. For detailed information on
using plug-ins and Vbox, see Chapter 9: Plug-Ins.

Once you have the right settings for your plug-ins, you
will probably want to apply the effects to the audio
document. This process is called “bouncing.” Bounce
the audio file to process the audio document with any
active plug-ins. Bouncing changes the audio data stored
on disk, allowing you to use the Save command to
permanently apply the plug-in effects to your audio
document (this action is undo-able before saving).

Vbox

Peak includes BIAS Vbox for managing and mixing plugins. Think of Vbox as a virtual effects box, in which you
can combine, repatch, and mix your plug-ins in real-time.
Using its unique effects matrix, Vbox lets you combine
multiple individual plug-ins. Vbox can patch plug-ins in
series, in parallel, or in series and parallel, and you can
hot-swap plug-ins. Vbox has controls for each plug-in to
mute, solo, and edit parameters. Vbox also provides
input and output gain controls both globally and for each
individual plug-in, and a control for the global Wet/Dry
mix. Use Vbox’s A/B comparison feature to get just the
right settings, and use Vbox’s presets to store
configurations and settings for later use.
To use multiple plug-ins within Vbox, you must
select Vbox from an available insert. While Vbox
can be used on one insert, and other VST plug-ins
can be used on other inserts, it is recommended to
use multiple plug-in within the Vbox matrix, as it
offers much more control and flexibility.
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Real-Time Bounce

The Real-Time Bounce command applies plug-ins to
audio documents in real time. That is, if you are applying
an effect to an hour long audio document, it will take an
hour to bounce. While this technique is significantly
slower than the standard Bounce command, it has the
added benefit of allowing plug-in parameters to be
adjusted during the bounce, and these changes will be
applied to the bounced file.
Another additional benefit of using the Real-Time
Bounce command is routing an audio signal out of Peak,
to a piece of outboard processing gear, and then back in
to Peak. This technique allows processing files with
outboard gear, and requires using the included Jack VST
plug-in, and a multichannel audio interface.
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Cache in RAM

Options Menu
This menu contains a number of commands that allow
you to customize aspects of your Peak software such as
waveform display colors, output volume, and other user
preferences.

On Mac systems with 2 GB or more of RAM, Cache in
RAM can be used to speed up the editing process by up
to 500%. When Cache in RAM is active, any audio files
that are opened are loaded completely into RAM, and all
temp files created during the editing process are also
stored in RAM. When a file has been edited as desired
and saved, all relevant temp files that have been stored in
RAM are written back to the hard drive.
Use Loop in Playback

If an audio document contains a loop (defined by loop
markers), the Use Loop in Playback command (-L)
allows you to listen just to the Loop. If playback is
initiated before the Loop, once the Loop is reached, it will
begin repeating. A check mark next to this menu item
indicates that it is enabled. To turn off loop playback,
disable this command by selecting it a second time.
Scroll During Play

Time Units

The Time Units command allows you to choose a time
format for the audio timeline in Peak’s audio document
window. You can choose Samples, Hours:Min:Sec:cdframes,
Min:Sec:ms, various SMPTE formats, and Bars|Beats. The
format you choose will depend on the nature of the project
that you are working on.

When the Scroll During Play command is enabled, Peak
will “scroll” through the audio document as playback
progresses. This conveniently allows you to visually
follow the progress of audio playback. A check next to
this menu item indicates that it is enabled. To disable
this command, deselect it.
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Move Waveform During Playback

The Sample Units command allows you to select whether
sample units will be displayed in decimal, percentage, or dB.

The Move Waveform During Play command will move
the waveform under the cursor as playback progresses,
so that the insertion point is always in the middle of the
waveform display. A check next to this menu item
indicates that it is enabled.

Playlist

Compute File Max dB

The Playlist menu item features a submenu with options
to view the Playlist’s List, Waveform, or both views
simultaneously.

The Compute File Max dB command scans the audio
document for it’s maximum amplitude, and gives you a
readout of the maximum value and its precise location.

Sample Units
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This feature requires extra time, and is best used with
smaller audio documents when needing to monitor
overall volume during editing. Otherwise, keep this
option off and option-click the “Max” text left of the
overview to update the current audio document’s
maximum volume indicator at the left of the overview.

Auto-Stacking Windows

Show Edits

Certain audio applications such as Digidesign’s Pro Tools
do not directly support stereo interleaved documents,
and instead use “dual mono” documents which comprise
the right and left channels of stereo material. Enabling
the Auto-Import Dual Mono command tells Peak to
automatically convert such documents into new stereo
audio documents when you attempt to open these
documents with the Open command. Because Peak
actually writes a new stereo audio file to disk, this
conversion process requires hard disk space equivalent
to the two original mono documents.

The Show Edits command indicates areas of an audio
document that you have edited by enclosing these areas with
hatched lines. This provides you with a convenient visual
reference to portions of the document that have been affected
by your editing actions. Once you save a document, the edits
are saved, and these indicators will no longer appear.
Show Marker Times

When this option is active, all audio documents that are
opened are stacked on the screen automatically.
Auto-Import Dual Mono

The Show Marker Times command will show a time value as
well as a marker name for all Peak markers, loops, and Regions.

Please note that the Import Dual Mono command
requires that both files be mono files, have the
same sample rate and bit depth, and the must
have the exact same name followed by the suffixes
“.L” and “.R”. If you are using file type extensions
(.aif, .wav, etc) the format must be
“Filename.Side.Extension”. For example –
“Song1.L.aif ” and ”Song1.R.aif ”.

Show Overview

The Show Overview command (-,) provides an
Overview display of the entire audio waveform along the
top of the Audio Document window under the title bar.
This provides you with a convenient visual reference of
the overall document when you are editing only a
portion in the audio document window.
Show Cursor Info

The Show Cursor Info command (-Shift-T) brings up a
floating, translucent cursor information window, which
follows along with the mouse cursor as it is moved.
Choosing this command again turns the window off.
Auto-Tiling Windows

When this option is active, all audio documents that are
opened are tiled on the screen automatically.
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Auto-Adjust Bounce for Latency

Plug-ins may introduce a short delay, known as latency,
into the audio they are being used to process.
Depending on the type of processing the plug-in
performs, the amount of latency can vary – so it is
common for different plug-ins to produce varying
amounts of latency. Latency typically appears in audio
documents after bouncing, by a shift in samples later in
time relative to the document’s own timeline.
Peak features an automatic plug-in latency compensation
feature called Auto Adjust Bounce for Latency – which
automatically compensates for the latency introduced
into a processed signal. Automatic latency compensation
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may be toggled on and off from Peak’s Options menu. A
check next to the Auto Adjust Bounce for Latency item
indicates that this feature is active. The absence of a
check next to this item means it is inactive.
Plug-in latency compensation may also be used manually.
To compensate for plug-in latency when bouncing effects
on a selection, hold down the Option key when choosing
Bounce, and enter the delay compensation you want in
samples in the Bounce Effects dialog. More information
about Plug-In latency is available in Chapter 9: Plug-Ins.

Movie Sound Tracks

The Movie Sound Tracks command brings up a dialog
that allows you to Enable or Disable the movie’s existing
soundtracks. You can use this dialog to toggle multiple
soundtracks contained in a movie on and off to check
balances or “solo” certain tracks. Click on the Set button
to accept the changes, or Cancel to leave the movie
unaffected.

Dynamic Scrub Time

Peak provides a unique audio auditioning technique called
dynamic scrubbing. This feature is very useful for
precisely pinpointing a desired location in an audio
document. Dynamic scrubbing allows you to drag the
mouse forward or backward over a waveform while Peak
plays a short loop (between 10 and 600 milliseconds) at
the scrub location. You can control the tempo and
direction (forward or backward) of playback by dragging
the mouse slower or faster, forwards or backwards. When
you have found the location you are looking for, you can
commence editing or playback. The Dynamic Scrub Time
command allows you to choose the length of this playback
loop. Depending on the audio document’s content, a
value of between 40 to 80 milliseconds typically works
well. See Chapter 5: Editing, for step-by-step instructions
on how to use the Dynamic Scrubbing feature.

The QuickTime Audio Tracks dialog

Half Size

Selecting this menu command displays the open
QuickTime movie at half of its original size.
Original Size

Selecting this menu command displays the open
QuickTime movie at its original size.
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Auto Snap

Double Size

The Auto Snap command will automatically “snap” any
selection to the specified Snap To units.

Selecting this menu command displays the open
QuickTime movie at double its original size.

Keyboard MIDI Input

“Open” Dialog after Launch

Choosing the Keyboard MIDI Input command makes your
computer’s keyboard function as a MIDI input device, able
to send MIDI signals to virtual instrument plug-ins being
hosted in Peak. Additional information about virtual
instruments is available in Chapter 9: Plug-Ins.

The “Open” Dialog after Launch option allows you to
choose whether an open dialog is automatically
displayed when Peak is launched. A check next to this
menu items indicates that it is active. The absence of a
check indicates that it is inactive.
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Window Menu

Contents

The commands in this menu allow you to display and manage
Peak’s windows – including the Transport, Toolbar, Contents,
Movie, MIDI, Playlist, audio document, or active plug-in windows.

Peak has a floating Contents Window that will display all
Regions, Markers, and Loops contained in any open
audio documents. There are three buttons at the bottom
of the palette that allow you to select which items to
view-from left to right: the Markers button, the Region
button and the Loop button. Option-double-clicking on
any item in the Contents window will bring up the Edit
Region or Edit Marker dialog.
Movie

The Movie command toggles the Movie window on and off
for any QuickTime movie you currently have open in Peak.
MIDI

Transport

The Transport window is a floating, re-sizable window. It
contains three areas: a time display showing elapsed time,
the Transport controls (Return to Zero, Stop, Play, Go to
End, Record, and Loop during playback), audio level meters
with clip/peak indicators, and a master volume fader.
Toolbar

You may assign almost any Peak command as an icon in the
Toolbar. The Toolbar menu allows you to group together the
functions you use most often, so that you can simply click a
button instead of going to the menus. For example, if you
frequently use Normalize and Pitch Change, you can choose
to have the icons for these functions in the Toolbar, so that
all you have to do to use one of them is to make an audio
selection and click a button. The Toolbar is an easy way to
make your work in Peak faster and more efficient, allowing
you to customize the program to suit the way you work.
To add or subtract items from the Toolbar, use the
Shortcuts & Toolbar command in the Preferences dialog.
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The MIDI command opens Peak’s MIDI keyboard
window, which can be used to send MIDI signals to
virtual instruments being hosted in Peak. More
information about the MIDI keyboard window is
available in Chapter 9: Plug-Ins.
Playlist

The Playlist command (-P) allows you to open up the
current Playlist window. For more information on using
Playlists, see Chapter 6: Playlists & CD Burning.
Tile Windows

The Tiling Windows command (-T) arranges all open
audio documents in a tile formation on your computer
screen. This type of arrangement allows you to view multiple
open audio documents at once, and is particularly
convenient if you are cutting and pasting between several
documents or jumping back and forth between them for
editing purposes. You can press a -number key
corresponding to an open audio document and the
document will become the active window. (Click the
Windows menu to see the numbers that correspond to each
open audio document.)
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Stack Windows

The Stack Windows command arranges all open audio
documents into a stack, with each document overlapping
the previous document, in the order that they were
opened. This type of arrangement allows you to have the
maximum number of documents open and use the
minimum amount of screen real estate. You can then
conveniently use the Windows menu to select any open
document and make it the active window. Alternatively,
you can press the -number key corresponding to the
open document and the document will become the active
window. (Click the Windows menu to see the -numbers
that correspond to each open audio document.)
These are active commands that will change the
state of document windows that are already open.
In addition, you can specify how windows are
opened by default, by using the Option menu’s AutoStacking and Auto-Tiling Windows commands.

document. Choosing this command will open the
Contents Drawer on the right side of an audio document.
Choosing this command when the Contents Drawer is
open will close the drawer. Toggling the Contents
Drawer can also be done with a button in the top right
corner of each audio document window.

LE

The Contents Drawer is not available in Peak LE!

Plug-In Effect (1-5)

These menu items correspond to open plug-in editor
windows. If you have plug-ins active, choosing the
corresponding insert number in the Window menu will
bring that plug-in’s editor window to the foreground.
Document Windows

All currently open documents appear at the bottom of
the Window menu. Choosing a filename here brings that
document window to the foreground.

Hide All Audio Document Windows

This command temporarily hides all open audio document
windows. This command is particularly useful when
working with Playlists, when the Playlist window is expanded
to a large size. In this mode, Regions may still be pulled from
hidden documents into Playlists. More information is
available in Chapter 6: Playlists & CD Burning.
Reset Windows

This command relocates and resizes the Toolbar and
Transport windows to their default size and position on the
screen. This is especially useful if you frequently work on
different size displays (for example, if you use a MacBook Pro
and occasionally use an external display as a main display).

Links Menu
The Links menu in Peak provides useful links to the BIAS
website. Included are the BIAS home page, the Peak
updates page, technical support pages, online
documentation, special offers, and current BIAS product
information pages.

Toggle Contents Drawer

The Toggle Contents Drawer command opens and closes
the Contents Drawer that is located on each audio
Chapter 12: Peak Menus
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Conclusion
You should now be familiar with using Peak. For
additional information about using Peak, tutorials,
frequently asked questions, etc. please visit the BIAS
website:
http://www.bias-inc.com
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Appendix 1:
Keyboard Shortcuts
Keyboard Shortcuts
This section lists the default keyboard shortcuts for Peak. As you learned in Chapter 3: Peak Basics, these keyboard
shortcuts may be reassigned to any desired key or combination of keys, as well as to icons in the Toolbar.
Keyboard Shortcut

Equivalent Menu Command

Command Comments

File Menu
-N
-Shift-N
Ctrl-N
-Shift-P
-Shift-B
-O
-W
-Option-W
-S
-Shift-S

New Mono Document
New Stereo Document
New Document from selection
New Playlist Document
New Document From Playlist
Open...
Close
Close All
Save
Save As...

Creates a blank mono document
Creates a blank stereo document
Creates new document from selection
Creates a blank playlist
Creates a document from a playlist
Opens a file from disk
Closes the front-most document
Closes all documents
Saves the front-most document
Saves the front-most document with a
new name and/or new location
Saves a copy of the front-most document
with a new name and/or new location
Quit Peak

-Option-S

Save a Copy As

-Q

Quit

Edit Menu
-Z

Undo

-Y

Redo

-X
-C

Cut
Copy

-V

Undo edits one by one
(as long as you haven’t Saved)
Redo edits one by one
(as long as you haven’t Saved)
Cut selected audio
Copy selected audio to clipboard
Paste

A1
(useful for Clipboard based DSP effects
like Mix and Convolve)
Pastes Copied or Cut audio at insertion
point
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Keyboard Shortcut

Equivalent Menu Command

Command Comments

-D

Insert

-E
Delete Key

Silence
Delete

Option-Delete
-`
-A
Up Arrow

Delete Markers Only
Crop
Select All
Insertion Point at Selection Start

Down Arrow
- “-”
-Shift-Left Arrow
-Shift-Right Arrow

Insertion Point at Selection End
Select Loop
Previous Selection
Next Selection

Pastes, pushing audio at insertion point
further to the right.
Replaces audio selection with silence
Deletes selection, does not put in
Clipboard
Deletes Markers, Loops & Regions
Crops selected audio
Selects all audio and events
Places Insertion Point at beginning of
selection
Places Insertion Point at end of selection
Selects loop
Selects previous view or selection
Selects next view or selection

Edit Menu(Cont.)

Action Menu
-] or +
-[ or Control-Up Arrow
Control-Down Arrow
-Shift-]
-Shift-[
Shift-Left Arrow
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Zoom In
Zoom Out
Increase Vertical Zoom
Decrease Vertical Zoom
Fit Selection
Zoom Out all the way
Zoom To Sample Level

Shift-Right Arrow

Zoom To Sample Level (End)

-Shift- “-”
Option-Left Arrow
Option-Right Arrow
- “-”
-M
-Shift-R
-G
-J
-K

Loop this Selection
Nudge Loop Backward
Nudge Loop Forward
Select Loop
New Marker
New Region
Go to Time...
Loop Surfer
Capture Region to Playlist
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Zoom in to start of selection at sample
level
Zoom in to end of selection at sample
level

Keyboard Shortcut

Equivalent Menu Command

Action Menu (Cont.)
-I
Shift--I

Edit Audio Info/Metadata
Edit Peak Metadata Chunk

Audio Menu
Spacebar
-Spacebar

Play/Pause
Play with Auditioning

Return
Shift-Return
-R
Option-R

Plays audio with pre-roll amount designated in Auditioning Preferences

Stop/Rewind
Stop & Extend Selection
Record
Record Settings

Option Menu
-L
-,
-Shift-T

Use Loop in Playback
Show Overview
Show Cursor Info

Window Menu
-P
-T

Playlist
Tile Windows

-1, -2, -3....

Command Comments

Document Windows

-Option-1, -2, -3.... Plug-In Windows

Toggles waveform overview on and off

Opens document’s Playlist.
Arranges open documents in a tile formation.
Brings document windows to front by
number, in the order they were opened.
Brings Plug-In windows to front by number, in the order they were opened.

A1
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Keyboard Shortcut

Equivalent Menu Command

Command Comments

Commands not in a
Menu
<

n/a

Moves playhead cursor to left by coarse
increments
Moves playhead cursor to right by coarse
increments
Moves playhead cursor to left by fine
increments
Moves playhead cursor to right by fine
increments

>

n/a

Option + <

n/a

Option + >

n/a

Playlist
The Playlist features a number of keyboard commands and modifier keys, which can speed up the editing process.
These are described below.
Keyboard Shortcut
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Equivalent Menu Command

Cmd-Shift-P

New Playlist Document

Spacebar

Play/Stop

Cmd-S

Save Playlist

Cmd-W

Close Playlist

Cmd-Z

Undo

Cmd-Y

Redo

Cmd -]

Zoom In

Cmd -[

Zoom Out

Cmd -Shift-]

Zoom to Fit Transition

Up Arrow

Select Previous Track

Down Arrow

Select Next Track

Left Arrow

Go To Selection Start

Right Arrow

Go To Selection End

Ctrl Left Arrow

Scroll Earlier in Timeline

Ctrl Right Arrow

Scroll Later in Timeline
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Keyboard Shortcut
Playlist (Cont.)
Cmd-A

Equivalent Menu Command

Select All

Delete

Delete Selection

Tilde (~) or S

Toggle Between Slip/Shuffle Modes

I

Audition Crossfade In

O

Audition Crossfade Out

X

Audition Crossfade

L

Loop Crossfade

Tab

Move to Next Field (when fields are editable)

Return/Enter

Exit Editable field

Comma (<)

Nudge “In” Event Earlier in Timeline

Period (>)

Nudge “In” Event Later in Timeline

Shift-Comma (<)

Nudge “Out” Event Earlier in Timeline

Shift-Period (>)

Nudge “In” Event Later in Timeline

Ctrl + Move Event Tool

Toggle to High Precision Move Event Mode

Ctrl + Trim Event Tool

Toggle to High Precision Trim Event Mode

Ctrl + Crossfade Tool

Toggle to High Precision Crossfade Edting Mode

A1
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Appendix 2:
Peak Actions

This section lists common Peak Actions not found in
Peak’s menus. It is organized by Peak windows and
functions.

To play from a desired location in the audio document:

•

Useful Peak Actions, General
To stop lengthy processes, Saves and recalculations:

•

Click cursor at desired location in track and press
the Space bar, click the Play button on the Toolbar,
or double-click mouse at desired location in the
track.

Scrubbing

Press -Period
To begin dynamic “shuttle” scrubbing:

•

Audio Document Window, General
To find the Max Level in an audio document:

•

Hold down the Control key and drag the mouse
across the desired area.

To begin dynamic “jog” scrubbing:

Option-click on Max Level Indicator (at bottom left
of audio document window).

•

Hold down the Control and Option keys, and drag
the mouse.

To bring up the Audio Info Dialog:

•

Click on the Audio Info Area at the bottom left of
the audio document window.

Selections
To make a selection:

To navigate the Overview without playing audio:

•

•

Click and drag the mouse.

Option-drag in the Overview
To select all:

•

Playback

To play from beginning of a document, or from the
location of the insertion point:
•

•

To extend or shorten a selection:

•

Press the Space bar, or click the Play button on the Toolbar

To stop playback:

-A

Shift-click on the end of the selection that you wish
to modify, then drag the mouse to extend or
shorten the selection.

To toggle selection start/end:

Press the Spacebar again, or click Stop on the
Transport.

•

Use the shift key.
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To snap selection to the nearest selected Snap To unit:

•

Hold -Option while making a selection.

Views

•

Double-click the triangular base, and click the
Loop Start or Loop End radio button.

To move a pair of loop markers together:

•

To zoom out by increments:

•

To change regular markers into loop markers:

Press - [

Hold down the Option key and drag one of the
loop markers, or select area containing loop
markers and turn on Horizontal Lock – markers
move together until Horizontal Lock is turned off.

To zoom in by increments:

•

Press -]

To move a marker to a zero-crossing:

•
To scroll audio display left or right:

•

Press control-arrow key left or right
To move both ends of a loop or region marker
simultaneously:

Markers, Loops, and Regions

•

To find a Marker by name:

•

Type in the first few letters of the marker name

To edit a Marker:

•

Click on the triangular base of the marker, and hold
down the Shift key while you drag the marker.

Hold down the Option key while moving the
marker, or select area containing loop markers and
turn on Horizontal Lock - markers move together
until Horizontal Lock is turned off.

To delete a marker:

Double-click on the triangular base of the Marker
to open the Edit dialog

•

Double-click the triangular base. Click the Delete
button. A range of markers can be selected and
deleted by clicking Option-Delete.

To name a Marker:

•

Double-click the triangular base of the marker, and
enter a name.

To delete all markers, loops and regions, leaving audio
intact:

•

Select all, then press Option-Delete.

To select the audio between two markers:

•

-click anywhere between the markers, or press
the Tab key.

To paste just markers, loops and/or regions, leaving audio
intact:

•

To select additional audio between markers:

•

-Shift-click between another two markers, or
press Shift-Tab.

Playlist
To scrub Playlist audio during playback:

To move a marker:

•

Click on the triangular base of the marker and drag
it.

•

Or, double-click on the triangular base and enter a time.
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hold down option while selecting paste from the
edit menu (-Option-V ).

•

Click and hold the mouse on the time display. The
cursor changes to a scrub cursor ( <—> ). Drag
to the left to scrub backwards, drag to the right to
scrub forwards. The farther to the left or right you
drag, the faster the scrub will progress.
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Loops

To bring up the Contextual Menu:

•

Control-shift-click in the audio waveform.

To create a loop from a selection:

•

Select desired range, and choose Loop This
Selection from the Action menu (-Shift-“-”).

The Contents Palette
To edit a region, marker or loop in the Contents Palette:

To listen to a loop:

•

Choose Use Loop in Playback from the Preference
menu or Toolbar, and start playback before the
loop end marker.

•

Option-double-click on its name in the Contents
Palette or Contents Drawer.

The Movie Window
Plug-Ins

To change the size of the Movie Window:

To set the delay compensation offset:

•

•

Click on the QuickTime movie’s “grow button” (at
the upper left corner of the Movie window) to
double the size of the movie window.

•

Control-Option-click on the QuickTime movie’s
“grow button” (at the upper left corner of the
Movie window) to halve the size of the movie
window.

•

Select the desired size (original, half, or double)
under the Options menu>Movie...

Hold down the Option key while choosing Bounce
from the Plug-Ins menu.
Note that the Auto Adjust Bounce for Latency
option must be disabled to manually compensate
for plug-in latency.

Tools – Audio Document Window
To toggle between tools:

•

Press the esc (Escape) key.

To toggle Blending on and off:

•

Press the Caps Lock key.

To set the zoom factor amount:

•

Option-click on the Zoom tool in the Cursor
Palette.

A2

To use the Magic Pencil tool:

•

With the Pencil Tool selected, Option-click on a
click/anomaly in the audio waveform – it is repaired.

To bring up the Smoothing dialog for the Pencil tool:

•

Option-click on the Pencil tool in the Cursor
Palette.
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Appendix 3:
Troubleshooting Before Calling For Help

Before you call BIAS Technical Support for help, please
take a moment to examine the Read Me file installed with
Peak. This document contains late-breaking information
not included in your User’s Guide.
Use the Apple System Profiler utility to gather
information about the configuration of your computer.
The information the Apple System Profiler reports is very
helpful when reporting a problem to BIAS Tech Support.
Visit the BIAS web site for the latest technical support
information, an extensive self-help technical FAQ library,
downloads, updates, and more at:
http://www.bias-inc.com

•

Double check that you have entered your serial
number properly! If you are copying/pasting your
serial number from an email, be sure that you have
not copied any extra leading or trailing spaces.
Make sure the version of the product you have
installed on your computer matches the version
listed on the registration card.

If you continue to have trouble, please contact the BIAS
Technical Support Department at:
Email: support@bias-inc.com
Phone: +1-707-782-1865

If you are experiencing strange behavior when using Peak, it
is possible that some of its preferences have been corrupted.
Resetting Peak to its default settings will resolve
most issues, and is the first step that a BIAS
technical support agent will walk you through if
you contact BIAS for support. It is strongly
recommended that you try the following steps
before contacting BIAS for help. This is the fastest
way to resolve most problems.

1. Delete the “ACA P6 Preferences” and “Peak 6.0
Preferences” files from:

Please verify the following:

•

Fixing Most Common Problems

/MacHD/Users/<YourAccount>/Library/Preferences/
2. Using Apple Disk Utility, Repair Disk Permissions.
Disk Utility is located in:
/Mac HD/Applications/Utilities/
3. Restart your Mac.
4. Launch Peak by clicking on the Peak application
icon in your Applications folder (or from an alias in
the Dock) – DO NOT launch by double-clicking on
an audio file.
5. Reset your Scratch Disk – see Chapter 3: Peak
Basics (pg. 53) for more information on setting
Scratch Disk preferences.
Peak is now reset, and should operate normally. Keep in
mind that you may need to reset other preferences, such
as waveform colors, audio input/output settings, etc.
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Resetting Peak as described above will not delete
custom keyboard shortcuts, fade envelopes, or
podcast server presets, as these items are each
stored in separate preference files.

Common Technical Questions about Peak

At this point you should see activity in the VU
meters in the Transport window.

6. The Record Dialog will pop up (Fig. C) – Press the
Record button (circled in red) in this window and
you will see a preview waveform of your recording
in the Audio Source Display, as well as metering in
the Transport’s VU meters.

How do I set up my USB or FireWire audio hardware device?

1. Please download the latest USB or FireWire driver
from your hardware manufacturer’s website.
2. Boot your computer system with your USB or
FireWire device already plugged into an available
USB or FireWire port directly on your computer
and NOT into a USB or FireWire hub.
3. Once your system has started up, launch Peak.
4. Then, from the Peak’s Audio menu, choose “Select
Audio I/O”. Confirm that the desired device is
selected for input and output (Fig. A).

Fig. C

If your audio device is not available for selection
within the Select Audio I/O dialog, verify that the
operating system recognizes it by launching the
Audio MIDI Setup Application located in:
/Mac HD/Applications/Utilities/
Fig. A

It is highly recommended that you use/select the
same audio device for both input and output.

5. After you have connected your audio recording
sources to your USB or FireWire device, and that the
recording source is playing, press the Record button
located on the Transport ( Fig. B cirlcled in red).

7. Ensure that your audio hardware device is an
option within the AudioMIDI Setup window. If it is
not an option please contact your hardware
manufacturer for support, as your operating
system must recognize the device for Peak to be
able to use it for recording or playback (Fig. D).
Why am I getting clicks and pops with my USB device?

1. Update to the most recent version of the Mac OS.
2. If your USB audio device manufacturer provides
drivers make sure you are using the most recent
version.
Fig. B
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Fig. D

Fig. E

3. Delete the “ACA P6 Preference” file. This file is
located in:
/MacHD/Users/<YourUserAccount>/Library/Preferences/
After you delete this file, you will need to reset your
hardware and recording settings in Audio MIDI Setup
and in your audio applications.

6. Open the Select Audio I/O dialog. Make sure you
have the USB device selected as your input AND
output device. Also try experimenting with recording
at different buffer sizes (increasing this buffer size
normally helps). The Select Audio I/O dialog is
located in Audio>Select Audio I/O. (See Fig. F)

4. Open the Audio MIDI Setup utility (shown in Fig.
E). The Audio MIDI Setup utility is located in:

A3

/Mac HD/Applications/Utilities/
5. Make sure the sample rate you have selected is
supported by your device
Fig. F
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7. If you are experiencing pops and clicks during
recording, go to Audio>Record Settings>Device
and Sample Format, and specify a bit depth and
sample rate that is supported by your device. (See
Fig. G)

I notice files on my hard drive with Peak file icons, called
“AFM.temp”

•

These are temporary files that Peak created as you
edited audio. If you change Scratch Disk
preferences at the end of a session, or force-quit or
crash in Peak, sometimes these temporary files
won’t be deleted. You can either manually drag
them into the Trash, or launch and then quit Peak.

I know that I can process separate channels in Peak, but
not edit them separately. Is there a workaround?

•

The workaround is to export dual mono files, open
the Left and Right channels in Peak as two separate
mono files, edit them, save them, and then Import
as Dual Mono. You will then have a stereo file with
your changes in it.

Peak stops or stutters during recording or playback:
Fig. G

8. Go to System Preferences>Energy Saver. Make
sure you turn off any energy saving preferences,
especially the option to spin down the hard
drive.

•

Is your hard disk too slow? For direct-from-disk
recording and playback, your hard drive must have an
average seek time of 18ms or faster. If you are not sure
of the speed of your drive, check with the manufacturer
or the dealer where you purchased the drive.

•

Is the data on your hard disk fragmented? If the
files on your hard drive have become fragmented
(see Chapter 3 for an explanation of
fragmentation) you may have to use a hard disk
maintenance program such as TechTool Pro™ to
defragment your drive.

•

Is Peak’s playback buffer in the Playback Preferences
(found in Peak’s Preference menu) set too low? Try
increasing the playback buffer to 128K or higher.

•

Try turning off Interrupt-based metering in Peak’s
Meters dialog.

•

Try increasing the playback buffer size in Peak’s
Playback Preferences dialog. (Always use the smallest
working setting, because this setting also affects how
much memory is used per audio document window.)

Peak will not launch:

•

Does your Mac have enough RAM to run Peak? You
must have at least 256MB of RAM — 512MB of RAM
is recommended. To find out how much memory
your Mac has, choose “About This Mac” in the
Finder’s Apple Menu. A window will appear telling
you how much memory is currently installed in
your computer. If you have less than the amount
required to run Peak, you will have to install
additional RAM in your computer.

When I place the cursor on the waveform, it jumps to the
right or the left. Why?

•
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This is the result of Peak’s “Auto Snap To
Zero”preference, that automatically places the
cursor at a zero crossing in the waveform. You can
turn it off by going to the Options menu and unchecking the option.

I can’t access Tape Style Scrubbing:

•

Make sure you have selected “Tape Style” from the
Dynamic Scrub Time submenu, under the Options menu.
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There are items in the DSP menu that are grayed out:

•

You need to open an audio document before the
DSP effects will be available.

•

Some DSP tools require a selection to be made in
the audio waveform before they can be used.

•

Not all DSP processes are available in Peak LE.

Problems using Peak with a SMDI sampler (via SCSI):

•

Use high-quality, tested SCSI cables that are as
short as possible.

•

Check for SCSI ID conflicts. Make sure every SCSI
device in the SCSI chain has a unique ID.

•

Check for problems with SCSI termination. For
more information, consult the manuals of your
SCSI devices. SCSI termination should exist on
each end of the SCSI chain: one termination inside
the Mac (usually this is the case), and one
termination on the last SCSI device in the chain.

•

Try turning off Asynchronous transfers in Peak’s
Samplers Preferences dialog.

•

Reduce the number of components in your SCSI
chain. If you have more than one device connected
between the sampler and your Mac, try removing
devices to determine if this affects the errors.

•

Change the power-up order of your devices. Try
turning all SCSI devices on first, including the sampler.
Once the devices have powered up, turn on the Mac.
If this does not help, try turning on your other SCSI
devices, then the Mac, and finally the sampler.

When I try to move a Region marker that’s in the same
position as a marker, the marker moves instead:

•

When editing markers that exist in the same
space/sample, markers take priority. To get to a
Region marker, move or delete the marker first.

How do I export MP3 and MP2 files from Peak 6?

To enable MP3 and MP2 export from Peak, you will need
to install the “LameLib” MP3 encoder and the “twolame”
MP2 encoder.

Please follow these steps to install the downloadable MP3
and MP2 encoders:

1. Download from this URL:
http://www.bias-inc.com/downloads/updates/
archive/MP3_MP2_encoders_inside.zip
2. When this file is done downloading, it should un-zip
itself
and
create
a
folder
called
“MP3_MP2_encoders_inside”.
This folder
contains both encoders and a copy of these
instructions.
3. Use the Finder to locate the Peak application.
Click on the Peak application icon once to
highlight it.
4. In the Finder, go to File > Get Info (-I). A
window will open information about the
application.

5. Click on the disclosure triangle next to “Plug-ins”.
This will display plug-ins that are used by the
application.
6. Click the “Add...” button. The “Add Peak Pro 6.0
Plug-ins” dialog will appear. Navigate into the folder
“MP3_MP2_encoders_inside”
and
select
LameLib.bundle and twolame.bundle, then click
“Choose”.
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How to I choose a Scratch Disk?

1. Create a folder called “Peak Scratch Disk” on a
drive/volume you prefer. We recommend
partitioning your hard drive or using an external
drive for the scratch disk, however creating a
scratch disk on the same drive as your operating
system will work as well.
2. Open Peak’s Preferences dialog.
3. Click on “Scratch Disk”.

Please note you have to close the “Plug-ins” viewer
and reopen for the twolame.Bundle to appear in
the list.

8. MP3 and MP2 now will show up as an available file
format under the Save As dialog.

4. Be sure that only the “Primary” radio button and
“Use” checkbox are selected for the drive you
created your scratch disk folder on as mentioned in
step 1. No other drive should should have
“Primary” or “Use” selected if you are using
multiple hard drives or partitions.
5. Click the “Folder” checkbox, then navigate to the
scratch disk folder you created in step 1 –
“Choose” that folder.
6. Click “OK” to exit the scratch disks dialog.
7. Locate the “Audio” menu (located next to the DSP
menu) within Peak.
8. Click on “Record Settings”.
9. From the “Record Disk” pop-up menu, choose the
hard drive on which you created the scratch disk,
and click “OK”.
After setting up the scratch disk and record disk
settings be advised that you will have to save all
your recorded files on the scratch disk drive.
Saving on any other drive or volume will result in
the following error “You must save the new audio
recording to the volume that you recorded onto”.

I try to instantiate a plug-in on an insert, but there is
already a plug-in called Vbox running on that insert:

•
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Choosing the Vbox menu item automatically opens
Vbox on the first available insert – perhaps this
menu item was chosen and automatically assigned
Vbox to the insert you are trying to use. To turn
off Vbox, simply select the insert it is running on,
and then choose None from the submenu.

Burning to CD-RW media:

Peak supports burning to CD-RW media, however the
CD-RW media must be blank. Peak will not erase a CDRW that already contains data.
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To erase CD-RW media:

•

Use the Mac OS X Disk Utility to erase a CD-RW
before attempting to burn audio data to it. The
Disk Utility is located in the Utilities folder, within
the Applications folder.

A3
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Appendix 4:
Sqweez-1 Wideband
Dynamics Processor

About Sqweez-1
Sqweez-1 is a flexible, high-quality compressor/expander
that is an invaluable tool for controlling the dynamics of
your audio. In addition to standard dynamics processor
controls, Sqweez-1 offers useful features, including peak
and RMS Metering, a soft clip function, and automatic
gain compensation. From adding punch to your drums
to final mastering before delivery, Sqweez-1 can give your
audio the professional sheen that marks high-end
productions.
In addition to all of the familiar controls found on most
compressors, Sqweez-1 includes helpful tools not
commonly found on hardware compressors such as
automatic gain compensation, and a soft clip option.
These controls enable you to maximize your audio signal
while eliminating the need to worry about digital
clipping.
Sqweez-1 is available exclusively as a plug-in
included with BIAS Peak Pro 6, and does not work
with other host applications.

Installation Notes
Sqweez-1 is installed into the following directory as part
of the Peak Pro 6 installation process:
/MacHD/Library/Audio/Plug-Ins/VST/

Sqweez-1 Controls
Sqweez-1 offers three types of controls: Sliders, buttons,
and numerical fields. The numerical fields always
accompany a slider and serve two purposes: First, to
display the exact value of the parameter, and, second, to
allow settings to be made to precise values by entering
the desired value directly into the field. Thus, Sqweez-1
enables you to work quickly with the slider or precisely
using the numerical fields. Option-clicking on any slider
resets it to its default value.
Input Level Meters

The stereo meter on the left side of the Sqweez-1
window shows the input level of your audio. This is a
peak-reading meter.
Input Clip Indicator

This indicator lights red if more than two consecutive
samples exceed the maximum value. The indicator can
be reset by clicking on it.
RMS Level Meter

This meter shows the RMS level of the signal. Since
Sqweez-1 uses RMS level for threshold control, this
meter shows you the same level that is being used to
Appendix 4: BIAS Sqweez-1
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Overview of Sqweez-1 Interface

Gain Compensation Button

Soft Clip Button

A/B/C/D Snapshot
Controls

Ratio Slider

Clip Indicator
Clip Indicator

Input Level Meters
Output Gain Slider
Output Level
Meters

Threshold Slider

Max Gain
Change Slider

RMS Level Meter

Attack Slider

Release Slider
Gain Change
Meter

Factory Preset Controls
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Knee Shape
Slider

User Preset
Save/Load Buttons
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Bypass Button

control the processing. Consequently, you will find that
the RMS level meter generally provides the best guide to
setting the threshold.
Threshold Slider

The threshold slider determines the RMS level at which
Sqweez-1 begins affecting the signal. Below the
threshold, the signal passes through unaltered. Once it
exceeds the threshold, Sqweez-1 will begin processing as
configured with the other settings.

the ratio. That is, a .5:1 ratio means that for every .5 dB
increase in input signal over the threshold, there is a 1 dB
increase in output signal. This is useful for adding more
punch to signals that might have been previously overcompressed, but it also presents the potential of
overloading Sqweez-1 and introducing clipping. Low
ratios are typically used for expansion applications.
The majority of the Ratio slider’s resolution is devoted to
compression, but precise expansion ratios are easily
achieved by entering a value less than one into the field.
Max Gain Change Slider

Gain Change Meter

The Gain Change meter displays the level of gain
processing being applied. When used as a compressor,
Sqweez-1 will reduce the gain above the threshold; when
used as an expander, it causes gain increase above
threshold. The Gain Change meter is RMS-reading.

The Max Gain Change slider limits the degree of
processing applied by Sqweez-1. When set for
compression, the Gain Change slider indicates the
maximum amount of gain reduction that will be
imposed. For expansion, it indicates the most gain that
will be added to the signal. Setting this parameter
carefully is important to avoid clipping when expanding.

Ratio Slider
Attack Slider

The ratio slider determines the degree of gain change to
be applied. For example, if Sqweez-1 is set to compress
using a 3:1 ratio, once the signal exceeds the threshold,
every increase of 3dB in the level of the signal coming in
will result in only 1dB of increase in the output signal.
This is described as being 2 dB of gain reduction.
The Ratio field indicates the first number of the ratio, with
the second number always being “1,” so entering “4” in the
field yields a 4:1 ratio, while entering “.5” yields a .5:1 ratio.

The attack slider controls the rate at which Sqweez-1
begins affecting the signal once it has exceeded the
threshold. Slower attack times are less obvious when
compressing and allow more peaks through; faster times
are better for catching sudden changes, but have a more
audible effect. When expanding, however, fast attack and
release times can be useful for restoring peaks.
Release Slider

The higher the ratio, the more the dynamics of the audio
will be reduced once the signal level is over the
threshold. Ratios greater than about 10:1 severely limit
the audio from getting much louder, an effect known as
“limiting”.
While ratios greater than 1 (e.g.. 2:1, 6:1) result in
compression, Sqweez-1 can also be set to ratios less than
1, which results in expansion. With expansion, when the
signal exceeds the threshold, gain is added according to

The release slider controls the rate at which the
compressor stops processing after the signal falls below
the threshold. The range of release times used can be
quite wide, depending on the application. For example,
taming peaks or compressing percussion is often best
achieved using faster release times, while leveling (an
overall smoothing of dynamics) usually requires a slow
release time. Similarly, expansion release times can be
quite variable according to the desired effect.
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Knee Shape Slider

Output Level Meters

The “knee” is the transition point at the threshold where
the onset of gain change occurs. If the gain change action
happens immediately upon the signal exceeding the
threshold, it is referred to as a “hard” knee, but if the
onset of the gain change is more gradual once the
threshold is exceeded, the processor is said to have a
“soft” knee. A soft knee gives a more transparent sound,
while a harder knee is more audible, but can be a
pleasing effect on some sources. Sqweez-1’s knee slider
enables you to choose a hard or soft knee, or something
in between, giving you flexibility for the task at hand.

The stereo meter on the right side of the Sqweez-1 plugin shows the peak output level. Dynamics processing
can have a dramatic effect on levels, so it is good to keep
a close eye on the output level, especially while setting
up Sqweez-1’s parameters.

Gain Compensation Button

Output Clip Indicator

This indicator lights red if more than two consecutive
samples exceed the maximum value. The indicator can
be reset by clicking on it.
A/B/C/D Compare Buttons

Since compression reduces gain, it is often necessary to
boost the output level to compensate. When the Gain
Compensation button is engaged, Sqweez-1
automatically adds “make-up gain”. The amount of gain
added is based on the threshold setting and is typically
effective. However, it is sometimes necessary to make
additional adjustments to the Output Gain slider, or to
engage Soft Clip.
Soft Clip Button

The Soft Clip feature is useful with signals that have lots
of peaks or are at a generally high level. Soft Clip keeps
Sqweez-1 from producing undesirable digital clipping
when it is overloaded. Try switching Soft Clip in and out
to compare the sound with and without it before making
up your mind.

The A/B/C/D comparison feature gives the ability to
preview different settings before committing to them.
Essentially, various tool settings are made and stored as
snapshot “A” – another group of settings can then be
assigned as snapshot “B” – and then clicking the A or B
buttons in the interface instantly toggles between the
two. As Sqweez-1 offers many fine-tuning options, it
features not just two comparison modes – but instead
includes A/B/C/D comparisons, for four unique
snapshots to compare between, before committing to
any file processing. These snapshots are similar to
saving and loading presets, but are instantaneous, and
do not require selecting presets from a menu to load
them. To permanently save one of these snapshots,
simply select the desired snapshot, and save it as a
custom User Preset.
Factory Preset Pop-Up Menu

Output Gain Slider

The Output Gain slider can be used to manually make up
for the gain lost from compression. After making your
settings to compress the peaks, you can use the output
gain to raise the overall level of your audio. Conversely,
when expanding, you may wish to lower the Output Gain
to avoid clipping.
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This menu displays the current factory preset, if one has
been selected. Clicking this menu shows a list of all
available factory presets. A factory preset may be
selected by choosing it from this pop-up menu.
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Factory Preset Selection Arrows

These arrows are used to navigate through factory
presets. Clicking the down arrow moves to the next
available factory preset, and clicking the up arrow moves
to the previous factory preset.
User Preset Save Button

Saves a user preset, which includes the state of all
Sqweez-1 parameters.
User Preset Load Button

Recalls a user preset, includes the state of all Sqweez-1
parameters.
User presets do not appear in the Factory Preset
pop-up menu, so be sure you are aware of the
directory where you are saving them into, so they
may be recalled easily later.

Bypass Button

The Bypass button is used to temporarily disable the
plug-in. When the plug-in is bypassed, audio playback is
not affected by the plug-in.

A4
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Glossary

AAC

Advanced Audio Coding – (Also known as AAC, MP4, or
mpeg 1, layer 4) – A compressed audio file format that
uses psychoacoustic modeling to reduce file size
significantly, while audio quality rivals that of
uncompressed CD audio. MP4 is a fairly new standard
and rising in popularity for use on the Internet and in
personal music players. Peak supports reading/writing
AAC files.
AIFF/AIF

Apple’s Audio Interchange File Format used for
recording and storing digital audio. It is also Peak’s
default file format and is supported by many Mac
software applications.

Audio hardware (audio interface, audio card)

An Audio hardware interface connects to a Mac via a PCI,
PCMCIA, USB, or Firewire connection – and may include
an additional break-out box. Third-party audio hardware
enhances a computer’s audio recording and playback
capabilities. Using Apple Core Audio, Peak works with a
variety of audio interfaces from Alesis, Apogee,
Digidesign, Digigram, Echo, Edirol, ESI, Korg, M-Audio,
Mark of the Unicorn, PreSonus, and others. Core Audio
Driver software from the manufacturer of the audio
hardware may be required to work properly with Peak.
Audio document

An audio document is a Mac audio data file created by Peak.
Peak can create and open audio documents in many
common audio file formats. AIFF is Peak’s default file format.

AU

AU, or .au, is the audio file format common to most Sun
Unix workstations. It is one of the most commonly used
audio file formats on the World Wide Web.
Audio Units

Audio Units is a real-time, native plug-in standard
developed by Apple, Inc. Audio Units plug-ins are
accessed by compatible host applications from a central
directory. Mac OS X includes several Audio Units plugins, which can be accessed in Peak. (Audio Units are
sometimes referred to as “AU” plug-ins, not to be
confused with the “AU”, or “.au” file format used on Sun
Unix workstations)

Bit resolution (bit rate or bit depth)

Describes how many bits – as in “0s” and “1s” – are
available to describe a digital recording. In practice, the
bit resolution defines the dynamic range of a sound,
whereas the sample rate defines the frequency range. 24bit is a high-resolution bit depth used for professional
audio recording, editing, and processing; 16-bit audio is
the professional Compact Disc and DV (Digital Video)
standard; 8-bit audio is suitable for less demanding
applications, such as multimedia presentations. More
bits result in better quality, but also require more hard
drive storage space. Also refer to dynamic range,
frequency, and sample rate.

Glossary

331

G

Blending

Blending is an automatic crossfade function that Peak
applies to areas during cutting, pasting and other editing
processes in order to smooth abrupt transitions between
waveform amplitudes. Blending can be toggled on or off
by choosing the Blending command from the Preference
dialog, or by clicking the Bending enable/disable button
in the Cursor Palette.

mismatch in level between an audio source and an audio
destination. When digital clipping occurs, such as during
digital recording, the results can be a harsh “crackling” or
“raspy” sound. When you use Peak, you can avoid digital
clipping by ensuring that the record levels are set so that
the loudest incoming audio passages stay below the
maximum input level, as indicated on the record or
playback meters. Peak’s Clip indicator will easily show
any clipping that occurs. Also refer to headroom.

Broadcast WAVE

CD Frame

Broadcast WAVE (also known as BWF) is a variation of the
Microsoft WAVE audio file format and is a common
recording format for non-linear audio and video
recording and editing equipment. This format adds
extensive metadata support.

A CD frame is a sector of data on a Red Book audio CD
that contains 588 samples of audio. CD frames are one
of available Peak’s time units options.

Centered crossfade

This is the most common unit used for measuring the
level of audio. The greater the number of decibels, the
higher the audio signal. Within Peak, the record and
playback meters show a signal’s relative level in terms of
dB. There are many different kinds of decibel scales, but
for the purposes of using Peak, “dB” can be used to
describe the relative gain of different passages of audio,
or to describe the available headroom during recording.
Also refer to gain and headroom.

Centered crossfades are crossfades that are based
around a centered “edit point” – which by default marks
the exact center point of the crossfade. Typically, this
edit point marks a specific part of the audio material
where two takes of music, dialogue, etc. are joined
together. When this type of crossfade is lengthened or
shortened, the edit point does not move, but instead
controls how smoothly the two takes of audio blend
together. This type of crossfade is popular with editors
of classical music, who commonly work with many short
takes of the same piece of music, as they piece together
the best takes into a single optimized performance.
Clipping

A type of audio distortion that occurs when a source
signal (such as from an audio CD player) is recorded at
such a high level that the recording device (such as a Mac
running Peak) runs out of “headroom.” It can also occur
when a signal is played back from an audio source into an
audio destination at an excessive level, such as when a
mixing console feeds a signal to a power amplifier at an
extremely high level. In either case, clipping represents a
332

dB (decibel)

DSP

DSP stands for digital signal processing. In the world of
audio, DSP refers to manipulating a digital audio signal
by processes such as level changes, reverberation, delay,
or other such effects. Peak uses DSP to perform many of
its audio processing tasks – including those found in the
DSP menu or Toolbar.
Dynamic range

In audio recording terminology, dynamic range refers to
the range in level between the quietest and loudest
passages of a selection of audio. It is usually expressed in
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decibels. Bit resolution determines a recording’s
dynamic range. An 8-bit recording has 256 available
levels, which translates into a dynamic range of 48 dB.
This may be suitable for some applications, but it may
also sound noisy, since the difference in gain between
the loudest passages and the quietest passages (which
may contain hiss and other potential noise) is not that
great. A 16-bit recording has 65,536 available levels,
which translates into a high-quality dynamic range of 96
dB. As a rule of thumb, you can calculate dynamic range
in decibels by multiplying the bit rate by “6.” Also refer to
bit resolution, decibel, and gain.
Fade-in/fade-out

A fade-in is a process that increases the gain of an audio
signal from zero (silence) to its full volume. A fade-out is
a process that decreases the gain of an audio signal from
its full volume to zero (silence). Peak allows you to
create fade-ins/fade-outs by making a selection and
choosing the Fade In or Fade Out command from the
DSP menu, from the Toolbar, or with a custom key
command. Envelope shapes can be editing with the
Fade In Envelope or Fade Out Envelope commands in
the Preference dialog.
FLAC

FLAC (Free Lossless Audio Codec) is an audio format
similar to MP3, but lossless, meaning that audio is
compressed without any loss in quality.

Gain

1) The process of amplifying a signal. 2) A way to express
relative signal levels for audio. For instance, by adding 6
decibels of level to a signal, we double the perceived
loudness of the signal. Also refer to decibel and
headroom.
Headroom

Describes how much gain is left before a signal induces
clipping or distortion. When recording with Peak, the
record meters indicate how much headroom is left
before clipping. When playing back audio in Peak, the
meter strip at the bottom of the screen will indicate this
as well. Most professional audio engineers leave between
3 dB and 12 dB of headroom while recording, to
minimize the possibility of clipping. If you leave too
much headroom, however, your signal may be recorded
at too low a level, and you may end up with excessive
noise or hiss. Also refer to clipping, decibel, and gain.
Hz (Hertz)

This is the unit of measurement for frequency, and refers
to the number how many “cycles per second” a sound
wave generates. In the world of sound, the higher the
number of Hertz, the higher the frequency of a sound
and hence the higher its “pitch” as perceived by human
ears. A thousand Hertz can be expressed as 1 kHz (one
kilohertz), so that 20,000 Hertz may also be referred to as
20 kHz.

Frequency
Loop

Sound consists of waves, which occur in cycles.
Frequency refers to how frequently these wave cycles
occur in a given period of time (generally, one second).
The higher the frequency of a sound, the higher its
“pitch” as perceived by human ears. Frequency is
measured in Hertz (Hz), or cycles per second. Roughly
speaking, humans are able to hear sounds in the
frequency range between 20 Hz and 20,000 Hz (20 kHz).

Loops are used to sustain or repeat a section of audio. They
can be used for material that you intend to transfer to a
sampler, or simply for playback within Peak itself. Peak
allows you to create one loop per audio file. You can do this
either by making a selection and choosing the Loop this
Selection command (-Shift-”-”) from the Action menu or
Toolbar, or by placing markers at the desired start and end
point of a region, and defining the markers as loop markers.
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Loop Tuner

MP3

A feature of Peak that allows you to “fine-tune” the start
and end points of a loop.

(Also known as mpeg 1, layer 3) – A compressed audio file
format that uses psychoacoustic modeling to reduce file size
significantly, while retaining good audio quality. Popular for
use on the Internet and with personal music players.

Loop Surfing

Peak’s term for adjusting loops during playback.
Loop Surfer™

A proprietary feature of Peak, which automates many of
the steps required to “loop surf.”
Marker

A marker is a location in an audio document that you
define as important; you can also think of a marker as
a “memory location.” By marking a specific location in
a recording, you can easily navigate to it for selection,
editing or playback purposes. Peak allows you to
define a marker by pressing -M or clicking a Toolbar
button, either when playback is stopped or while it is
engaged.
Metadata

Metadata is commonly described as “data about data,”
but it is easier just to say that it is descriptive information
about an audio file. Artist, album, and song are three
typical pieces of metadata that might describe a music
file purchased from an online music retailer, while
metadata for a file from a sound effects library might
include file name, genre, description, copyright, and
other information.
MP2

(Also known as mpeg 1, layer 2) – A compressed
audio file format that is widely used in digital
broadcasting.

MP4

(Also known as AAC, or mpeg 1, layer 4) – A compressed
audio file format that uses psychoacoustic modeling to
reduce file size significantly, while audio quality rivals
that of uncompressed CD audio. MP4 is a fairly new
standard and rising in popularity for use on the Internet
and in personal music players. Peak supports
reading/writing MP4 files.
Playlist

A playlist is a list of audio events, or “regions,” strung
together in a specific order. See also region.
Overlap crossfade

This type of crossfade is used when assembling completed
tracks (songs) together in a Playlist. It is used to smoothly
transition from one song to the next, and differs from a
centered crossfade in that there is no static edit point.
Plug-ins

Plug-Ins are optional software enhancements for Peak
that are available from BIAS and other third-party
manufacturers. By installing plug-ins, you can enhance
Peak’s audio processing capabilities with tools such as
reverberation, chorusing and flanging, noise reduction,
spatialization, multi-band dynamics, pitch correction,
spectral matching, equalization, and more.
QuickTime

This is an audio format developed by Apple, Inc. for
QuickTime-based multimedia. It is supported by all Mac
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software applications that support QuickTime. The
QuickTime format is best if you plan to use an audio
document in multimedia applications.

a keyboard or other controller. Samplers are used
extensively in all areas of audio production, ranging from
recording and performance, to film production and
sound design. See sample rate.

Region
Sample rate

A region is a portion of an audio document bounded by
region markers. Regions are portions of an audio
document defined using the New Region command (Shift-R) from the Actions menu or Toolbar. Regions can
be saved into only AIFF and Sound Designer II files
created by Peak. See also playlist.
Rolling edit

A rolling edit occurs when the usually static “edit point”
(or exact mid-point of a centered crossfade) is moved
along the timeline, without changing the duration of the
crossfade, or altering the shape of the crossfade’s
component fade in and out envelopes. Rolling edits are
useful when two pieces of audio occur at the correct
position on the timeline, and relative to each other, but
the location where the two meet needs to be adjusted
with no changes in timing between the two.
Sample

(verb) Sampling refers to the act of recording audio
material digitally by a sampling instrument or other
digital recording device. See sampler and sample rate.
Sample

(noun) A sample refers to audio material which was
recorded digitally or “sampled” by a sampling instrument,
recording software such as Peak, or other digital recording
device. Sample also refers to a single wave-cycle”
snapshot” of sound. See also sampler and sample rate.
Sampler

A sampler is an electronic instrument capable of digitally
recording or “sampling” a sound and playing it back from

Sample rate describes how frequently an analog audio
signal is been “sampled” or analyzed as it is recorded and
converted to a digital medium. Sample rate directly
affects audio fidelity in terms of upper frequency
response: the higher the sample rate, the higher the
available frequency response. A fundamental principle of
sampling (known as the Nyquist Theorem) states that to
accurately capture a sound, the sample rate must be at
least twice the highest frequency in the sound. The
standard sample rate for Compact Discs is 44.1 kHz. The
following are common sample rates which are supported
by many Mac computers and Peak software.
192.000 kHz

This is the upper standard for HD (High-Definition)
audio hardware/production. This rate results in an
upper frequency response of 96 kHz – well above the
range of human hearing.
96.000 kHz

This is a standard sample rate for HD (High-Definition)
DVD audio, and is often used by sound editors working
in audio post-production for DVD. This rate results in an
upper frequency response of 48 kHz – well above the
range of human hearing.
48.000 kHz

This is a standard sample rate for digital audio tape
(DAT) recorders, and Digital Video (DV ) equipment, and
is often used by sound editors working in audio postproduction for video or film. This rate results in an upper
frequency response of 24 kHz – above most people’s
hearing range.
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44.100 kHz

Sound Designer II

This is the standard sample rate for Compact Discs,
digital audio tape (DAT) recorders, and high-fidelity
audio applications on Mac and PC-compatible computers
with 16-bit playback capability. It is colloquially called
“forty-four one” (as in 44.1 kHz). Most sound engineers
working in music production – or anything that may be
distributed on a CD – work at this rate. This rate results
in an upper frequency response of 22,000 Hz – above
most people’s hearing range.

This is an audio file format developed by Digidesign for
use with its digital audio products. The format can also
be read by a wide variety of Mac-based audio editing and
multimedia development programs, including Peak.

22.050 kHz & 11.025 kHz

These sample rates are sometimes used for lower-fidelity
audio playback on Mac and PC-compatible computers.
Many games, websites and other multimedia productions
utilize 22.050 kHz (or lower) 8-bit audio, since it uses half
the disc space of CD-quality audio. The 22.050 kHz
sample rate results in an upper frequency response of
12.025 kHz; this may sound “muffled,” since most people
can hear considerably higher frequencies than 12.025
kHz.
Also refer to bit resolution, frequency, and Hertz.
SCSI

VST

“Virtual Studio Technology” – VST is a real-time, native
plug-in standard created by Steinberg Media
Technologies, AG. Plug-ins conforming to the VST
standard can be used in any compatible host application.
VST plug-ins are accessed from a central directory in the
Mac OS, making it very easy to maintain large collections
of plug-ins.
WAVE

This is Microsoft’s Windows Audio File Format. It is
supported by many Windows software applications and
some Mac applications. The WAVE format is best if you
plan to use an audio document in an application that
supports or requires WAVE format files. See also
Broadcast WAVE.
Zero-crossing

Stands for Small Computer System Interface. It is a
standard developed to allow a variety of computers
and peripheral devices such as samplers, hard disks,
CD recorders, scanners, and other storage media, to
connect and transfer data. The SCSI specification
allows up to seven SCSI-equipped devices to be
connected or “daisy-chained” together.

The zero-crossing is the point where the waveform
meets the zero crossing line or the center line through
the waveform. It is the point of zero amplitude in the
waveform.

SMDI

SMDI stands for SCSI Musical Data Interchange Protocol.
SMDI Samplers use SCSI to send samples between
devices several times more quickly than over MIDI. In
order to transfer samples between the Mac and your
sampler using SMDI, you must connect a SCSI cable
between your Mac and the sampler.
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Symbols/Numbers
0 Character 100
# Character 100
# Items 262
+ 47
+/- 49
- 48
8-bit 38, 46
16-bit 38, 46, 64, 202
24-bit 38, 202
32-bit 38
20 Hz 37
11,025 kHz 336
20 kHz 37
22,050 kHz 336
22.5 kHz 37
44,100 kHz 37, 62, 64, 175, 336
48,000 kHz 335
96,000 kHz 335
192,000 kHz 335
3D panner 232

A
.au 43
A/B Comparisons 240
A/B/C/D Snapshots 159, 240, 328
Clearing 165
For a series of Playlist Events 164
Recalling 137, 153, 163
Setting/storing 137, 153, 163, 164

A/D (analog-to-digital) 37
AAC 189, 331
Abrupt transition(s) 91,109
Accented characters (CD-TEXT) 172
Action Menu 279
Active 163
Add 97, 198, 288
Region Button 130
Adding
Regions to a Playlist 127
Regions to Specific Location in a Playlist 129
Additive resynthesis 217
Adjust
Plug-in parameters during recording 71, 241
Advanced
Audio Coding (AAC) 43, 331
Audio Hardware Configuration 63
Playlist Concepts 127
AFM.temp 320
Aggregator 190
AIFC 39, 45
AIFF 39, 43, 45, 64, 98, 173, 331
Alaw 39, 45
Allow Servers 55, 85, 268
Alternate Authorization 31
Ambiance 231
Ambrosia Software 183
Amp simulator 231
Amplitude 48, 78
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Fit 198, 288
Envelope, applying to an audio selection 198
Finding, max point in selection 210
Smoothing 218
Analog
Clicks 89
Tape 38, 77, 204
To-digital converter 37
Analysis
Tool 232
Window Duration 218
Anchor To Sample 96
Anchored 79
Apogee 61
Append to Document Checkbox 67, 286
Apple
Events 251-256
Inc. 231
System Profiler 317
Application icon 42
Applying
CD-TEXT to Tracks in an iTunes playlist. 174
Effects plug-ins 117
Effects Plug-ins to Playlist Events 163
Arranger 166, 167
Arranging Regions in a Playlist 117
Arrow Cursor 47
Assembling
Takes 122
Tracks/finished songs 122
Asynchronous SCSI transfer 264
Attack 227
Slider 224, 327
Attenuation Skew 175
AU 331
Audio
AUDIO.DAT (DDP)174
Between Adjacent Markers 80
Card 331
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Compact Disc Info Button 134
Configuration for USB or FireWire Device 318
Document 47, 77, 331
Create new 88, 173
File Info Bar 47
File Name on Server 184, 189
Hardware 61, 331
Info Area 80
Info Dialog 313
Input Settings 63, 65, 67, 286, 287
Interface 331
Menu 284
MIDI preferences 61
MIDI Setup utility 56, 62
Output Settings 63, 64, 287
Processing 50
Processing with DSP Tools 197
Recording 70
Restoration 232
Selecting between markers 81, 314
Selecting between markers with Tab key 81
Source level 70
Units 159, 231, 233, 300, 331
Waveform 78
Overview 69, 78
Audition(ing) 52, 268
Audio 82
Controls 119
Dialog 52
Fade In 141, 142
Fade Out 140, 142
Looping142
Transitions 125, 140-142
With pre-/post-roll 82
Author 187
Authorization 30
Alternate 31
File 30, 32
Manager 267
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Request File 30, 32
System 30
Auto
-Adjust Bounce for Latency 242, 302
-Apply Default Settings (Adding items to Playlist) 134
-Define Tracks 198, 200, 289
After 201
Before 200
Tips for using 200
-Gain compensation 325
-Import Dual Mono 53, 302
-Snap 79, 89, 303
-Stacking Windows 302
-Tiling Windows 302

B
Background color 267
Balance 213
Barcode 166
Bars/Beats 48, 54, 79, 280
Basic
Audio Hardware Configuration 62
Playlist Concepts – Getting Started 120
Playlist Controls 130
Recording 70
Batch File Processor(ing) 42, 251, 275
Apply Just To First x Seconds 252
Apply Just To Last x Seconds 252
Available Processes 252
Batch script 251
Cancelling 254
Errors 254
Input Area 252
Output Area 253
Process Area 252
Be a Reference Marker 96
Beats
Per measure 54
Per minute (BPM) 48

Begin/End Fade In/Out Envelope Breakpoints 146, 147
Behavior Controls 134
BIAS 231, 299
Authorization Manager 30
Documentation for 231
Freq-2 231
Master Perfection Suite 232
Plug-ins 233
SoundSoap 2 71
Sqweez Compressor/Limiter plug-in 71, 232
Vbox 3.0 232, 234
Bit
-Depth 44, 175, 331
Radio Buttons 66
Truncation 44
Rate 331
Resolution 37, 80, 331
Saturation 201
“True” (bit depth) 201
Usage Meter 201, 289
Blending 52, 91, 268, 332
Configuring Blending 52
Custom 92
Editor 92, 106, 208
Enabling/Disabling 91, 315
Envelope 52
On/Off 47
Boosting volume 216
Bounce(ing) 300
Playlist 44, 135, 176
Plug-ins 235
Real-Time 235, 300
Box
Controls 236, 238
Meters 238
BPM 48, 109
Breakpoint(s) 92, 106, 203, 207, 241
Default 153
Fade In/Out Envelope Breakpoints 146, 147
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Reset Default 153
Broadcast .WAV/WAVE 43, 332
Buffer
Size 62, 68, 72
Underrun Protection 172
BulkProtect 264
Burn(ing)
Audio CD 44, 126, 170, 171, 275
From an Audio Document 171
From a Playlist 126, 170
CD Button 135
CD-TEXT 24, 172
CD-RW media 322
In Simulation Mode 172
Playlist to Audio CD 126
Speed Pop-up Menu 171
Butt
Edits 150, 161
To Previous Event End Button 131
Bypass 163, 238, 329
Byte order 42

C
“C” checkbox 57
Cache in RAM 54, 301
Cancelling Batch Processes 254
Caps Lock key 47
Capture Region to Playlist 281
Categories 191
CD
Burning (see: Burning)117
Burning Options 171
Burning verification failure 172
Frame(s) 54, 79, 280, 332
Boundaries 136
Conform Regions to 98
Import Track Range 41
Options Controls Group 118, 136
-ROM drive 40
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-RW media 322
Erasing 323
-TEXT 117, 134, 166-167, 174
CDDB 41, 165
Centered crossfade(s) 122, 151, 161, 332
Tool 124, 150
Cents 204
Change(ing)
All (color prefs) 53
Duration 202, 289
( Variable) 203, 290
Gain 80, 204, 290
Input Routing 239
Order of Columns (Playlist)159
Pitch 204, 290
( Variable) 205, 290
Sample rate of a document 206
Channel(s)
& Bit Depth radio buttons 64, 66
Independent Processing 79
Level (Podcasting/XML/RSS Feed) 188
Reversing left and right 225
Check for Updates 267
Choose(ing)
A Time Format 53
An item to generate 218
Colors 53
Classical music 130
Clean(ing) 71, 221
Audio 71, 201, 221
SoundSoap/SoundSoap Pro 71, 201, 221
Tape/Cassette 71, 201
Vinyl 201, 221
Noise 71, 201
Clear
Clipboard 278
Snapshot 164
Clearing the Clipboard to Reclaim Disk Space 86
Clicking and dragging 78
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Click(s) 51, 79, 158, 165, 201,
Repairing 89, 221
Clip
Indicator Hold 49
Indicators 49, 240
Clipboard 214
Clipguard 204
Clipping 332
Clock Source Menu 65, 66
Clos (Close the front-most window) 256
Close 46, 272
All 46, 272
Button 46
Closing Audio Documents 46
Colors 267
Background 267
Palette 53
Customize waveform display 53
Comb filtering 232
Command ()-clicking 40
Commercial 226
Common Technical Questions about Peak 318
Compact Disc(s) 37, 331
Composer 166, 167
Compressed file format 45
Compression 39
Compressor 232, 325
Pop-up menu 45
Compute File Max dB 301
Configuration
Of Peak’s Playback & Record Settings 61
For Virtual Instrument Playback 243
Configuration for USB or FireWire Device 318
Conform
Playlist Event to Source Region Button 131
To the selected Snap To format 79
Connect to Server 184
Contacting Technical Support 317
Contents 304

Drawer 47, 48
Window 50
Contextual Menus 315
Contiguous
Selections 128
Space (hard disk) 38
Control
+ Left Arrow 148
+ Right Arrow 148
Area 118
Panel 61
-Spacebar 52, 82
Surfaces 57
Controller Thru 247
Controls Area 136
Convert
Markers into loop markers 103, 314
Mono to stereo 213
Sample Rate 205, 290
Stereo to mono 213
Convolution 206, 211, 247
Variable 207
Convolve 206, 291
Copy (ing)276
Audio 86
CD-TEXT 168
From Peak Metadata to file metadata 113
Protection, adding to a Track 168
Protection Subcode Column 158
Only Markers 98
Only Regions 100
Core Audio 61
Counter Display 118, 134
Country Code 167
CPU meter 236
Create Split Stereo Files Checkbox 67
Creating
Markers 94
New Document from a Playlist 172
Index
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New Peak Document 39
Parallel Effect Chains 239
Playlist 120
Serial Effect Chains 239
Transitions between Playlist Events 125, 150, 160
Volume Envelopes 125
Crop 278
Selection 88
Cross-synthesis 245
About Types in Peak 247
To use 246
Crossfade(s) 52, 92, 117
About Modes 122
Controls 118, 136
In & Out Duration Fields 133
Loop 104, 105, 207, 291
Mode Radio Buttons 136
Overlap 122, 151, 161, 334
Playlist Default 133
Previewing 125
Shape and Duration Controls 133
Style Radio Buttons 133
Crossfading Loops 104
Variations 5, 207
Cursor
Arrow 47
Hand 47
Jumps 320
Magnifying Glass (zoom) 47
“Magic” Pencil 48, 90
Pencil 47, 90
Modes 47
Selection Information 48
Tools 148
Custom
Blending envelope 92
Fade Breakpoints 147
Gaps 117
Units 79, 280
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Volume Envelope Breakpoints 147
Customize 50
Cut 276
Cutting 38
Audio 86
Cycling ‘74 183, 231

D
dB/ Decibel 38, 204, 332
DCAT (Dither Cloning Audio Technology) 44, 175
DDP 174-175
Deactivating Virtual Instrument Plug-ins 245
Deauthorizing a Computer 32
Decay 227
Decrease Vertical Zoom 144, 279
Default breakpoints 153
Delay (effect plug-in) 232
Compensation offset 315
Delete 278
Audio 86
Breakpoint(s) 92
Marker(s) 96, 97
Markers/Loops/Regions Only 278
Markers in a Selection 97
Playlist Events 131, 150, 160
Preferences 317
Delta symbol (Δ)147
Detection Setting 221
Digidesign 61
Digital
Audio, A Brief Explanation of 37
Audio Editing 77
Ceiling 216
Clicks 89, 221
Signal Processing (DSP) 197, 332
Sync 65
Video 331
Direct monitoring 68, 244
Directory permissions 55
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Disc
Description Protocol (DDP) 174-175
Identifier 166
-specific CD-TEXT 166
Disclosure triangle 78, 128, 187
Show/Hide Controls Area 136
Show/Hide List View 155
Show/Hide Waveform View Area 142
Discontiguous selections 128
Disk permissions 55
Distance to Reference Marker (DTR) 48
Distortion 68
Dither(ing)44, 171, 175, 232
Cloning Audio Technology (DCAT) 44, 175
Preferences 175, 271
Preferences dialog 44
Truncation 44
DJ mix 47
Document
Audio 47, 77, 331
From Playlist 272
From Selection 272
Go to end of 69
Windows 305
Recently Opened 275
Documentation for BIAS plug-ins 231
Don’t Save 58
Button 46
Double
Size 303
-click on Waveform to Begin Playback 51, 69, 270
-clicking 81
Down Arrow key 78
Dragging and Dropping 42
Drawing directly on the waveform 47
Dropouts 62, 68
Drum loop pitch changer 232
“Drutil” Terminal Commands 169, 170
Dry 212

DSP (Digital Signal Processing) 22, 197, 332
Menu 197, 288
Categorization 269
Greyed out items 321
Preferences 269
Process audio with 197
Tools 197
Add 198
Amplitude Fit 198, 288
Auto Define Tracks 198, 200, 289
Bit Usage 201, 289
Change Duration 202, 289
Change Duration ( Variable) 203, 290
Change Gain 80, 204, 290
Change Pitch 204, 290
Change Pitch ( Variable) 205, 290
Convert Sample Rate 205, 290
Convolve 206-207
Crossfade Loop 5, 104, 207
Envelope from Audio 209, 291
Fade In 93, 209
Fade Out 93, 209
Find Peak 210, 292
Gain Envelope 210, 292
Harmonic Rotate 210, 292
ImpulseVerb 206, 211, 292
Invert 212, 293
Loop Tuner 212, 293, 334
Mono-to-Stereo 213
Mix 214
Modify Sample Rate 214
Modulate 215
Normalize 215
Normalize (RMS) 216, 294
Panner 216, 295
Perpetual Looper 219
Phase Vocoder 219, 296
Rappify 220, 296
Remove DC Offset 222, 297
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Repair Click(s) 89, 220, 222, 296
Reverse Boomerang 222, 297
Reverse 223, 297
Strip Silence 223, 297
Swap Channels 225, 298
Threshold 225, 298
Voiceover Ducking 226, 227, 298
Stereo-to-Mono 213
DTR 48
Dual mono 53, 67
Auto-Import 53
Ducking Amount 227
Duplicate 277
Playlist Event 130
Audio 87
Duration 48
DV 331
Dynamic
Jog scrubbing 82
Level change 126
Range 38, 332
Scrub Time 51, 303
Scrubbing 82
Shuttle scrubbing 82

E
E-mu 43, 261, 299
EAN (European Article Number) 166
Earthlink 190
Edirol 61
Edit(s)(ing) 23, 77, 238, 276
Audio Info 283
Blending Envelope button 52
Breakpoint 92
Command 77
Crossfade Loop Envelope 106, 208
Essential Functions 85
Fade In/Fade Out envelope 93
Fade In/out Duration 157
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History list 84
Marker dialog 95, 103
Menu 276
MIDI & Tempo Info 54, 283
Peak Metadata Chunk 283
Point 123, 146
Marker 314
Metadata 111
Plug-In Parameters 238
QuickTime Soundtracks 110
Region 99
Region, marker or loop in the Contents Palette 315
Rolling 123, 138, 335
Subcode Data 168
Tools 77
Track Duration 156
Track End Time 156
Track Name 156
Track Start Time 156
Track TS Offset 156
Undo/Redo, one at a time 122
Volume Envelopes & What It Does 153
Effects 231
Included with Peak Pro/LE/XT 231
Matrix ( Vbox) 234
Real-Time Bounce 235, 300
Eighth-note 54
Elapsed time 49, 134
Select Audio I/O Dialog 67
Eliminate latency 68
Email Address 31, 190
Emphasis Subcode Column 158
Encoding 45
Enforce CD Frames 120, 136
Ensoniq ASR-X 299
Envelope
Amplitude, applying to an audio selection 198
Blending 52
Fade In/Out 93
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From Audio 209, 291
Gain 210
ImpulseVerb Response 212
Plug-ins 241
Episode
Advisory 189
Description 188
Format 189
Information 184, 188
Settings 189
Title 188
EQ 231
Freq Plug-in 232
Matching 232
Equal Power X-fade 92
Erase CD-RW media 323
Errors 39, 42
Batch Processing 254
Samplers 263
ESC key 47
Ethernet 55
Example Scripts 256
Expander 232, 325
Export(ing)
As Text 274
Dual Mono 274
Playlist Text Report 176
Regions 101, 102, 226, 253, 274
Drag & Drop from Contents window/drawer 101
Through Batch File Processor 102
Send to iTunes 102
With the Export Regions Dialog 101
External clock source 66

F
Factory Preset
Assignment Menu 237
Controls 238
Pop-up Menu 328

Selection Arrows 329
Fade In 92, 93, 209, 292, 333
Column 157
Duration 146
Envelope 146, 269
Fast 157
Field 136
In Shapes 133
Linear 157
Menu 137
Slow 157
Fade Out 92, 93, 209, 292, 333
Column 157
Duration 147
Envelope 146, 269
Fast 157
Field 136
Shapes 133
Linear 157
Menu 136
Slow 157
FAQ 317
Fast
Fourier Transform (FFT) 217, 218, 220
-Forward 49, 68, 69
-Forward Button 135
Feedback loops 66
Fetch 184
FFT (Fast Fourier Transform) 217, 218, 220
File
Format 80, 173, 286
I/O 23
Menu 66, 271
Name Suffix 253, 254
Overview 47
Recovery 42
Size 80
Type pop-up menu 44
FileMaker Pro 56, 251
Index
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Filename on Server (xml) 188
Final production stage 44
Find
Peak 210, 292
Section 100
Fine-tuning recording levels 70
FireWire 61
Fit Selection 279
Fixing Most Common Problems 317
FLAC (Free Lossless Audio Codec) 43, 333
Flanger 232
Floating windows 271
Format 189
Formatted Playlist Text Report 176
Fragmentation 38
Free
Lossless Audio Codec (FLAC) 43
Space 55
Frequency 37, 333
Domain 110
Skew 175
Smoothing 218
Spectrum 211
Frontier Design Tranzport 57
FTP 182, 191
Host Name 191
Password 192
Path 192
Username 192

G
Gain 333
Change Amount Column 157
Change Meter 327
Change (on a selection) 204
Change ( Variable) 210
Compensation Button 328
Envelope 210, 292
Gaps 152, 161
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Gate 232
Genre 166
Go To 282
End 49, 68, 285
Time dialog 49
Gracenote CDDB 165
Grains 198
Granular normalization 198
Graphic representation 47
Guess Tempo 109, 284

H
Half Size 303
Hand Cursor 47
Hard disk/Hard drive 24, 38
-based recording 37
Maintenance 38
Storage Requirements 38
Hardware
Configuration for USB or FireWire Device 318
Process with external 235
Harmonic Rotate 210, 292
Headroom 333
Help 26, 267, 317
Hertz (Hz) 37, 333
Hide
All Audio Document Windows 305
Others 271
Peak 271
High
Amplitude 78
Frequency dynamics processor 231
Key 54
Precision Editing Mode 150
Highlight color 159
Hold 227
Times 49
Horizontal
Lock 47, 99, 104
Peak 6 User’s Guide

Scroll Arrow Buttons 148
Scroll Arrows 159
Scrollbar 148, 159
Host-based 231
Hours:Min:Sec:cdframes 53
Hz 37, 333

I
iChat AV 183
ID3 tags 111
IFPI (International Federation of Phonographic Industry
167
IMA 4:1 39, 45
Import
CD Track 40, 273
Range 41
Dual Mono 273
ImpulseVerb (reverb) 206, 211, 292
Increase Vertical Zoom 144, 279
Index(es) 130, 168
Create within CD track 169
Input
Clip Indicator 325
Device 62
Menu 68
Level 62
Meters 325
Slider 68
Insert 277
Audio 87
Silence 277
Silence into a Document 89
Insertion point 78
At Selection Start/End 278
Inserts 234, 299
Installing
& configuring your audio interface 61
Peak 29
Plug-ins 233

Interactive editing 77
Interleaved 41, 53
Internal clock source 66
Invert 212, 293
Phase 212
iPod 183
ISRC 117
Codes 167
Country Code 167
Display Column 158
Owner Code 167
Serial Number 167
Year of reference Code 167
iTunes 41, 165, 186
Directory 193
Extensions 184, 190
Music Store 39, 43, 183, 193
Playlist 173
Podcast Directory 189, 191
Subtitle 188
Summary 188
Send audio document to 102

J
Jack plug-in 235
JAM 43, 117
Image 43, 173
Jog Scrubbing 83

K
Keep Volume Constant 216
Keyboard
MIDI Input 303
Shortcuts 55, 307
Adding 55
Create A Custom “Cue Card” of 56
Removing 56
Keywords 188
Knee Shape Slider 328

Index
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Korg 231
Kurzweil 261, 299

L
.L 41, 53
Latency
Auto -Adjust Bounce for 242, 302
Eliminate 68
Manually compensate for 242
Toggle Compensation On/Off 242
Largest drive 64
Leave Open 253
LED 49
Level
Find Max Level in audio document 313
Meters 49
Leslie 232
LFO 232
Limiter 232
Linear 38
Blend Calculations 92
Fade In/Out 157
View Button 143
Link(s) 190
Menu 26, 305
List
Of Samples 262
View
Area 118, 154
Columns, Controls, and Fields 118, 155
Live
Document Resizing 271
Recording 47
Sound effects playback 69
Lo-fi 220
Rappify 220, 296
Load(ing) 238
And Restoring Vbox Presets 240
Fade In/Fade Out envelope 94
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Script 254
Virtual Instruments on Inserts 244
Locate
Marker 95
Region 99
Log File 253
Long Recordings 72
Loop(s) 50, 47, 80, 333
Audition Button 142
Color 268
Create from a selection 103, 315
Create Regions from 108
Create with Perpetual Looper 219
Crossfading 105, 208
De-activate Audition Looping 142
During playback 49
Hold 208
Listen to loop 315
Listen to loop only 104
Markers, convert to loop markers 103, 314
Morph Out Time 218
Move a pair of together 103, 314
Points 261
Save AIFF File with the Loop Flag On/Off 104
Start and End Marker 95
Surfer 284, 334
Surfing 334
Surfing, based on a musical tempo 106
Surfing, based on a selection 108
This Selection 280
Tuner 212, 293, 334
Tuning 212
With release 208
Looper, Perpetual 110, 295
Low amplitude 78
Key 54
Quality sampling 231
Quality stereo pitch shifter 232
Lower pitch 205
Peak 6 User’s Guide

M
M-Audio 61
.Mac 182, 190, 192
Password 192
Path 192
Username 192
Mac keyboard 69
MACE
3:1 39, 45
6:1 39, 45
Macromedia Director 43
“Magic” Pencil Tool 48, 90
Magnifying glass icon (Zoom tool) 47
Magnitude Multiplication 247
Make Loop button 108
Making
A Keyboard Shortcuts “Cue Card” 56
And modifying selections 81
Loops into Regions 108
Marker(s) 47, 79, 334
Are Indexes command 172
As Navigational Aids 81
Be a Reference (Marker) 96
Color 268
Convert to loop markers 103, 314
Copy just markers, loops and/or regions 98, 100, 314
Create during playback 96
Create during recording 96
Create while using dynamic scrubbing 96
Deleting 97, 314
Edit dialog 95, 103
Find by name 314
From Tempo 281
Move 97, 314
Move to zero-crossing 314
Name a marker 97, 314
Nudge a marker 97
Paste just markers, loops and/or regions 98, 100, 314
Position 95

Rename Series of Markers 101
Set attributes 97
To Regions (conversion)98, 281
Master(s) 117
Fader 49, 50
Level Controls & Meters 240
Output volume 51
Perfection Suite 232
Wet/Dry Controls 239
Mastering 325
Max
dB 80
Finding, Amplitude point in selection 210
Gain Change Slider 327
Level Indicator 47
Level, Finding in an audio document 313
Maxim Digital Audio 231
Maximizing Peak’s Performance 24
Maximum
Amplitude 80, 215
Pitch 218
MCN (Media Catalog Number) 166
MDA Dither plug-in 45
Megabytes per minute 38
Memory (RAM) 206, 270
Message 166
Metadata 334
Copying from Peak Metadata to file metadata 113
Editing 111
Peak Metadata Chunk 113
Reading 111
Meter(s) 49, 54
Settings 287
Level 49
Dialog 49
Michael Geoghagan 194
Microphones 37
Microsoft 43
Xbox Loop Boundaries 79, 280

Index
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MIDI 304
& Tempo dialog 54
“C” checkbox (Preferences Dialog) 57
Controller Thru 247
Interface 243
MIDI thru functionality for input device 57
Modulation wheel 246
Note Name 54
Preferences 56
To block control messages to software instruments 57
Receiving MIDI data device 56
Min:Sec:ms 48, 53
Minimizing quantization distortion 44
Minimum
Pitch 218
Silence Between Tracks 199
System Requirements 24
Track Duration 199
Miscellaneous Controls 127
Mix 214, 294
Mixer 247
Mixing
Audio tracks together 214
Board 49
Modifier 48, 138, 139
Modify Sample Rate 214
Modulate 215, 294
Modulation 247
Modulator 245
Monitor Checkbox 66, 286
Monitoring
Direct 68, 244
Recording 244
Mono
Document 272
To Stereo (Conversion) 213, 293
Monophonic sounds 203
MOTU 61
Mouse cursor 48
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Move Waveform During Playback 52, 301
Movie 110, 304
Change size of Window 315
Icon 73
Sound Tracks 111, 303
Move Event Tool 123, 149
Moving Plug-Ins 238
MP2 43, 321, 334
MP3 43, 189, 321, 334
Bit Rate 189
Edit ID3 Tags 189
Mono 189
Quality 189
MP4 43, 334
Multi
Band compressors 232
Band distortion 231
Channel I/O Devices 63
Document Recordings 72
Musical interval 204
Mute 238

N
Name 190
Track dialog 40
Naming convention 72
Native 231
Instruments 231
New 272
Document from Selection 88
Document from Playlist 173
Marker 280
Podcast RSS 184
Podcast RSS Checkbox 187
Region 281
Region Split 281
Next Track Button 135
Noise
Floor 225
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Gate 223
Reduction 232
Shaping 44, 175
Non
Destructive Editing 38, 77, 117
Destructive gain change 157
Linear 38
Zero crossings 89
Normalize 215, 294
A selection 215
RMS 216, 294
Selected Playlist Event Button 133
Notepad Cues (Recording Notepad) 285
Nudge 282
Amount Field 140
Buttons 119
Controls 119
Controls Group 137
In buttons 139
In Event Earlier in Timeline Button 139, 140
In Event Later in Timeline Button 139, 140
Loop Backward 280
Loop Forward 280
Markers 201
Markers dialog 97
Set amount 140
Set Time Unit 140
Out Buttons 139
Out Event Earlier in Timeline Button 140
Out Event Later in Timeline Button 140
Number of Songs field 200
Nyquist frequency 37

O
Octave 204
Odoc (Open Document) 255
Offf (Open the FindFile File) 256
Offset 54
One channel 213

Open 272
A dual mono file 41
After Saving Checkbox 67, 286
An audio file 39
Dialog 39
After Launch 303
Dual Mono Files 41
Opening
Compressed Audio Documents 39
Existing Audio Documents 39
Operating System & Authorization 23
Option
+ Tab keys 81
+ Control 48
+ Control + Drag 48
-clicking 48
Options menu 47, 301
Opto-electronic style limiter 232
Orange Book 170
Organizing Plug-ins with Folders 234
Original Size 303
Output
Area 253
Clip Indicator 328
Device 62
Device Menu 68
Directory 101
Area 102
Format 101
Area 102
Gain Slider 328
Level Meters 328
To new windows 101
Overlap
Crossfade(s) 122, 151, 161, 334
Duration Field 137
Overview
Conforming Playlist Events to Source Regions 132
Navigate File Overview without playing audio 313
Index
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Playlist Interface 118
List View Area 155
Waveform View Area 145
Show/hide Audio Waveform Overview 78
Sqweez-1 Interface 326
Vbox Interface 237
Owner Code 167

P
.paf 43
Panner 216, 295
Panning 216
Paragraphic EQ 232
Paris 43
Partial Harmonic Audio Technology (PHAT)110, 217
Choose an item to generate 218
Partials 217
Partials + Residual 218
Residual 217
Paste/Pasting 38, 277
Audio 86
Only Markers 98, 277
Only Regions 100
Pause(s) 152, 156, 162
Between tracks 117
Create, containing audio 153, 162
Create, silent 152, 162
Duration Column 156
Indicator 147
PCI 61
Peak(s)
About (Peak LE) 25
About (Peak) 267
Actions 313
Audio Librarian Tools 255
Audio Processing Tools 197
Events ( event class = ‘FURP’ ) 255
Features 21
Hold 49
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Impulses folder 211
Indicators 49
Menu 267
Metadata Chunk 113
MIDI Keyboard Window 243
Movie Window 110
Quitting 58, 255, 271
Shortcuts 55
Stops or stutters during recording or playback 320
User’s Guide 267
Volume 49
What it Installs 29
What’s New in Version 6 22
Will not launch 320
Windows and Palettes 46
Peavey 261, 299
Pencil Tool 47, 90
Dialog 48
Magic 48, 90
Smoothing for 315
Performer 166, 167
Permissions 55
Perpetual Looper 110, 217, 295
Choose an item to generate 218
Partials 217
Partials + Residual 218
Residual 217
Residual Gain 219
Residual Gain Morph In Time 219
Personal Web Sharing 193
Phase Vocoder 219, 296
PHAT (Partial Harmonic Audio Technology) 110
Pitch 37
Change, to apply variable 205
Change, of an audio selection 204
Correction 232
Slider 204
Quarter-tone 204
Raise 205
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Place In Toolbar checkbox 58
Play 49, 68, 256
+Pause 284
Button 135
From beginning of document or insertion point 313
From desired location in audio document 313
Selection 285
Through menu 63, 65
With Auditioning 285
Playback 61
Buffer 51, 270
Fast-forward 69
From specific point in a document 69
Preferences 51, 270
Rewind 69
Scroll During 52
Start/stop 69, 313
To Stop and have cursor return to original location 69
Volume control 49
Playhead cursor 52, 118, 148
Playing
Audio 68
Backwards 223
Virtual Instruments 244
Virtual Instruments with Audio Documents 245
Playlist 22, 117, 301, 304, 334
Add an Emphasis (Emp/PE) Flag to a Track 168
Add ISRC Code to a Track 158
Add Region(s) to, from Contents Drawer 128, 129
Add Region(s) to, from Contents Window 128
Add Region to, using Add Region Button 120, 127
Add Volume Envelope Breakpoint 153
Audition a transition 140
Audition Fade In portion of a transition 141
Audition Fade Out portion of a transition 141
Burn an Audio CD from a Playlist 126, 170
Butt Event to preceding Event in List View 161
Butt Event to preceding Event in Waveform View 151
Change Fade Type 152
Index

Change Gain of Volume Envelope Breakpoint(s) 154
Change order of Playlist Event(s) 160
Change Position of Volume Envelope Breakpoint 154
Choose a Fade Envelope 133
Close a Playlist 127
Conform Playlist Events to Source Region edits 131
Conform Source Regions to Playlist Event edits 131
Centered Crossfade in List View 161
Create a Centered Crossfade in Waveform View 151
Create a Gap in List View 161
Create a Gap in Waveform View 152
Create a Pause 156
Create new Audio Document from 173
Create Overlap Crossfade in List View 125, 161
Create Overlap Crossfade in Waveform View 125, 151
Customize order of columns in List View 159
Deleting Playlist Events 121, 150, 160
Delete Volume Envelope Breakpoints 153
Disable Vbox automation for Playlist Event 164
Document 272
Enable Vbox automation for Playlist Event 164
Enter an ISRC code 168
Event Begin Boundary 145
Event Begin Time Display 145
Event End Boundary 145
Event End Time Display 145
Event Name Display 145
Event Waveform Display 144
Events 117
Event in List View 121, 159
Event in Waveform View 121, 150
Export a DDP Fileset from a Playlist 175
Export a Formatted Text Report in PDF Format 176
Export an iTunes Playlist file from a Peak Playlist 174
Export a Jam Image file from a Playlist 173
Export a Tab-delimited Text Report 176
Function Buttons 118
List View Area 118, 154
List View Columns, Controls, and Fields 155
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List View Columns/Data Fields 118
Lock In & Out Checkbox 133
Modify a Volume Envelope 126
Move breakpoint while constraining dB value 154
Multiple Playlist Events in the List View Area 159
Merge Selected Playlist Events Button 130
Normalize an Event’s Level 133
Open a Playlist 127
Opening, Saving, and Closing Playlists 127
Output Options 170
Preview a Transition with Pre- & Post-roll 142
Print a Formatted Text Report in PDF Format 176
Preserve Timing 138
Program Duration Time Display 155
Rename a Playlist Event 160
Renaming Events 160
Reordering Events 160
Reset a Default Breakpoint: 153
Scrub audio using the Counter 135
Scrub Playlist audio during playback 314
Scroll Regions 139
Tools, About the 123
Playstation 279
Plug-ins 22, 231, 334
Apply/Bounce/Render a plug-in 235
Apply effects plug-ins dynamically 241
Assign a plug-in 236
Assignment Pop-up 236
Close/deactivate a plug-in 235, 237, 245
Configuring Peak to Record Virtual Instruments 244
Determining delay (latency) compensation of 242
Effect Inserts 305
Envelope 241, 269, 300
“Hot swap” 237
Included with Peak 231
Included with Peak Pro 232
Included with Peak Pro XT 232
Manually compensating for latency 242
Moving 238
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Menu 299
Open BIAS or VST on an insert 235
Open Audio Units on an insert 234
Open Vbox in Peak 236
Record Through 241, 244, 287
Rotary speaker simulator (Leslie) 232
Selecting a preset 237
Toggle delay Compensation On/Off 242
Using with the Batch File Processor 242
Podcast(ing) 23, 181
Add an Episode to an Existing Podcast 184
Advisory 191
Aggregator 183
Author 187
How it Works 181
Description 187
Image 189
Information 187
Producing 183
Publishing 182, 184, 185, 191, 274
Show intro 226
Solutions (book) 194
Submit to iTunes Music Store 193
Subscribe 184
Technical information (specs) 194
Title 187
What is? 181
Polyrhythmic sounds 203
Pops (clicks) 51, 79, 158, 165, 201
Repairing 89, 221
Post-roll 52, 82
Amount Field 141
Presets Pop-up Menu 141
Pre-roll 52, 82
Amount Field 141
Presets Pop-up Menu 141
Pre/Post buttons (Transport) 50
Preferences 50, 55, 267
Preserve
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Duration 204
File Attributes 253
Timing Checkbox 138
PreSonus 61
Preset(s) 191
Pressure waves 37
Preview
Crossfades 125
Previous
Track Button 135
/Next Selection 278
Primary Disk 55
Pro Tools 53
Process(es)(ing) (see also DSP)
Area (batch processor) 252
Audio with a DSP function 197
To stop lengthy 313
With external hardware 235
Real-Time Bounce 235, 300
Processing chain 44
Product
Code 166
Updates 30
Progress Bar 50
Public service announcement 226

Q
QDesign 39, 45
Quarter
Note 54
Tone 204
QuickTime 39, 43, 45, 334
Size of Movie Window 315
Quitting Peak 58, 255, 271

R
.R 41, 53
Radio Buttons
Channels & Bit Depth 64

RAM (Memory) 51, 54, 206, 270
Random-access 38
Range of human hearing 37
Rappify 220, 296
Ratio Slider 327
Raw 43
Real-Time 231
Bounce 235, 300
Re-compressing 45
Recall
Snapshot 137, 153, 163
Receive 262
Recently Opened Documents 40, 275
Record 49, 68, 285
Audio 70
Button 70
Dialog 70
Disk 286
Disk menu 64, 66
Notepad 285
Settings 64, 285
Dialog 64, 66
Through menu 63, 65
Through Plug-Ins 67, 241, 244
Timer 67, 286, 287
Recording 61
Audio 70
Cassettes 71
Format & Settings Options 64
Into a QuickTime movie 72
Levels 63
LPs 71
Output of virtual instrument plug-ins 67
Pausing/resuming 71
Through Effects Plug-ins 71
Timed 67, 71
To stop 70
Recover Audio File 42, 273
Red Book 117, 120
Index

355

I

Audio CD specification 120
CD mode 126
Checkbox 136
Redo 84, 276
Reduction Ratio Slider 224
Region(s) 47, 50, 335
Are Tracks (CD burning option) 171, 172
About, and CD Frame Boundaries 98
Capture to Playlist 281
Change name of 99
Conform to CD frame boundaries 98
Conform Source, to Playlist Event edits 131
Detection 101
Detection area 102
Export Dialog 101
Export from audio document 101
Locate 99
Modify length of 99
Move 99
Move both ends of, simultaneously 314
Rename a Series of Regions 101
Split 100
Registration 30
Account 30
Using another computer with Internet access 31
Release Slider 224, 327
Remove DC Offset 222, 297
Rename(ing) 282
Dialog 100
Field 100
Find Section 100
Marker(s) 95, 100
Region(s) 99, 100
Renaming Playlist Events 160
Series of Markers/Regions 101
Reordering Playlist Events 160
Repair(ing)
Clicks & Pops 89
Repair Click(s) 220, 222, 296
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Size 221
Replace(ing) 277
Audio 87
Repeat a section of audio 80
Report
Printing A Playlist Text 135, 176
Required Silence Before Strip Slider 225
Reset Windows 305
Residual 217
Gain 219
Gain Morph In Time 219
Resize
Columns in Contents Window 50
Contents Window 50
Toolbar 57
Icons in Toolbar 58
Resonant filter 232
Return
To beginning of document 69
To Start 49, 68
Reverb (ImpulseVerb) 206, 211, 231, 292
Decay 211
Length 211
Modify characteristics of 212
Impulses 211
Impulse Gain 211
Source Gain 211
Reverse 223, 297
Boomerang 222, 297
Revert
All from Sampler 299
From Sampler 299
Revert to Item 85, 129
Rewind 49, 68, 69, 135
Ring modulator 215, 232
RMS (Root Mean Square) 216
Level 216
Level Meter 325
Metering 325
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Rollover Help Tips 26
Root key 54
Root Mean Square (RMS) 216
Rotary speaker simulator (Leslie) 232
Roxio
JAM 43,117
Toast 117
RSS Feed 181, 182
Anatomy of 182

S
Sample 335
Anchor To 96
Playback instruments 54
Rate 37, 80, 175, 335
Conversion 203, 205
Converter Quality Menu 64. 65
Rate of a document, changing 206
Units 301
Value 214
Sampler(s) 105, 246, 261, 335
Loop point offsets 261
Menu 298
Preferences 264, 269
Receive 262
Revert All from Sampler 299
Revert from Sampler 299
Send All to 299
Send to 299
Samples 48, 53
Sampling 37
Save 238, 272
A Copy As 43, 273
As 43, 45, 272
Audio document under another name 44
Audio document with compression 45
Changes... 253
Dialog 44
Peak document 43

Script 254
To Disk 192
With file compression 45
Saving
A Playlist 126
And Closing Documents 42
Compressed Audio Documents 45
Scratch Disks 85, 268
Choosing 55, 322
Dialog 55
Scroll 47
Audio display left/right 314
During Play 51, 52, 301
Regions Checkbox (Playlist) 139
Wheel mouse, zooming/scrolling with 148
Scrubbing 51, 82
Can’t access Tape Style 320
Dynamic 82, 83
Jog 83
Loop duration for 51, 82
Shuttle 82
Tape-style 83
Time 51, 303
SCSI 261, 336
SDII (Sound Designer II) 173
Seamless loops 109, 110, 217
Select
All 81, 313, 278
Audio between markers 81, 314
Audio between two markers with Tab key 81
Audio I/O 287
Audio I/O Button 65, 67, 287
Audio I/O dialog 62
Loop 278
Loop duration for dynamic scrubbing 51, 82
Multiple Playlist Events in the List View Area 159
Nonadjacent Playlist Events 160
Playlist Event in List View 121, 159
Playlist Event in Waveform View 121, 150
Index
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Plug-in preset 237
Selected Processes For Batch 252
Selecting
Audio 80
Playlist Events 150, 159
Transitions 124
Selection(s) 78, 197
Contiguous 128
Create Loop from a 103, 315
Discontiguous 128
Delete markers in a 97
Extend/shorten 81, 313
Fit 279
Making a 313
With mouse 81
Normalize a 215
Snap selection to nearest Snap To unit 314
To reverse a 223
Toggle start/end 313
Semi-tone 204
Send 262
To iTunes 102, 275
Serial Number 30, 167
Server Type 191
Set
Blending parameters 91
Default Fades for Playlist 133
Delay compensation offset 315
Import Times button 41
Marker attributes 97
Nudge amount 140
Nudge Time Unit 140
Selection 278
Snapshot 153, 163
Track Start Offsets 154, 163
Zoom factor amount 315
Setting(s) 189
Peak’s Playback Parameters 51
Preferences 50
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Record Disk & Format 64
Record 285
Sff (Set FindFile Volume) 255
Sfff (Set FindFile File) 256
Shepard tone generator 232
Shift-click 40
Shortcuts and Toolbar 55, 270
Show
Cursor Info 302
Edits 91, 302
Marker Times 52, 302
Overview 302
Playlist Type Chooser 134
Vbox 164
Shuffle Mode 138
Silence 278
A Selection 88
Is Audio Below slider 200
Simple stereo delay 231
Sixteenth note 54
Size of the Vbox matrix 240
Skipping 62
Skype 183
Slip Mode 137
Choosing 138
Slip/Shuffle Mode Radio Buttons 137
Slow
Down playback 203
Fade in 157
Fade out 157
SMDI 208, 336
Browse samples in SMDI device 263
Device 262
Send a sample to Peak 263
Send audio document to sampler 263
Receive 262
Sampler dialog 262
Sampler(s) 105, 208, 261
Problems using Peak with a 321
Peak 6 User’s Guide

Error Messages & Troubleshooting 263
Smooth transition 91, 109
Smoothing 221
Factor 221
For the Pencil tool 315
The transition 207
SMPTE 48, 54
Snap
End 280
Start 280
Start & End 280
To 280
CD Frames 98
Options 79
Zero Crossings 79
Sony PS2 Loop Boundaries 79
Selection to nearest selected Snap To unit 314
Snapshots 159, 240
Clearing 165
For a series of Playlist Events 164
Recalling 137, 153, 163
Setting/storing 137, 153, 163, 164
Soft Clip 216, 325
Button 328
Solo 238
Songwriter 166, 167
Sonic
AIFF 43
Solutions 43
Sony PS2 Loop Boundaries 79, 280
Sound Designer II (SDII) 43, 64, 98, 173, 336
Sound-on-sound 214
Soundflower 183
SoundSoap 201, 221
SoundSoap Pro 71, 201, 221, 232
Specific duration for recording 67
Specifying a record disk 64
Speed up playback 203
Spike 220

Split
Audio document by amplitude 225
Audio recordings 198
Selected Playlist Event Button 130
Stereo 67
Files checkbox 286
Sqweez-1 Wideband Dynamics Processor 325
Ratio Slider 327
Stack Windows 305
Staggered View Button 143
Start 262
Start Surfing button 108
Steinberg Media Technologies, AG 231
Stereo
Document 272
I/O Devices 62
Image adjustment 232
-To-Mono 213, 293
Stop 49, 68, 135, 256
& Extend Selection 285
/Return to Start 284
Lengthy processes/saves/recalculations 313
Strip Silence 223, 297
Required Silence Before Strip Slider 225
Stripper 223, 225
Subcodes
Add an Emphasis (Emp/PE) Flag to a Track 168
Copy Protection, adding to a Track 168
SUBCODES.DAT 174
Subscribe 184
Sustain loops 110
Swap Channels 225, 298
Synthesizer 246
System 7 Sound 43
System Administrator 55

T
Tab
Key 81
Index
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-delimited Playlist Text Report 176
Talkbox 232
Tape
Hiss 71, 201
-Style Scrubbing 51, 65, 83
To control speed in 83
Tascam 61
Technical
Support 26, 317
Questions, common about Peak 318
Tempo 48, 54, 107
Calculator 107
Envelope 203
Terminal 184
Commands 169, 170
drutil cdtext 169
drutil discinfo 170
drutil info 169
drutil list 170
drutil status 170
drutil subchannel 170
drutil trackinfo 170
Test
Recordings 68
Tones 232
Text Report 95
Printing 135, 176
Tab-delimited Playlist Report 177
Theme pop-up menu 53
Third-party interface 61
Threshold 225, 298
Slider 223, 327
Tile Windows 304
Time 48
Display 49, 134
Domain 78, 110
Format 48
Shifting Window 203, 205
Stretching 202
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Units 53, 301
Bars/Beats 48, 54, 79, 280
Min:Sec:ms 48, 53
Choosing format 54
Timecode 54
Timed Recording 71
Timeline 53, 148
Timestamp 54
Title 166, 167
Toast 117
Toggle Contents Drawer 47, 85, 128, 305
Toolbar 57, 304
Add new icon to 58
Preferences 270
Remove icon from 58
Resize icons in 58
Tools
Centered Crossfade 150
Magic Pencil 315
Move Event 123, 149
Toggling between 315
Trim Event 124, 149
Zoom 47
Track
CD-TEXT Column 158
Duration Column 156
End Time Column 156
Name Column 155
Number Column 155
Number Display 134
-specific CD-TEXT 167
Start Offsets 154, 163
Start Offset Column 156
Start Offset Indicator 147
Start Time Column 156
Transition(s)
Abrupt 91,109
Butt Edits 150, 161
Gaps 152, 161
Peak 6 User’s Guide

Preview with Pre- & Post-roll 142
Smoothing 207
Snapshots/Controls 137, 153, 162
Transmit 184
Transparent cursor overlay 48
Sel 48
Transport 304
Controls 49, 68, 119
Window 49
Transposition 204, 232
Tremolo 218
Triggering Playback of Multiple Audio Documents 69
Trim Event Tool 123, 149
Troubleshooting 317
Turn Loop Flag On/Off 104
Two channel 213
Twolame.Bundle 322

U
Undo 84, 276
Undoing/Redoing 129
UNIX Commands (Terminal) 169
Unlimited Undo/Redo 77
UPC (Universal Product Code) 166
Update(s) 262
Check for 267
URL 185
USB 61
Clicks and pops when recording with 318
Use
CD-TEXT for Naming 176
Default .Mac Account checkbox 192
Dither Checkbox 171
Loop in Playback 103, 218, 301
Post-roll in Audition Checkbox 141
Pre-roll in Audition Checkbox 141
Selection box 108
Subcategories in DSP Menu 269
User

Guide, About Your 24
Interface 23
Preset Controls 238
Preset Load Button 329
Preset Save Button 329
Using
Crossfades and Blending to Smooth Edits 91
Edits Command to Undo a Series of Actions 84
Effect Plug-ins with the Batch File Processor 242
Effects Plug-ins 234
Guess Tempo command to find tempo 109
Loop Surfer 106
Loop Tuner 109
Mac OS Terminal 169
Modulation Wheel to Control Cross-synthesis 246
Nudge Buttons in Centered Mode 140
Nudge Buttons in Overlap/Gap Mode 139
Threshold command to find tempo 109
Undo and Redo Commands 122
Unlimited Undo/Redo 84
Virtual Instrument Plug-ins 243

V
Variable wet/dry mix 241
Vbox 234, 300
Column 119
Inserts Column 159
Matrix 236
Move plug-in from one box to another 239
Open in Peak 236
Preferences 240
Verify After Burn Checkbox 172
Vertical
Lock Mode 47, 99
Scaling 78
Scroll Arrows 159
Scrollbar 159
Vibrato 218
View
Index
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Controls 142
L+R Sum Waveform Radio Button 143
Left Channel Waveform Radio Button 143
Right Channel Waveform Radio Button 143
Stereo Waveform Radio Button 144
Virtual instruments 231
Configure and Play along with audio documents 245
Configuring Peak to Record 244
Piano 232
Playing 244
With an External MIDI Controller 243
With your Computer keyboard 243
Vocoder 232, 245, 247
Voiceover 226
Ducking 226, 227, 298
Preroll 227
Postroll 227
Volume
Boosting 216
Envelope 147
VST 159, 231, 233, 300, 336
VU 49

Window(s)
Auto-tiling 302
Auto-stacking 302
Buffer 51, 270
Contents, change sort order 50
Contents, sort columns in 50
Floating 271
Magnetism 271
Menu 304
Movie window, change size of 315
Preferences 271
Stack 305
Tile 304
Reset 305
Wire Tap Pro 183
Working with
CD-TEXT 165
Loops 103
Markers 94
Regions 98
Subcodes 165
Write ISRC Codes Checkbox 172

W

X

.WAV/WAVE 43, 98, 336
Waveform
Color 267
Display 47
Display Area 119, 144
How to “read” 78
Show/hide Overview 78
View Area 118, 142
Waves 231
Website Link 187
Wet 212
Wet/dry 246
Mix 234
Slider 212
Variable mix 241

X-axis 48
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Y
Y-axis 48
Yamaha 261, 299
A note about the A3000 263
Year of Reference Code 167

Z
Zero-crossing(s) 78, 212, 280, 336
Zoom
Amount dialog 48
At Sample Level 90, 279
At Sample Level (End) 280
Controls 144
Factor amount 315
Peak 6 User’s Guide

In 47, 79, 144, 279
In/out by increments 314
Out 48, 144, 279
Out All the Way 279
To Fit Transition 144
Tool 47
Vertical scaling 78
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